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(HEC-SSP), and, ecosystems function analysis (HEC-EFM).  HEC 
software implementation is under the guidance of Christopher N. Dunn, 
Director, Hydrologic Engineering Center. 
 
Design and development of the WAT computer program has been a team 
effort.  The initial design and concepts of the WAT were done by Messrs. 
Christopher Dunn, Gary Brunner, Jeff Harris, and William Charley.  This 
group also included John DeGeorge of Resources Management 
Associates (RMA).  Once a draft design document was created, the 
formal design process started and several other individuals joined the 
team; Mark Jensen, William Scharffenberg, Joan Klipsch, and Penni 
Baker.  The team contributed to the writing of this user's manual. 
 
Mark Ackerman, John DeGeorge, and Shannon Newbold of Resources 
Management Associates (RMA) developed the graphical user interface, 
developed the concept of plug-ins, implemented and assisted HEC in the 
development of the plug-ins, and assisted with debugging and the overall 
design of the program.  
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Foreword 
 
 
The Hydrologic Engineering Center’s Watershed Analysis Tool program, 
HEC-WAT, provides an interface that will streamline and integrate the 
analytical process using the tools commonly applied by the multi-
disciplinary teams of Corps offices.  Although the original goal of the WAT 
was to help offices perform watershed and/or system-wide studies, it can 
also be used for smaller studies as well, like a CAP (Continuing 
Authorities Program) study. 
 
The WAT graphical user interface (GUI) integrates software and software 
tools that could be used during the analytical process.  Software is 
incorporated in the WAT through the use of a plug-in.  The plug-in 
concept means that the WAT does not "know" anything about the 
software application code; the individual pieces of software provide the 
analytical computations, while the WAT provides the framework to 
coordinate the study.  The graphical user interface is illustrated and 
described in detail in this manual. 
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CHAPTER 1  
 
 

Introduction 
 
 
The U.S. Army Corps of Engineers (USACE) conducts watershed and 
water resources management studies.  These studies begin with the 
definition of problems, issues, and opportunities and continue with various 
analyses to determine impacts so that appropriate decisions may be made.  
The studies often require hydrologic/hydraulic, economic, environmental, 
and social impact analyses.  In most cases, varying sections within a 
district office perform these impact analyses independently with the 
reporting and visualization of modeling results through independent 
models.  For the project study, coordination, file/data sharing, logistics, 
reporting of modeling results, and status reporting are often a problem for 
the modeling teams as well as project management. 
 
The Corps determined that there was a need to streamline and integrate the 
tools commonly applied by the district and division offices to perform 
these analyses so that more efficient and coordinated modeling and 
planning may be performed.  Modeling teams would benefit because they 
would be able to develop their models in a closely coordinated manner, 
track progress of other models, and automatically retrieve results from 
previous model runs thus assuring a more efficient and coordinated result.  
A control and visualization type interface would allow data and results 
sharing, common schematic assembly, alternative definition and 
representation, model setup, editing and implementation, and direct data 
and results visualization.  A management team would benefit through the 
use of a tool that employs a common interface by being able to track 
project status through each modeling component and being able to display 
results during public and project status meetings. 
 
 

1.1 Purpose 
 
The HEC-WAT (Watershed Analysis Tool) program streamlines the 
analytical and reporting processes while producing more consistent results 
for watershed type studies.  Software guidelines established at HEC have 
been used in the implementation of the WAT.  These guidelines facilitate 
a common user interface, a common look-n-feel, and provide better 
interaction between HEC software in the PC environment.  Other HEC 
software implemented under HEC software guidelines are:  rainfall-runoff 
analysis (HEC-HMS), river hydraulics (HEC-RAS), reservoir system 
analysis (HEC-ResSim), flood damage analysis (HEC-FDA), flood impact  
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analysis (HEC-FIA), statistical analysis (HEC-SSP), and ecosystem 
response analysis (HEC-EFM).  The WAT software has a windows style 
user interface and operates on Windows XP and Windows NT. 
 
The terminology, analysis procedures, and output are consistent with 
requirements of ER 1105-2-100, ER 1105-2-101, EM 1110-2-1619, and 
other Corps guidance criteria.  WAT is designed to facilitate: 
 
 ● The entry of the appropriate data into each of the individual 

modeling programs. 
 ● Trade-off analyses as all study alternatives will eventually be 

created within the WAT using consistent schematics, data, and 
tools.  Their results will be easier to compare and contrast thus 
making the trade-off analysis easier to perform. 

 ● The analytical process and enhanced coordination among study 
team members, while producing more consistent results, and shared 
displays. 

 ● The definition of alternatives through schematic representations, 
model identification and sequencing, and tabular formats. 

 ● The study status by reviewing reports in the WAT.  During any 
given study, the manager or any other member of the project 
delivery team (PDT) will be able to determine the study status. 

 ● The reviewing of modeling results at all modeled locations without 
the direct knowledge of how any of the individual models develop 
those results.  Those attending meetings will be able to see the 
results directly rather than reading the results from a few locations 
in a hard copy report or poster. 

 
 

1.2 Organization of Manual 
 
The organization of this manual is shown in Table 1.1 (see page 1-3).  An 
overview of the WAT is described in Chapter 2.  The capabilities of the 
WAT are described in Chapters 3 through 11. 
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Table 1.1 

Summary of Contents of User's Manual 
 

If you want to find out… Refer to… 
Overview of HEC-WAT Chapter 2 
WAT Framework Chapter 3 
How to create and manage studies Chapter 4 
How to work with layers Chapter 5 
How to create and manage alternatives Chapter 6 
How to create and manage schematics Chapter 7 
How to create and manage analysis periods and 
events 

Chapter 8 

How to create and manage simulations Chapter 9 
Computes and Alternative Analysis Chapter 10 
Model Results Chapter 11 
Concept of pug-ins Appendix B 
Tools available from the WAT Appendix C 
How to setup the coordinate system for map layers Appendix D 
Map layer editors Appendix E 
Using the Color Chooser Appendix F 
How to use HEC-DSSVue Appendix G 
Glossary Appendix H 
How to edit model data Appendix I 
How to customize plots Appendix J 
Printing and copying data from the WAT Appendix K 
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CHAPTER 2  
 
 

Overview of HEC-WAT 
 
 
The HEC-WAT program provides a Graphical User Interface (GUI) that 
streamlines and integrates the tools commonly applied by the Corps 
District and Division offices so that more efficient and coordinated 
modeling and planning may be performed.  The WAT GUI provides 
dialogs for file management, data entry and editing, and viewing output. 
 
 

2.1 Overview 
 
The WAT is a tool that will help in the performance of water resources 
studies (Figure 2.1), whether they are CAP (Continuing Authorities 
Program) studies or large comprehensive studies.  A WAT study is 
comprised of alternatives and analysis periods, with the combination of 
these two items creating a simulation.  Computations executed in the 
WAT are performed through simulations. 

 
It allows the Corps and its partners and stakeholders to conduct their 
studies in a coordinated fashion. The WAT interface streamlines and 
integrates a water resources study using software commonly applied by 
the multi-disciplinary teams that comprise a typical Project Delivery Team 
(PDT).  The WAT is not replacing existing software but rather it's an 
interface that allows unique pieces of software to work together.  Software  

Figure 2.1  A Typical HEC-WAT Study 

Simulation1

Analysis 
Period1

Without Project 
Conditions

WAT Study

Simulation2

Alternative B Analysis 
Period2

The HEC-WAT 
software 
streamlines 
and integrates 
tools 
commonly 
used by the 
Corps District 
and Division 
offices so that 
more efficient 
and 
coordinated 
modeling and 
planning may 
be performed. 
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such as Hydrologic Modeling Systems (HEC-HMS), Statistical Software 
Package (HEC-SSP), River Analysis Systems (HEC-RAS), Reservoir 
System Simulation (HEC-ResSim), Data Storage System Visual Utility 
Engine (HEC-DSSVue), Flood Impact Analysis (HEC-FIA), and 
Ecosystem Functions Model (HEC-EFM) are currently implemented 
within the WAT.  This coordination allows a study team to perform many 
of the necessary hydrologic, hydraulic, environmental, and planning 
analyses all orchestrated from a single interface. 
 
Coordination begins as each model uses the common schematic that is 
built within the WAT interface.  The common schematic demands that 
each team use the same nomenclature for each of their models and 
alternatives.  The individual models can be built and edited inside or 
outside the WAT and model results are viewed from the WAT by 
selecting the elements found on the schematic.  Once the models are 
located within the WAT, the models can be run in sequence.  The storage 
of data is organized by DSS and a simple DSS linking device is used to 
connect the models.  The models themselves, the input data, and the 
results are all stored in the WAT’s directory structure.  Therefore, all data 
and files used to make decisions are easily retrieved.  Alternative analyses 
can be performed, and output from multiple alternatives can be viewed at 
the same time making alternative analyses and selection easier. 
 
A common, central framework is provided through the WAT.  From the 
framework, GIS based layers can be loaded such as shapefiles and DEMs; 
stream networks and schematics can be established; locations (common 
computation points) can be identified where models would share 
information; the modeling programs and their sequence order are defined; 
existing models are imported; and new models are developed.  The WAT 
framework will meet the following objectives: organize and develop 
alternatives; access modeling programs directly; and, view and compare 
alternative results. 
 
 

Software 
currently 
implemented in 
the WAT, 
includes: 
 HEC-HMS 
 HEC-SSP 
 HEC-RAS 
 HEC-ResSim 
 HEC-FIA 
 HEC-DSSVue 
 HEC-EFM 

2.2 Identify a WAT Study 
 
An issue at the beginning of any project study (i.e., reconnaissance, or 
feasibility) is the definition, study extent, and representation of 
alternatives.  The WAT helps to alleviate this issue by allowing the project 
study team to jointly define alternatives through schematic 
representations, model identification and sequencing, and tabular formats. 
 
The study team, under the direction of a Project Manager (PM), will start 
the analysis process by meeting to acquaint themselves with the type and 
location of study to be conducted (i.e., reconnaissance, feasibility, 
watershed, restoration).  A typical study team could be composed of a PM,  
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GIS specialist, hydrologist, hydraulic engineer, water manager (reservoir), 
economist (flood damage), biologist (water quality), and planner. 
 
The team will determine what data or models already exist and what data 
and models will need to be built.  With the WAT, there is no extracting or 
copying of other data to a DSS file before a simulation is computed.  
Therefore, you need to be sure if your study area requires the use of 
observed data, historical, or other model data, that this data is stored in one 
DSS file.  This requirement is based on the way the WAT links model 
alternatives together and simulations are computed. 
 
With a map in hand, the PM would lead the study team on choosing the 
study boundaries, identifying gage locations, sub-basin delineations, 
points where models would share data (common computation points), 
damage area centers, and location of measures (reservoirs, levees, etc.).  
Once this information has been identified then someone from the study 
team would be chosen to set up the base alternative (Without Project 
Conditions).  This should be someone with some knowledge of the study 
area. 
 
With the study area defined, the study team needs to find out if any 
models already exist, what data is available, and what is the time window 
(analysis period) of the available data for the base alternative (Without 
Project Conditions).  Once the base alternative is set the study team 
should identify, name, and gather information for the additional 
alternatives.  These alternatives could include the use of additional flood 
damage reduction measures, environmental features, or simply represent 
future conditions.  The benefit of the WAT is that each of the modeling 
teams will be able to use the identical schematic to perform their modeling 
and naming will be consistent across all models.  Each alternative will be 
tied to a given schematic.  Therefore, the alternative definitions will be 
fully coordinated making for more consistent modeling and results. 
 
 

A study, in the 
WAT is a 
combination of 
the data and 
models and 
events 
required to 
analyze a 
specific 
geographic 
area. 

2.3 Create a WAT Study 
 
After the study team has identified the study area, then a WAT study can 
be created (see Figure 2.1, page 2-1).  A study, in the WAT is a 
combination of the data and models and events required to analyze a 
specific geographic area.  The first step is to define the schematic for the 
base alternative, and then schematics for other defined alternatives. 
 
A schematic is a physical representation of a stream alignment, and the 
flood damage reduction and environmental measures that will be modeled.  
One individual from the study team will build the schematic for the base 
alternative.  The first basic item of a WAT schematic is the stream 
alignment; this is usually created from importing information from a map  
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layer (shapefile).  Once a stream alignment has been built, then common 
computation points, and existing flood control or restoration measures, 
will be added to the schematic that will be shared across all models.  To  
aid in the placement of elements on the schematic, background maps of 
gage locations, reservoir locations, sub-basin delineations, study boundary 
areas, etc. should be added to the study. 
 
By default, the WAT creates the base alternative – Without Project 
Conditions.  The study team has probably defined other alternatives that 
can be created, as well (Figure 2.2).  An alternative in the WAT is a way 
to group a schematic with different operations and model parameters.  

Once an alternative is created, the next step is to create analysis periods.  
Analysis periods define the time window and events that could be 
associated with an alternative.  An event is an occurrence of 
precipitation/snowmelt that leads to some sort of hydrologic response 
normally associated with a specific time period.  The event can be 
historical or hypothetical or represent the upper limit of a precipitation 
runoff response. 
 
Now that alternatives and analysis periods have been defined in the WAT, 
existing models that have been identified for the study can be brought into 
the WAT either by importing or copying the files into the WAT directory 
structure.  If models are to be built, the WAT provides two options.  One 
is that you can create the models through the WAT by accessing the 
individual pieces of software directly from the WAT.  The other option is 
for you to copy the files created by the WAT to your computer, and then 
return the files to the WAT study once you are finished with the modeling.  
For example, if the RAS model for a study needs to be built, from the  

A schematic is 
a physical 
representation 
of a stream 
alignment, and 
the flood 
damage 
reduction and 
environmental 
measures that 
will be 
modeled. 
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Figure 2.2  Relationship of Alternatives and Schematics 
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WAT directory structure there is a RAS folder which contains the default 
RAS files for the study.  You can copy these files to your own computer, 
create the RAS model, and then copy the files back to the WAT study. 
 
Once all the models have been added to the WAT study, simulations 
(Figure 2.3) can be created.  A simulation is a combination of an analysis 
period and event(s) associated with an alternative.   For each of these 

combinations, models will need to be selected, the simulation will be 
computed, and results will be reviewed.  The process is then repeated for 
the other identified alternatives, and after several WAT simulations, 
alternative result comparison can be reviewed. 
 
 

Simulation
Without Project 

Conditions-AP-Event1

Simulation

Alternative B-AP-
Event1

Analysis 
Period/Event1

Alternative B
(e.g. new reservoir)

Without Project 
Conditions

Figure 2.3 Relationship of Alternatives and Analysis Periods to Simulations 

A simulation is 
a combination 
of an analysis 
period and 
event(s) 
associated 
with an 
alternative. 

2.4 Starting the WAT 
 
When starting the 
WAT, double-click the 
HEC-WAT program 
icon on your desktop, 
or from the taskbar 
click Start, point to 
Programs, point to 
HEC, and then click 
WAT.  The splash 
dialog box for the W
will open (Figure 2.4). 
 

AT 

he splash dialog box 
r 

f y to 

Figure 2.4  HEC-WAT Splash Dialog Box 

T
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CHAPTER 3  
 
 

HEC-WAT Framework 
 
 
For HEC-WAT, a study is a combination of the data and models and 
events required to analyze a specific geographic area.  A study will 
include all of the background maps needed for the spatial configuration, 
the stream system associated with the watershed, measures (e.g., 
reservoirs, levees), gage locations, impact areas, hydrometeorological 
data, and models for the study. 
 
 

3.1 Overview 
 
The WAT is an interface that streamlines and integrates a water resources 
study using software commonly applied by multi-disciplinary teams.  The 
WAT is not replacing existing software but rather provides an interface 
that allows unique pieces of software to work together.  Software such as 
HEC-HMS, HEC-SSP, HEC-RAS, HEC-ResSim, HEC-DSSVue,  
HEC-FIA, and HEC-EFM are currently implemented within the WAT.  
The integration of the programs and tools is accomplished through the use 
of a concept called a "plug-in".  The "plug-in" concept allows the WAT to 
remain oblivious to the computing requirements of the individual pieces of 
software, but provides an analysis framework for the programs.  A "plug-
in" can provide the ability to access model parameters and view results of 
a model from the WAT framework.  In other cases the "plug-in" only 
provides the viewing of results, with the changing of model parameters 
being done outside of the WAT. 
 
The common framework provides the user with the ability to load GIS 
based layers such as shapefiles and DEMs; stream networks and 
schematics can be established; locations where programs would share 
information (common computation points) can be identified; the programs 
and their sequence order are defined; existing models are imported; and 
new models are developed. 
 
 

The "plug-in" 
concept allows 
the WAT to 
remain 
oblivious to the 
computing 
requirements 
of the 
individual 
pieces of 
software, but 
provides an 
analysis 
framework for 
the programs. 

3.2 WAT Main Window 
 
The WAT main window (see Figure 3.1, page 3-2) displays the framework 
for the WAT that will allow you to enter data, review data, create 
alternatives, run simulations, and view results.  The main window is laid  
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Figure 3.1  HEC-WAT Main Window 
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out in panes along with a desktop area for viewing results from a common 
schematic. 
 
The Title Bar (Figure 3.1) displays the WAT study title.  After a study is 
opened, the name of the study will appear here.  The Menu Bar contains 
the following menus: 
 
 File This menu is used for study management (creating, 

opening, closing, saving, details, properties); print the 
active map, importing model alternatives (ResSim, RAS, 
FIA), exporting model alternatives (Version 1.0), open 
recent studies, and exiting the WAT.  The following 
commands are available:  New Study, Open Study, 
Close Study, Save Study, Study Details, Print Map, 
Import, Export, Recent Studies and Exit. 

 
 Edit From this menu you can set the program order, 

manipulate alternatives and simulations, link the 
individual models, and access the individual program 
editors.  Available commands are:  Program Order, 
Alternative and Simulation Manager, Model Linking 
Editor, HMS, ResSim, RAS, FIA, and EFM. 

 
 View This menu is used to setup the WAT main window, you 

can select toolbars and panes, set display units for 
plotting and tabulating, and manage layouts for the main 
window.  Available commands are: Toolbars, Study 
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Pane, Messages, Status, Set Display Units, Save 
Layout, Restore Layout, and Layout Manager. 

 
 Maps From this menu you are setting up map layers and map 

windows.  You can set spatial properties, zoom the 
active map window out to its full extents, add map 
layers, remove map layers, open a new map window, 
adjust the active map windows properties, save the 
contents of the active map window as a graphic file, 
import a stream alignment from an ArcView® shapefile, 
import impact areas from an ArcView® shapefile, 
export a stream alignment to an ArcView® shapefile, 
and, export impact areas to an ArcView® shapefile.  
Available commands are: Default Map Properties, 
Zoom To All, Add Map Layers, Remove Map Layers, 
New Map Window, Map Window Properties, Save 
Map Image, Import, and Export. 

 
 Compute This menu is used to compute individual simulations, 

compute multiple simulations, compute by individual 
programs, and view the compute log for the active 
simulation.  Available commands are: Compute 
Manager, Compute, and View Compute Log. 

 
 Results From this menu you can select the simulations for 

comparison, and view results from the integrated 
software.  Available commands are:  Result 
Comparison Manager, HMS, ResSim, RAS, and FIA. 

 
 Tools This menu provides access to DSS data (HEC-DSSVue); 

access to the Statistical Software Package (HEC-SSP); 
access to the GeoRAS and GeoHMS software packages; 
allows creating and editing of scripts; provides options 
for WAT startup, setting system properties, viewing 
threads, setup simulation and compute color, and plug-in 
information; customize menus and toolbars, view WAT  
program activity, and monitor memory usage.  Available 
commands are:  HECDssVue, SSP, GeoHMS, 
GeoRAS, Scripts, Options, Customize, Console 
Output, and Memory Monitor 

 
 Window From this menu you control the appearance of the map 

windows in the Desktop Pane (see Figure 3.1, page 3-2) 
of the WAT main window.  You can organize all of the 
currently opened map windows in either a vertical or 
horizontal tile, place one map window on top of the next 
in a cascading fashion, bring the next map window in the  
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  list of currently opened map windows to the top, bring 
the previous map window that was on top to the top, 
provide a pick list of the currently opened map windows, 
and a sub-menu of all the currently opened map 
windows.  Available commands are:  Tile, Cascade, 
Next Window, Previous Window, Window Selector, 
and Window. 

 
 Help Displays current version information about the WAT. 
 
 

3.2.1 Toolbar 
 
The toolbar area of the WAT main window (see Figure 3.1, page 3-2) 
provides quick access to the most frequently used options from the WAT 
menu bar.  There are five available toolbars from the main toolbar: 
 
 Standard There are four tools available from the Standard 

Toolbar (Figure 3.2).  The tools allow you to open a 
study, close a study, save a study, and print the 

currently selected map window.  These tools have the 
same function as the items under the File menu (see 
Section 3.1, page 3-2). 

 
 WAT Tools There are three tools available 

from the WAT Tools 
Toolbar (Figure 3.3).  The 
tools allow you to link the 
individual model alternatives 
(Modeling Linking Editor, see Chapter 9, Section 
9.5.1, page 9-30); manipulate alternatives and 
simulations (Alternative and Simulation Manager, 
see Chapters 6, 8, and 9); and, set the program order 
for the WAT (Program Order dialog box, see 
Chapter 9, Section 9.2, page 9-1). 

 
 Management  There are two tools  
 Tools available from the 

Management Tools 
Toolbar (Figure 3.4).  The 
first tool allows you to 
compute simulations (Compute Manager, see  

Toolbars 
provide quick 
access to 
frequently used 
option in the 
WAT.  There 
are five toolbars 
available: 
 Standard 
 WAT Tools 
 Management 
 Tools 

Figure 3.2  Standard Toolbar 

 Tools 
 Programs 

Figure 3.3 WAT Tools 
Toolbar 

Figure 3.4 Management 
Tools Toolbar
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  Chapter 10, Section 10.1.1, page 10-1); and, the 
second tool is for setting up comparisons of simulation 
results (Results Comparison Manager, see Chapter 
10, Section 10.2.1, page 10-7). 

 
 Tools There are four tools available from the Tools Toolbar 

(Figure 3.5).  The tools allow 
you to access DSS data 
(HEC-DSSVue, see 
Appendix G); access the 
Statistical Software Package (HEC-SSP, see Appendix 
C, Section C.1, page C-1); access the geospatial 
hydraulic tool HEC-GeoRAS (see Appendix C, Section 
C.2, page C-3);and, access the geospatial hydrology tool 
HEC-GeoHMS (see Appendix C, Section C.3, page  

  C-4). 
 
 Programs There are four tools available from the Programs 

Toolbar (Figure 3.6) that represent the individual 
software programs available from the WAT:   

  HEC-HMS, HEC-ResSim, HEC-RAS, HEC-FIA, and 
HEC-EFM.  These buttons allow you to directly execute 
the selected software program from the WAT. 

 
To toggle these toolbars on and off, on the View menu, point to Toolbars, 
and select the toolbar you which to toggle on and off. 
 
 

Figure 3.5  Tools Toolbar

Figure 3.6  Programs Toolbar 

3.2.2 Panes 
 
Panes are viewing areas that allow you to view WAT study data at the 
same time or to display different, yet simultaneous, views of WAT study 
data.  The WAT main window has four main panes.  The panes are: 
 
 Study Pane This pane (see Figure 3.7, page 3-6) provides an 

overview of WAT alternatives, simulations, and 
analysis periods that have been defined for a study.  A 
WAT alternative is a way to group a schematic with 
different operations and model parameters.  Analysis 
periods define the time windows and events that could 
be associated with an alternative.  Simulations are 
combinations of analysis periods and events, 
associated with an alternative.  A simulation will be  

In the WAT 
graphical user 
interface, panes 
are viewing 
areas that allow 
the user to view 
study data.  
There are four 
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 Content Pane 
 Desktop Pane 
 Message Pane 
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  computed and results will be reviewed.  Once a 
simulation has been computed, you can visually tell 
the status of the compute (from the Study Pane). 

 
  The Study Pane (Figure 3.7) acts like an explorer tree 

in the study.  The top level is the study, the next level 
lists the alternatives, and the final level lists the 
analysis periods.  Under the alternatives level is where 
the simulations for each defined study alternative are 
located.  Each alternative also contains a schematic 
and associated background maps. 

 
 Content Pane The Content Pane (Figure 3.8) provides details on the 

selected WAT component in the Study Pane.  For 
example, in Figure 3.7, a WAT simulation has been 
selected – Without Project Conditions-1993 Flood.   

 

Figure 3.7  Study Pane 

The Study 
Pane provides 
an overview of 
WAT 
alternatives, 
simulations, 
and analysis 
periods that 
have been 
defined for a 
study. 

Figure 3.8  Content Pane 
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  The Content Pane (see Figure 3.8, page 3-6) displays 
the elements of that simulation.  Information includes 
the alternative, the analysis period, the model 
alternatives that were run, the time window, the 
directory where the results from the simulation were 
written, and the status of the simulation. 

 
 Desktop Pane This pane (Figure 3.9) is where the different map 

windows (see Section 3.2.4, page 3-9) available from 
the WAT will display.  For example, in Figure 3.9, the 
Desktop Pane contains a map window of a selected 
simulation and a map window of a selected schematic.  
These two map windows provide the user with a 
graphical representation of a simulation and a 
schematic, respectively. 

 
 Message Pane The Message Pane (Figure 3.10) contains messages 

that the WAT program is providing for informational 
purposes.  The information in the Message Pane is a 
record of the WAT program activity, recording the 
opening of a study, opening map windows, accessing 
DSS, and many other WAT activities. 

 

The Desktop 
Pane is where 
the different 
WAT map 
windows are 
displayed.  
This is where 
the user is 
viewing model 
results and 
interacting 
graphically 
with each 
model. 

Figure 3.9  Desktop Pane 

Figure 3.10  Message Pane 
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3.2.3 Tabs 
 
The WAT tabs provide different views of the available data in a study and 
users can perform certain operations for a study from the tabs.  There are 
five tabs: 
 
 Study The default tab (see Figure 3.1, page 3-2) which provides 

a view of study data.  Also, you can create, edit, and delete 
alternatives, analysis periods, events, and simulations. 

 
 Analysis The Analysis Tab (Figure 3.11) provides a view for 

comparing results for the selected analysis group.  You 
can select which alternatives to compare, which alternative 
will be the base alternative, and select analysis groups. 

 
 Maps The Maps Tab (Figure 3.12) provides a view of the 

selected map window; this includes the map layers, stream  

 

Tabs are a 
WAT graphical 
user interface 
item that 
provides 
different views 
of data and 
depending on 
the tab the 
user can 
perform 
certain 
operations.  
There are five 
tabs: 
 Study 
 Analysis 
 Maps 
 Schematic 
 Files 

Figure 3.11  Analysis Tab 

Figure 3.12  Maps Tab 
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  alignment, and information specific to what is being 
displayed by the selected map window. 

 
 Schematic The Schematic Tab (Figure 3.13) is where the schematics 

are created, edited, and deleted. 

 
 Files The Files Tab (Figure 3.14) provides a view of the files 

and directory structure of the currently opened WAT 
study. 

 

Figure 3.13  Schematic Tab 

Figure 3.14  Files Tab 

3.2.4 Map Windows 
 
Map windows are a way to graphically display stream alignments, 
schematics, alternatives, and simulations.  From an alternative map 
window you can open editors and view results.  A schematic map window 
allows you to edit, modify, and delete measures, common computation 
points, impact areas, and make adjustments to the stream alignment.  The  
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simulation map window (Figure 3.15) is where you can edit individual 
model parameters and view results. 

 

Map windows 
graphically 
display the 
major 
components for 
a WAT study 
(i.e., stream 
alignments, 
schematics, 
simulations, 
etc.). 

Figure 3.15  Simulation Map Window 

3.3 Plug-Ins 
 
The primary purpose of the WAT is to streamline and integrate a water 
resources study using software commonly applied by multi-disciplinary 
teams.  The integration of the models and tools is accomplished through 
the use of a concept called a "plug-in".  By using the "plug-in" concept the 
WAT incorporates individual pieces of software such as our suite of 
software (HEC-RAS, HEC-HMS, HEC-ResSim, HEC-EFM, HEC-FIA, 
and HEC-FDA) and allows them to work together in a coordinated fashion 
so that water resources, economic, and environmental decisions can be 
made from the same interface. 
 
The "plug-in" concept allows the WAT to remain oblivious of the 
computing requirements of the individual pieces of software, but provides 
an analysis framework for the models.  A "plug-in" can provide integrated 
schematic elements, access to model editors, access to model results, and 
the ability to perform model computations all from the WAT framework.  
For further details on the "plug-in" concept, see Appendix B. 
 
 

The WAT 
incorporates 
individual 
pieces of 
software such 
as our suite of 
software 
(HEC-RAS, 
HEC-HMS, 
HEC-ResSim, 
HEC-EFM, 
HEC-FIA, and 
HEC-FDA) 
through the 
use of a "plug-
in". 
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CHAPTER 4  
 
 
 

Creating and Managing Studies 
 
 
 
Data management by HEC-WAT is largely done behind the scenes.  Files 
are automatically created and named by the WAT to store information.  
Simulation information is stored in an HEC-DSS 
file, while general information, alternative 
descriptions, and simulation descriptions are all 
stored in ASCII text files. 

Figure 4.1 File Menu  

 
 

4.1 Managing Studies 
 
In the WAT, the set of files associated with a 
particular watershed is called a study.  The WAT 
creates a directory (folder) with the study name 
specified, and stores all the files associated with 
the study in that directory.  
 
Commands available in the File menu (Figure 4.1) 
allow you to create a new study, open an existing 
study, close the current study, save the current 
study, and create a copy of the current study. 
 
 

 Commands 

4.1.1 Creating a New Study 
 
To create a new study: 
 
 1. On the File menu, click New Study. 
 2. In the New Study dialog box (see Figure 4.2, page 4-2), enter a 

name (required) in the Study Name box, and in the Description 
box, enter a description (optional, but recommended) for the new 
study. 

 3. In the Directory box, either enter the name of the directory where 
you want to store your WAT study, or click the button, and an 
Open Browser (see Figure 4.3, page 4-2) will open.  You can 
navigate to the directory you want to store the WAT study on your 
computer or network. 
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Figure 4.2  New Study Dialog Box 

Figure 4.3  Open Browser 

 4. By default the 
WAT creates a 
default alternative 
– Without Project 
Conditions.  If you 
want the default 
alternative to have 
a different name 
you have several 
choices, including 
Other (Figure 4.2) 
which allows you 
to name the default 
alternative 
anything you want.  If you don't want to create an alternative, click 
Create Default Alternative. 

 5. You can add map layers (see Chapter 5) to your study if you wish.  
Click Add Maps, the Select Map to Add browser will open (see 
Figure 4.4, page 4-3).  If you want the WAT to copy the map layers 
to the study directory (maps folder) click Create Copy.  Select the 
desired map layers and click Open.  The Select Map to Add 
browser (see Figure 4.4, page 4.3) will close. 

 6. Click OK, the New Study dialog box will close (Figure 4.2).  The 
WAT main window will now have the name of the study in the title 
bar. 

 7. A schematic map window will open in the Desktop Pane (see 
Chapter 3, Section, 3.2.2, page 3-7) and in the Study Pane (see  
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Figure 4.4  Select Map to Add Browser 

  Chapter 3, Section 
3.2.2, page 3-6) 
the study name 
and the default 
alternative will be 
displayed. 

 8. A directory with 
the study name 
and associated 
files will be 
created for the 
study.  For further 
details on the 
study directory and files, see Section 4.2 (page 4-5). 

 
 

4.1.2 Opening an Existing Study 
 
There are two ways to open existing studies in the WAT.  One way is to 
open a study by selecting it from the list of most-recently-opened studies.  
On the File menu (see Figure 4.1, page 4-1), point to Recent Studies, 
from the list of the most recently opened five studies, click on the name of 
the study you wish to open, and the WAT will automatically load the 
selected study.  The second way to open an existing study is described 
below. 
 
To open an existing study: 
 
 1. On the File menu, click Open Study, an Open Browser (see 

Figure 4.3, page 4-2) will open. 
 2. From the Open Browser, browse to the location of the existing 

WAT study.  By default, the WAT is looking for a file with the 
extension *.sty. 

 3. Select the study name, click Open, the Open Browser will close, 
and the selected study will open in the WAT. 

 
 

4.1.3 Close a Study 
 
To close an active study, on the File menu (see Figure 4.1, page 4-1), click 
Close Study, if there have been no changes made to the study, then the  
study will automatically close.  If changes have been made a Save File 
dialog box will open (see Figure 4.5, page 4-4). 
 
The WAT keeps track of changes being made to a study by the major 
study components – alternatives, analysis periods, and simulations.  The 
list of items that will appear in the table on the Save File dialog box will  
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Figure 4.5  Save File Dialog Box 

be all of the items that you 
have changed during a 
session.  By default, 
everything is selected for 
saving; however, you have 
the choice of being able to 
pick and choose by 
component what changes to 
save. For example, from 
Figure 4.5, say for some 
reason you do not want to 
save any changes you made 
to the Without Levee alternative, click in the Save column of the table, this 
unselects the alternative.  Therefore, when you click OK, the changes that 
were made for the Without Levee alternative are gone. 
 
 

4.1.4 Save a Study 
 
To save a study on the File menu (see Figure 4.1, page 4-1), click Save 
Study, the WAT will automatically save the study. 
 
 

4.1.5 Study Details 
 
One of the objectives of the WAT is to provide information regarding the 
status of the study, to the manger or any other member of the project 
delivery team.  Some of the information required needs to be entered by 
the study team, from the Study Properties dialog box (Figure 4.6).  This 
dialog box has three tabs – Contacts, Model Info, and Simulations.   

Figure 4.6  Study Properties Dialog Box 
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Information that can be entered is: team member name, user name, team 
member's model responsibility, team member who has imported a model 
alternative, date imported, and much more.  The Study Properties dialog 
box also provides information about the study:  the study name, 
description, location of the study file, the unit system chosen, who created 
the study, and the data and time the study was created. 
 
 

4.2 Study Directories and Files 
 
Figure 4.7 (page 4-6) shows an example of how the WAT organizes the 
directories and files that it creates in the study directory.  In this example, 
the study directory is /BaldEagle.  As data is entered, other files and 
subdirectories are created.  Table 4.1 (pages 4-7 thru 4-8) describes each 
directory and file that is shown in Figure 4.7 (page 4-6). 
 
 

4.3 Automatic Backup Files 
 
As you add a stream alignment, map layers, and data to a study the files 
and directories listed in Table 4.1 (page 4-7) are created, along with  
automatic backup files.  For example, a baldeagle.sty file and a 
baldeagle.sty.bak file are created when the study is created.  If you add a 
map layer for example, the .bak file would not have any reference to the 
added map layer, the backup file reflects the state previous to the current 
changes.  So every time you Save a study, the *.bak file is updated to the 
previous state. 
 
Automatic backup files are created for all study files, alternative files, 
analysis period files, simulation files, and results files.  DSS files are not 
automatically backed up.  Since the .bak file reflects the previous state of 
that file, the user can go back to the previous state by eliminating the .bak 
extension.  This would allow the information for that previous state to 
become the current state.  The overall effect would be "undoing" all 
changes you made in the last cycle. 
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Figure 4.7  Example HEC-WAT Study Directory Structure 

BaldEagle

BaldEagle.wksp

fia

this folder contains all HEC-FIA 2.0 model files

FrequencyBasedEvents.wap

SimulationA.container

layouts

shared

study

stream.align

Default.ag

modified.dbf

modified.dbt

modified.mdx

Study.dbf

Study.dbt

Study.mdx

BaldEagle.sty

programOrder.xml

Without_Project_Conditions.walt

SimulationA.simulation

hms

this folder contains all HEC-HMS model files

maps

ras

this folder contains all HEC-RAS model files

rss

this folder contains all HEC-ResSim model files

ssp

this folder contains all SSP model files

2004_Flood.wap

1993_Flood.wap

Without_Levee.walt

Reservoir_Re-Op.walt
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File or Directory Name Contents 

 Study directory that is created when a user 
creates a new study (see Section 4.1.1, page  
4-1). 

 

ASCII text files created by the WAT when a 
study is created.  Contains the name and 
description of the study, what user created the 
study, map coordinate information, and 
references to the stream alignment and the 
schematic data.  The *.bak file is an automatic 
backup file of the *.sty file. 

 ASCII text files created by the WAT when a 
study is created.  Contains the name and 
description of the study, location of stream 
alignment file, and location of any map layers 
that have been added to the study.  The *.bak 
file is an automatic backup file of the *.wksp 
file. 

 ASCIISerializer text file created by the WAT 
when a study is created.  Contains information 
for a default analysis group.  The 
Default.ag.bak file is an automatic backup file 
of the Default.ag file. 

BaldEagle 

BaldEagle.sty 

Bald Eagle.sty.bak 

BaldEagle.wksp

Bald Eagle.wksp.bak

Default.ag

Default.ag.bak

 An XML file created by the WAT when a 
study is created.  Contains information on the 
program order that can be defined by the 
WAT.  Initially, contains the default program 
order:  HEC-HMS, HEC-ResSim, HEC-RAS, 
and HEC-FIA.  The programOrder.xml.bak 
file is an automatic backup file of the 
programOrder.xml file. 

programOrder.xml

programOrder.xml.bak

 

ASCII text files created by the WAT when a 
study is created.  Contains the name, 
description, and other information that define 
the stream alignment (stream nodes, vertex 
points, stream element(s), etc.).  The 
stream.align.bak file is an automatic backup 
file of the stream.align file. 

stream.align.bak

stream.align

 ASCII text file created by the WAT when a 
study is created, contains information on the 
default alternative.  Contains the name, 
associated stream alignment, and other 
information.  The 
Without_Project_Conditions.walt.bak file is 
an automatic backup file of the 
Without_Project_Conditions.walt file. 

 

Sub-directory created by the WAT when a 
study is created.  This folder contains all 
HEC-FIA 2.0 model files. 

 Sub-directory created by the WAT when a 
study is created.  This folder contains all 
HEC-HMS model files. 

Without_Project_Conditions.walt

Without_Project_Conditions.walt.bak

fia

hms 

 Table 4.1  Example HEC-WAT Directories and Files 
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File or Directory Name Contents 

 Sub-directory created by the WAT when a 
study is created.  This folder contains the 
saved layouts for the WAT Desktop Pane. 

 

Sub-directory created by the WAT when a 
study is created.  Used to store map layers and 
GIS coverages associated with a study. 

 Sub-directory created by the WAT when a 
study is created.  This folder contains all 
HEC-RAS model files. 

 Sub-directory created by the WAT when a 
study is created.  This folder contains all 
HEC-ResSim model files. 

 

Sub-directory created by the WAT when a 
study is created.  This directory is a place to 
store files that might be used by the study. 

 Sub-directory created by the WAT when a 
study is created.  This folder contains all 
HEC-SSP model files. 

 

Sub-directory created by the WAT when a 
study is created.  This directory contains the 
information created from the Schematic Tab.  
Contains database files (*.dbf, *.dbt, *.mdx) 
that contain the data when creating measures, 
impact areas, and common computation 
points. 

layouts 

maps 

ras 

rss 

shared

ssp 

study

 
 
Table 4.1  Example HEC-WAT Directories and Files (continued) 
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CHAPTER 5  
 
 

Using Layers 
 
 

5.1 Concept of Layers 
 
There are several types of layers available in the HEC-WAT software.  
The Stream Alignment Layer is specifically for the stream alignment, 
which is discussed in Chapter 7.  Map layers are used in the WAT to 
visualize a system layout and or a flood inundation.  The WAT program 
creates primary layers when a user creates a stream alignment, schematic, 
alternatives, and a simulation.  This chapter covers map and primary 
layers. 
 
 

5.2 Map Layers 
 
To help you visualize a study area, the WAT has the capability to display 
maps of study features.  Sub-basin boundaries, watershed boundary, and 
stream gage locations, are just a few of the digital maps of study features 
that can be displayed in the WAT. 
 
 

5.2.1 Map Layer Formats 
 
In the WAT, digital maps are referred to as map layers.  When a map 
layer is included in a watershed, the program displays it as a color picture.  
In the Beta Version, the map layers are used for visual purposes only.  In 
future versions, depending on the type of map layer, the program will 
interact with map layers as data sources.  The map layer formats that the 
WAT can display are listed in Table 5.1 (page 5-2). 
 
 

 Arc Shapefiles (.shp) 
 
This layer type is the native data structure for the ArcGIS® program.  
Shapefiles store non-topological geometry and attribute information for 
the spatial features of a data set.  Usually there are three files associated 
with a shapefile:  *.dbf, *.shp, and *.shx.  The .shp file contains the shapes 
(point, polylines, or polygons) that are displayed in the layer.  Each shape 
has a record in the .dbf file containing descriptive data  
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called "attributes."  The .shx file contains an index that links each shape to 
its record in the .dbf file. 
 

Table 5.1 
Map Layer Formats Supported by HEC-WAT 

 
 

Description 
Common Filename 

Extension 
USGS digital line graph .dlg 
AutoCAD® DXF .dxf 
Arc Shapefile .shp 
Raster image .img, .jpg, .gif 
ASCII NetTin .net 
USGS DEM .dem 
ArcInfo® DEM .asc 

 
 

 AutoCAD® DXF (.dxf) 
 
A Drawing Interchange File (.dxf) is created by a Computer-Aided Design 
(CAD) package, AutoCAD®.  This format is a tagged data representation 
of an AutoCad® drawing file.  Tagged data is where each data element is 
preceded by a group code.  A group code is an integer indicating the type 
of data element.  The file created is a vector-based graphic.  The DXF 
format is commonly used for data export from other CAD and GIS 
programs. 
 
 

 Raster Image 
 
The raster image formats supported by the WAT are JPEG format (*.jpg) 
and Graphics Interchange Format (*.gif).  For the WAT to access these file 
types, an *.img (ASCII text) file must be created by the user outside of the 
WAT.  The file needs to contain the information shown in Figure 5.1,  

 
Image West=2051443. 
Image North=355443. 
Image East=2054925.6 
Image South=351947.4 
 
 
 
 
Image URL = path and filename of raster image 
  (i.e., maps/lh_2m.gif) 

These are image boundaries that are 
determined by the user and usually 
figured out by using a program like 
ArcInfo®.  

Figure 5.1  Raster Image File 



HEC-WAT User's Manual Chapter 5 – Using Layers 

 5-3 

this information needs  to match the easting and northing parameters 
stated in the Map Default Properties for StudyName dialog box (see 
Section 5.2.5, page 5-7). 
 
 

 USGS Digital Line Graph (.dlg) 
 
USGS Digital Line Graphs (DLG) are created from two sources using 
manual and automated digitizing methods.  The two sources are aerial 
photographs or cartographic sources.  DLG files are vector representations 
of the data.  When the WAT interacts with a .dlg file it automatically 
creates a .dlgbin file for use. 
 
 

 USGS DEM (.dem) 
 
The USGS Geological Survey publishes the file format USGS DEM.  A 
raster file format, .dem files usually contain terrain elevations, but the file 
format can be used for representing any surface.  The format, published by 
the USGS, allows internal documentation of coordinate system, date of 
publication, etc.  These values are referenced horizontally, either to a 
Universal Transverse Mecator (UTM) projection or to a geographic 
coordinate system. 
 
 

 ASCII NetTin (.net) 
 
This is an ASCII file format used to represent a triangulated irregular 
network (TIN).  TIN data are stored in a simple format that defines the 
nodes, edges, and triangles contained in the TIN.  This format is common 
for transferring TIN data between software. 
 
 

 ArcInfo® DEM (.asc) 
 
This is an ASCII file format representation of a grid generated by 
ArcInfo®.  The file consists of keywords followed by values defining the 
number of columns, number of rows, lower left corner, cell size, no data 
value, and each cell value. 
 
 

5.2.2 Adding Map Layers 
 
You can add as many types of map layers as you need.  However, you 
must make sure that all map layers use the same origin and measurement 
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units.  In GIS jargon, all map layers must use the same projection.  You 
can add map layers to your study from any of the WAT tabs. 
 
When a map layer is added to the study, the WAT reads the coordinates of 
points, lines, and polygons on the map layer and resets the geographic 
extents of your study to the smallest rectangle that will contain all objects 
in the map layer.  When adding more than one map layer, you must ensure 
that each is projected in the same coordinate system.  For example, if you 
add a digital line graph (DLG) map layer that shows the major streams in 
an area, the geographical extents will change according to the projection 
of that DLG.  If that DLG is projected in state plane coordinates in feet, 
the WAT will set the geographic extents accordingly, and the units of the 
stream alignment (described in Chapter 7) will be in feet. 
 
To add map layers: 
 
 1. On the Maps menu, click Add Map Layers, and the Select Map to 

Add browser will open (Figure 5.2). 
 2. The browser 

defaults to the 
study directory, 
but you can 
retrieve maps 
from anywhere on 
your computer.  
From the study 
directory is a 
maps directory, 
which is where 
HEC encourages 
you to copy your 
various maps. 

 3. If you want the 
WAT to copy the 
selected map layer to the study directory, click Create Copy. 

 4. From the Select Map to Add browser, select the desired map layer 
format from the Files of type list, locate the file of the desired map 
layer format, select filename, and click Open.  The browser will 
close and the map layer will appear in the active map window. 

 5. If you select the Maps tab there will now be an entry for the added 
map layer.   

 
 

All map layers 
must use the 
same origin 
and 
measurement 
unit, which in 
GIS jargon, 
means all map 
layers must use 
the same 
projection. 

Figure 5.2  Select Map to Add Browser 

5.2.3 Removing Map Layers 
 
To remove map layers: 
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 1. On the Maps menu, click Remove Map Layers. 
 2. The Remove Map dialog box will open (Figure 5.3). 
 3. From the Existing box there is list of map layers, select a map layer 

by clicking on the 
name. 

 4. In the Remove box, the 
name of the selected 
map layer will appear in 
the Name box. 

 5. Click Remove, a 
warning message will 
appear, asking you if 
you really want to 
remove the map layer 
from the study, click 
Yes. 

 6. The warning message 
will close, the Remove 
Map dialog box will 
close, and the map layer will be gone from the active map window. 

 
 

Figure 5.3  Remove Map Dialog Box 

5.2.4 Shortcut Menu for Map Layers 
 
The shortcut menu for map layers is accessed by right-clicking on any 
map layer that is listed in the Maps Tab (see Chapter 3, Section 3.2.3, 
page 3-8).  This list of map layers refers to the currently active map 
window (see Chapter 3, Section 3.2.4, page 3-9) that is open in the 
Desktop Pane (see Chapter 3, Section 3.2.2, page 3-7).  The shortcut 
menu provides several ways to manipulate map layers.  This ability to 
manipulate depends on the type of map layer, since the WAT does not 
provide the same capabilities to all recognized map layer formats (see 
Table 5.1, page 5-2).  The available commands are: 
 
 Expand – expands the selected map layer's tree; the tree provides 

information on the available elements of a map layer, and details 
provided are based on what the WAT recognizes for the individual 
map layer format. 

 
 Collapse – collapses the selected map layer's tree; the tree provides 

information on the available elements of a map layer, and details 
provided are based on what the WAT recognizes for the individual 
map layer format. 

 
 Move to Top – moves the selected map layer to the top of the tree 
 
 Move Up – moves the selected map layer up the tree one position 
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 Move Down – moves the selected map layer down the tree one 
position 

 
 Move to Bottom – moves the active map layer to the bottom of the 

tree 
 
 Show Legend – shows the legend for the active map layer in the tree 

structure. 
 
 Change Label – allows you to change the label of the map layer in the 

Maps Tab.  This does not change the filename of the map layer. 
 
 Properties – shows the properties of the selected map layer.  See 

Appendix E for further details on the available map layer editors. 
 
 Set Scale for Zoom-in – set the zoom-in visualization scale for the 

selected map layer 
 
 Set Scale for Zoom-out – set the zoom-out visualization scale for the 

selected map layer 
 
 Remove Scale Factors – disable or clear all scale settings for the 

selected map layer 
 
 

5.2.5 Geographic Reference for Map Layers 
 
To maintain a geographic reference (also called a geo-reference), the 
WAT uses a user-selected coordinate system, called the World Coordinate 
System (WCS).  This superimposes a grid on layer features to establish x- 
and y-coordinates in WCS for each point on the layer.  The x-coordinate is 
referred to as "easting" and the y-coordinate is referred to as "northing".  
You can select the extent of this grid, the dimensions of the cells of the 
grid, the units of measurement of the grid, and even the location of the 
origin of the grid.  Because of this flexibility, you can specify and use 
virtually any grid coordinates convenient for water resources studies.  To 
do so: 
 
 1. On the Maps menu, click Default Map Properties, the Map 

Default Properties for StudyName dialog box will open (see 
Figure 5.4, page 5-7).  By default, the Map Extents tab is selected. 

 2. The information in the Map Extents tab includes: 
 ● Coordinate System.  This box identifies the established 

coordinate system for a study.  To edit the coordinate system, 
click Edit, and the Map Coordinate Information dialog box 
(see Figure 5.5, page 5-7) will open.  See Appendix D for  

For the WAT 
to have the 
flexibility to 
use virtually 
any grid 
coordinates 
convenient for 
water 
resources 
studies, the 
WAT uses a 
user-selected 
coordinate 
system, called 
the World 
Coordinate 
System (WCS). 
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Figure 5.4  Map Default Properties for StudyName Dialog Box 

Note that the 
geographic 
extents of your 
layers must be 
selected 
carefully, and 
must be 
consistent for 
all layers to 
ensure that the 
entire study is 
included. 

Figure 5.5  Map Coordinate Information Dialog Box 

  details on editing the coordinate system.  Remember that all 
layers must exist in one unified coordinate system. 

 ● Extents – Easting Minimum, Maximum, Northing 
Minimum, and Maximum.  These values indicate the 
location of the left, right, bottom and top borders 
(respectively) of the grid in the map window. 

 ● Grow to Map Extents.  When selected, the WAT 
automatically sets the geographic extents to define the 
smallest rectangle that encompasses all the objects in the 
study. 

 ● Set Map Extents to Display.  This will set the limits of the 
map window.  If you zoom in on an area, and click Set Map 
Extents to Display, the Map Default Properties for 
StudyName dialog box (Figure 5.4) extents will change to the 
zoomed area. 

 
Note that the geographic extents of your layers must be selected carefully 
to ensure that the entire study is included.  Further, the extents you specify 
and the coordinate system you use must be consistent for all the layers. 
Therefore, you may need to use GIS tools to transform the layers from one 
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coordinate system to another before using them with the WAT.  The WAT 
has no coordinate system transformation tools. 
 
 

Figure 5.6  Map Layer Properties Dialog Box - Scale Tab 

5.2.6 Setting Visualization Scales - Map Layer 
 
The easy way to set the visualization scale for map layers is outlined in the 
following steps: 
 
 1. From a map window zoom-in to the point at which you want the 

map layer to become visible. 
 2. From the Maps Tab, in the Content Pane, right-click on the map 

layer.  From the shortcut menu, click Set Scale for Zoom-in, the 
visualization scale is set automatically for that map layer. 

 3. If you go to the map window and zoom-out, the map layer you 
selected will no longer display.  Inversely, if you want the map 
layer to become visible as you zoom-out, from the shortcut menu 
click Set Scale for Zoom-out. 

 4. Visualization scale settings can be cleared or disabled for a map 
layer.  From the shortcut menu, click Remove Scale Factors, the 
current visualization scale for that particular map layer is cleared. 

 
Another way to set the visualization scale for a map layer is the specific 
map layer's properties dialog box.  The following steps outline the 
procedure: 
 
 1. From the Maps Tab, right-click on a map layer, from the shortcut 

menu, click Properties, the map layer specific properties dialog 
box will open (Figure 5.6). 

 2. Click Scale, both zoom-in and zoom-out scale factors can be set 
from the map layer property dialog box.  By default the map layer is 
set for Always show layer.  To set visualization scales click Only 
show layer in the following scale range. 



HEC-WAT User's Manual Chapter 5 – Using Layers 

 5-9 

 
 
 3. To set the scale so that the map layer becomes visible as you zoom-

in, you can set the scale to the current scale by clicking Set to 
Current.  If you wish to enter a value, from the Only visible below 
1: box enter the scale factor.  

 4. To set the scale so that the map layer becomes visible as you zoom-
out, you can set the scale to the current scale by clicking Set to 
Current.  If you wish to enter a value, from the Only visible above 
1: box enter the scale factor. 

 5. Click OK, the map layer specific properties dialog box closes, and 
the visualization scale is set for the map layer. 

 
 

5.3 Primary Layers 
 
The WAT program creates primary layers when a user creates a stream 
alignment, schematics, alternatives, and simulations.  These primary layers 
appear in the Maps Tab.  Depending on which type of map window that 
is open, you will be able to access different primary layers. 
 
 

5.3.1 Stream Alignment Layer 
 
The Stream Alignment Layer contains the stream alignment (see  
Chapter 7, Section 7.8, page 7-13) that you imported or digitized on the 
map window, is visible in the Maps Tab, and is available in all map 
window types.  This layer has sub-layers for each stream alignment 
element, and can be accessed by expanding the tree for the Stream 
Alignment Layer.  To expand the tree, click the plus sign; to collapse the 
tree, click the minus sign. 
 
When you expand the tree, you can see the different sub-layers for the 
stream alignment.  There are three – Stream Junctions, Streams, and 
Stream Nodes.  A stream junction is where two streams connect, and is 
represented by a bight green circle on the stream alignment.  A stream 
node is a location (a dark green circle) on a stream that provides stream 
stationing information.  By default, the WAT creates two automatically, 
and a user can add stream nodes to a stream.  A stream in a stream 
alignment is a multi-segmented line with beginning and ending stream 
nodes.  If, for some reason you do not want to see the stream junctions for 
the entire stream alignment, you would clear Stream Junctions, and the 
stream junctions would no longer display in the active map window.  To 
view the stream junctions, you would click Stream Junctions.  This 
procedure applies to all of the sub-layers. 
 
 

The Stream 
Alignment 
Layer contains 
the stream 
alignment 
displayed in 
the active map 
window.  This 
primary layer 
has three sub-
layers which 
represent the 
components of 
a stream 
alignment. 



Chapter 5 – Using Layers HEC-WAT User's Manual 

5-10 

 Stream Alignment Properties 
 
For the Stream Alignment Layer, you can configure the appearance of 
the streams and their labels, configure the appearance of the stream 
junctions and stream nodes, and, set the visualization scaling for the 
Stream Alignment Layer.  To configure these properties, from the Maps 
Tab, right-click on Stream Alignment.  From the shortcut menu, click 
Properties, the Stream Alignment Properties dialog box will open 
(Figure 5.7). 

Figure 5.7  Stream Alignment Properties Dialog Box 

A stream in a 
stream 
alignment is a 
multi-segmented 
line with 
beginning and 
ending stream 
nodes.  Stream 
properties 
include width, 
color, 
appearance of 
stream labels, 
displaying 
stream names, 
and tic marks 

 
Streams 
 
To change the appearance of all streams in the map window: 
 
 1. You can set the width of the lines that represent the streams in your 

stream alignment from the Stream Width list (Figure 5.8). 

Figure 5.8  Stream Alignment Properties - Streams 

 2. You can select 
the color of the 
lines that 
represent the 
streams in your 
stream alignment 
from the Stream Color list (Figure 5.8).  The default color is 
orange, there are several colors to choose from, plus you can create 
your own colors from a color chooser.  From the Stream Color list,  
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  click Custom, the Choose A Color dialog box (Figure 5.9) will 
open.  See Appendix F for further details on the color chooser. 

Figure 5.9  Choose A Color Dialog Box 

 3. Either changing the width or color of the streams, can be previewed 
in the example to the right of the Edit Properties box (Figure 
5.10).  For the changes to appear in 
the map window, click Apply, and the 
map window will update. 

Figure 5.10  Preview Changes 

Figure 5.11  Font Chooser 

 4. By default, the labels for the streams 
appear in the active map window.  If 
you do not want the labels displayed, 
clear Show Stream Name (see 
Figure 5.8, page 5-10); click Apply, 
all of the stream labels no longer 
display in the map window. 

 5. To change the font of the stream 
labels, click Choose Font (see Figure 
5.8, page 5-10), next to Show Stream 
Name.  A Font Chooser opens 
(Figure 5.11), select the font type 
from the Type list, and select a size 
using the Size slider.  Click OK, the 
Font Chooser closes, from the 
Stream Alignment Properties dialog 
box (see Figure 5.7, page 5-10), click 
Apply, now all of the stream labels 
will appear in the font and size you 
choose. 

 
Tic marks appear on a stream representing the stream stationing of the 
stream.  There are two types of tic marks – minor and major, to change the 
appearance of tic marks in the stream alignment: 
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Tic marks 
represent the 
stream stations 
of a stream.  
There are two 
types – minor 
and major.  Tic 
marks 
properties 
include display 
of tic marks, 
length of minor 
and major, 
display of tic 
mark labels, and 
appearance of 
tic mark labels. 

 1. If you do not want to display the tic marks clear Draw Station Tics 
(Figure 5.12), click Apply, all of the tic marks no longer display in 
the active map 
window. 

Figure 5.12 Stream Alignment Properties - Tic 
Marks 

Figure 5.13 Stream Alignment Properties - 
Stream Nodes 

 2. From the Tic Length 
list, you can set the 
length of the minor 
tic marks.  To change 
the length of the 
major tic marks, 
from the Major Tic 
Length list (Figure 5.12), you can select the length of the major tic 
marks.  For the changes to appear in the active map window, from 
the Stream Alignment Properties dialog box (see Figure 5.7, page 
5-10) click Apply, and the map window will update. 

 3. By default, the labels for the tic marks appear in the active map 
window.  If you do not want the labels to display, clear Draw Tic 
Labels (Figure 5.12).  To change the font of the tic mark labels, 
click Choose Font, a Font Chooser opens (see Figure 5.11, page  

  5-11), select the font type from the Type list, and select a size using 
the Size slider.  Click OK, the Font Chooser closes, from the 
Stream Alignment Properties dialog box (see Figure 5.7, page  

  5-10), click Apply.  Now all of the tic mark labels will appear in the 
font and size you choose. 

 
Stream Nodes 
 
To change the appearance of all stream nodes in the map window: 
 
 1. If you do not want to display the stream nodes clear Draw Stream 

Nodes (Figure 5.13), from the Stream Alignment Properties 
dialog box (see Figure 5.7, page 5-10)click Apply, all of the stream 
nodes no longer 
display in the active 
map window. 

A stream node 
is a location (a 
dark green 
circle) on a 
stream that 
provides 
stream 
stationing 
information.  
Stream node 
properties 
include 
displaying 
stream nodes, 
color, outline 
color, and 
width 

 2. You can select the 
color of the stream 
nodes in your stream 
alignment from the 
Node Color list (Figure 5.13).  The default color is green, there are 
several colors to choose from, plus you can create your own colors 
from a color chooser.  From the Node Color list, click Custom, the 
Choose A Color dialog box (see Figure 5.9, page 5-11) will open.  
See Appendix F for further details on the color chooser. 

 3. You can select the color of the outline of stream nodes in your 
stream alignment from the Node Outline Color list (Figure 5.13).  
The default color is dark green, there are several colors to choose  
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  from, plus you can create your own colors from a color chooser.  
From the Node Outline Color list, click Custom, the Choose A 
Color dialog box (see Figure 5.9, page 5-11) will open.  See 
Appendix F for further details on the color chooser. 

 4. You can set the width of the stream nodes in your stream alignment 
from the Node Width list (see Figure 5.13, page 5-12). 

 
Stream Junctions 
 
To change the appearance of all stream junctions in the active map 
window: 

A stream 
junction is 
where two 
streams connect, 
and is 
represented by a 
bight green 
circle on the 
stream 
alignment.  
Stream junction 
properties 
include 
displaying 
stream 
junctions, color, 
and width. 

 

Figure 5.15  Create new Scale Dialog Box 

Figure 5.14 Stream Alignment Properties - 
Stream Junctions 

 1. If you do not want to display the stream junctions clear Draw 
Junctions (Figure 5.14), from the Stream Alignment Properties 
dialog box (see Figure 5.7, page 5-10) click Apply, all of the stream 
junctions no 
longer display in 
the active map 
window. 

 2. You can select the 
color of the stream 
junctions in your stream alignment from the Junction Color list 
(Figure 5.14).  The default color is darkgreen, there are several 
colors to choose from, plus you can create your own colors from a 
color chooser.  From the Junction Color list, click Custom, the 
Choose A Color dialog box (see Figure 5.9, page 5-11) will open.  
See Appendix F for further details on the color chooser. 

 3. You can set the width of the stream junctions in your stream 
alignment from the Junction Width list (Figure 5.14). 

 
Scale 
 
Visualization scale can be set for the Stream Alignment Layer: 
 
 1. To set the visualization scale for the stream alignment to a default, 

from the Scale menu, click Set to Defaults.  The visualization scale 
is set automatically. 

 2. To enter your own scale factor, from the Scale menu, click New.  
The Create new Scale dialog box opens (Figure 5.15), in the Scale 
box, enter your values for the scale factor. 
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 3. Click OK, the Create new Scale dialog box closes (see Figure 
5.15, page 5-13), and the visualization scale is set for the stream 
alignment. 

 
 

Figure 5.16  Simulation Layer 

5.3.2 Simulation Layer 
 
When a simulation map window is open, the Simulation Layer for that 
map window is available.  In Figure 5.16, the Simulation Layer is 
Without Project Conditions-1993 Flood.  The Simulation Layer contains 
the graphical representations of each program being run for the active 

simulation.  When you expand the tree, you can see the different sub-
layers that represent each program.  Therefore, if you did not want to see 
the impact areas, clear FIA.  The impact areas will no longer be visible in  
the simulation map window.  To view the impact areas, click FIA.  This 
procedure applies to all of the sub-layers of the simulation layer. 
 
 

The Simulation 
Layer contains 
the graphical 
representation 
of each piece 
of software 
that has been 
included in the 
active 
simulation.  
Each piece of 
software is 
represented as 
a sub-layer. 

5.3.3 Shortcut Menu for Primary Layers 
 
The shortcut menu for primary layers is accessed by a right-clicking on 
any primary layer that is listed in the Maps Tab (see Chapter 3, Section 
3.2.3, page 3-8).  This list of map layers refers to the currently active map 
window (see Chapter 3, Section 3.2.4, page 3-9) that is open in the 
Desktop Pane (see Chapter 3, Section 3.2.2, page 3-7).  The shortcut 
menu provides several ways to manipulate primary layers: 
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 Expand – expands the selected primary layer's tree; the tree provides 
information on the available elements of a primary layer, and details 
provided are based on what the WAT recognizes for the individual 
primary layer. 

 
 Collapse – collapses the selected primary layer's tree; the tree provides 

information on the available elements of a primary layer, and details 
provided are based on what the WAT recognizes for the individual 
primary layer. 

 
 Move to Top – moves the selected primary layer to the top of the tree 
 
 Move Up – moves the selected primary layer up the tree one position 
 
 Move Down – moves the selected primary layer down the tree one 

position 
 
 Move to Bottom – moves the selected primary layer to the bottom of 

the tree 
 
 Properties – shows the properties of the selected primary layer. 
 
 

5.4 Layer Visualization Scaling 
 
Layers may be set to become visible or invisible as you zoom-in or zoom-
out on the active map window.  Generally, this capability allows you to 
display finer levels of detail as you zoom-in on regions in the map window 
and avoid clutter when displaying the full area.  This might include 
detailed map layers to become visible, and raster or other images to appear 
that are not as distinguishable at a courser zoom level.  
 



Chapter 5 – Using Layers HEC-WAT User's Manual 

5-16 

 



HEC-WAT User's Manual Chapter 6 – Creating and Managing Alternatives 

 6-1 

CHAPTER 6  
 
 

Creating and Managing Alternatives 
 
 

6.1 Overview 
 
The start of most studies involves defining the problem, the study extent, 
and representation of the alternatives to be evaluated.  HEC-WAT will 
help define alternatives through schematic representations, model 
identification and compute sequencing.  An alternative in the WAT is a 
representation of the physical and operational system, and groups a 
schematic with different measures, operations, and model parameters. 
 
 

Figure 6.1  Default Alternative Name 

6.2 Default Alternative 
 
When a WAT study is created (see Chapter 4, Section 4.1.1, page 4-1), a 
default alternative is generated (Figure 6.1).  This alternative is given the 
name Without Project Conditions, the user can select several other name 
choices, or, a user can also create an alternative name. 

 
Once the study is created, a schematic map window opens in the Desktop 
Pane (Chapter 3).  The first action following the creation of the default 
alternative should be to define the default schematic (Chapter 7).  After 
defining the default schematic, analysis periods and simulations can then 
be created for the default alternative. 
 
 

An alternative 
in the WAT is a 
representation 
of the physical 
and 
operational 
system, and 
groups a 
schematic with 
different 
measures, 
operations, 
and model 
parameters. 

6.3 Alternative and Simulation Manager 
 
After the default alternative has been created, the remaining alternatives 
that have been identified by the study team need to be developed.  The  
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Figure 6.2  Alternative and Simulation Manager 

WAT provides two ways to organize and develop alternatives; one way is 
from the Alternative and Simulation Manager (Figure 6.2), and the 
other way is from the Study Pane (see Section 6.4, page 6-11).  This 
section covers using the Alternative and Simulation Manager for 
organizing and developing alternatives. 

 
In the WAT, the Alternative and Simulation Manager (Figure 6.2) 
provides a convenient way to organize and develop the main components 
for a WAT study – alternatives, analysis period (events), and simulations.  
This chapter will focus on the organization and development of 
alternatives.  The Alternative and Simulation Manager has three areas 
where you can access commands that will allow you to create, delete, and 
rename alternatives.  These areas are the Table (see Section 6.3.1, page  
6-2), Toolbar (see Section 6.3.2, page 6-10) and Menu Bar (see Section 
6.3.3, page 6-10).  These areas and the available commands are described 
in the following sections. 
 
To access the Alternative and Simulation Manager, from the WAT 
main window, from the WAT Tools toolbar (see Chapter 3, Section 3.2.1, 
page 3-4), click      .  Another way to access the Alternative and 
Simulation Manager is from the WAT main window, on the Edit menu, 
click Alternative and Simulation Manager.  From either method the 
Alternative and Simulation Manager will open (Figure 6.2). 
 
 

The Alternative 
and Simulation 
Manager 
provides a 
convenient way 
to organize and 
develop the 
main 
components for 
a WAT study – 
alternatives, 
analysis period 
(events), and 
simulations. 

6.3.1 Table 
 
The Alternative and Simulation Manager (Figure 6.2) table allows 
organization of a study's alternatives; a way to track the state of data sets 
needed for each model, create analysis periods, and create simulations.  
Since the focus of this chapter is alternatives, this section will only focus  
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on the available commands from the table to develop and organize 
alternatives. 
 

Figure 6.4  Create New Alternative Dialog Box 

Figure 6.3  Alternatives Shortcut Menu 

 Alternatives 
 
The alternatives shortcut menu (Figure 6.3) is available from the 
Alternative and Simulation 
Manager (see Figure 6.2, page 
6-2) table, by right-clicking on 
the column header 
Alternatives.  This shortcut 
menu will allow you to create, 

rename, and delete 
alternatives.  The following 
sections provide further details. 
 
Creating an Alternative 
 
To create an alternative: 
 
 1. From the alternatives shortcut menu (Figure 6.3), click New, the 

Create New Alternative dialog box will open (Figure 6.4). 

 2. In the Name box enter the name (required), and in the Description 
box, enter a description (optional, but recommended). 

 3. Each alternative requires a schematic to provide the layout of the 
study area measures and components.  From the Schematic list, 
select a previously defined schematic, or create a schematic for the 
alternative (see Step 7). 

 4. A stream alignment is also required with an alternative, from the 
Stream Alignment list, select Stream Alignment, which is the 
default stream alignment name. 

 5. Click OK, if there is not a map window open in the Desktop Pane, 
the Create New Alternative dialog box (Figure 6.4) will close and 
an alternative map window will open in the Desktop Pane. 

The table 
allows 
organization of 
a study's 
alternatives; a 
way to track 
the state of 
data sets 
needed for 
each model, 
create analysis 
periods, and 
create 
simulations. 

To access the 
Alternative 
and 
Simulation 
Manager, from 
the WAT main 
window, from 
the WAT Tools 
toolbar click      

. 
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Figure 6.5  Select Map Dialog Box 

Figure 6.6  Enter Schematic Name Dialog Box 

 6. If a map window is open in the Desktop Pane (see Chapter 3, 
Section 3.2.2, page 3-7), the Select Map dialog box will open 
(Figure 6.5).  You can choose whether to open the alternative map 
window in the current map 
window or in a new map 
window, click OK.  The Select 
Map dialog box and the Create 
New Alternative dialog box 
(see Figure 6.4, page 6-3) will 
both close, and the alternative 
map window for the new 
alternative will appear in the 
Desktop Pane. 

 7. If you need to create a new 
schematic for the alternative, 
from the Schematic list, click 
<Create New Schematic>.  When you click OK, the Enter 
Schematic Name dialog box will open (Figure 6.6).  The name of 
the alternative will appear in the Name box for the new schematic.  
You can accept this name or enter a name for the schematic in the 
Name box. 

 8. Click OK, if there is not a map window open in the Desktop Pane, 
the Enter Schematic Name dialog box (Figure 6.6) will close and a 
schematic map window will open in the Desktop Pane. 

 9. If a map window is open in the Desktop Pane (see Chapter 3, 
Section 3.2.2, page 3-7), the Select Map dialog box (Figure 6.5) 
will open.  You can choose whether to open the schematic map 
window in the current map window or in a new map window, click 
OK.  The Select Map dialog box (Figure 6.5) and the Enter 
Schematic Name dialog box (Figure 6.6) will both close, and the 
schematic map window for the new schematic will appear in the 
Desktop Pane. 

 10. The alternative name will now appear in the table on the 
Alternative and Simulation Manager, under the Alternatives 
column header (see Figure 6.2, page 6-2). 

Another way to 
access the 
Alternative 
and 
Simulation 
Manager, 
from the WAT 
main window, 
on the Edit 
menu, click 
Alternative 
and 
Simulation 
Manager. 
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Figure 6.7  Rename Alternative Dialog Box 

 
Renaming Alternatives 
 
If you want to rename an alternative, but you want to choose from a list of 
the developed alternatives for a study: 
 
 1. From the alternatives shortcut menu (see Figure 6.3, page 6-3), 

click Rename, the Rename Alternative dialog box will open 
(Figure 6.7). 

 2. From the Existing list select an alternative, in the Rename box the 
name and description of the selected alternative will appear. 

 3. In the Name box, enter the new name, and enter a description in the 
Description box if needed (recommended). 

 4. Click Rename, a warning message will appear asking you if you 
really want to rename the selected alternative.  Click Yes, the 
warning message and the Rename Alternative dialog box will 
close, and on the table (see Figure 6.2, page 6-2), under the 
Alternatives column the renamed alternative will appear. 

 
Deleting Alternatives 
 
If you want to delete an alternative, but you want to choose from a list of 
the developed alternatives for a study: 
 
 1. From the alternatives shortcut menu (see Figure 6.3, page 6-3), 

click Delete, the Delete Alternative(s) dialog box will open (see 
Figure 6.8, page 6-6). 

 2. From the Existing list select an alternative, in the Delete box the 
name and description of the selected alternative will appear. 
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Figure 6.8  Delete Alternative(s) Dialog Box 

Figure 6.9 Individual Alternative 
Shortcut Menu 

 3. Click Delete, a warning message will appear asking you if you 
really want to delete the selected alternative.  Click Yes, the 

warning message will close and a second warning message will 
appear.  This message is reminding you that by deleting this 
alternative you will also delete the listed simulations.  Click Yes, 
the warning message will close and the alternative will no longer 
appear under the Alternatives column of the table (see Figure 6.2, 
page 6-2). 

 
 

 Individual Alternative 
 
The individual alternative shortcut 
menu (Figure 6.9) is available from 
the Alternative and Simulation 
Manager (see Figure 6.2, page  
6-2), by right-clicking on an 
alternative name in the table.  This 
shortcut menu will allow you to 
view the selected alternative in a 
map window, edit, make a copy, 
rename, delete from the study, and 
view the properties of the 
alternative.  The following sections 
provide further details.  
 
Viewing an Alternative 
 
To view an alternative in a map window: 
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Figure 6.10  Alternative Editor 

 1. From the individual alternative shortcut menu (see Figure 6.9, page 
6-6), click Display in Map Window. 

 2. If there is not a map window open in the Desktop Pane, the 
alternative map window for the alternative will open in the Desktop 
Pane.  From the alternative map window you can edit the stream 
alignment, measures, impact areas, and adjust background maps 
associated with the alternative. 

 3. If a map window is open in the Desktop Pane (see Chapter 3, 
Section 3.2.2, page 3-7), the Select Map dialog box (see Figure 6.5, 
page 6-4) will open.  You can choose whether to open the 
alternative map window in the current map window or in a new 
map window, click OK.  The Select Map dialog box (see Figure 
6.5, page 6-4) will close, and the alternative map window for the 
selected alternative will appear in the Desktop Pane. 

 
Editing an Alternative 
 
To edit an alternative: 
 
 1. From the individual alternative shortcut menu (see Figure 6.9, page 

6-6), click Edit.  The Alternative Editor will open (Figure 6.10). 

 2. You can edit the description and turn on and off the background 
maps associated with the selected alternative.  The editor also 
provides information on the schematic associated with the selected 
alternative. 

 3. Click OK, the Alternative Editor will close and the information 
you changed will be saved. 

 
Making a Copy of an Existing Alternative 
 
To make a copy of an existing alternative: 
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Figure 6.12  Rename Alternative Dialog Box 

Figure 6.11  Save Alternative As Dialog Box 

 1. From the individual alternative shortcut menu (see Figure 6.9, page 
6-6), click Save As.  The Save Alternative As dialog box will open 
(Figure 6.11).  The information displayed in the dialog box 
represents the alternative you have selected to make a copy of. 

 2. In the Name box, enter the name (required) of the new alternative, 
and in the Description box, enter a description (optional, but 
recommended). 

 3. You can also choose to create a copy of the associated schematic 
(will create a new schematic with the new alternative name) or use 
the associated schematic of the alternative you have selected to 
make a copy of. 

 4. The alternative name will now appear in the table on the 
Alternative and Simulation Manager, under the Alternatives 
column header (see Figure 6.2, page 6-2). 

 
Renaming an Alternative 
 
To rename an alternative: 
 
 1. From the individual alternative shortcut menu (see Figure 6.9, page 

6-6), click Rename.  The Rename Alternative dialog box will 
open (Figure 6.12). 

 2. In the Name box, enter the new name, and enter a description in the 
Description box if needed (recommended). 

 3. Click OK, a warning message will appear asking you if you really 
want to rename the selected alternative.  Click Yes, the warning  
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Figure 6.13  Properties for AlternativeName Dialog Box 

  message and the Rename Alternatives dialog box (see Figure 6.12, 
page 6-8) will close, and in the Alternative and Simulation 
Manager (see Figure 6.2, page 6-2), on the table the name of the 
selected alternative will be changed. 

 
Deleting an Alternative 
 
To delete an alternative, right-click on an alternative in the table, from the 
individual alternative shortcut menu (see Figure 6.9, page 6-6), click 
Delete From Study.  A warning message will appear asking you if you 
really want to delete the selected alternative.  Click Yes, the warning 
message will close and a second warning message will appear.  This 
message is reminding you that by deleting this alternative you will also 
delete the listed simulations.  Click Yes, the alternative will no longer 
appear on the table in the Alternative and Simulation Manager (see 
Figure 6.2, page 6-2). 
 
Alternative Properties 
 
The properties of an alternative include the name and description for the 
Beta Version. For Version 1.0 properties that will be displayed are: stream 
alignment, list of measures, common computation points, and impact 
areas.  To view the properties of an alternative: 
 
 1. From the individual alternative shortcut menu (see Figure 6.9, page 

6-6), click Properties.  The Properties for AlternativeName dialog 
box will open (Figure 6.13). 

 2. For the Beta Version the properties for viewing are the name and 
description of the selected alternative; the date and time the 
alternative was last modified; the location of the alternative file; 
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and, the name of the file which contains information about the 
alternative. 

 
 

6.3.2 Toolbar 
 
From the toolbar of the Alternative and Simulation Manager (see Figure 
6.2, page 6-2), you can create an alternative.  Click       , the Create New 
Alternative dialog box will open (see Figure 6.4, page 6-3).  The steps for 
creating an alternative are the same as in Creating an Alternative, under 
Section 6.3.1, page 6-3.  
 
 

6.3.3 Menu Bar 
 
From the Menu Bar of the Alternative and Simulation Manager (see 
Figure 6.2, page 6-2), you can create an alternative, rename alternatives, 
and delete alternatives. 
 

 Creating an Alternative 
 
To create an alternative: 
 
 1. On the File menu, point to Alternatives, and then click New, the 

Create New Alternative dialog box will open (see Figure 6.4, page 
6-3). 

 2. The steps for creating an alternative are the same as in the Creating 
an Alternative, under Section 6.3.1, page 6-3. 

 
 Renaming Alternatives 

 
If you want to rename an alternative, but you want to choose from a list of 
the developed alternatives for a study: 
 
 1. On the File menu, point to Alternatives, and then click Rename, 

the Rename Alternative dialog box will open (see Figure 6.7, page 
6-5). 

 2. The steps for renaming an alternative are the same as in Renaming 
Alternatives, under Section 6.3.1, page 6-5. 

 
 Deleting Alternatives 

 
If you want to delete an alternative, but you want to choose from a list of 
the developed alternatives for a study: 
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 1. On the File menu, point to Alternatives, and then click Delete, the 
Delete Alternative(s) dialog box will open (see Figure 6.8, page  

  6-6). 
 2. The steps for deleting an alternative are the same as in Deleting 

Alternatives, under Section 6.3.1 page 6-5. 
 
 

Figure 6.14  Alternative and Simulation Manager - Tooltip 

6.3.4 ToolTips 
 
From the Alternative and Simulation Manager (Figure 6.14) you can 
review information regarding the status of certain elements of the study.  
For example, in Figure 6.14, if you hover the mouse pointer over the FIA 
model alternative associated with the Without Project Conditions_1993 

Flood simulation, a small box will appear, this is a tool tip.  This tooltip 
provides the description of the model alternative, who imported the model 
alternative, and the date the model alternative was imported.  See Chapter 
4, Section 4.1.5 (page 4-4) for details on how the information is entered. 
 
 

A tooltip is a 
graphical user 
interface 
element used 
in conjunction 
with a cursor.  
The user 
hovers the 
mouse pointer 
(cursor) over 
an item, and a 
small box 
appears with 
supplementary 
information 
regarding the 
item being 
hovered over. 

6.4 Study Pane 
 
The user can also create, edit, rename, and delete alternatives from the 
Study Pane (see Chapter 3, Section 3.2.2, page 3-5).  This section of the 
chapter describes how to perform these operations directly from the Study 
Pane. 
 
 

6.4.1 Alternatives 
 
The alternatives shortcut menu (Figure 
6.15) is available from the Study Pane, 
by right-clicking on the Alternatives 
folder.  This shortcut menu will allow 
you to create, rename, and delete 
alternatives.  The following sections 
provide further details. 

Figure 6.15 Alternatives Shortcut 
Menu 
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 Creating an Alternative 

 
To create an alternative from the Study pane: 
 
 1. From the Study Tab, on the Study Pane, right-click on the 

Alternatives folder, from the alternatives shortcut menu (see Figure 
6.15, page 6-11), click New, a dialog box similar to the Create 
New Alternative dialog box will open (see Figure 6.4, page 6-3). 

 2. The steps for creating an alternative are the same as in the Creating 
an Alternative, under Section 6.3.1, page 6-3. 

 
 Deleting Alternatives 

 
If you want to delete an alternative, but you want to choose from a list of 
the developed alternatives for a study: 
 
 1. From the Study Tab, on the Study Pane, right-click on the 

Alternatives folder, from the alternatives shortcut menu (see Figure 
6.15, page 6-11), from the shortcut menu, click Delete.  The Delete 
Alternatives dialog box will open (see Figure 6.8, page 6-6). 

 2. The steps for deleting an alternative are the same as in Deleting 
Alternatives, under Section 6.3.1 page 6-5. 

 
 Renaming Alternatives 

 
If you want to rename an alternative, but you want to choose from a list of 
the developed alternatives for a study: 
 
 1. From the Study Tab, on the Study Pane, right-click on the 

Alternatives folder, from the alternatives shortcut menu (see Figure 
6.15, page 6-11), from the shortcut menu, click Rename.  The 
Rename Alternatives dialog box will open (see Figure 6.7, page  

  6-5). 
 2. The steps for renaming an alternative are the same as in Renaming 

Alternatives, under Section 6.3.1, page 6-5. 
 
 

Study Pane 
provides an 
overview of 
WAT 
alternatives, 
simulations 
and analysis 
periods. 

6.4.2 Individual Alternative 
 
The individual alternative shortcut menu (see Figure 6.16, page 6-13) is 
available from the Study Pane, by right-clicking on an alternative name 
under the Alternatives folder.  This shortcut menu will allow you to view 
the selected alternative in a map window, edit, make a copy, rename, 
delete from the study, and view the properties of the alternative.  The 
following sections provide further details.  
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Figure 6.16  Individual Alternative Shortcut Menu 
 

 Viewing an Alternative 
 
To view an alternative in a map window: 
 
 1. From the Study Tab, on the Study Pane, from the Alternatives 

folder, right-click on an alternative, from the individual alternative 
shortcut menu (Figure 6.16), click Open. 

 2. The steps for viewing an alternative are the same as in Viewing an 
Alternative, under Section 6.3.1, page 6-6. 

 
 Editing an Alternative 

 
To edit an alternative: 
 
 1. From the Study Tab, on the Study Pane, from the Alternatives 

folder, right-click on an alternative, from the individual alternative 
shortcut menu (Figure 6.16), click Edit.  The Alternative Editor 
will open (see Figure 6.10, page 6-7). 

 2. The steps for editing an alternative are the same as in Editing an 
Alternative, under Section 6.3.1, page 6-7. 

 
 Saving an Alternative 

 
To save an alternative, from the Study Tab, from the Study Pane, from 
the Alternatives folder, right-click on an alternative, from the shortcut 
menu, click Save.  Any changes that have occurred to the selected 
alternative will be saved by the WAT. 
 

 Making a Copy of an Existing Alternative 
 
To make a copy of an existing alternative: 
 
 1. From the Study Tab, on the Study Pane, from the Alternatives 

folder, right-click on an alternative, from the individual alternative 
shortcut menu (Figure 6.16), click Save As. 
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 2. The steps for making a copy of an existing alternative are the same 
as in Making a Copy of an Existing Alternative, under Section 
6.3.1, page 6-7. 

 
 Renaming an Alternative 

 
 1. From the Study Tab, on the Study Pane, from the Alternatives 

folder, right-click on an alternative, from the individual alternative 
shortcut menu (see Figure 6.16, page 6-13), click Rename.  The 
Rename Alternatives dialog box will open (see Figure 6.12, page 
6-8). 

 2. The steps for renaming an alternative are the same as in Renaming 
an Alternative, under Section 6.3.1, page 6-8. 

 
 Deleting an Alternative 

 
 1. From the Study Tab, on the Study Pane, from the Alternatives 

folder, right-click on an alternative, from the individual alternative 
shortcut menu (see Figure 6.15, page 6-13), click Delete. 

 2. The steps for deleting an alternative are the same as in Deleting an 
Alternative, under Section 6.3.1, page 6-9. 

 
 Alternative Properties 

 
The properties of an alternative include the name and description for the 
Beta Version. For Version 1.0 properties that will be displayed are: stream 
alignment, list of measures, common computation points, and impact 
areas.  To view the properties of an alternative: 
 
 1. From the Study Tab, from the Study Pane, from the Alternatives 

folder, right-click on an alternative, from the shortcut menu, click 
Properties. 

 2. The steps for accessing alternative properties are the same as in 
Alternative Properties, under Section 6.3.1, page 6-9. 
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CHAPTER 7  
 
 
 

Schematics 
 
 

7.1 Concepts 
 
Once a study has been created and background maps have been collected, 
the next step is the development of the common schematic.  A schematic 
is a physical representation of a stream alignment, and the flood damage 
reduction and environmental measures that will be modeled.  The 
schematic also provides a common starting point for construction of 
compatible model data sets.  A common schematic assures the naming 
convention, measure identification and location for the study is consistent 
throughout the modeling disciplines.  The individual models can be edited 
and their results viewed from HEC-WAT by selecting the elements found 
on the common schematic. 
 
The common schematic will provide geo-referencing, stream referencing 
(stream alignment), common physical features (measures), data exchange 
locations (common computation points) and a set of features present for a 
particular modeling scenario (schematics). 
 
 

7.2 Elements of a Schematic 
 
The following sections describe in general terms the main elements of a 
schematic and the tools provided by the WAT to create schematics.  Also, 
further details on each element are provided in the subsequent sections of 
this chapter. 
 
 

7.2.1 Stream Alignment 
 
The backbone of any schematic is the stream alignment (see Figure 7.1, 
page 7-2), and is the starting point in creating a schematic.  A stream 
alignment is a one-dimensional river coordinate system, which defines the 
natural downstream flow network.  Also, from the stream centerline, 
stationing will be provided relative to its global location and specific to the 
study.  See Section 7.8 (page 7-13) for further details on establishing and 
modifying a stream alignment. 
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Figure 7.1  Stream Alignment 

Figure 7.2  Measures 

 
7.2.2 Measures 

Measures for 
the WAT 
include 
structural/non-
structural 
measures 
(flood damage 
reduction), 
and/or 
ecosystem 
measures. 

A stream 
alignment is a 
one-
dimensional 
river 
coordinate 
system, which 
defines the 
natural 
downstream 
flow network. 

 
Measures (Figure 7.2) for the WAT include structural/non-structural 
measures (flood damage reduction), and/or ecosystem measures.  
Structural measures are physical modifications designed to reduce the 
frequency of damaging levels of flood inundation, and include dams with  

reservoirs, levees, channelization measures, walls, diversion channels, 
pumps, bridge modifications, and ice-control structures.  Non-structural 
measures are activities that reduce flood damage without significantly  
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altering the nature or extent of flooding (e.g., flood proofing, relocation of 
structures, raising structures).  Ecosystem restoration measures are 
physical modifications or other actions that improve the value and 
function of an ecosystem (e.g., channel restoration, removal of drainage 
structures or levees).  There are various measures that you can define for 
the WAT, but this User's Manual will only focus on reservoirs (see 
Section 7.9.1, page 7-31) and levees (see Section 7.9.2, page 7-378).  
Other measures available in the WAT are diversions, channel 
improvements, off-channel storage, and other projects. 
 
 

Figure 7.3  Common Computation Points 

7.2.3 Common Computation Points 
 
Common computation points (Figure 7.3) are locations where one model 
transfers data to another model, or where results are needed for model 
development or alternative analysis, or where input boundary conditions 

are to be defined.  The common computation points need to be consistent 
for all models and should be placed on the stream alignment based on 
knowledge of possible study alternatives.  The entire study team should be 
involved in the  definition of the common computation points.  For further 
details on common computation points and how to create, edit, and 
modify, see Section 7.10 (page 7-43). 
 
 

Common 
computation 
points are 
locations 
where one 
model 
transfers data 
to another 
model, a 
location where 
results are 
needed for 
model 
development 
or alternative 
analysis, or 
locations 
where input 
boundary 
conditions are 
to be defined. 

7.2.4 Impact Areas 
 
An impact area (see Figure 7.4, page 7-4) is any distinct portion of a 
study that is affected by rising or falling stage in a stream, river, lake, or  
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Figure 7.4  Impact Areas 
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7.3 Study Element Tools 

here are tools available to view and create the study elements from the 

Pointer/Selector Tool – use this tool to edit, rename, and delete 
ds 
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Zoom Tool - use this tool to zoom in and out of map windows.  To 
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here are tools available to view and create the study elements from the 

Pointer/Selector Tool – use this tool to edit, rename, and delete 
ds 

udy 

 
Zoom Tool - use this tool to zoom in and out of map windows.  To 

 

An impact 
area is any 
distinct portion 
of a study area 
that is affected 
by rising or 
falling stage in 
a stream, river, 
lake, or 
reservoir. 

reservoir.  The boundariereservoir.  The boundarie
polygon, and you characterize the effects of rising or falling stage by
describing the property, project, and/or population at risk in the area 
bounded by the polygon.  Impact areas are an optional element, and a
only required when you want to compute impacts at damage area centers
in the study area, and you have an HEC-FIA model as part of your WAT 
modeling effort.  For further details on impact areas and how to create, 
edit, and modify, see Section 7.11 (page 7-49). 
 

polygon, and you characterize the effects of rising or falling stage by
describing the property, project, and/or population at risk in the area 
bounded by the polygon.  Impact areas are an optional element, and a
only required when you want to compute impacts at damage area centers
in the study area, and you have an HEC-FIA model as part of your WAT 
modeling effort.  For further details on impact areas and how to create, 
edit, and modify, see Section 7.11 (page 7-49). 
 
  

  
TT
schematic map window.  These tools are as follows: 
 
schematic map window.  These tools are as follows: 
 
  
  

elements (does not include stream alignment elements).  Comman
available for editing existing study elements are available by 
selecting the Pointer/Selector Tool, and right-clicking on a st
element. 

elements (does not include stream alignment elements).  Comman
available for editing existing study elements are available by 
selecting the Pointer/Selector Tool, and right-clicking on a st
element. 

  
zoom in, hold the left mouse button down and outline the area you 
want to enlarge.  To zoom out, click the right mouse button (right-
click).  The zoom out is done by a factor of two and positions the 
clicked location at the center of the map window. 

zoom in, hold the left mouse button down and outline the area you 
want to enlarge.  To zoom out, click the right mouse button (right-
click).  The zoom out is done by a factor of two and positions the 
clicked location at the center of the map window. 
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 Pan Tool – use this tool to move the map window while you are 

Impact Area Tool - use this tool to create, delete, rename, and edit 

 
Computation Point Tool - use this tool to create, delete, rename, 

ts 

t 

  

 
Stream Alignment Tool - use this tool to create, delete, and edit 

 

Stream Node Tool - use this tool to create, delete, and edit stream 

 

Reservoir Tool - use this tool to create, delete, rename, and edit 

 
Levee Tool - use this tool to create, delete, rename, and edit levees.  

 
Diversion Tool - use this tool to create, delete, rename, and edit 

.  

s a 

 

 
Channel Modification Tool - use this tool to create, delete, 

tion  

zoomed in. 
 
 

impact areas.  See Section 7.11 (page 7-48) for more detail on 
creating, deleting, renaming, and editing impact areas. 

 
and edit common computation points.  Common computation poin
are locations where one model transfers data to another model, 
where results are needed for model development, or where inpu
boundary conditions are to be defined.  See Section 7.10 (page  
7-43) for more detail on creating, deleting, renaming, and editing
common computation points. 

 
streams that make up the stream alignment (see Section 7.8, page  
7-13). 

 
 

nodes (see Section 7.8.5, page 7-23) and stream junctions (see 
Section 7.8.7, page 7-25) on the stream alignment. 

 
7.4 Measure Tools 

 
 

reservoirs.  See Section 7.9.1 (page 7-31) for more detail on 
creating, deleting, renaming, and editing reservoirs. 

 
See Section 7.9.2 (page 7-37) for more details on creating, deleting, 
renaming, and editing levees. 

 
diversions.  A diversion has to be started on the stream alignment
To create a diversion, select the Diversion Tool, hold down the 
CTRL key, and click on the stream alignment.  Each click create
vertex point along the diversion.  When reaching the end point of 
the diversion, release the CTRL key, and click.  You will be asked
to name the diversion.  After naming the diversion, the diversion 
will appear on the active map window.  Commands available for 
editing an existing diversion are available by selecting the 
Diversion Tool, and right-clicking on a diversion. 

 
rename, and edit channel modifications.  A channel modifica
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 has to be created on the stream alignment.  To create a channel 
modification, select the Channel Modification Tool, hold down 
the CTRL key, click on the upstream end of the channel 
modification, release the CTRL key, and drag along the stream 
alignment to the downstream end of the channel modification and 
click.  You will be asked to name the channel modification.  After 
naming the channel modification, the channel modification will 
appear on the active map window.  Commands available for editing 
an existing channel modification are available by selecting the 
Channel Modification Tool, and right-clicking on a channel 
modification. 

 
 Off-Channel Storage Area Tool - use this tool to create, delete, 

rename, and edit off-channel storage areas.  To create an off-
channel storage area, select the Off-Channel Storage Area Tool 
and hold down the CTRL key while clicking the mouse button.  
Each click creates a vertex point, which is the boundary of the 
polygon.  When reaching the end point, release the CTRL key and 
click.  You will be asked to name the off-channel storage area.  
After naming the off-channel storage area, the off-channel storage 
area will appear on the active map window.  Commands available 
for editing an existing off-channel storage area are available by 
selecting the Off-Channel Storage Area Tool, and right-clicking 
on an off-channel storage area. 

 
 Other Project Tool - use this tool to create, delete, rename, and 

edit other projects.  This tool enables the placement of elements that 
represent "other" projects, such as pump stations.  To create an 
"other" project, select the Other Project Tool and hold down the 
CTRL key and click.  You will be asked to name the "other" 
project.  After naming the "other" project, the "other" project will 
appear on the active map window.  Commands available for editing 
an existing "other" projects are available by selecting the Other 
Project Tool, and right-clicking on an "other" project. 

 
 

7.5 Creating the Default Schematic 
 
When a new study is created in the WAT, a default alternative is created 
(see Chapter 6) with either a WAT default name (Without Project 
Conditions) or a user-defined name.  After the alternative has been 
created, the default schematic needs to be defined, this will have the same 
name as the default alternative.  The first step in defining the default 
schematic is to create the stream alignment (see Section 7.8, page 7-13) 
and then add measures (see Section 7.9, page 7-31), common computation 
points (see Section 7.10, page 7-43), and impact areas (see Section 7.11, 
page 7-48) to the schematic. 
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To define the default schematic: 
 
 1. Once a study is created, the default schematic map window will 

open in the Desktop Pane (see Chapter 3, Section 3.2.2, page 3-7). 
 2. Add a map layer (Chapter 5) that will guide you in creating your 

stream alignment.  You will either digitize the stream alignment by 
hand or import a stream alignment.  See Section 7.8 (page 7-13) for 
further details on creating a stream alignment. 

 3. Once the stream alignment is established you will need to add the 
measures that describe the default alternative.  There are several 
types of measures (see Section 7.9, page 7-31) that you can add, but 
for the Beta version, this manual will concentrate on reservoirs (see 
Section 7.9.1, page 7-31) and levees (see Section 7.9.2, page 7-37). 

 4. After measures have been defined, you should add common 
computation points (see Section 7.10, page 7-43) to the default 
schematic.  Common computation points are locations where the 
models associated with the alternative will hand off data to each 
other, the user can view results, or locations where input boundary 
conditions are defined. 

 5. An optional element to add to the default schematic is impact areas.  
Impact areas are required if you want to compute impacts at damage 
area centers in the study area, and you have an HEC-FIA model as 
part of your alternative.  See Section 7.11 (page 7-48) for further 
details on defining impact areas. 

 6. Once you have your default schematic complete, be sure to save 
your schematic data.  You can now create other alternatives and 
schematics based on the default schematic. 

 
 

A schematic is 
a physical 
representation 
of a stream 
alignment, and 
the flood 
damage 
reduction and 
environmental 
measures that 
will be 
modeled. 

Figure 7.5  Creating a New Schematic 

7.6 Creating Schematics 
 
There are two ways to create a schematic, one is from the Schematic Tab, 
and the other is when you are creating an alternative (Chapter 6). 
 
To create a schematic from the Schematic Tab: 
 
 1. From the Schematic Tab, on the Study Pane (Figure 7.5), right-

click on the Schematics, folder, from the shortcut menu click New.  
The New Schematics dialog 
box will open (see Figure 7.6, 
page 7-8). 

 2. In the Name box enter the 
name (required), and in the 
Description box, enter a 
description (optional, but 
recommended). 
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Figure 7.7  Creating a New Alternative 

Figure 7.8  New Alternatives Dialog Box 

Figure 7.6  New Schematics Dialog Box 

 3. Click OK, the New 
Schematics dialog box w
close.  In the Study Pane
(see Figure 7.5, page 7-7), 
the Schematics folder will 
now contain the new 
schematic.  You now need 
to edit the schematic, to 
add the correct measures 
for the alternative that is associated with this schematic.  

ill 
 

 
To create a schematic when you are creating an alternative: 
 
 1. From the Study Tab, on the 

Study Pane (Figure 7.7), 
right-click on the 
Alternatives folder, from the 
shortcut menu click New.  
The New Alternatives dialog 
box will open (Figure 7.8). 

 2. Enter the alternative name in the Name box enter the name 
(required), and an optional (recommended) description in the 
Description box. 

 3. Each alternative requires a schematic to provide the layout of the 
study area measures and components.  Select a previously defined 
schematic, or create a schematic for the alternative from the 
Schematic list (see Step 7). 

 4. A stream alignment is also required with an alternative, from the 
Stream Alignments list, select Stream Alignment, which is the 
default stream alignment name. 

 5. Click OK, if there is not a map window open in the Desktop Pane, 
the New Alternatives dialog box will close (Figure 7.8) and a map 
window will open in the Desktop Pane representing the alternative. 

 6. If a map window is open in the Desktop Pane (see Chapter 3, 
Section 3.2.2, page 3-7), the Select Map dialog box will open  

The schematic 
also provides a 
common 
starting point 
for 
construction of 
compatible 
model data 
sets. 
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Figure 7.9  Select Map Dialog Box 

Figure 7.10  Enter Schematic Name Dialog Box 

 
  (Figure 7.9).  You can choose 

whether to open the alternative 
in the current map window or in 
a new map window, click OK.  
The Select Map dialog box and 
the New Alternatives dialog 
box (see Figure 7.8, page 7-8) 
will both close, and the map 
window for the new alternative 
will appear in the Desktop 
pane. 

 7. If you want to create a new 
schematic for the alternative, 
from the Schematic list, click <Create New Schematic>.  When 
you click OK, the Enter Schematic Name dialog box will open 
(Figure 7.10).  By default the name of the alternative will appear in 
the Name box for the new schematic, you can accept this name or 
enter a name for the schematic in the Name box. 

 8. Click OK, if there is not a map window open in the Desktop Pane, 
the Enter Schematic Name dialog box (Figure 7.10) will close and 
a map window will open in the Desktop Pane representing the 
schematic. 

 9. If a map window is open in the Desktop Pane (see Chapter 3, 
Section 3.2.2, page 3-7), the Select Map dialog box (Figure 7.9) 
will open.  You can choose whether to open theschematic in the 
current map window or in a new map window, click OK.  The 
Select Map dialog box (Figure 7.9) and the Enter Schematic 
Name dialog box (Figure 7.10) will both close and the map window 
for the new schematic will appear in the Desktop Pane. 

 10. The schematic name will now appear on the Schematic Tab, under 
the Schematics folder (see Figure 7.5, page 7-7).  You now need to 
edit the schematic by adding measures, common computation 
points, and impact areas. 

 

A common 
schematic 
assures the 
naming 
convention, 
measure 
identification 
and location 
for the study is 
consistent 
throughout the 
modeling 
disciplines. 
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Figure 7.11  Schematic Shortcut Menu 

7.7 Existing Schematics 
 
After creating a schematic, you can view the schematic, edit certain 
properties of a schematic, save the active schematic, create a copy of an 
existing schematic, delete a schematic that is not associated with an 
alternative, and view an existing schematic's properties.  All of these tasks 
are accomplished through the schematic shortcut menu (Figure 7.11).  To 
access the schematic shortcut menu, from the Schematic Tab, on the 
Study Pane, right-click on an existing schematic under the Schematics 
folder; and, the schematic shortcut menu will appear. 

 
7.7.1 Viewing a Schematic 

 
To view a schematic in a map window: 
 
 1. From the schematics shortcut menu (Figure 7.11) click Open. 
 2. If there is not a map window open in the Desktop Pane (see 

Chapter 3, Section 3.2.2, page 3-7), the map window for the 
selected schematic will open in the Desktop Pane.  From the map 
window you can edit the stream alignment, add measures 
(reservoirs, levees), and impact areas for the schematic. 

 3. If a map window is open in the Desktop Pane (see Chapter 3, 
Section 3.2.2, page 3-7), the Select Map dialog box (see Figure 7.9, 
page 7-9) will open.  You can choose whether to open the schematic 
in the current map window or in a new map window, click OK.  
The Select Map dialog box (see Figure 7.9, page 7-9) will close, 
and the map window for the selected schematic will appear in the 
Desktop Pane. 

 
 

7.7.2 Editing an Existing Schematic 
 
To edit the description, or to add and remove measures from an existing 
schematic: 
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Figure 7.12  Schematic Editor 

 1. From the schematics shortcut menu (see Figure 7.11, page 7-10) 
click Edit.  The Schematic Editor will open (Figure 7.12). 

 2. In the Description box you can edit the description of schematic. 
 3. From the Measures box you can add or remove measures from a 

schematic by selecting the measures.  For example (Figure 7.12), if 
you decide for this schematic not to include the Lock Haven Levee, 
clear Lock Haven Levee.  The Lock Haven Levee will now be 
removed from the schematic. 

 4. Click OK, the Schematic Editor will close, and if the map window 
associated with the schematic is open, the measure will no longer 
display in the map window. 

 
 

7.7.3 Saving a Schematic 
 
To save the active schematic, from the schematic shortcut menu (see 
Figure 7.11, page 7-10), click Save.  Any changes that have occurred to 
the selected schematic will be saved by the WAT. 
 
 

7.7.4 Making a Copy of an Existing Schematic 
 
To make a copy of an existing schematic: 
 
 1. From the schematics shortcut menu (see Figure 7.11, page 7-10), 

click Save As.  The Save Schematic As dialog box will open (see 
Figure 7.13, page 7-12). 

 2. The information displayed in the dialog box represents the 
schematic you have chosen to make a copy of. 

 3. In the Name box, enter the name (required) of the new schematic, 
and in the Description box, enter a description (optional, but 
recommended). 
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Figure 7.14 Schematic Shortcut Menu - Delete 

Figure 7.13  Save Schematic As Dialog Box 

 4. Click OK, the Save Schematic As dialog box (Figure 7.13) will 
close, and in the Study Pane; under the Schematics folder the new 
schematic name will appear. 

 
7.7.5 Deleting a Schematic 

 
You can only delete a schematic that is not associated with an alternative.  
For example, in Figure 7.11 (page 7-10), the Without Project Conditions 
schematic is associated with an alternative, so the Delete command does 
not display on the schematic shortcut menu.  To delete a schematic not 
associated with an alternative: 
 
 1. From the Schematic Tab, on the Study Pane, from the Schematics 

folder, right-click on a schematic that is not associated with an 
alternative.  From the Schematics shortcut menu (Figure 7.14), 
click Delete. 

 2. A message window will open, asking you if you really want to 
delete the selected schematic.  Click Yes, the schematic name will 
no longer appear under the Schematics folder on the Study Pane. 

 
 

7.7.6 Schematic Properties 
 
The properties of a schematic include the name and description for the 
Beta Version.  For Version 1.0 properties that will be displayed are: 
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Figure 7.15  Properties for SchematicName Dialog Box 

stream alignment, list of measures, common computation points, and 
impact areas.  To view the properties of a schematic: 
 
 1. From the schematics shortcut menu (see Figure 7.11, page 7-10), 

click Properties.  The Properties for SchematicName dialog box 
will open (Figure 7.15). 

 2. For the Beta Version the properties for viewing are the name and 
description of the selected schematic; the date and time the 
schematic was last modified; the location of the schematic file; and, 
the name of the file which contains information about the 
schematic. 

 
 

7.8 Establishing the Stream Alignment 
 
Stream alignments represent the stream system in the study.  The 
alignment indicates where confluences and bifurcations occur and 
provides a sense of distance and scale.  Stream alignments are composed 
of a series of streams, stream nodes, and stream junctions (see Figure 7.16, 
page 7-14).  A stream  typically begins or ends at a confluence, 
bifurcation, or at the boundary of the river system.  A stream is composed 
of vertex points, with the beginning and ending vertex points being stream 
nodes. 
 
Streams are drawn as multi-segmented lines.  Each stream must have at 
least two stream nodes, defining the beginning and end of the stream.  
Streams, stream nodes, and stream junctions, are illustrated in Figure 7.17 
(page 7-14). 
 
The WAT creates and labels stream stations (or river stations) along each 
stream.  The station at the downstream end of a stream is Station 0 (zero), 
and the stationing increases upstream along the stream according to the 
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Figure 7.16  Stream Alignment Parts 

Stream Nodes

Stream Alignment Streams 

Stream Junctions 

A stream 
alignment 
represents the 
stream system 
in the 
watershed.  
The alignment 
indicates 
where 
confluences 
and 
bifurcations 
occur and 
provides a 
sense of 
distance and 
scale.  In the 
WAT, stream 
alignments are 
composed of a 
series of 
streams. 

Figure 7.17  Relationships of Streams in a Stream Alignment 

linear distance between vertices on the stream in the study coordinate 
system.  You can override the default stationing by editing the station 
values of the stream nodes at the upstream and downstream ends of the 
stream, as well as by adding additional nodes along the stream. 

Stream stationing is based on the geographic extents that are defined when 
a stream is drawn.  If the geo-extents are based on a map layer, the units 
for the stream stationing are the same as the map layer (i.e., feet, meters).  
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In the Beta Version of the WAT there is no indication of what the units 
are, in future versions there will be a way for the user to view the units. 
 
A stream alignment created without an underlying map layer will use the 
default coordinate system of X-Y.  This default does not have any units 
attached to it.  More information on the coordinate system is contained in 
Appendix D. 
 
 

7.8.1 Creating the Default Stream Alignment 
 
If your stream alignment is going to be based on a map layer, the map 
layer should already have been included in the study.  The details on how 
to include a map layer are given in Chapter 5.  The map layer should 
contain water features, such as stream channels and reservoirs.  Use this 
map layer as a guide while creating the stream alignment.  By doing this, 
the units of the labels on the stream alignment will be the same as the units 
of the water feature layer (i.e., if your water feature layer is projected in 
state plane coordinates (feet), then the labels on the stream alignment will 
be in feet). 
 
You can either digitize a stream alignment by hand or import a stream 
alignment from an ArcView® shapefile.  The following are the steps for 
digitizing a stream alignment; see Section 7.8.10 (page 7-28) for details on 
importing a stream alignment. 
 
To create the default stream alignment for a new study: 
 
 1. When a new study is created (see Chapter 4, Section 4.1.1, page  
  4-1), the default stream alignment is created (Stream Alignment) 

and a schematic map window is automatically opened in the 
Desktop Pane (see Chapter 3, Section 3.2.2, page 3-7). 

 2. The default stream alignment is blank, to begin building the default 
stream alignment; find a location on the map window where you 
want to start a stream.  Streams should be created from upstream to 
downstream.  Hold down the CTRL key, while clicking the mouse 
button.  Each click creates a vertex point (see Figure 7.18, page  

  7-16), on your stream.  The first vertex point is the upstream or 
beginning stream node of a stream. 

 3. For the most downstream or last vertex point, release the CTRL 
key, and then click the mouse button.  This creates the ending 
stream node of the stream.  You have now created a single stream. 

 4. The Create New Stream dialog box will open (see Figure 7.19, 
page 7-16).  You can either accept the default name or enter a new 
name (required) in the Name box.  If needed, you can enter an 
optional description (recommended) in the Description box.  Click 
OK, the Create New Stream dialog box will close. 

Stream 
Alignment 
Tool  
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 5. Repeat steps 2 through 4 to add more streams to your stream 
alignment. 

 6. To connect a stream to an existing stream, place the first or last 
click of the new stream on the existing stream where you want the 
two streams to join.  After naming the new stream, a message box 
will appear asking if you want to connect the new stream to the 
existing stream.  Click Yes if you want the two streams connected.  
Otherwise, click No and the new stream will not be connected to the 
existing stream. 

 7. Once you have completed your stream alignment, save your work. 
 
The Zoom Tool (see Section 7.3, page 7-4) can be used to help define the 
stream alignment.  Use it to magnify the stream network, which makes 
defining the vertices along a stream easier. 
 

  
Figure 7.18  Creating a Stream 

Figure 7.19  Create New Stream Dialog Box 
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Figure 7.11  Schematic Shortcut Menu 

7.8.2 Existing Stream Alignments 
 
After creating a stream alignment, you can view the stream alignment, 
save the stream alignment, create a copy of an existing stream alignment, 
delete a stream alignment, view an existing stream alignment's properties, 
and, reverse direction of all streams that make up a stream alignment.  All 
of these tasks are accomplished through the stream alignment shortcut 
menu (Figure 7.20).  The stream alignment shortcut menu is available 
from the Schematic Tab, on the Study Pane, and then right-click on an 
existing stream alignment under the Components folder. 

 
Figure 7.20  Stream Alignment Shortcut Menu 

 Viewing a Stream Alignment 
 
To view a stream alignment in a map window: 
 
 1. From the stream alignment shortcut menu (Figure 7.20) click Open. 
 2. If there is not a map window open in the Desktop Pane, the map 

window for the selected stream alignment will open in the Desktop 
Pane (see Chapter 3, Section 3.2.2, page 3-7).  From the map 
window you can edit the streams, stream nodes, and stream 
junctions that make-up the stream alignment. 

 3. If a map window is open in the Desktop Pane, a message box will 
open letting you know that the stream alignment is already 
displayed in the active map window.  If you wish to open a separate 
map window for the stream alignment, click Yes.  The message box 
will close, and a map window will open with the selected stream 
alignment displayed. 
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 Saving a Stream Alignment 
 
To save the active stream alignment, from the stream alignment shortcut 
menu (see Figure 7.20, page 7-17), click Save.  Any changes that have 
occurred to the selected stream alignment will be saved by the WAT. 
 

 Making a Copy of an Existing Stream Alignment 
 
To make a copy of an existing stream alignment: 
 
 1. From the stream alignment shortcut menu (see Figure 7.20, page  
  7-17) click Save As.  The Save Stream Alignment As dialog box 

will open (Figure 7.21).  The information displayed in the dialog 
box represents the 
stream alignment you 
have chosen to make a 
copy of. 

Figure 7.21 Save Stream Alignment As 
Dialog Box 

 2. In the Name box, enter 
the name (required) of 
the new stream 
alignment, and in the 
Description box, enter a 
description (optional, but recommended). 

 3. Click OK, the Save Stream Alignment As dialog box will close, 
and in the Study Pane, the Stream Alignments folder will now 
contain the new stream alignment. 

 
 Renaming an Existing Stream Alignment 

 
To rename an existing stream alignment: 
 
 1. From the stream alignment shortcut menu (see Figure 7.20, page  
  7-17) click Rename.  The Rename Stream Alignment dialog box 

will open (Figure 7.22).  The information displayed in the dialog 
box represents the stream alignment you have chosen to rename. 

Figure 7.22  Rename Stream Alignment Dialog Box 

 2. In the Name box, enter the name (required) of the new stream 
alignment, and in the Description box, enter a description 
(optional, but recommended). 
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 3. Click OK, the Rename Stream Alignment dialog box (see Figure 
7.22, page 7-18) will close, and in the Study Pane, the Stream 
Alignments folder will now contain the renamed stream alignment. 

 
 Deleting an Existing Stream Alignment 

 
To delete an existing stream alignment: 
 
From the stream alignment shortcut menu (see Figure 7.20, page 7-17), 
click Delete.  A message window will open, asking you if you really want 
to delete the selected stream alignment.  Click Yes, the stream alignment 
name will no longer appear under the Stream Alignments folder on the 
Study Pane. 
 

 Stream Alignment Properties 
 
To view certain properties of a stream alignment, from the stream 
alignment shortcut menu (see Figure 7.20, page 7-17). click Properties.  
The Properties for Stream Alignment dialog box will open (Figure 
7.23).  Properties that you can view include: name of the active stream 
alignment, description, last time the stream alignment was modified, the 
file name and location of the stream alignment, and the geographic extents 
of the stream alignment. 

Figure 7.23  Properties for Stream Alignment Dialog Box 
 

 Reverse Direction of All Streams in a Stream 
Alignment 

 
When importing a stream alignment from ArcView® shapefiles or when 
digitizing a stream alignment, individual streams can be in the wrong 
direction (downstream to upstream).  You can reverse the direction of 
individual streams (see Reverse Direction of a Stream, under Section 
7.8.3, page 7-21), but if all your streams are in the wrong direction, the 
WAT has provided an option to handle this. 
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From the stream alignment shortcut menu (see Figure 7.20, page 7-17), 
click Reverse Direction All.  A warning message box will appear, 
warning you that reversing the streams direction will reverse the default 
stationing for all the streams in the stream alignment.  Click Yes, the 
warning message box will close, and all streams associated with the 
stream alignment will have reversed direction. 
 
 

Figure 7.24  Stream Shortcut Menu 

7.8.3 Editing a Stream Alignment – Streams 
 
After establishing a stream alignment, 
you can rename and edit the 
description for individual streams, 
delete individual streams, reverse the 
direction of a stream, disconnect a 
stream at both the upstream or 
downstream end, and view the stream 
stationing and coordinates of the 
stream nodes on a stream.  All of 
these tasks are accomplished through 
the stream shortcut menu (Figure 
7.24).  To access the stream shortcut 
menu, the Stream Alignment Tool 
must be selected, and from the map window, right-click on a stream. 
 

Stream 
Alignment 
Tool  

 Renaming a Stream 
 
To rename a stream: 
 
 1. Press the Stream Alignment Tool from the toolbar, right-click on 

the stream you want to rename, and click Rename Stream Element 
from the stream shortcut menu (Figure 7.24). 

 2. The Rename Stream dialog box opens (see Figure 7.25, page  
A stream  is a 
segment of the 
stream 
alignment that 
is composed of 
vertex points, 
with the 
beginning and 
ending vertex 
points being 
stream nodes.   

  7-21).  Enter the new name in the Name box (required) and 
description in the Description box (optional, but recommended).  
Click OK and the dialog box will close.  The new name of the 
stream will be shown on the map window. 

Figure 7.25  Rename Stream Dialog Box 
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 Deleting a Stream 
 
To delete a stream: 
 
 1. Press the Stream Alignment Tool from the toolbar, right-click on 

the stream you want to delete and click Delete Stream Element 
from the stream shortcut menu (see Figure 7.24, page 7-20). 

 2. A warning message will open asking you whether you really want 
to delete the selected stream.  Click Yes, the warning message will 
close and the stream will be deleted from the map window. 

 
 Reverse Direction of a Stream 

 
If you draw a stream in the wrong direction (downstream to upstream), the 
WAT provides a way for you to reverse the direction of a stream, instead 
of having to delete and redraw the stream. 
 
To reverse direction of a stream: 
 
 1. Press the Stream Alignment Tool from the toolbar, right-click on 

the stream you want to reverse and click Reverse Direction from 
the stream shortcut menu (see Figure 7.24, page 7-20). 

 2. A warning message will appear asking if you really want to reverse 
the direction of the stream.  Click Yes, the warning message will 
lose and the stream's direction will be reversed. 

 
 Disconnecting a Stream 

 
If you want to disconnect a stream from another stream, the WAT will 
allow you to do so at either the upstream or downstream end of the stream. 
 
To disconnect a stream from another stream: 
 
 1. Press the Stream Alignment Tool from the toolbar, right-click on 

the stream you want to disconnect and either click Disconnect 
Upstream or Disconnect Downstream from the stream shortcut 
menu (see Figure 7.24, page 7-20). 

 2. The stream will now be disconnected from the stream at the 
location you chose.  On the map window, the upstream or 
downstream point will physically move away from the connecting 
stream and a stream node will remain on the connecting stream. 

 
 Editing a Stream 

 
The previous sections have described the editing that you can do to a 
stream.  Edit Stream Element allows you to edit a stream's description  
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and view the stream's stationing and coordinates of the upstream and 
downstream stream nodes, plus any stream nodes in between the two. 
 
To edit the description of a stream: 
 

Stream 
stationing is 
based on the 
geographic 
extents that are 
defined when a 
stream is 
drawn.  
Watershed 
adopted 
stations along 
a stream 
normally 
denoted as 
miles 
(kilometers) 
above the 
mouth of a 
stream. 

 1. Press the Stream Alignment Tool from the toolbar, right-click on 
the stream element you want to edit, click Edit Stream Element 
from the stream shortcut menu (see Figure 7.24, page 7-20), the 
Stream Editor will open (Figure 7.26). 

Figure 7.26  Stream Editor 

 2. You can either enter a new description (recommended) or edit the 
description of the stream in the Description box. 

 3. The table provides you with the stream stationing and coordinates 
of the stream nodes that are on the selected stream and is 
informational only. 

 4. Click OK, the Stream Editor will close. 
 
 

7.8.4 Graphically Editing a Stream Alignment – Streams 
 
After establishing a stream alignment, you can graphically edit the 
individual streams of the stream alignment.  By using the Stream 
Alignment  Tool, the CTRL key, and the SHIFT key, you can edit 
individual streams by adding, moving, and deleting vertex points.  This is 
done graphically on the schematic in the active map window. 
 

Stream 
Alignment 
Tool  

 Adding Vertices to a Stream 
 
To add vertex points to an existing stream: 
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 1. Press the Stream Alignment Tool from the toolbar, double-click 
on a stream that you want to add a vertex point to, and the stream 
will turn red, with blue points that represent vertices. 

A vertex point 
is a point with 
known 
coordinates on 
a stream in the 
stream 
alignment. 

 2. Place the pointer on the selected stream where you want to add a 
vertex point.  Hold down the CTRL key and click.  A blue point 
will now appear on the selected stream, which represents a new 
vertex point. 

 
 Moving the Vertices of a Stream 

 
To move vertex points on an existing stream: 
 
 1. Press the Stream 

Alignment Tool from the 
toolbar; double-click on the 
stream where you want to 
move a vertex point.  The 
selected stream will turn 
red, and the individual 
vertex points will be blue 
points. 

Figure 7.27  Move a Vertex Point 

 2. Click on the vertex point 
you wish to move and then 
drag the vertex point to a 
new location; this is 
illustrated in Figure 7.27. 

 
 Deleting Vertices from a Stream 

 
To delete vertex points from an existing stream: 
 
 1. Press the Stream Alignment Tool from the toolbar; double-click 

on the stream where you want to delete a vertex point.  The selected 
stream will turn red, and the individual vertex points will be blue 
points. 

 2. Hold down the SHIFT+CTRL keys and click on the vertex point to 
be deleted.  The blue vertex point will disappear from the stream. 

 
 

7.8.5 Editing a Stream Alignment - Stream Nodes 
 
After establishing the stream alignment, you can edit and delete the 
individual stream nodes of the stream alignment.  Both of these tasks are 
accomplished through the stream node shortcut menu (see Figure 7.28, 
page 7-24).  To access the stream node shortcut menu, the Stream Node 
tool must be selected, and from the map window right-click on a stream 
node. 

Stream  
Node  
Tool  
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 Establishing Stream Stationing 
 
The WAT creates a beginning and ending 
stream node for each stream.  Stream 
nodes are also created where streams meet 
(stream junctions).  Stream nodes are used 
to establish stationing for a stream.  To 
establish stream stationing for a stream, 
you can edit the stream nodes.  To edit a 
stream node: 

Figure 7.28 Stream Node 
Shortcut Menu 

 
 1. Press the Stream Node Tool from the toolbar, right-click on the 

stream node that you want to edit.  From the stream node shortcut 
menu (Figure 7.28) click Edit Node; the Stream Node Editor will 
open (Figure 7.29). 

Stream nodes 
are created 
where streams 
meet (stream 
junctions), and 
are used to 
establish 
stationing for a 
stream. 

Figure 7.29  Stream Node Editor 

 2. The default stream station has the downstream node at zero (0) and 
the upstream node is based on the coordinate system you used when 
digitizing the stream alignment.  To change the stream stationing, 
clear Use Default Stationing.  The Station box can now be edited. 

 3. Click OK, the Stream Node Editor will close.  Based on what you 
enter, the WAT will automatically adjust the stream stationing for 
the stream associated with the stream node.  This includes the 
upstream and downstream nodes. 

 
 Deleting a Stream Node 

 
To delete a stream node, press the Stream Node Tool from the toolbar, 
right-click on the stream node that you want to delete.  From the stream 
node shortcut menu (Figure 7.28) click Delete Node.  A warning message 
will open asking you whether you really want to delete the selected stream 
node.  Click Yes, the warning message will close and the stream node will 
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be deleted from the stream alignment.  You cannot delete the beginning 
and ending stream nodes of a stream element. 
 
 

7.8.6 Graphically Editing a Stream Alignment – Stream 
Nodes 

 
After establishing a stream alignment, you can graphically edit the 
individual stream nodes of the stream alignment.  By using the Stream 
Node Tool, and the CTRL key, you can add and move stream nodes.  
This is done graphically on the schematic in the active map window. 
 

Stream  
Node  
Tool  

 Adding a Stream Node 
 
Two stream nodes are created automatically – beginning and ending 
stream nodes of a stream.  You can add stream nodes to a stream by 
pressing the Stream Node Tool from the toolbar.  Using the Stream 
Node Tool, place the pointer on the stream where you want to add a 
stream node.  Hold down the CTRL key and click.  A circle will now 
appear on the stream that indicates the new stream node. 
 

 Moving a Stream Node 
 

Figure 7.30  Move a Stream Node 

To move a stream node, press the 
Stream Node Tool from the toolbar; 
double-click on the stream node that 
you want to move.  It becomes a y
circle with a black outline and four 
small black dots (Figure 7.30).  To 
move the stream node, click and drag the stream node along the stream to 
its new position.  You cannot move the beginning and ending stream 
nodes of a stream. 

ellow 

 
 

Figure 7.31 Stream Junction 
Shortcut Menu 

7.8.7 Editing a Stream Alignment - Stream Junctions 
 
When two streams intersect, a stream junction is created.  A stream 
junction is multiple stream nodes at one location and is represented by a 
dark green circle with a light green halo 
around the circle.  You can establish stream 
stationing at a stream junction.  This task is 
accomplished through the stream junction 
shortcut menu (Figure 7.31).  To access the 
stream junction shortcut menu, the Stream 
Node tool must be selected, and from the 
map window right-click on a stream junction. 

Stream  
Node  
Tool  
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 Editing a Stream Junction 
 
To edit a stream junction: 
 
 1. Press the Stream Node Tool from the toolbar, right-click on the 

stream junction that you want to edit.  From the stream junction 
shortcut menu (Figure 7.31), click Edit Stream Junction.  The 
Stream Junction Editor will open (Figure 7.32). When two 

streams 
intersect, a 
stream 
junction is 
created.  A 
stream 
junction is 
multiple 
stream nodes 
at one location 
and is 
represented by 
a dark green 
circle with a 
light green 
halo around 
the circle. 

Figure 7.32  Stream Junction Editor 

 2. The editor displays information about the stream nodes associated 
with the stream junction.  To change the stream stationing for a 
stream node, clear the checkbox for a stream node from the Use 
Default Stationing column of the table.  The cell in the Station 
column becomes active.  Based on what you enter, the WAT will 
automatically adjust the stream stationing for the stream associated 
with the stream node. 

 3. Click OK, the Stream Junction Editor will close. 
 
 

7.8.8 Graphically Editing a Stream Alignment – Stream 
Junctions 

 
After establishing a stream alignment, you can graphically edit the 
individual stream junctions of the stream alignment.  By using the Stream 
Node Tool, you can move a stream junction.  This is done graphically on 
the schematic in the active map window. 
 

Stream  
Node  
Tool  

 Moving a Stream Junction 
 
To move a stream junction press the Stream Node Tool from the toolbar; 
double-click on the stream junction that you want to move.  It becomes a 
green circle with a black outline and four small black dots (see Figure 
7.33, page 7-27).  Click and drag the stream junction along the stream 
element to its new position. 
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Figure 7.33  Move a Stream Junction 

 
7.8.9 Changing Stream Alignment Properties 

 
Stream alignment properties that can be changed include: color of streams, 
stream nodes, and stream junctions; the width of streams, stream nodes, 
and stream junctions; font for the stream name; tic mark properties; and 
set visualization scaling for the stream alignment. 

The Stream 
Alignment 
Layer contains 
the stream 
alignment 
displayed in 
the active map 
window.  This 
primary layer 
has three sub-
layers which 
represent the 
elements of a 
stream 
alignment. 

 
To change stream alignment properties: 
 
 1. From the Maps Tab, right-click on Stream Alignment in the tree.  

From the shortcut menu, click Properties. 
 2. The Stream Alignment Properties dialog box will open (Figure 

7.34). 

Figure 7.34  Stream Alignment Properties Dialog Box 

 3. To change the color of the stream alignment, select a color from the 
Stream Color list.  The example to the right of the Edit Properties  
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  box (see Figure 7.34, page 7-27) will preview the selected color. 
 4. Click OK, the Stream Alignment Properties dialog box (see 

Figure 7.34, page 7-27) will close and the color change will appear 
in the map window. 

 5. For further details on changing stream alignment properties, see 
Chapter 5, Stream Alignment Properties, under Section 5.3.1, 
page 5-9. 

 
 

7.8.10 Importing a Stream Alignment 
 
To import a stream alignment you must have as an active map layer 
(Chapter 5) an ArcView® shapefile (see Chapter 5, Section 5.2.1, page  
5-1) that represents the stream system of your watershed.  This shapefile 
must have an attribute that is the name of each stream, and each stream 
must form a contiguous line with at least one upstream point and one 
downstream point. 
 
To import a stream alignment: 
 
 1. From the WAT main window, on the Maps menu, point to Import, 

and then click Stream Alignment. 
 2. The Import Stream Alignment dialog box will open (Figure 7.35). 

 3. In the Shapefile Name box, the name of the ArcView® shapefile 
that the WAT has chosen is displayed.  The WAT automatically 
selects the first shapefile that contains polylines; if this is not the 
correct shapefile, on the File menu, click Choose Shapefile. 

Figure 7.35  Import Stream Alignment Dialog Box 
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 4. The Choose Shapefile dialog box will open (Figure 7.36).  The 
Available box lists the available polyline shapefiles that you have 
added as map layers.  The Selected box shows the polyline 

shapefile that has been selected.  To choose a different polyline 
shapefile, use the Add and Remove buttons to get the correct 
shapefile.  In the example, Figure 7.36, the correct polyline 
shapefile is BaldEagleStreams.shp.  Click OK, the Choose 
Shapefile dialog box (Figure 7.36) will close. 

 5. Once the correct shapefile has been chosen, the program 
automatically searches for a database field name of Stream_ID.  If 
there is not a database field name of Stream_ID in the shapefile 
you choose, you must select the database field name that contains  

  the names of each stream from the Database Field Name list.  In 
the example, Figure 7.35 (page 7-28), for the shapefile 
BaldEagleStreams.shp, the database field name is Stream_ID. 

 6. When you have selected the correct database field name, the table 
will list the stream names.  If each stream is a contiguous line with 
one upstream point and one downstream point, then the checkbox in 
the Import column of the table (see Figure 7.35, page 7-28) will be 
set.  If there is something wrong with the line that represents a 
stream, the checkbox will not be set, and the WAT will not import 
that stream element. 

 7. Gap Tolerance is used to connect stream elements that have a gap 
between the end point and the junction with another stream.  By 
default, the Gap Tolerance is set to zero (0.0), so the WAT can 
connect streams to other streams that are right on top of each other.   

To import a 
stream 
alignment, you 
must have an 
ArcView® 
shapefile 
active as a 
map layer.  
This shapefile 
must have an 
attribute that is 
the name of 
each stream, 
and each 
stream must 
form a 
contiguous line 
with at least 
one upstream 
point and one 
downstream 
point. 

Figure 7.36  Choose Shapefile Dialog Box 
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  If you click Gap Tolerance, then you need to enter a value larger 
than zero in the Gap Tolerance box (see Figure 7.35, page 7-28), 
which will allow the WAT to connect streams that might have a 
larger gap between them. 

 9. The Replace Existing Stream Alignment flag, allows you to 
replace the existing stream alignment with the one you are currently 
importing from the selected ArcView® shapefile. 

 10. When importing a stream alignment from an ArcView shapefile, the 
individual streams can be in the wrong direction (downstream to 
upstream).  You can reverse the direction of individual streams or 
all streams.  From the Import Stream Alignment dialog box (see 
Figure 7.35, page 7-28), click Reverse Direction.  This will place a 
check mark in the Reverse Direction column of the table for all 
streams.  If you know that only individual streams have an issue, 
click in the Reverse Direction to select the stream. 

 11. Once everything is set, click Import.  The stream alignment will be 
automatically drawn in the map window.  A message box will 
appear letting you know that the stream alignment imported 
successfully, click OK and the message box will close.  From the 
File menu, click Close, the Import Stream Alignment dialog box 
will close (see Figure 7.35, page 7-28). 

 
 

7.8.11 Exporting a Stream Alignment 
 
If you have digitized a stream alignment, you can save that stream 
alignment as an ArcView® shapefile.  To export a stream alignment you 
must have a stream alignment in the map window. 
 
To export a stream alignment: 
 
 1. On the Maps menu, point to 

Export, and then click 
Stream Alignment. 

 2. A Save browser will open 
(Figure 7.37).  Enter a name 
in the File name box.  Click 
OK, the Save browser will 
close, and you will have an 
ArcView® shapefile of the 
displayed stream alignment. 

 
 

Figure 7.37  Save Browser 

7.8.12 Saving Stream Alignment Data 
 
To save your stream alignment input, from the Stream Alignment 
shortcut menu (see Figure 7.20, page 7-17), click Save, your stream 
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alignment has been saved.  Another way to save data is on the File menu, 
click Save Study.  Both commands will save all of the stream alignment 
input to the appropriate files created and used by the WAT for the stream 
alignment. 
 
 

7.9 Measures 
 
Measures are components of an existing or proposed physical system and 
provide a starting point for implementation in a particular model.  All 
models must incorporate the presence of measures in the system, although 
the measures maybe represented very differently from model to model.  In 
the Beta Version, measure data consists of the measure type, name, 
description, and location. 
 
 

7.9.1 Reservoirs 
 
A reservoir is the impoundment created behind dams, or behind 
navigation locks and dams.  For the WAT a reservoir also includes the 
dam built on a stream to store water for uses such as flood damage 
reduction, hydroelectric power generation, recreation use, and water 
supply, etc. 
 

 Creating a Reservoir 
 
To add a reservoir: 
 
 1. From the Schematic Tab, on the Schematics folder, right-click on 

the schematic that requires a reservoir to be added.  From the 
shortcut menu, click Open; a schematic map window will open. Reservoir 

Tool  
 2. On the map toolbar, press the Reservoir Tool. 
 3. Hold down the CTRL key and click on the stream alignment to 

place the upstream end of the reservoir.  Release the CTRL key; 
drag the mouse to the downstream end of the reservoir and click. 

 4. The Name New 
Reservoir dialog 
box will open 
(Figure 7.38).  
Enter the new 
Name (required) 
and Description 
(optional, but 
recommended).  
Click OK, the 
Name New 
Reservoir dialog box will close. 

Figure 7.38  Name New Reservoir Dialog Box 
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 5. The reservoir will now appear on the schematic as a cyan triangle 
(reservoir pool), a blue line (storage reach), a gray rectangle (dam), 
and two common computation points that represent the upstream 
and downstream ends of the reservoir, as shown in Figure 7.39. 

A reservoir is 
the 
impoundment 
created behind 
dams, or behind 
navigation locks 
and dams.  For 
the WAT a 
reservoir also 
includes the 
dam built on a 
stream to store 
water for uses 
such as flood 
damage 
reduction, 
hydroelectric 
power 
generation, 
recreation use, 
and water 
supply, etc. 

Figure 7.39  A Reservoir Added to the Map Window 

 6. The default representation of the reservoir pool is a triangle; you 
can edit this triangle if you want a more detailed representation of 
the pool.  With the Reservoir Tool pressed, double click on the 
reservoir.  The triangle (Figure 7.40) will now be green with a blue 
outline color.  Also, there 
are three vertex points 
(blue), and at the apex of 
the triangle is the r
label, which is represente
by a yellow circle. 
By click

eservoir 
d 

 7. ing and dragging 

 

 

 7- voir pool 

 8. two common computation 
at 

 

accordingly. 

the yellow circle you can 
move the reservoir label to
an appropriate location.  
Just like on the stream 
alignment you can add,
move, and delete vertex 
points.  Figure 7.41 (page
shown in Figure 7.40 has been edited to give a more detailed 
representation of the reservoir pool. 
When a reservoir is created there are 

Reservoir
Label

Vertex
Points

A reservoir in 
the WAT is 
represented as a 
reservoir pool 
(cyan triangle), 
a storage reach 
(blue line), a 
dam (gray 
rectangle), and 
two common 
computation 
points that 
represent the 
upstream and 
downstream 
ends of the 
reservoir 

Figure 7.40  Reservoir Pool 

33) illustrates how the reser

points that are created with default names.  It is recommended th
you change the names of the two common computation points.  
These two common computations points represent the inflow and
outflow junctions of the reservoir and should be renamed 
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Figure 7.41  Detailed Representation of a Reservoir Pool 

 9. To change the name of a common computation point, press the 
Computation Point Tool, right click on one of the common 
computation points.  From the shortcut menu, click Rename 
Computation Point; the Rename Computation Point dialog box 
will open 
(Figure 7.42).  
In the Name 
box, enter the 
new name, and 
in the 
Description 
box enter a 
description (optional, but recommended).  For example, in Figure 
7.41, the inflow junction for the Sayers Reservoir has been labeled 
Sayers Inflow Jct, and the outflow junction has been labeled 
Blanchard since there is a gage that is named and very close to the 
outflow junction of the reservoir.  For further information on 
common computation points see Section 7.10 (page 7-43). 

 
 Editing an Existing Reservoir 

 
After drawing a reservoir in the display area, you can rename an 
individual reservoir, remove a reservoir from the active configuration, 
delete individual reservoirs, create configuration notes for individual 
reservoirs, and edit individual reservoir properties.  All of these tasks are 
accomplished through the reservoir shortcut menu (see Figure 7.43, page 
7-34).  To access the reservoir shortcut menu, from a schematic, and with 
the Reservoir Tool (on the map toolbar, press the Reservoir Tool) 
selected, right-click on a reservoir. 

Figure 7.42  Rename Computation Point Dialog Box 
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Figure 7.43  Reservoir Shortcut Menu 

Renaming a Reservoir 
 

 
To renam

7.43). 
 2. 

 f

 3. 

m a Schematic 

3). 

e a reservoir: 
 
 1. Right-click on the reservoir that you want to rename, and click 

Rename Reservoir from the reservoir shortcut menu (Figure 
The Rename Reservoir dialog box will open (Figure 7.44).  Enter 
the new Name (required) and Description (optional, but 
recommended)

Click OK, a warning message will open asking you if you really 
want to rename the selected reservoir.  Click Yes, the warning 
message and the Rename Reservoir dialog box will close, and the 
reservoir will display the new name. 

Figure 7.44  Rename Reservoir Dialog Box 

or the reservoir. 

 
Removing a Reservoir fro
 
The WAT allows you to remove reservoirs from existing schematics.  The 
reservoir will be removed from the schematic, but not from the study. 
 
To remove a reservoir from a schematic: 
 
 1. Right-click on the reservoir you want to remove from the active 

schematic, and click Remove ReservoirName from 
SchematicName from the reservoir shortcut menu (Figure 7.4
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Figure 7.45  Notes: Dialog Box 

 2.  want 
to rem
Yes

 

 

 
 1. 

nu (see 
Figu

2. A warning message will open asking you if you really want to 
lick Yes, another warning message 

sh to delete the computation points 
e reservoir.  Click Yes, the warning message will 

putation points will no longer appear in 

 
Schem ation about a reservoir specific to 
a schematic. tics have 
been defined. 
 
To add schem
 
 1. tic notes to, 

and click enu 
(see Fig

 

 

A warning message will open asking you if you are sure you
ove the selected reservoir from the current schematic.  Click 

, the warning message will close, and the reservoir will 
disappear from the schematic. 

Deleting a Reservoir 

To delete a reservoir: 

Right-click on the reservoir you want to delete, and click Delete 
ReservoirName from Study from the reservoir shortcut me

re 7.43, page 7-34). 
 

delete the selected reservoir.  C
will open asking you if you wi
associated with th
close, the reservoir and com
the schematic and both have been removed from the study. 

 
Adding Schematic Notes for a Reservoir 

atic notes allow you to add inform
  Schematic notes are helpful when multiple schema

atic notes for a reservoir: 

Right-click on the reservoir that you want to add schema
Configuration Notes from the reservoir shortcut m

ure 7.43, page 7-34). 
 2. The Notes: dialog box (Figure 7.45) will open.  Enter information

in the Configuration Notes box that describes the selected 
reservoir for the current schematic. 
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Figure 7.46  Reservoir Properties Editor 

 
You c ties that 

ether the reservoir is an existing 
and enter the year the 

rties: 

4). 
m 

3. If the selected reservoir is an existing project, select the Existing 

 4. 

 computation. 
 
 

 Graphically Editing a Reservoir 
 
After creating a reservoir, you can graphically edit the reservoir.  By using 
the Reservoir Tool, the CTRL key, and the SHIFT key, you can edit a 
reservoir by adding, moving, and deleting vertex points.  This is done 
graphically on the schematic in the active map window. 
 
Adding Vertices to a Reservoir 
 
To add vertex points to an existing reservoir: 
 

Editing Reservoir Properties 

an edit the properties of a reservoir you have created.  Proper
can be changed are the description, wh
project, whether the reservoir is a Corps project, 
reservoir came on-line. 
 
To edit reservoir prope
 
 1. Right-click on the reservoir whose properties you would like to 

change, and click Edit Reservoir from the reservoir shortcut menu 
(see Figure 7.43, page 7-3

 2. The Reservoir Properties Editor will open (Figure 7.46).  Fro
the Description box you can edit or add a description. 

 
Project check box (Figure 7.46). 
If the reservoir is a Corps project, select the Corps Project check 
box. 

 5. If you know what year the reservoir came on-line, enter a year in 
the Year in Service box.  For the Beta Version this is just 
informational and is not used in any

Reservoir 
Tool  
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 1. Double-click on the reservoir that you w
and the polygon will turn green. 

Figure 7.47  Move a Vertex Point 

ant to add a vertex point to, 

 

oving the Vertices of a Reservoir 

To mo
 

 2. 

 
Deleting Vertices from a Reservoir 

To del eservoir: 

 1. le-click on the reservoir where you want to delete a vertex 

 2. he vertex point 
that you want to delete.  The vertex point will disappear from the 

7.9.2 Levee

e 
lood damage by 

reventing flood stages from reaching a potential damage area. 

 Creating a Levee 

o add a levee: 
 

 2. Place the pointer on the selected reservoir where you want to add a 
vertex point.  Hold down the CTRL key and click.  A blue point 
will now appear on the selected reservoir, which represents a new
vertex point. 

 
 
M
 

ve vertex points on an existing reservoir: 

 1. Double-click on the 
reservoir where you want 
to move a vertex point.  
The selected reservoir 
will turn green, and the 
individual vertex points 
will turn blue. 
Click on the vertex point 
you wish to move, and 
drag the vertex point to a 
new location, this is 
illustrated in Figure 7.47. 

 
ete vertex points from an existing r

 
Doub
point.  The selected reservoir will turn green, and the individual 
vertex points will turn blue. 
Hold down the SHIFT+CTRL keys, and click on t

reservoir. 
 
 
s 
 
A levee/floodwall is a man-made barrier built along a stream to provid
protection from flooding.  A levee/floodwall can reduce f
p
 

 
T
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 1. From the Schematic Tab, from the Schematics folder, right-click 
on the schematic that requires a levee to be added.  From the 

 2. 
 3. 

ream end of the levee.  Release the CTRL key, drag 
the mouse to the downstream end of the levee and click. 

4. The Name New Levee dialog box opens (Figure 7.48).  Enter the 
 but 
e dialog box will 

5. The levee will now appear on the schematic as a black line, as 

ing Levee 

al levees, 
reate schema

hese tasks are accomplished through the levee shortcut 
.50, page 7-39).  To access the levee shortcut menu, 

, and with the Levee Tool (on the map toolbar, press the 
cted, right-click on a levee. 

shortcut menu, click Open; a schematic map window will open. 
On the map toolbar, press the Levee Tool. 
Hold down the CTRL key and click on the stream alignment to 
place the upst

Levee 
Tool  

 
new Name (required) and Description (optional,
recommended).  Click OK, the Name New Leve
close. 

Figure 7.48  Name New Levee Dialog Box 

 
shown in Figure 7.49. 

Figure 7.49  A Levee Added to the Schematic 
 

 Editing an Exist
 
After drawing a levee on the schematic, you can rename an individual 
levee, remove a levee from the active schematic, delete individu
c tic notes for individual levees, and edit individual levee Levee 
properties.  All of t

enu (see Figure 7
Tool  

m
from a schematic

evee Tool) seleL
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Figure 7.51  Rename Levee Dialog Box 

Figure 7.50  Levee Shortcut Menu 
 
 Renaming a Levee 
 
To rename a levee: 
 
 1. Right-click on the levee that you want to rename, and click 

Rename Levee from the levee shortcut menu (Figure 7.50). 
 2. The Rename Levee dialog box will open (Figure 7.51).  Enter the 

new Name (required) and Description (optional, but 
recommended) for the levee. 

 3. Click OK, a warning message will open asking you if you really 
want to rename the selected levee.  Click Yes, the warning message 
and the Rename dialog boxes will close, and the levee will display 
the new name. 

 
Removing

levees from existing schematics.  The 
vee will be removed from the schematic, but not from the study. 

 

 a Levee from a Schematic 
 
The WAT allows you to remove 
le
 
To remove a levee from a schematic: 
 
 1. Right-click on the levee you want to remove from the active 

schematic, and click Remove LeveeName from SchematicName
from the levee shortcut menu (Figure 7.50). 
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 2. 
Yes, 

 

 

 

 
 1. 

2. A warning message will open asking you if you really want to 
Yes, the warning message will 

 in the schematic and has been 
 the study. 

 

schem atics have 
been d
 
To add schem
 
 1. 

click 

 2. The ).  
Enter i  box that describes 
the selected levee for the current schematic. 

Edit
 

ou c roperties of a levee you have created.  Properties 
er the levee is 
 year the levee 

ame on-line; what stream the levee is located on; the start and end 
e 

hange, 

A warning message will open asking you if you are sure you want 
to remove the selected levee from the current schematic.  Click 
the warning message will close, and the levee will disappear from
the schematic. 

Deleting a Levee 

To delete a levee: 

Right-click on the levee you want to delete, and click Delete 
LeveeName from Study from the levee shortcut menu (see Figure 
7.50, page 7-39). 

 
delete the selected levee.  Click 
close, the levee will no longer appear
removed from

 
Adding Schematic Notes for a Levee 

Schematic notes allow you to add information about a levee specific to a 
atic.  Schematic notes are helpful when multiple schem
efined. 

atic notes for a levee: 

Right-click on the levee you want to add schematic notes too, and 
Configuration Notes from the levee shortcut menu (see 

Figure 7.50, page 7-39). 
Notes: dialog box will open (see Figure 7.45, page 7-35

nformation in the Configuration Notes

 
ing Levee Properties 

an now edit the pY
that can be changed are: the description of the levee; wheth
an existing project; whether the levee is a Corps project; the
c
stations of the levee; adjust the distance (offset) from the stream the leve
is placed; and, what stream bank the levee is located on. 
 
To edit levee properties: 
 
 1. Right-click on the levee whose properties you would like to c

and click Edit Levee from the levee shortcut menu (see Figure 
7.50, page 7-39). 
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 2. The Levee Properties Editor will open (Figure 7.52). 

Figure 7.52  Levee Properties Editor
 3.  you can edit or add a description. 

4. If the selected levee is an existing project, click Existing Project. 
(Figure 7.52). 

 stationing 

e Start Station and End Station columns in the table. 
7. By default a levee will follow a stream, so the Follows Stream 

owever, not all levees follow a stream 
ore detailed representation of the 

, 

ove, and delete vertex points.  Figure 7.53 
een 

 8. vee 
ou want to change the stream bank location, from 

From the Description box
 
 5. If the levee is a Corps project, select Corps Project 

6. The table shows the stream the levee is on and the stream 
for the starting and ending stations of the levee.  If you want to 
change the starting and ending stations of the levee, edit the cells 
under th

 
check box will be selected.  H
exactly, so if you want to give a m
levee, clear Follows Stream.  Now if you double click on the levee
vertex points (black circles) appear.  Just like on the stream 
alignment you can add, m
illustrates how the levee shown in Figure 7.49 (page 7-38) has b
edited to give a more detailed representation. 

Vertex Point

Figure 7.53  Detailed Representation of a Levee 

The program automatically determines which stream bank the le
is located on.  If y
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the Bank list (see Figure 7.52, page 7-41) select the app

Figure 7.54  Move a Vertex Point 
illustrated in Figure 
7.54. 

ropriate 
stream bank. 

 9. If you know what year the levee came on-line, enter a year in the 
Year in Service box.  For the Beta Version this is just 
informational and is not used in any computation. 

 10. When a levee is created, a default-offset distance from the stream 
alignment is set.  The default offset is shown in the Average Offset 
box (see Figure 7.52, page 7-41) and is 50.  To change the offset, in 
the Average Offset box change the value, click Apply.  The levee 
on the schematic will move according to the new offset value. 

 11. Click OK, the Levee Properties Editor (see Figure 7.52, page  
  7-41) will close. 
 
 

 Graphically E

e

the sch
 
Add

To add
 
 1. 

 2. 

epresents a new 
vertex point. 

 
Moving the Vertices of a Levee 
 
To move vertex points on an existing levee: 
 
 1. Double-click on the levee where you want to move a vertex point.  

The selected levee will turn yellow, and the individual vertex points 
will turn black. 

 2. Click on the vertex 
point you wish to 
move, and drag the 
vertex point to a new 
locatio

 

diting a Levee 
 
After creating a levee, you can graphically edit the levee.  By using the 

Levee 
Tool  Leve  Tool, the CTRL key, and the SHIFT key, you can edit a levee by 

adding, moving, and deleting vertex points.  This is done graphically on 
ematic in the active map window. 

ing Vertices to a Levee 
 

 vertex points to an existing levee: 

Double-click on the levee that you want to add a vertex point to, 
and the line will turn yellow. 
Place the pointer on the selected levee where you want to add a 
vertex point.  Hold down the CTRL key and click.  A black point 
will now appear on the selected levee, which r

n, this is 
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Dele

 
  

 2. 

7.9.3 Saving Measure Data 

 the File menu, click Save Study.  

7.10 Comm

 where one model transfers 
odel development 

dary conditions are to be 
e e

ge 

 
 

7.10.1 Creating a Common Computation Point 

matics folder, right-click on 

 press the Computation Point Tool. 
L

omputation point. 
 4. putation Point dialog box will open (see 

).  Enter the new Name (required) and 
l, but recommended).  Click OK, the Name 
o

 
  

 2. 

7.9.3 Saving Measure Data 

 the File menu, click Save Study.  

7.10 Comm

 where one model transfers 
odel development 

dary conditions are to be 
e e

ge 

 
 

7.10.1 Creating a Common Computation Point 

matics folder, right-click on 

 press the Computation Point Tool. 
L key and click on the stream alignment to 

omputation point. 
 4. putation Point dialog box will open (see 

).  Enter the new Name (required) and 
l, but recommended).  Click OK, the Name 
o

ting Vertices from a Levee ting Vertices from a Levee 
 
To delete vertex points from an existing levee: 

Double-click on the levee where you want to delete

 
To delete vertex points from an existing levee: 

Double-click on the levee where you want to delete 1.  a vertex point.
The selected levee will turn yellow, and the individual vertex points 
will turn black. 
Hold down the SHIFT+CTRL keys, and click on the vertex point 
that you want to delete.  The vertex point will disappear from the 
levee. 

 1.  a vertex point.
The selected levee will turn yellow, and the individual vertex points 
will turn black. 
Hold down the SHIFT+CTRL keys, and click on the vertex point 
that you want to delete.  The vertex point will disappear from the 
levee. 

  
  

 
To save your input for measures, on
 
To save your input for measures, on
TThis will save all of the data for measures to the appropriate files created 
and used by the WAT for measures. 
 
 
on Computation Points 

his will save all of the data for measures to the appropriate files created 
and used by the WAT for measures. 
 
 
on Computation Points 

 
Common computation points are locations
 
Common computation points are locations
ddata to another model, or where results are needed for m
or alternative analysis, or where input boun
ata to another model, or where results are needed for m

or alternative analysis, or where input boun
dd fin d.  The common computation points need to be consistent for all 
models and should be placed on the stream alignment based on knowled

fin d.  The common computation points need to be consistent for all 
models and should be placed on the stream alignment based on knowled
of possible study alternatives.  The entire study team should be involved in 
the definition of the common computation points. 
of possible study alternatives.  The entire study team should be involved in 
the definition of the common computation points. 

 
To add a common computation point: 
 
To add a common computation point: 
  
 1. From the Schematic Tab, on the Sche 1. From the Schematic Tab, on the Sche

the schematic that requires a common computation point to be 
added.  From the shortcut menu, click Open; a schematic map 
window will open. 
On the map tool

the schematic that requires a common computation point to be 
added.  From the shortcut menu, click Open; a schematic map 
window will open. 
On the map tool

Computation 
Point 
Tool   2. bar,

 3. Hold down the CTR
place the common c
The Name New Com
Figure 7.55, page 7-44
Description (optiona
New Computation P

 2. bar,
 3. Hold down the CTR

place the common c
The Name New Com
Figure 7.55, page 7-44
Description (optiona
New Computation P

 key and click on the stream alignment to 

int dialog box will close. int dialog box will close. 
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Figure 7.55  Name New Computation Point Dialog Box 

 5. The common computation point will now appear in the map 
window as a black circle.  

 
o add a common computation pointT  at a stream junction (see Section 

7.8.5, page 7-23): 

k on the schematic that requires 
a common computation point to be added.  From the shortcut menu, 

lace 

 5. tion Point list, you 
determine exactly where the common computation point will be 

am 

 
 1. From the Schematic Tab, right-clic

click Open; a schematic map window will open. 
 2. On the map toolbar, press the Computation Point Tool. 
 3. Hold down the CTRL key and click on the stream junction to p

a common computation point. 
 4. A slightly different Name New Computation Point dialog box will 

open (Figure 7.56).  Enter the new Name (required) and 
Description (optional, but recommended). 

From the Select the Placement of the Computa

Figure 7.56 Name New Computation Point Dialog Box at a Stre
Junction 
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Figure 7.58  Rename Computation Point Dialog Box 

Figure 7.57 Common Computation Point 
Shortcut M

shortcut menu (Figure 7.57).  To 
 the computation point 
ut menu, from a schematic enu 

map window, and with the 

placed.  You chose to have the common computation point placed 
on the stream junction, along one of the streams that form the 
stream junction, or none of the above.  For example, in Figure 7.56 
(page 7-44), the common computation point will be placed on the 
stream junction. 

 6. Click OK, the Name New Computation Point dialog box will 
close.  The common computation point will now appear in the 
display area as a black circle. 

 
 

7.10.2 Editing an Existing Common Computation Point 
 
After draw , you can 
rename an individual common computation point, delete individual 

and ed
omputation point properties.  

gh the 
ommon computation point 

access
shortc

Point 

 
 Renaming int 

 
To rename a common computation point: 
 
 1. Right-click on the common computation point you want to rename, 

and click Rename Computation Point from the common 
computation point shortcut menu (Figure 7.57). 

 2. The Rename Computation Point dialog box opens (Figure 7.58).  
The new Name (required) and Description (optional, but 
recommended) are entered for the common computation point. 

 

ing a common computation point in the map window

common computation points, 
it individual common 

c
All of these tasks are 
accomplished throu
c

Computation Point Tool (on the map toolbar, press the Computation 
Tool) selected, right-click on a 

Computation 
Point 
Tool  

common computation point. 
 

 a Common Computation Po
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 3. 

 message and the Rename Computation Point 
 

 
 Deleting a Common Computation Point 

or an 
pact area cannot be deleted.  These common computation points are 

ion point: 

on computation point you want to delete, 
 ComputationPointName from Study from the 

n point shortcut menu (see Figure 7.57, page  

 open asking you if you really want to 
 
 and the common computation point will 

e map window. 

 Editin

am associated 
ith the common computation point; the position of the common 

; the stream stationing 
ssociated with the common computation point; the easting and northing 

compu that 
comm mputation point on 

 
To edi
 
 1. 

from the 

  7-45). 
 2. The 

descripti

Click OK, a warning message will open asking you if you really 
want to rename the selected common computation point.  Click 
Yes, the warning
dialog boxes will close, and the common computation point will
display the new name. 

 
Common computation points created with a project (i.e., reservoirs) 
im
deleted when the project or impact area is deleted. 
 
To delete a common computat
 
 1. Right-click on the comm

and click Delete
common computatio

  7-45). 
 2. A warning message will

delete the selected common
warning message will close
no longer appear in th

 
g Common Computation Point Properties 

computation point.  Click Yes, the 

 
The general properties of a common computation point that you can edit 
include: the description of the computation point; the stre
w
computation point label on the map window
a
coordinates of the common computation point; if the common 

tation point was system generated what projects generated 
on computation point; and, place the common co

the stream alignment. 

t common computation point properties: 

Right-click on the common computation point whose properties you 
would like to change, and click Edit Computation Point 
common computation point shortcut menu (see Figure 7.57, page  

Computation Point Properties Editor will open (see Figure 
7.59, page 7-47). From the Description box you can edit or add a 

on (recommended). 
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Figure 7.59  Computation Point Properties Editor 

3 By default the WAT automatically decides which stream the 

le. 
 4. 

omputation point.  If you want to change the stream 

 5. 

 6. ion point is displayed by the 
northing and easting coordinates.  These values are not editable. 

m in 

an edit 
tion 

7.10.3 Graphically Editing a Common Computation Point 

u can graphically edit a 
ommon computation point.  By using the Computation Point Tool, you 

schem
 

 Moving a Common Comput

To mo
 

 
common computation point is located on.  The Stream Name box 
(Figure 7.59) provides you with this information and is not editab
The WAT automatically generates the stream station for the 
common c
station, in the Stream Station box enter a new value. 
The Label Position list allows you to place the common 
computation point label on the map window. 
The location of the common computat

 7. By default, a common computation point is placed on a strea
the stream alignment.  If you wish to have a common computation 
point that is not on a stream, clear the Snap to Steam Element 
check box. 

 8. Once you have cleared the Snap to Stream Element, you c
the easting and northing coordinates of the common computa
point, and you can move the common computation point off the 
stream alignment. 

 
 

 
After creating a common computation point, yoComputation 

Point 
Tool  

c
can move common computation points.  This is done graphically on the 

atic in the active map window. 

ation Point 
 

ve a computation point: 
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Figure 7.60 Move a Common 
Com

ap toolbar, press the Computation Point Tool. 
Double click on a common computation point (Figure 7.60). 
The common computation point now has four little black dots 

) at each corner.  Click 
and drag the common computation 
point to where you want the 
common computation point to be 

ed, and release.  The 
common computation point will 
now appear on the map window in 
its new position. 
You will only be able to move the common computation point 
along a stream.  By default a common computation point m

.  If you want a common computation point

putation Point 

 1. On the m
 2. 
 3. 

(handles

position

 4. 
ust live 

on a stream  not to be on 
the str  editor (see 

n 

 

7.10.4 Saving Co
 

enu, 
click S ommon computation 

compu

 
7.11 Impact Ar

 

or fall
option
impac nters in the study area, and you have an  

EC-FIA model as part of your WAT modeling effort. 

 

.11.1 

pact areas by hand or import impact areas 
om an ArcView® shapefile.  The following are the steps for digitizing 

eam alignment, you must change a setting in the
Edit Common Computation Point Properties, under Sectio
7.10.2, page 7-47, Steps 7 and 8).. 

 
mmon Computation Point Data 

To save your input for common computation points, on the File m
ave Study.  This will save all of the data for c

points to the appropriate files created and used by the WAT for common 
tation points. 

 

eas 

An impact area is any distinct portion of a study that is affected by rising 
ing stage in a stream, river, lake, or reservoir.  Impact areas are an 
al element, and are only required when you want to compute 
ts at damage area ce

H
 
You can use underlying map layers to aid in placing impact areas at the
roper location on the schematic.  Besides location, a map layer can also p

give you a concept of the dimensions of an impact area.  However, the 
Beta version of the WAT does not have any geo-referencing attached to 
the impact area polygon. 
 
 

7 Creating an Impact Area 
 
You can either digitize your im
fr
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Figure 7.62  Name New Impact Area Dialog Box 

our 

To add : 
 
 1. m the Schematics folder, right-click 

mmon computation point to be 
Open; a schematic map 

 2. ct Area Tool
 3. RL key while clicking the mouse button.  Each 

 of 

e New Impact Area dialog box will open (Figure 7.62).  
 enter a name, and if needed, you can enter a description.  

impact areas; see Section 7.11.4 (page 7-54) for details on importing y
impact areas. 
 

 an impact area to the schematic

From the Schematic Tab, fro
on the schematic that requires a co
added.  From the shortcut menu, click 
window will open. 
On the map toolbar, press the Impa
Hold down the CT

Impact  
Area 
Tool  

. 

click creates a vertex point (Figure 7.61), which is the boundary
the polygon.  When reaching the end point, release the CTRL key 
and click. 

Figure 7.61  Add an Impact Area to the Schematic 

 4. The Nam
You must
Click OK, the Name New Impact Area dialog box will close. 

 5. The impact area will now appear in the display area as a green 
polygon with a name.  Repeat steps 3 and 4 for each impact area in 
your watershed. 
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Figure 7.63  Impact Area Shortcut Menu 

To access the impact area 
ut menu, from a 
atic, and with the Impact 
Tool (on th

Figure 7.64  Rename Impact Area Dialog Box 

7.11.2 Editin

atic, you can rename an 
impact areas, create schematic 

f

impac
these t
h g

shortc
schem
Area e map toolbar, 
press the Impact Area Tool) selected, right-click on an impact area. 
 

 Renaming an Impact Area 
 
To rename an impact area: 
 
 1. Right-click on the impact area you want to rename, and click 

Rename Impact Area from the impact area shortcut menu (Figure 
7.63). 

 2. The Rename Impact Area dialog box will open (Figure 7.64).  
Enter the new Name (required) and Description (optional, but 
re

you if you really 
want to rename the 
selected impact 
area.  Click Yes, 
the warning message and the Rename Impact Area dialog boxes 
will close, and the impact area will display the new name. 

 
 Deleting an Impact Area 

 
To delete an impact area: 
 
 1. Right-click on the im Delete 

Imp a shortcut menu 

g an Existing Impact Area 
 
After drawing an impact area on the schem
individual impact area, delete individual 
notes or individual impact 
areas, and edit individual 

t areas properties.  All of 
asks are accomplished 
h the impact area t rou

shortcut menu (Figure 7.63).  

commended for 
the impact area. 

 3. Click OK, a 
warning message 
will open asking 

pact area you want to delete, and click 
actAreaName from Study from the impact are

(Figure 7.63). 
 2. A warning message will open asking you if you really want to 

delete the selected impact area.  Click Yes, the warning message 
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Figure 7.65  Con

If the notes are in regards to non-structural attributes, select Displa
Non-Structural Symbol.  This will cause a symbol to appear in th
selected impact area on the schematic. 

figur

pear in the display 

 Addin

 to add information about an impact area 
re useful for describing impact areas that 

de non-structural measures.  If there are 
for an impact area, you can have a symbol appear 

d impact area.  Schematic notes are only 
cs have been defined. 

or an imp

, 
and click Configuration Notes from the impact area shortcut menu 
(see Figure 7.63, page 7-50). 

Editor will open (Figure 7.65).  The 
s the current schematic.  Enter 

s impact area for the current schematic in the 
 box. 

 3. y 
e 

erties 

scribe the general and aesthetic properties of an 

impac
ay 

l  

will close, and the impact area will no longer ap
area. 

 
g Schematic Notes for an Impact Area 
 
Schematic notes allow you
specific to a schematic.  These a
belong to schematics that inclu
non-structural attributes 
in the schematic for the selecte
added when other schemati
 
To add schematic notes f
 
 1. Right-click on the impact area you want to add schematic notes to

act area: 

 2. The Configuration Notes 
Configuration box display
information about thi
Configuration Notes

ation Notes Editor 

 
 Editing Impact Area Prop

 
n a schematic, you can deI

impact area.  The impact area properties that you can edit in a schematic 
include:  the description of the impact area; the stream associated with the 

t area; what bank of the stream the impact area is on; the color of the 
impact area polygon; the position of the impact area label on the displ
area; the geographical location of the index station; and, the geographica
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Figure 7.66  Impact Area Properties Editor 

locatio
 

o edit impact area properties: 

uld like to 
ut 

 3. If the Auto check box is selected for an item, the value for this data 
item is automatically updated as the polygon or index location is 
moved in the display area.  By default, when a polygon is drawn in 
the display area, these values are filled in automatically.  If the 
check box is cleared, data can be entered manually into these fields, 
and the value will cease to be automatically updated if changes are 
made to the polygon.  However, reselecting the check box allows 
the values to be automatically determined when edits are made in 
the display area. 

 4. From the Description box (Figure 7.66) you can edit or add a 
description. 

 5. I e WAT is incorrect, clear 

 6. 
ream bank from the Bank 

 area polygon that you have 
drawn is green.  You can change the color by selecting a different 

n 

n of the beginning and ending stations of the impact area polygon. 

T
 

1. Right-click on the impact area whose properties you wo 
change, and click Edit Impact Area from the available shortc
menu (see Figure 7.63, page 7-50).   

 2. The Impact Area Properties Editor will open (Figure 7.66). 

f the default stream name selected by th
the Auto check box, and from the Stream Name list select the 
appropriate stream name. 
If the default bank selected by the WAT is incorrect, clear the Auto 
check box, and select the appropriate st
box. 

 7. By default, the color of the impact

color from the Color list. 
 8. The Label Position list allows you to place the impact area label o

the display area. 
 9. For each impact area, the WAT generates an index station; this 

index station is a location.  If you want to place the index station 
yourself, clear the Auto check box next to the Index box (see 
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Figure 7.66, page 7-52), and then enter the new stream stationing in

Figure 7.67  Move a Vertex Point 

drag the vertex point to a 
new location, this is 
illustrated in Figure 7.67. 

 
the Index box. 

ginning and ending station that the 
program automatically computes.  If you want to change the stream 

t 
m 

he Downstream box. 
6, 

page 7-52) will close. 
 
 

7.11.3 Graphically Editing an Impact Area 
 
After creating an impact area, you can graphically edit the impact area.  
By using the Impact Area Tool, the CTRL key, and the SHIFT key, you 
can edit an impact area by adding, moving, and deleting vertex points.  
This is done graphically on the schematic in the active map window. 
 

 Adding Vertices to an Impact Area 
 
To add ve
 

 2. 
t 

 
 Moving th

 

 10. Each impact area has a be

stationing the program has generated, clear the Auto check box nex
to the Upstream and Downstream boxes, and enter the new strea
stationing in the Upstream box and t

 11. Click OK, the Impact Area Properties Editor (see Figure 7.6

Impact  
Area 
Tool  

rtex points to an existing impact area: 

 1. Double-click on an impact area that you want to add a vertex point 
to, and the impact area will turn yellow. 
Place the pointer on the selected impact area where you want to add 
a vertex point.  Hold down the CTRL key and click.  A red poin
will now appear on the selected impact area, which represents a 
new vertex point. 

e Vertices of an Impact Area 
 
To move vertex points on an existing impact area: 
 
 1. Double-click on an 

impact area where you 
want to move a vertex 
point.  The selected 
impact area will turn 
yellow, and the 
individual vertex points 
will turn red. 

 2. Click on the vertex point 
you wish to move, and 
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 Deleting V

 
 1. 

 
.  The vertex point will disappear from the 

impact area. 

7.11.4 Importing 

t are 
 is the name of 

rm a contiguous polygon. 

 2. ill open (Figure 7.68). 

 3. x, the name of the ArcView® shapefile 
sen is displayed.  The WAT automatically 
file th t the 

t shapefile, on the File menu, click Choose Shapefile. 

ertices from an Impact Area 
 
To delete vertex points from an existing impact area: 

Double-click on an impact area where you want to delete a vertex 
point.  The selected impact area will turn yellow, and the individual 
vertex points will turn red. 

 2. Hold down the SHIFT+CTRL keys, and click on the vertex point
that you want to delete

 
 

Impact Areas 
 
To import impact areas, you must have as an active map layer (see 
Chapter 5, Section 5.2.2, page 5-3) that is an ArcView® shapefile (see 
Chapter 5, Section 5.2.1, page 5-1) that represents the impact areas tha
in your study.  This shapefile must have an attribute that
each impact area, and each impact area must fo
 
To import impact areas: 
 
 1. On the Maps menu, point to Import, and then click Impact Areas. 

The Import Impact Areas dialog box w

In the Shapefile Name bo
that the WAT has cho
selects the first shape
correc

at contains polygons; if this is no

Figure 7.68  Import Impact Areas Dialog Box 
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 4. The Choose Shapefile dialog box will open Figure 7.69).  The 
Available box lists the available polygon shapefiles that you have 
added as map layers.  The Selected box shows the polygon 

shapefile that has been selected.  To choose a different polygon 
shapefile, use the Add and Remove buttons to get the  

  correct shapefile.  In the example, Figure 7.69; the correct polygon 

 5. 

 6. 

im

closes and the left 
column of the table 
will reflect the 
fieldname in the column header.  In the example, Figure 7.68 (page  

Figure 7.69  Choose Shapefile Dialog Box 

shapefile is BaldEagleImpactAreas.shp. 
Once the correct shapefile has been selected, click OK.  The 
Choose Shapefile dialog box will close. 
Once the correct shapefile has been chosen, the program 
automatically searches for a database fieldname of ID_IMPAREA 
(see Figure 7.68, page 7-54).  If ID_IMPAREA is not a fieldname, 
you must select the database fieldname that contains the names of 
each impact area.  
Click Map Fields, a 
dialog box opens 
(Figure 7.70).  From 
the ImpactArea 
Name Attribute list, 
select the fieldname 
that contains the 
names of each 

pact area.  Click 
OK, the dialog box 

Figure 7.70  Database Fieldname Selection 
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  7-54), for the shapefile BaldEagleImpactArea
field name is ID_IMPAREA. 

s.shp, the database 

ld name, the table 
tiguous 

 

 
 

9. 
 have imported successfully, click OK and 
ose.  The impact areas will be automatically 

ge 

7.11.5 Expor

act areas, you can save the impact areas as an 

To export impact areas: 
 
 1. On the Maps menu, point 

to Export, and then click 
Impact Areas. 

 3. A Save File browser will 
open (Figure 7.71).  Enter 
a name in the File nam
box.  Click OK, the 
File browser will close, 
and you will have an 
ArcView® shapefile of 
the displayed impact 
areas. 

 
 

7.11.6 Saving Imp
 

 
This w
create
 

 7. When you have selected the correct database fie
will list the impact area names.  If each impact area is a con
polygon, then the check box in the Import column of the table will
be set.  If there is something wrong with the polygon that represents 
an impact area, the check box will not be set, and the WAT will not 
import that impact area. 

 8. The Replace Existing Impact Areas flag allows you to replace the
existing impact areas with the one you are currently importing from
the selected ArcView® shapefile. 

 Once everything is set, click Import.  A message box will appear 
stating the impact areas
the message box will cl
drawn in the schematic.  From the File menu, choose Close, the 
Import Impact Areas dialog box will close (see Figure 7.68, pa
7-54). 

 
 
ing Impact Areas t

 
 you have digitized impIf

ArcView® shapefile.  To export impact areas you must have impact areas 
in the schematic. 
 

e 
Save 

Figure 7.71  Save File Browser 

act Area Data 

To save your input for impact areas, on the File menu, click Save Study. 
ill save all of the data for impact areas to the appropriate files 

d and used by the WAT for impact areas. 
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CHAPTER 8  
 
 
 

Analysis Periods/Events 
 
 

8.1 Overview 
 
Analysis periods define the time window and events that could be 
associated with an alternative, and will be used for all the models.  An 
analysis period can represent single or multiple events.  For example, a 
historical event, such as the 1993 flood, would be entered as a single event 
for a specific analysis period (time window).  However, the development 
of frequency based storm events would be represented as multiple events 
under a single analysis period.  An event is an occurrence of 
precipitation/snowmelt that leads to some sort of hydrologic response 
normally associated with a specific time period.  An event can be 
historical or hypothetical, or it could represent a long term simulation 
(e.g., a fifty year simulation).  Once the user has defined an alternative 
(such as the Without Project Conditions alternative), the next step is to 
create analysis periods and events. 
 
 

Analysis 
periods define 
the time 
window and 
events that 
could be 
associated 
with an 
alternative, 
and will be 
used for all the 
models. 

8.2 Alternative and Simulation Manager 
 
After the default alternative has been created, the next step is to create 
analysis periods (which include events).  The WAT provides two ways to 
organize and develop analysis periods; one way is from the Alternative 
and Simulation Manager (Figure 8.1), and the other way is from the  

Figure 8.1  Alternative and Simulation Manager 
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Study Pane (see Section 8.3, page 8-10).  This section covers using the 
Alternative and Simulation Manager for organizing and developing 
analysis periods. 
 
In the WAT, the Alternative and Simulation Manager (see Figure 8.1, 
page 8-1) provides a convenient way to organize and develop the main 
components for a WAT study – alternatives, analysis period (events), and 
simulations.  This chapter will focus on the organization and development 
of analysis periods.  The Alternative and Simulation Manager has three 
areas where you can access commands that will allow you to create, 
delete, and rename analysis periods.  These areas are the Table (Section 
8.2.1), Toolbar (see Section 8.2.2, page 8-9) and Menu Bar (see Section 
8.2.3, page 8-9).  These areas and the available commands are described in 
the following sections. 
 
To access the Alternative and Simulation Manager, from the WAT 
main window, from the WAT Tools toolbar (see Chapter 3, Section 3.2.1, 
page 3-4), click      .  Another way to access the Alternative and 
Simulation Manager is from the WAT main window, on the Edit menu, 
click Alternative and Simulation Manager.  From either method the 
Alternative and Simulation Manager will open (see Figure 8.1, page  
8-1). 
 
 

8.2.1 Table 
 
The Alternative and Simulation Manager (see Figure 8.1, page 8-1) 
table allows organization of a study's alternatives; a way to track the state 
of data sets needed for each model, create analysis periods, and create 
simulations.  Since the focus of this chapter is analysis periods, this 
section will only focus on the available commands from the table to 
develop and organize analysis periods. 
 

 Analysis Periods 
 
The analysis period shortcut menu (Figure 8.2) is available from the 
Alternative and Simulation Manager (see Figure 8.1, page 8-1) table, by 
right-clicking on the column header Analysis Periods.  This shortcut 
menu will allow you to create, rename, and delete analysis periods.  The 
following sections provide further details. 

Figure 8.2  Analysis Periods Shortcut Menu 
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Creating an Analysis Period 
 
To create an analysis period: 
 

To access the 
Alternative 
and 
Simulation 
Manager, from 
the WAT main 
window, from 
the WAT Tools 
toolbar click      

. 

 1. From the analysis periods shortcut menu (see Figure 8.2, page 8-2), 
click New, the Create New Analysis Period dialog box will open 
(Figure 8.3). 

Figure 8.3  Create New Analysis Period Dialog Box 

 2. In the Name box, enter a name (required) for the analysis period.  
Optionally (but recommended), you can enter a description in the 
Description box. 

 3. In the Time Window box, you will enter a start date in the Start 
Date box, a start time in the Start Time box.  For the end date of 
the time window you will enter that in the End Date box, and the 
end time in the End Time box. 

 4. If the analysis period does not have multiple events (e.g., 2-yr,  
  20-yr, 50-yr, etc. for the same time window), click OK.  The 

Create New Analysis Period dialog box (Figure 8.3) will close.  
On the Alternative and Simulation Manager (see Figure 8.1, page 
8-1), below the Analysis Periods header in the table will be a 
header that will contain the name of the analysis period that you just 
created. 

 5. If the analysis period contains multiple events, from the Create 
New Analysis Period dialog box (Figure 8.3), click Use Multiple 
Events.  The Add Event and Delete Event buttons become active.  
To add an event, click Add Event, this will add a row to the Event 
Table (see Figure 8.4, page 8-4).  Click Add Event for as many 
events as you want to add to the analysis period. 

 6. The events are given a default name and time window; you can edit 
this name and the time window for each event. 
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 7. You can also place the events in order by clicking the up and down 
arrows to the right of the Event Table (Figure 8.4). 

Figure 8.4  Create New Analysis Period Dialog Box – Event Table 

 8. If you wish to delete an event, select the event from the Event 
Table, and click Delete Event.  The event will be removed from 
the Event Table. 

Figure 8.5 Alternative and Simulation Manager – Analysis 
Periods and Events 

 9. Once you have your events defined, click OK.  The Create New 
Analysis Period dialog box (see Figure 8.3, page 8-3) will close.  
On the Alternative and Simulation Manager (Figure 8.5), below 
the Analysis Periods header in the table will be a header that will 
contain the name of the analysis period that you just created and its 

associated events.  You will notice the first column in the multiple 
events analysis period header in the table (Figure 8.5) is blank.  
That column will be used later to help define the software/models to 
be used for that alternative. 

The table 
allows 
organization of 
a study's 
alternatives; a 
way to track 
the state of 
data sets 
needed for 
each model, 
create analysis 
periods, and 
create 
simulations. 

 10. If you have more analysis periods to create, repeat Steps 1-9 until 
you have defined all your analysis periods and events for the study. 

 11. Once you are finished with defining your analysis periods and 
events, your next step will be to import your models (see Chapter 9, 
Section 9.3, page 9-4). 

 
Renaming Analysis Periods 
 
If you want to rename an analysis period, but you want to choose from a 
list of the developed analysis periods for a study: 
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 1. From the analysis periods shortcut menu (see Figure 8.2, page 8-2), 
click Rename, the Rename Analysis Period dialog box will open 
(Figure 8.6). 

Figure 8.6  Rename Analysis Period Dialog Box 

 2. From the Existing list select an analysis period, in the Rename box 
the name and description of the selected analysis period will appear. 

 3. In the Name box, enter the new name, and enter a description in the 
Description box if needed (recommended). 

 4. Click Rename, a warning message will appear asking you if you 
really want to rename the selected analysis period.  Click Yes, the 
warning message and the Rename Analysis Period dialog box 
(Figure 8.6) will close, and on the table, under the Analysis Periods 
column (see Figure 8.5, page 8-4) the renamed analysis period will 
appear. 

 
Deleting Analysis Periods 
 
If you want to delete an analysis period, but you want to choose from a list 
of the developed analysis periods for a study: 
 
 1. From the analysis periods shortcut menu (see Figure 8.2, page 8-2), 

click Delete, the Delete Analysis Periods dialog box will open (see 
Figure 8.7, page 8-6). 

 2. From the Existing list select an analysis period, in the Delete box 
the name and description of the selected analysis period will appear. 

 3. Click Delete, a warning message will appear asking you if you 
really want to delete the selected analysis period. Click Yes, the 
warning message and the Delete Analysis Periods dialog box  
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  (Figure 8.7) will close and the analysis period will no longer appear 
under the Analysis Periods column of the table (see Figure 8.5, 
page 8-4). 

Figure 8.7  Delete Analysis Periods Dialog Box 
 

 Individual Analysis Period 
 
The individual analysis period shortcut menu (Figure 8.8) is available 
from the Alternative and Simulation Manager (see Figure 8.5, page  

Figure 8.8  Individual Analysis Period Shortcut Menu 

8-4), by right-clicking on an analysis period name in the table.  This 

shortcut menu will allow you to edit, make a copy, rename, delete from 
the study, and view the properties of an analysis period.  The following 
sections provide further details. 
 
Editing an Analysis Period 
 
To edit an analysis period: 
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 1. From the individual analysis period shortcut menu (see Figure 8.8, 
page 8-6), click Edit.  The Analysis Period Editor will open 
(Figure 8.9). 

Figure 8.9  Analysis Period Editor 

 2. You can edit the name, description, and time window of the 
selected analysis period.  Also, you can modify the events 
associated with the analysis period. 

 3. Click OK, the Analysis Period Editor will close (Figure 8.9), and 
the information you changed will appear on the Alternative and 
Simulation Manager (see Figure 8.5, page 8-4) in the table. 

 
Making a Copy of an Analysis Period 
 
To make a copy of an existing analysis period: 
 
 1. From the individual analysis period shortcut menu (see Figure 8.8, 

page 8-6), click Save As.  The Save Analysis Period As dialog box 
will open (Figure 8.10).  The information displayed in the dialog 
box represents the analysis period you have selected to make a copy 
of. 

Figure 8.10  Save Analysis Period As Dialog Box 
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 2. In the Name box, enter the name (required) of the new analysis 
period, and in the Description box, enter a description (optional, 
but recommended). 

 3. Click OK, the Save Analysis Period As dialog box (see Figure 
8.10, page 8-7) will close.  The new analysis period name will now 
appear in the table on the Alternative and Simulation Manager, 
under the Analysis Periods column header (see Figure 8.5, page  

  8-4). 
 
Renaming an Analysis Period 
 
To rename an analysis period: 
 

Another way to 
access the 
Alternative 
and 
Simulation 
Manager, 
from the WAT 
main window, 
on the Edit 
menu, click 
Alternative 
and 
Simulation 
Manager. 

 1. From the individual analysis period shortcut menu (see Figure 8.8, 
page 8-6), click Rename.  The Rename Analysis Period dialog 
box will open (Figure 8.11). 

Figure 8.11  Rename Analysis Period Dialog Box 

 2. In the Name box, enter the new name, and enter a description in the 
Description box if needed (recommended). 

 3. Click OK, a warning message will appear asking you if you really 
want to rename the selected analysis period.  Click Yes, the warning 
message and the Rename Analysis Period dialog box (Figure 8.11) 
will close, and in the Alternative and Simulation Manager (see 
Figure 8.5, page 8-4), on the table the name of the selected analysis 
period will be changed. 

 
Deleting an Analysis Periods 
 
To delete an analysis period, right-click on an analysis period in the table, 
from the shortcut menu (see Figure 8.8, page 8-6), click Delete From 
Study.  A warning message will appear asking you if you really want to 
delete the selected analysis period.  Click Yes, the analysis period will no 
longer appear on the table in the Alternative and Simulation Manager 
(see Figure 8.5, page 8-4). 
 
Analysis Period Properties 
 
The properties of an analysis period include the name and description for 
the Beta Version. For Version 1.0, properties will also include the event 
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names associated with an analysis period.  To view the properties of an 
analysis period: 
 
 1. From the individual analysis period shortcut menu (see Figure 8.8, 

page 8-6), click Properties.  The Properties for 
AnalysisPeriodName dialog box will open (Figure 8.12). 

Figure 8.12  Properties for AnalysisPeriodName Dialog Box 

 2. For the Beta Version the properties for viewing are the name and 
description of the selected analysis period; the date and time the 
analysis period was last modified; the location of the analysis 
period file; and, the name of the file which contains information 
about the analysis. 

 
 

8.2.2 Toolbar 
 
From the toolbar of the Alternative and Simulation Manager (see Figure 
6.2, page 6-2), you can create an analysis period.  Click      , the Create 
New Analysis Period dialog box will open (see Figure 8.3, page 8-3).  
The steps for creating an analysis period are the same as in the Creating 
an Analysis Period, under Section 8.2.1, page 8-3.  
 
 

8.2.3 Menu Bar 
 
From the Menu Bar of the Alternative and Simulation Manager (see 
Figure 8.5, page 8-4), you can create an analysis period, rename analysis 
periods, and delete analysis periods. 
 

 Creating an Analysis Period 
 
To create an analysis period: 
 
 1. On the File menu, point to Analysis Periods, and then click Create 

New, the Create New Analysis Period dialog box will open (see 
Figure 8.3, page 8-3). 



Chapter 8 – Analysis Periods/Events HEC-WAT User's Manual 

8-10 

 2. The steps for creating an analysis period are the same as in the 
Creating an Analysis Period, under Section 8.2.1, page 8-3. 

 
 Renaming Analysis Periods 

 
If you want to rename an analysis period, but you just want to choose from 
a list of the developed analysis periods for a study: 
 
 1. On the File menu, point to Analysis Periods, and then click 

Rename, the Rename Analysis Period dialog box will open (see 
Figure 8.6, page 8-5). 

 2. The steps for renaming an analysis period are the same as in the 
Renaming Analysis Periods, under Section 8.2.1, page 8-4. 

 
 Deleting Analysis Periods 

 
If you want to delete an analysis period, but you just want to choose from 
a list of the developed analysis periods for a study: 
 
 1. On the File menu, point to Analysis Periods, and then click Delete, 

the Delete Analysis Periods dialog box will open (see Figure 8.7, 
page 8-6). 

 2. The steps for deleting an analysis period are the same as in the 
Deleting Analysis Periods, under Section 8.2.1, page 8-5. 

 
 

8.3 Study Pane 
 
The user can also create, edit, rename, and delete analysis periods from the 
Study Pane (see Chapter 3, Section 3.2.2, page 3-5).  This section of the 
chapter describes how to perform these operations directly from the Study 
Pane. 
 
 

Figure 8.13 Analysis Periods Shortcut Menu 

8.3.1 Analysis Periods 
 
The analysis periods s
menu (Figure 8.13) is 
available from the Study 
Pane, by right-clicking on 
the folder Analysis Periods.  
This shortcut menu will 
allow you to create, rename, 
and delete analysis periods.  
The following sections provide further details. 

hortcut 

 
 

Study Pane 
provides an 
overview of 
WAT 
alternatives, 
simulations 
and analysis 
periods. 
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 Creating an Analysis Period 
 
To create an analysis period: 
 
 1. From the Study Tab, on the Study Pane, right-click on the 

Analysis Periods folder, from the analysis periods shortcut menu 
(Figure 8.13), click New.  The Create New Analysis Period dialog 
box will open (see Figure 8.3, page 8-3). 

 2. The steps for creating an analysis period are the same as in the 
Creating an Analysis Period, under Section 8.2.1, page 8-3. 

 
 Deleting Analysis Periods 

 
If you want to delete an analysis period, but you want to choose from a list 
of the developed analysis periods for a study: 
 
 1. From the Study Tab, on the Study Pane, right-click on the 

Analysis Periods folder, from the analysis periods shortcut menu 
(see Figure 8.13, page 8-11), click Delete.  The Delete Analysis 
Periods dialog box will open (see Figure 8.7, page 8-6). 

 2. The steps for deleting an analysis period are the same as in the 
Deleting Analysis Periods, under Section 8.2.1, page 8-5. 

 
 Renaming Analysis Periods 

 
If you want to rename an analysis period, but you just want to choose from 
a list of the developed analysis periods for a study: 
 
 1. From the Study Tab, on the Study Pane, right-click on the 

Analysis Periods folder, from the analysis period shortcut menu 
(see Figure 8.13, page 8-11), click Rename.  The Rename 
Analysis Period dialog box will open (see Figure 8.6, page 8-5). 

 2. The steps for renaming an analysis period are the same as in the 
Renaming Analysis Periods, under Section 8.2.1, page 8-4. 

 
 

8.3.2 Individual Analysis Period 
 
The individual analysis period shortcut menu (see Figure 8.14, page 8-13) 
is available from the Study Pane, by right-clicking on an analysis period 
name under the Analysis Periods folder.  This shortcut menu will allow 
you to edit, make a copy, rename, delete from the study, and view the 
properties of an analysis period.  The following sections provide further 
details.  
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 Editing an Analysis Period 
 
To edit an analysis period: 
 
 1. From the Study Tab, on 

the Study Pane, from the 
Analysis Periods folder, 
right-click on an analysis 
period, from the individual 
analysis period shortcut 
menu (Figure 8.14), click 
Edit.  The Analysis 
Period Editor will open 
(see Figure 8.9, page 8-7). 

Figure 8.14 Individual Analysis Period 
Shortcut Menu  2. The steps for editing an 

analysis period are the 
same as in the Editing an Analysis Period, under Section 8.2.1, 
page 8-6. 

 
 Saving an Analysis Period 

 
To save an analysis period, from the Study Tab, from the Study Pane, 
from the Analysis Periods folder, right-click on an analysis period, from 
the individual analysis period shortcut menu (Figure 8.14), click Save.  
Any changes that have occurred to the selected analysis periods will be 
saved by the WAT. 
 

 Making a Copy of an Existing Analysis Period 
 
To make a copy of an existing analysis period: 
 
 1. From the Study Tab, on the Study Pane, from the Analysis 

Periods folder, right-click on an analysis period, from the 
individual analysis period shortcut menu (Figure 8.14), click Save 
As.  The Save Analysis Period As dialog box will open (see Figure 
8.10, page 8-7) 

 2. The steps for making a copy of an existing analysis period are the 
same as in the Making a Copy of an Analysis Period, under 
Section 8.2.1, page 8-7. 

 
 Renaming an Analysis Period 

 
 1. From the Study Tab, on the Study Pane, from the Analysis 

Periods folder, right-click on an analysis period, from the 
individual analysis period shortcut menu (Figure 8.14), click  
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  Rename.  The Rename Analysis Period dialog box will open (see 
Figure 8.11, page 8-8). 

 2. The steps for renaming an analysis period are the same as in the 
Renaming an Analysis Periods, under Section 8.2.1, page 8-8. 

 
 Deleting an Analysis Period 

 
 1. From the Study Tab, on the Study Pane, from the Analysis 

Periods folder, right-click on an analysis period, from the 
individual analysis period shortcut menu (see Figure 8.14, page  

  8-12), click Delete. 
 2. The steps for deleting an analysis period are the same as in the 

Deleting an Analysis Period, under Section 8.2.1, page 8-8. 
 

 Analysis Period Properties 
 
The properties of an analysis period include the name and description for 
the Beta Version. For Version 1.0, properties that will also include the 
event names associated with an analysis period.  To view the properties of 
an analysis period: 
 
 1. From the individual analysis period shortcut menu (see Figure 8.14, 

page 8-12), click Properties.  The Properties for 
AnalysisPeriodName dialog box will open (see Figure 8.12, page  

  8-9). 
 2. The steps for accessing analysis period properties are the same as in 

the Analysis Period Properties, under Section 8.2.1, page 8-9. 
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CHAPTER 9  
 
 
 

Creating and Managing Simulations 
 
 

9.1 Overview 
 
Once you have defined alternatives and analysis periods, you are ready to 
create simulations.  A simulation in HEC-WAT is a combination of an 
analysis period and event(s) and an alternative.  After a simulation has 
been created, the models need to communicate with each other.  In the 
WAT this is accomplished by linking (DSS mapping) the models thru 
DSS.  This chapter discusses how to establish program order, import 
models that have been built for the study, how to create, edit, and manage 
simulations, and how to link the models of a simulation. 
 
 

9.2 Program Order 
 
The WAT allows for a flexible set of programs, computation sequence, 
and data flow for individual simulations.  You can establish several 
different program orders for a WAT study.  The WAT has a default 
program order named Default, which consists of HMS, ResSim, RAS and 
FIA. 
 
There are two ways to establish multiple program orders in the WAT; the 
recommended way is from the Alternative and Simulation Manager 
(Section 9.2.1).  The second way is from the main window of the WAT 
(see Section 9.2.2, page 9-4); both of these methods are discussed in the 
following sections. 
 
 

9.2.1 Alternative and Simulation Manager 
 
In the WAT, the Alternative and Simulation Manager (see Figure 9.1, 
page 9-2) provides a convenient way to organize and develop the main 
components for a WAT study – alternatives, analysis period (events), and 
simulations.  This section will focus on the organization and development 
of program orders.  The Alternative and Simulation Manager has two 
areas where you can create program orders.  These areas are the Toolbar 
(see page 9-2) and the Menu Bar (page 9-4).  These areas and the ability  
to create programs orders are described in the following sections. 
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Figure 9.1  Alternative and Simulation Manager 
 
To access the Alternative and Simulation Manager, from the WAT 
main window, from the WAT Tools toolbar (see Chapter 3, Section 3.2.1, 
page 3-4), click      .  Another way to access the Alternative and 
Simulation Manager is from the WAT main window, on the Edit menu, 
click Alternative and Simulation Manager.  From either method the 
Alternative and Simulation Manager will open (Figure 9.1). 
 
 

 Toolbar 
 
From the toolbar of the Alternative and Simulation Manager (Figure 
9.1), you can create a program order.  Click       , the Program Order 
dialog box will open (Figure 9.2).  The steps for creating a program order 
are detailed in the following section. 

Figure 9.2  Program Order Dialog Box 
 
Creating a Program Order 
 
To create a program order: 
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 1. By default, the Default program order is displayed in the Program 
Order dialog box (see Figure 9.2, page 9-2).  To create a new 
program order, from Program, click New.  The New Program 
Order dialog box will open (Figure 9.3). 

Figure 9.3  New Program Order Dialog Box 

 2. In the Name box enter a name for the program order.  Optionally 
(but recommended), you can provide a description in the 
Description box, and if you have an icon, you can enter the 
location of the icon file in the Icon box. 

 3. To select the programs you want in your program order, click 
Select Programs, the Selection Editor will open (Figure 9.4).  
From the Available list select the programs you would like in your 
program order.  Click Add, the name of the selected program will 
move to the Selected list and be removed from the Available list 
(Figure 9.4). 

Figure 9.4  Selection Editor 

 4. Once you have selected all the programs, click OK, the Selection 
Editor will close (Figure 9.4).  On the New Program Order dialog  
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  box (see Figure 9.3, page 9-3) the names of the selected programs 
will appear.  Click OK, the New Program Order dialog box will 
close. 

 5. On the Program Order dialog box (see Figure 9.2, page 9-2) the 
name of the new program order will appear in the Name list, and 
the table will display the programs selected. 

 
 Menu Bar 

 
From the Menu Bar of the Alternative and Simulation Manager (see 
Figure 9.1, page 9-2), you can create a program order.  On the File menu, 
click Program Order, the Program Order dialog box will open (see 
Figure 9.2, page 9-2).  The steps for creating a program order are the same 
as in the Creating Program Order, under Section 9.2.1, page 9-2. 
 
 

9.2.2 WAT Main Window 
 
From the WAT main window (see Chapter 3, Figure 3.1, page 3-2) there 
are two ways to establish multiple programs orders in the WAT.  From the 
main window, from the WAT Tools toolbar (see Chapter 3, Section 3.2.1, 
page 3-4) click       .  The second way is from the Edit menu, click 
Program Order; both of these methods will open the Program Order 
dialog box (see Figure 9.2, page 9-2).  To create a program order, follow 
the same steps in Creating a Program Order, under Section 9.2.1, page 
9-2. 
 
 

9.3 Import Models 
 
This section discusses how to import existing HEC models (HEC-HMS, 
HEC-ResSim, HEC-RAS, and HEC-FIA) into the WAT system, for use in 
developing WAT alternatives.  In the Beta Version of HEC-WAT you can 
import ResSim, RAS and FIA models.  The HMS model will have to be 
copied using system tools for the Beta release.  The import of an HMS 
model should be available in Version 1.0 of the WAT. 
 
 

9.3.1 HMS Model 
 
To incorporate an HMS model into the WAT, you will need to copy files 
outside of the WAT.  A WAT study has a directory structure (Chapter 4), 
which includes an hms directory.  Once you have identified your HMS 
model for your particular WAT study, using system tools, copy all files 
and folders associated with your HMS model into the hms directory.  The 
WAT will now find your hms model for that particular study. 
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Figure 9.6  Add Watershed Location Dialog Box 

9.3.2 ResSim Model 
 
Before importing the ResSim model, you will have to tell the WAT 
through ResSim, what working directory the ResSim model is stored in.  
From the Programs toolbar, click ResSim, to specify the ResSim working 
directory perform the following steps: 
 
 1. From the ResSim main window, on the Tools menu, click Options, 

the Options dialog box will open (Figure 9.5).  From the Model 
Directories tab, click Add Location. 

 2. The Add Watershed Location dialog box will open (Figure 9.6).  
In the Name box, enter a name (e.g. ResSim) that will simply 
reference the directory location.  Enter a directory location (e.g., 
C:/Documents and Settings/xxx/My Documents/ watershed) that 

specifies where ResSim should search for watersheds in the 
Location box.  You must enter an existing directory name. 

 3. You can also browse to the directory that you want, from the Add 
Watershed Location dialog box (Figure 9.6), click Browse.  A 
browser will open; you can then navigate to a directory on your 
computer or network.  Select a directory, click OK, the browser 
will close and the name will appear in the Location box. 

 4. Click OK, the Add Watershed Location dialog box (Figure 9.6) 
will close, and the working directory you identified will now appear 
on the table in the Options dialog box. 

 5. Click OK, the Options dialog box (Figure 9.5) will close. 
 

Figure 9.5  Options Dialog Box 
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Figure 9.7  Import Alternative Wizard – Step 1 of 7 

Figure 9.8  Import Alternative Wizard – Step 2 of 7 

Now that you have finished that setup, you are ready to import a ResSim 
model into the WAT: 
 
 1. From the WAT main window, on the File menu, point to Import, 

click ResSim. 
 2. The Import Alternative Wizard will open (Figure 9.7). 

 3. In the Watershed Locations box, select the name that identifies the 
directory where your ResSim model is stored.  In the Watersheds 
box, the table will display the available ResSim models in that 
directory. 

 4. Select the ResSim watershed, click Next, the Import Alternative 
Wizard (Figure 9.8) will now ask you to select which ResSim 
alternative you want to import.  From the Available Alternatives 
box, on the table select the alternative you want to import. 
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Figure 9.9  Import Alternative Wizard – Step 3 of 7 

Figure 9.10  Import Alternative Wizard – Step 4 of 7 

 5. Click Next, the Import Alternative Wizard (Figure 9.9) will now 
ask you if you want to give the ResSim alternative a new name or 
use the default name.  We recommend you use the default name. 

 6. Click Next, the Import Alternative Wizard (Figure 9.10) will now 
give you a chance to accept the default name of the ResSim 
network that is associated with the selected ResSim alternative, or 
change the name.  We recommend you use the default name. 

 7. Click Next, the Import Alternative Wizard (see Figure 9.11, page 
9-8) will now ask you to assign stream names to the various 
elements of the selected ResSim network.  This has to be done 
because the current version of ResSim does not store the stream 
names by name but by an ID, the WAT stores the stream names by 
name.  If the elements are on different streams, in the To Stream 
column (see Figure 9.11, page 9-8), click a cell, a list of the  
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Figure 9.11  Import Alternative Wizard – Step 5 of 7 

Figure 9.12 Select Stream Name Dialog Box 

  available stream names from the WAT will appear, select the 
appropriate stream name(s) from the list.  The name of the selected 
stream will now appear in the To Stream column (Figure 9.11,). 

 8. If all the elements are on the same stream name, click Assign 
Stream Names.  The Select Stream Name dialog box will open 
(Figure 9.12), in the To Stream column, click a cell, a list of the 
available stream names from the WAT will appear, select the 

appropriate stream name(s) from the list. Click OK, the Select 
Stream Name dialog box will close.  On the Alternative Import 
Wizard (Figure 9.11) the To Stream column of table will display 
the selected stream name. 

 9. Click Next, the Import Alternative Wizard (see Figure 9.13, page 
9-9) will now ask you to assign a common computation point to a 
ResSim junction name.  This has to be done because the current 
version of   ResSim does not store the common computation point 
names by name but by an ID, the WAT stores the common 
computation point names by name.  Click on a cell in the  
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Figure 9.13  Import Alternative Wizard – Step 6 of 7 

Figure 9.14  Assignment Warnings 

Figure 9.15 Import Alternative Wizard – 
Step 7 of 7 

  Watershed Computation Point column (Figure 9.13), a list of 
common computation point names will appear, select a name from 
the list for the selected ResSim junction name.  Repeat this process 
for all elements listed in the 
table. 

 10. Click Next, in the Beta release 
of the WAT, the common 
computations point assignment 
does not seem to be working 
correctly, so Assignment 
Warnings will open (Figure 
9.14), click OK. 

 11. The Import Alternative 
Wizard (Figure 9.15) will 
now provide you with a 
summary of what you are 
about to import for your 
ResSim model in the 
WAT.  After reviewing, 
click Finish.  A warning 
will appear telling you that 
the import operation will 
create a new alternative 
and network with the 
chosen names.  Click Yes, 
to continue with the 
import. 

 12. You have now completed 
the import of a ResSim 
alternative, if you want to 
have more ResSim 
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alternatives included in your ResSim model you will need to repeat 
these steps for each ResSim alternative. 

 
 

Figure 9.16  Select RAS project to import from Browser 

9.3.3 RAS Model 
 
To import a RAS model into the WAT: 
 
 1. From the WAT main window, on the File menu, point to Import, 

click RAS. 
 2. The Select RAS project to import from browser will open (Figure 

9.16).  From the browser select the directory that contains the RAS 
model files.  The browser is looking for a RAS project file (*.prj).  
Select the project file; click Open, the Select RAS project to 
import from browser will close. 

 3. The RAS files associated with the selected RAS project will be 
copied to the ras directory in the WAT.  The WAT will now be able 
to recognize the RAS model. 

 
 

9.3.4 FIA Model 
 
To import an FIA model (Version 2.0) into the WAT: 
 
 1. From the WAT main window, on the File menu, point to Import, 

click FIA. 
 2. An Alternative Import Wizard will open (see Figure 9.17, page  
  9-11), browse to the FIA study that contains the FIA model needed 

for the WAT.  The browser is looking for an FIA study file (*.prj).  
Select the project file, click Next. 
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Figure 9.17 Alternative Import Wizard – Step 1 of 6 

Figure 9.18 Alternative Import Wizard –  
 Step 2 of 6 

Figure 9.19 Alternative Import Wizard – Step 3 of 6 

 3. The Alternative Import 
Wizard (Figure 9.18) 
will now ask you to 
select which FIA 
alternative you wish to 
choose.  From the 
Available Alternatives 
box (Figure 9.18), on the 
table select the 
alternative you want to 
import. 

 4. Click Next, the 
Alternative Import Wizard (Figure 9.19) will now ask you if you 
want to give the  

 



Chapter 9 – Creating and Managing Simulations HEC-WAT User's Manual 

9-12 

Figure 9.21 Alternative Import Wizard – Step 5 of 6 

Figure 9.20 Alternative Import Wizard – Step 4 of 6 

  FIA alternative a new name or use the default name.  We 
recommend you use the default name. 

 5. Click Next, the Import Alternative Wizard (Figure 9.20) will now 
give you a chance to accept the default name of the FIA impact area 
set that is associated with the selected FIA alternative, or change the 
name.  We recommend you use the default name. 

 6. Click Next, the Import Alternative Wizard (Figure 9.21) will now 
give you a chance to accept the default name of the FIA time series 
set that is associated with the selected FIA alternative, or change the 
name.  We recommend you use the default name. 

 7.  The Alternative Import Wizard (see Figure 9.22, page 9-13) will 
now provide you with a summary of what you are about to import 
for your FIA model in the WAT.  After reviewing, click Finish, you 
have now completed the import of an FIA alternative, if you want to  
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Figure 9.22 Alternative Import Wizard – Step 6 of 6 

  have more FIA alternatives included in your FIA model you will 
need to repeat these steps for each FIA alternative. 

 
 

9.4 Simulations 
 
A simulation in the WAT is a combination of an analysis period and 
event(s) and an alternative.  The WAT provides two ways to organize and 
develop simulations; one way is from the Alternative and Simulation 
Manager (Section 9.4.1), and the other way is from the Study Pane (see 
Section 9.4.2, page 9-22). 
 
 

9.4.1 Alternative and Simulation Manager 
 
In the WAT, the Alternative and Simulation Manager (see Figure 9.23, 
page 9-14) provides a convenient way to organize and develop the main 
components for a WAT study – alternatives, analysis period (events), and 
simulations.  This section will focus on the organization and development 
of simulations.  The Alternative and Simulation Manager has three 
areas where you can access commands that will allow you to create, 
delete, and rename simulations.  These areas are the Table (page 9-14), 
Toolbar (page 9-20) and Menu Bar (page 9-21).  These areas and the 
available commands are described in the following sections. 
 
To access the Alternative and Simulation Manager, from the WAT 
main window, from the WAT Tools toolbar (see Chapter 3, Section 3.2.1, 
page 3-4), click       .  Another way to access the Alternative and  
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Figure 9.23  Alternative and Simulation Manager - Simulation 

Simulation Manager is from the WAT main window, on the Edit menu, 
click Alternative and Simulation Manager.  From either method the 
Alternative and Simulation Manager will open (Figure 9.23). 

 

A simulation 
in HEC-WAT 
is a 
combination 
of an analysis 
period and 
event(s) and 
an alternative 

 Table 
 
The Alternative and Simulation Manager (Figure 9.23) table allows 
organization of a study's alternatives; a way to track the state of data sets 
needed for each model, create analysis periods, and create simulations.  
Since the focus of this section is simulations, the focus will only be on the 
available commands from the table to develop and organize simulations. 
 

Figure 9.24  Individual Simulation Shortcut Menu 

The individual simulation shortcut menu (Figure 9.24) is available from 
the Alternative and Simulation Manager, by right-clicking on a 
simulation in the table.  This shortcut menu will allow you to view the 

selected simulation in a map window; edit the model alternatives 
associated with the selected simulation; edit the name, description, and 
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DSS mapping identifier of the selected simulation; compute; view the log 
of the compute; rename; and, delete from the study the selected 
simulation.  The following sections provide further details on how to 
create a simulation and the other commands available from the table.  
 
Creating a Simulation 
 
To create a simulation: 
 

Figure 9.25  Alternative and Simulation Manager – Table 

 1. A simulation on the table is the cell where an analysis period and 
alternative intersect.  In Figure 9.25, this intersection is the blue 

cell.  Right-click on the cell, from the shortcut menu, click Create 
Simulation.  The Create New Simulation dialog box will open 
(Figure 9.26). 

Figure 9.26  Create New Simulation Dialog Box 

 2. In the Name box a default name has been generated by the WAT.  
The default name for a simulation is the concatenation of the 
alternative name, analysis period name, and an event name.  You 
can change this name, but it is recommended to use the default 
name.  In the Description box, you can enter a description 
(optional, but recommended). 

 3. From the WAT the programs share data from a DSS file, the F-Part 
of the pathnames informs the programs what simulation the 
pathname belongs to.  In the F Part box (Figure 9.26), a default 
name has been generated by the WAT.  This default name is the  
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  first ten characters of the alternative name, the first ten characters of 
the analysis period name, and the first ten characters of the event 
name.  You can change this name, but it is recommended to use the 
default name. 

 4. Information is provided on what alternative and what analysis 
period are being used for this simulation.  This information is 
displayed in the Alternative box and the Analysis Period box, 
respectively (see Figure 9.26, page 9-15). 

 5. From the Program Order list (see Figure 9.26, page 9-15) you can 
choose which program order is appropriate for this simulation.  The 
default program order is: HEC-HMS, HEC-ResSim, HEC-RAS, 
and HEC-FIA.  If the program order you want is not available, click 
New, the New Program Order dialog box will open (see Figure 
9.3, page 9-3).  You can then define a new program order, save, and 
then select from the Program Order list. 

Figure 9.27 Alternative and Simulation Manager – Simulation with no 
Model Alternatives 

 6. From the Create News Simulation dialog box (see Figure 9.26, 
page 9-15) click OK, the dialog box will close.  On the Alternative 
and Simulation Manager (Figure 9.27), the cell that you right-
clicked in now contains the programs in your program order, and 

drop-down lists for each program so you can choose what model 
alternatives to use for the simulation. 

Figure 9.28  Model Alternative Selection - RAS 

 7. For each program you now need to select the appropriate model 
alternative for the simulation.  For example, in Figure 9.28, click 
the RAS list, the RAS model alternatives that you imported are 

listed, select one.  That name is now displayed in the table of the 
Alternative and Simulation Manager (see Figure 9.23, page  

  9-14). 
 8. If you have more simulations to create, repeat steps 1-7 until you 

have defined all your simulations for the study.  Once you are 
finished with defining simulations, your next step will be to 
compute the simulations (Chapter 10). 
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Viewing a Simulation 
 
To view a simulation in a map window: 
 
 1. From the individual simulation shortcut menu (see Figure 9.24, 

page 9-14), click Display in Map Window. 
 2. If there is not a map window open in the Desktop Pane (see 

Chapter 3, Section 3.2.2, page 3-7), the simulation map window for 
the simulation will open in the Desktop Pane.  From the simulation 
map window you can edit the stream alignment, view model 
alternative results, and edit model alternatives that are associated 
with a simulation. 

 3. If a map window is open in 
the Desktop Pane (see 
Chapter 3, Section 3.2.2, p
3-7), the Select Map dialog
box (Figure 9.29) will open.  
You can choose whethe
open the simulation m
window in the current map 
window or in a new map 
window, click OK.  The 
Select Map dialog box will 
close, and the simulatio
window for the selected 
simulation will appear in the
Desktop Pane. 

age 
 

r to 
ap 

n map 

 
Figure 9.29  Select Map Dialog Box 

 
Editing the Model Alternatives of a Simulation 
 
To edit the model alternatives associated with a simulation: 
 
 1. From the individual simulation shortcut menu (see Figure 9.24, 

page 9-14), point to Edit Model, from the sub-menu (Figure 9.30) 
click on the model alternative you wish to edit. 

Figure 9.30  Editing a Model Alternative 
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 2. The program associated with the model alternative that you selected 
will open.  For example, in Figure 9.30 (page 9-17), if you select 
the model alternative Run 1, the HMS program will open. 

 3. You can now make changes to the selected model alternative, save, 
and close the program associated with the model alternative.  For 
further details on the individual program editors, see Appendix I. 

 
Editing a Simulation 
 
To edit a simulation: 
 
 1. From the individual simulation shortcut menu (see Figure 9.24, 

page 9-14), click Edit Simulation.  The Simulation Editor will 
open (Figure 9.31). 

Figure 9.31  Simulation Editor 

 2. You can edit the name, description, and F-Part associated with a 
simulation.  The editor also provides you with information on what 
WAT alternative and analysis period are associated with the 
simulation.  The editor also provides information on what model 
alternatives are being computed for the simulation. 

 3. Click OK, the Simulation Editor will close (Figure 9.31) and the 
information you changed will be saved. 

 
Computing a Simulation 
 
To compute a simulation: 
 
 1. From the individual simulation shortcut menu (see Figure 9.24, 

page 9-14), click Compute Simulation.  The Compute Progress 
dialog box will open (see Figure 9.32, page 9-19). 
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Figure 9.32  Compute Progress Dialog Box 

 2. From this dialog box you can see which model is computing for the 
simulation and information from each model is displayed in the 
Compute Progress dialog box (Figure 9.32). 

 3. When the compute is finished click Close, the Compute Progress 
dialog box will close. 

 
Viewing the Compute Log of a Simulation 
 

Figure 9.33  SimulationName.log Dialog Box 

To view the compute log 
of a simulation, from the 
individual simulation 
shortcut menu (see Figure 
9.24, page 9-14), click 
View Compute Log.  The 
SimulationName.log 
dialog box will open 
(Figure 9.33) in the 
Desktop Pane (see 
Chapter 3, Section 3.2.2, 
page 3-7).  This contains 
information regarding the 
compute for the selected 
simulation.  This 
information is provided b
each individual prog
that was part of the compute. 

y 
ram 
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Saving a Simulation 
 
To save a simulation, from the individual simulation shortcut menu (see 
Figure 9.24, page 9-14), click Save.  Any changes that have occurred to 
the selected simulation will be saved by the WAT. 
 
Renaming a Simulation 
 
To rename a simulation: 
 
 1. From the individual simulation shortcut menu (see Figure 9.24, 

page 9-14), click Rename.  The Rename Simulation dialog box 
will open (Figure 9.34). 

Figure 9.34  Rename Simulation Dialog Box 

 2. In the Name box, enter the new name, and enter a description in the 
Description box if needed (recommended). 

 3. Click OK, a warning message will appear asking you if you really 
want to rename the selected simulation.  Click Yes, the warning 
message and the Rename Simulation dialog box will close. 

 
Deleting a Simulation 
 
To delete a simulation, right-click on a simulation in the table, from he 
individual simulation shortcut menu (see Figure 9.24, page 9-14), click 
Delete From Study.  A warning message will appear asking you if you 
really want to delete the selected simulation.  Click Yes, the intersection of 
the alternative and analysis period/event that the simulation was associated 
with will now be blank in table in the Alternative and Simulation 
Manager (see Figure 9.25, page 9-15). 
 
 

 Toolbar 
 
From the toolbar of the Alternative and Simulation Manager (see Figure 
9.23, page 9-14), you can create a simulation.  Click       , the Create New 
Simulation dialog box will open (see Figure 9.26, page 9-15).  The steps 
for creating a simulation are the same as in the Creating a Simulation, 
under Section 9.4.1, page 9-15.  
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 Menu Bar 

 
From the Menu Bar of the Alternative and Simulation Manager (see 
Figure 9.24, page 9-14), you can create simulation, rename simulations, 
and delete simulations. 
 
Creating a Simulation 
 
To create a simulation: 
 
 1. On the File menu, point to Simulation, and then click New, the 

Create New Simulation dialog box will open (Figure 9.35). 

Figure 9.35  Create New Simulation Dialog Box 

 2. From the Analysis Period list, select an analysis period.  Once an 
analysis period is selected, the name, F part are created and the 
dialog box changes.  The dialog box is now similar to Figure 9.26 
(page 9-15). 

 3. The steps for creating a simulation are the same as in the Creating 
a Simulation, under Section 9.4.1, page 9-15. 

 
Renaming Simulations 
 
If you want to rename a simulation, but you want to choose from a list of 
the developed simulations for a study: 
 
 1. On the File menu, point to Simulation, and then click Rename, the 

Rename Simulation dialog box will open (see Figure 9.36, page  
  9-22). 
 2. From the Existing list (see Figure 9.36, page 9-22) select a 

simulation, in the Rename box the name and description of the 
selected simulation will appear. 



Chapter 9 – Creating and Managing Simulations HEC-WAT User's Manual 

9-22 

Figure 9.36  Rename Simulation Dialog Box 

 3. In the Name box (Figure 9.36), enter the new name, and enter a 
description in the Description box if needed (recommended). 

 4. Click Rename, a warning message will appear asking you if you 
really want to rename the selected simulation.  Click Yes, the 
warning message and the Rename Simulation dialog box (Figure 
9.36) will close. 

 
Deleting Simulations 
 
If you want to delete a simulation, but you want to choose from a list of 
the developed simulations for a study: 
 
 1. On the File menu, point to Simulation, and then click Delete, the 

Delete Simulations dialog box will open (see Figure 9.37, page  
  9-23). 
 2. From the Existing list select a simulation, in the Delete box the 

name and description of the selected simulation will appear. 
 3. Click Delete, a warning message will appear asking you if you 

really want to delete the selected simulation. Click Yes, the 
intersection of the alternative and analysis period/event that the 
simulation was associated with will now be blank in the table on the 
Alternative and Simulation Manager (see Figure 9.25, page  

  9-15). 
 
 

9.4.2 Study Pane 
 
The user can also create, edit, rename, and delete simulations from the 
Study Pane (see Chapter 3, Section 3.2.2, page 3-5).  This section of  
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Figure 9.37  Delete Simulations Dialog Box 

the chapter describes how to perform these operations directly from the 
Study Pane. 
 

 Simulations 
 
The simulations shortcut menu (Figure 9.38) is available from the Study 
Pane, by right-clicking on the folder Simulations.  This shortcut menu 
will allow you to create, rename, and delete simulations.  The following 
sections provide further details. 

Figure 9.38  Simulations Shortcut Menu 
 
Creating a Simulation 
 
To create a simulation from the Study Pane: 
 
 1. From the Study Tab, on the Study Pane, from the Simulations 

folder, right-click on a simulation, from the simulations shortcut 
menu (Figure 9.38), click New the Create New Simulation dialog 
box will open (see Figure 9.35, page 9-21). 

 2. The steps for creating a simulation are the same as in the Creating 
a Simulation, under Section 9.4.1, page 9-15. 
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Renaming Simulations 
 
If you want to rename a simulation, but you want to choose from a list of 
the developed simulations for a study: 
 
 1. From the Study Tab, on the Study Pane, from the Simulations 

folder, right-click on a simulation, from the simulations shortcut 
menu (see Figure 9.38, page 9-23), click Rename.  The Rename 
Simulation dialog box will open (see Figure 9.36, page 9-22). 

 2. The steps for renaming a simulation are the same as in the 
Renaming Simulations, under Section 9.4.1, page 9-21. 

 
Deleting Simulations 
 
If you want to delete a simulation, but you want to choose from a list of 
the developed simulations for a study: 
 
 1. From the Study Tab, on the Study Pane, from the Simulations 

folder, right-click on a simulation, from the simulations shortcut 
menu (see Figure 9.38, page 9-23), click Delete.  The Delete 
Simulations dialog box will open (see Figure 9.37, page 9-23). 

 2. The steps for deleting a simulation are the same as in the Deleting 
Simulations, under Section 9.4.1, page 9-22. 

 
 

 Individual Simulations 
 

Figure 6.15  Individual Alternative Shortcut Menu 

Figure 9.39  Individual Simulation Shortcut Menu 

The individual simulation shortcut menu (Figure 9.39) is available from 
the Study Pane, by right-clicking on a simulation name under the 
Simulation folder.  This shortcut menu will allow you to view the selected 

simulation in a map window; edit the model alternatives associated with 
the selected simulation; edit the name, description, and DSS mapping 
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identifier of the selected simulation; compute; view the log of the 
compute; rename; and, delete from the study the selected simulation.  
 
Viewing a Simulation 
 
To view a simulation in a map window: 
 
 1. From the Study Tab, on the Study Pane, from the Simulations 

folder, right-click on a simulation, from the individual simulation 
shortcut menu (see Figure 9.40, page 9-25), click Display in Map 
Window. 

 2. The steps for viewing a simulation are the same as in the Viewing a 
Simulation, under Section 9.4.1, page 9-17. 

 
Editing the Model Alternatives of a Simulation 
 
To edit the model alternatives associated with a simulation: 
 
 1. From the individual simulation shortcut menu (see Figure 9.40, 

page 9-25), point to Edit Model, from the sub-menu (see Figure 
9.30, page 9-17) click on the model alternative you wish to edit. 

 2. The steps for editing the model alternatives associated with a 
simulation are the same as in the Editing the Model Alternatives 
of a Simulation, under Section 9.4.1, page 9-17. 

 
Editing a Simulation 
 
To edit a simulation: 
 
 1. From the individual simulation shortcut menu (see Figure 9.40, 

page 9-25), click Edit Simulation.  The Simulation Editor will 
open (see Figure 9.31, page 9-18). 

 2. The steps for editing a simulation are the same as in the Editing a 
Simulation, under Section 9.4.1, page 9-18. 

 
Computing a Simulation 
 
To compute a simulation: 
 
 1. From the individual simulation shortcut menu (see Figure 9.39, 

page 9-25), point to Compute, from the sub-menu (see Figure 9.40, 
page 9-26) you have two options for computing.  

 2. All will compute all of the programs associated with the program 
order (see Section 9.2, page 9-1) of the simulation.  The first 
compute will compute all programs; any subsequent computes will  
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Figure 9.40  Computing Through a Particular WAT Program 

  only compute the model that has changed.  To force a recomputed 
hold down the CTRL key when clicking All. 

 3. The other option is to compute the simulation through a particular 
program alternative, stopping the compute process at that program.  
For example, in Figure 9.40, if you only wish to compute the 
simulation thru the ResSim alternative you would click 
StdOpNoDiv, the compute would proceed through ResSim and then 
stop.  Once again, the first compute will compute through to the 
selected program alternative, to force a re-compute hold down the 
CTRL key when clicking the program alternative. 

 4. With either option (step 2 or 3) the Compute Progress dialog box 
will open (see Figure 9.32, page 9-19).  From this dialog box you 
can see which program alternative is computing for the simulation 
and information from each program alternative is displayed in the 
Compute Progress dialog box. 

 5. If you want to stop the computation the selected simulation, from 
the Compute Progress dialog box (see Figure 9.32, page 9-19), 
click Cancel. 

 6. Once the computation is finished, click Close and the Compute 
Progress dialog box will close (see Figure 9.32, page 9-19). 

 
Viewing the Compute Log of a Simulation 
 
To view the compute log of a simulation, from the individual simulation 
shortcut menu (see Figure 9.39, page 9-25), click View Compute Log.  
The SimulationName.log dialog box will open (see Figure 9.33, page  
9-19) in the Desktop Pane (see Chapter 3, Section 3.2.2, page 3-7).  This 
contains information regarding the compute for the selected simulation.  
This information is provided by each individual program that was part of 
the compute. 
 
Saving a Simulation 
 
To save a simulation, from the individual simulation shortcut menu (see 
Figure 9.39, page 9-25), click Save.  Any changes that have occurred to 
the selected simulation will be saved by the WAT. 
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Renaming a Simulation 
 
To rename a simulation from the Study Pane: 
 
 1. From the Study Tab, on the Study Pane, from the Simulations 

folder, right-click on a simulation, from the individual simulation 
shortcut menu (see Figure 9.39, page 9-25), click Rename.  The 
Rename Simulation dialog box will open (see Figure 9.34, page  

  9-20). 
 2. The steps for renaming a simulation are the same as in the 

Renaming a Simulation, under Section 9.4.1, page 9-20. 
 
Deleting a Simulation 
 
To delete a simulation, from the Study Tab, on the Study Pane, from the 
Simulations folder, right-click on a simulation, from the individual 
simulation shortcut menu (see Figure 9.39, page 9-25), click Delete From 
Study.  A message will open asking you if you really want to delete the 
selected simulation.  Click Yes, the warning message will close and the 
simulation will no longer appear under the Simulations folder. 
 
Simulation Properties 
 
The properties of a simulation include the name and description for the 
Beta Version.  For Version 1.0 properties that will be displayed are: WAT 
alternative, analysis period, program order, and models and model 
alternatives.  To view the properties of a simulation: 
 
 1. From the Study Tab, on the Study Pane, from the Simulations 

folder, right-click on a simulation, from the individual simulation 
shortcut menu (see Figure 9.39, page 9-25), click Properties. 

 2. The Properties for SimulaitonName dialog box will open (Figure 
9.41). 

Figure 9.41  Properties for SimulationName Dialog Box 
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 3. For the Beta Version the properties for viewing are the name and 

description of the selected simulation; the date and time the 
simulation was last modified; the location of the simulation file; 
and, the name of the file which contains information about the 
simulation. 

 
 

Figure 9.42  Model Linking Editor 

9.5 Model Linking 
 
The next step is to have the models of a simulation communicate with 
each other.  This is accomplished by linking (DSS mapping) the models 
thru DSS and using a simulation name.  From the WAT, the Model 
Linking Editor (Figure 9.42) provides an easy way to link models 
including observed data, and provides a mechanism where the linking will 
have to be done once per alternative. 

 
To access the Model Linking Editor, from the WAT main window, from 
the WAT main window, from the WAT Tools toolbar, click      , the 
Modeling Linking Editor will open (Figure 9.42).  You can also access 
the Model Linking Editor from the WAT main window in another 
location.  From the Edit menu, click Model Linking Editor, and the 
Modeling Linking Editor will open (Figure 9.42). 
 
Another way to access the Model Linking Editor is from the Alternative 
and Simulation Manager (see Figure 9.23, page 9-14).  From the Edit 
menu, click Model Linking Editor; the Model Linking Editor will open 
(Figure 9.42).  Section 9.5.1 concentrates on accessing the Model Linking 
Editor from the Alternative and Simulation Manager, but the concepts 
are the same from wherever you access the Model Linking Editor in the 
WAT. 
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Figure 9.43  Model Linking Editor – ResSim Model Alternative Linked 

9.5.1 Model Linking Editor 
 
To link models for a simulation: 
 
 1. From the WAT main window, from the WAT Tools toolbar (see 

Chapter 3, Section 3.2.1, page 3-4), click       .  The Alternative 
and Simulation Manager will open (see Figure 9.23, page 9-14). 

 2. On the Edit menu, click Model Linking Editor, the Model 
Linking Editor will open (see Figure 9.42, page 9-28). 

 3. The linking of models is done by simulation, so from the 
Simulation list you need to select a simulation. 

 4. Next, you need to select the model that you want to link, with the 
default program order that would be ResSim, since the first program 
is not linked.  From the Model To Link list select the appropriate 
model. 

 5. Since a simulation knows what model alterative is being used for a 
specific model, once you make your model selection the Model 
Alternative box will display the correct model alternative.  The 
table on the Model Linking Editor will fill in with information 
provided from the model alternative (see Figure 9.42, page 9-28). 

 6. If the model alternative has not been linked to a model in the 
program order, the WAT will default to what the previous linking 
was for that model alternative.  You will need to select the model 
that ResSim will be receiving data from.  From the Model Linking 
Editor (Figure 9.43), on the table, under the Input From header, in 
the Model column, for each location, from the Model list, select 

from the choices available.  Based on the program order, the 
choices will include the available programs, the ability to link to a 
DSS file, and a user defined choice (available Version 1.0). 

 7. If your Model to Link (Figure 9.43) is ResSim, then from the 
Model list, select HMS.  Once this selection is made, the Model 
Alternative column will fill in automatically with the correct model 
alternative; since this information is know by the simulation. 
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 8. If you have selected a model, now you need to provide the location 
(common computation point) and parameter (e.g., FLOW, STAGE) 
information, the WAT has compiled a list of locations and 
parameters from the model alternative.  From the 
Location/Parameter column, from the list select the appropriate 
location/parameter.  You will need to repeat this step for all the 
locations in the table, once you are finished, the table will be 
complete (see Figure 9.43, page 9-29) and the linking for that one 
model will be finished for the selected simulation. 

 9. Before proceeding to the next model, from the toolbar click Save, 
or on the File menu, click Save. 

 10. Repeat Steps 5 thru 9 to complete the linking information for the 
rest of the programs set in the program order. 

 11. If you have chosen to link to a DSS file, from the Model list, click 
DSS File, a Select Pathname dialog box will open (Figure 9.44).  
From this dialog box, find the appropriate DSS file, and then select 
the correct pathname for the location in the table.  Click Set 

Pathname, the Select Pathname dialog box will close and on the 
table on the Model Linking Editor, under the 
Location/Parameter column for that location, the DSS filename 
and the selected pathname will appear (see Figure 9.43, page 9-29). 

 
Once you have completed the model linking step for all the programs for 
that simulation, you can then establish model linking for other simulations.  
After the model linking has been finished you are now ready to compute 
simulations. 
 

Figure 9.44  Select Pathname Dialog Box 
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CHAPTER 10  
 
 
 

Computes and Alternative Analysis 
 
 
 

10.1 Computing in HEC-WAT 
 
Now that simulations have been defined, the linking of model alternatives 
has been completed for the simulations, and model alternatives have been 
imported into the WAT, you are now ready to compute.  Once again the 
WAT provides you with several ways to compute simulations.  You can 
compute a simulation individually, compute multiple simulations, or 
compute through a specific program.  For example if you want to compute 
the simulation through the RAS model, the WAT would compute the 
HMS, ResSim and RAS model alternatives for the simulation (see 
Section 10.1.2, page 10-4).  The following sections describe in detail how 
you would compute simulations in the WAT. 
 
 

Figure 10.1  Compute Manager 

10.1.1 Compute Manager 
 
The Compute Manager (Figure 10.1) provides you with information on 
the computes of simulations.  The Compute Manager has a table which is 
color coded so you can easily tell which simulations need to be computed, 

which simulations have errors, which simulations have been computed, 
which simulations have had changes made and need to be re-computed,  
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Figure 10.2  Alternative and Simulation Manager 

Figure 10.3  Compute Manager – Compute Commands for Simulations 

and, which simulations that are not computable, because something is 
incomplete.  Also, from the Compute Manager (see Figure 10.1, page 
10-1) you can select individual simulations, multiple simulations, or all 
simulations for computation. 
 
From the WAT you can access the Compute Manager from several 
different places.  From the WAT main window, on the Compute menu, 
click Compute Manager, or, from the Management Tools toolbar, click  
      , either way open the Compute Manager (see Figure 10.1, page 10-1). 
 
Another way to access the Compute Manager is from the Alternative and 
Simulation Manager (Figure 10.2).  From the Toolbar, click       .  The 
steps below assume you access the Compute Manager from the 
Alternative and Simulation Manager, but the concepts are the same 
from wherever you access the Compute Manager in the WAT. 

 
To compute simulations: 
 
 1. From the WAT main window, from the Management Tools toolbar 

(see Chapter 3, Section 3.2.1, page 3-4), click     .  The Compute 
Manager will open (see Figure 10.1, page 10-1). 

 2. To compute all simulations click Select All (Figure 10.3), a green 
checkmark will appear for all simulations in the table on the 
Compute Manager (see figure 10.1, page 10-1). 

 3. To compute individual simulations, click on the cell in the table that 
represents an individual simulation. 
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Figure 10.4  Compute Progress Dialog Box 

 4. To clear selecting simulations, click Clear Selection (see Figure 
10.3, page 10-2), any green check marks will no longer display on 
the table. 

 5. To compute all simulations that are out-of-date, click Select Out-
of-Date, the WAT will select all simulations that are out-of-date. 

 6. After selecting a single simulation or multiple simulations, click 
Compute.  The Compute Progress dialog box will open (Figure 
10.4).  From this dialog box you can see which model is computing 
for the simulation and information from each model is displayed in 
the Compute Progress dialog box. 

 7. If a simulation has been previously computed and only one model 
has changed, when you re-compute, the previous models that did 
not change will not be re-computed.  If you want the whole 
simulation to re-compute, click Force Recompute (see Figure 10.3, 
page 10-2), the Compute Progress dialog box will open (Figure 
10.4) and all models associated with the selected simulation will re-
compute. 

 8. If you want to stop the current computation of a simulation, from 
the Compute Progress dialog box, click Cancel.  Remember this 
only cancels the compute of the active simulation, if you have 
multiple simulations selected, the next simulation will start 
computing. 

 9. If during a compute that has multiple simulations, if one of the 
simulations fails, the WAT will compute the other simulations.  If 
you want the WAT to stop when any simulation fails, click Stop 
Compute on Failure. 

 10. Once the computation is finished, click Close and the Compute 
Progress dialog box will close (Figure 10.4). 



Chapter 10 – Computes and Alternative Analysis HEC-WAT User's Manual 

10-4 

Figure 10.5  Select Log File Dialog Box 

Figure 10.6  SimulationName.log Dialog Box 
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 15. have 
computations, click  

 
ow that you have successfully computed simulations, you can now setup 

 11. If you wish to view the logs of simulations that have computed, 
click Compute Logs.  The Select Log File dialog box will open 
(Figure 10.5).  From the Existing box, select the simulation you 
wish to view the log file of the last compute for that simulation, 
click Open. 

 12. The SimulationName
log dialog box will 
open (Figure 10.6) i
the Desktop Pane 
(see Chapter 3, 
Section 3.2.2, pa
3-7).  This contains 
information regardin
the compute for the 
selected simulation.  
This information is 
provided by each 
individual program
that was part of the 
compute. 
Once you 
completed your 
will close (see Figure 10.1, page 10-1). 

Close, the Compute Manager

N
comparing and reviewing results.  Section 10.2 (page 10-7) reviews the 
WAT mechanism for comparing results. 
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Figure 10.7  Study Pane – Simulation Shortcut Menu 

10.1.2 Study Pane 

rom the Study Pane (see Chapter 3, Section 3.2.2, page 3-6) of the WAT 

 
S, 

 Compute an Individual Simulation 

o compute an individual simulation: 

1. From the Study Tab, on the Study Pane (Figure 10.7), expand the 
 

 simulation you 
 

ge 

model 
 

 2. ress dialog box will open (see Figure 10.4, page 

 3. m 

 
F
you can compute a simulation individually or compute a simulation 
through a specific program.  For example if you want to compute the
simulation through the RAS model, the WAT would compute the HM
ResSim and RAS model alternatives for the simulation.  The following 
two sections detail how to compute a simulation from the Study Pane. 
 

 
T
 
 

Alternatives folder, expand the folder of the alternative you wish to
compute simulations from (e.g., Without Project Conditions), 

wish to compute, for example in Figure 10.7, right-click on Without
Project Conditions-1993 Flood.  From the shortcut menu, point to 
Compute, click All, the WAT will compute all of the programs 
associated with the program order (see Chapter 9, Section 9.2, pa
9-1) of the simulation.  The first compute will compute all 
programs; any subsequent computes will only compute the 
that has changed.  To force a re-compute hold down the CTRL key
when clicking All. 
The Compute Prog

expand the Simulations folder.  Right-click on the

10-3).  From this dialog box you can see which program alternative 
is computing for the simulation and information from each program 
alternative is displayed in the Compute Progress dialog box. 
If you want to stop the computation the selected simulation, fro
the Compute Progress dialog box (see Figure 10.4, page 10-3), 
click Cancel. 
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 4. Once the computation is finished, click Close and the Compute 
Progress dialog box will close (see Figure 10.4, page 10-3). 

 5. If you wish to view the log of the simulation that has computed, 
from the simulation shortcut menu (see Figure 10.7, page 10-5), 
click View Compute Log.  The SimulationName.log dialog box 
will open (see Figure 10.6, page 10-4) in the Desktop Pane (see 
Chapter 3, Section 3.2.2, page 3-7).  This contains information 
regarding the compute for the selected simulation.  The information 
is provided by each individual program that was part of the 
compute. 

 
 Compute a Simulation through a Specific Program 

 
To compute a simulation through a specific program: 
 
 1. From the Study Tab, on the Study Pane (see Figure 10.7, page  
  10-5), expand the Alternatives folder, expand the folder of the 

alternative you wish to compute simulations from (e.g., Without 
Project Conditions), expand the Simulations folder.  Right-click on 
the simulation you wish to compute, for example in Figure 10.7, 
right-click on Without Project Conditions-1993 Flood.  From the 
shortcut menu, point to Compute, select which program you want 
the simulation to compute through. 

 2. For example, in Figure 10.7 (page 10-5), if you only wish to 
compute the simulation thru the ResSim model alternative you 
would click StdOpNoDiv, the compute will proceed through 
ResSim and then stop.  Once again, the first compute will compute 
through to the selected program alternative, to force a re-compute 
hold down the CTRL key when clicking the program alternative. 

 3. The Compute Progress dialog box will open (see Figure 10.4, page 
10-3).  From this dialog box you can see which program alternative 
is computing for the simulation and information from each program 
alternative is displayed in the Compute Progress dialog box. 

 4. If you want to stop the computation the selected simulation, from 
the Compute Progress dialog box (see Figure 10.4, page 10-3), 
click Cancel. 

 5. Once the computation is finished, click Close and the Compute 
Progress dialog box will close (see Figure 10.4, page 10-3). 

 6. If you wish to view the log of the simulation that has computed, 
from the simulation shortcut menu (see Figure 10.7, page 10-5), 
click View Compute Log.  The SimulationName.log dialog box 
will open (see Figure 10.6, page 10-4) in the Desktop Pane (see 
Chapter 3, Section 3.2.2, page 3-7).  This contains information 
regarding the compute for the selected simulation.  The information 
is provided by each individual program that was part of the 
compute. 
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Now that you have successfully computed simulations, you can now setup 
comparing and reviewing results.  Section 10.2 reviews the WAT 
mechanism for comparing results. 
 
 

10.2 Alternative Analysis 
 
How can you compare with-project and without-project losses?  How are 
urban flood damages in a particular impact area reduced by each of three 
alternative projects?  For the alternative that most reduces crop losses, are 
urban losses increased?  What percentage of the projected flood damages 
is prevented if a given project is implemented?  One of the basic 
objectives of the WAT is to view and compare alternative results from a 
single interface. 
 
After the computations are completed, you will be able to view and 
compare alternative results directly from simulation map windows.  The 
user will select the alternative(s) for comparison from the WAT, through 
the Result Comparison Manager (see Section 10.2.1).  Once the 
selection(s) is made, you will then be able to select any hydrologic object 
or element (computation points, reservoirs, river reaches, impact areas, 
cross sections, storage areas etc.) on a simulation map window and a list 
of tabular or graphical output will be available.  Selecting the table or 
graphic of choice, the WAT will then find that output from the appropriate 
program and display the result.  The user could be oblivious to which 
model the results came from. 
 
Rearranging the alternatives is important because the comparisons you 
make consider the first alternative to be the base alternative.  The WAT 
uses whichever alternative you designated as primary as the base 
alternative.  Most of the time, this will be your Without Project Condition 
alternative.  After you arranged your alternatives for comparison, the 
WAT provides access to several graphs and reports from the individual 
models that will compare alternative results. 
 
 

10.2.1 Result Comparison Manager 
 
The Result Comparison Manager (see Figure 10.8, page 10-8) provides 
you with the capability to compare results easily from within the WAT.  
The Result Comparison Manager has a table which is color coded so 
you can easily tell which simulations need to be computed, which 
simulations have errors, which simulations have been computed, which 
simulations have had changes made and need to be re-computed, and, 
simulations that are not computable, because something is incomplete.  
Also, from the Result Comparison Manager you can select individual 
simulations, multiple simulations, or all simulations for comparison. 
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Figure 10.8  Result Comparison Manager 
 
From the WAT you can access the Result Comparison Manager from 
the WAT main window, on the Results menu, click Result Comparison 
Manager, or, from the Management Tools toolbar, click      , either way 
the Result Comparison Manager will open (Figure 10.8) 
 
To setup comparing results: 
 
 1. From the WAT main window, from the Management Tools toolbar 

(see Chapter 3, Section 3.2.1, page 3-4), click     , the Result 
Comparison Manager will open (Figure 10.8). 

 2. To compare all results, click Select All, a green checkmark will 
appear for all simulations. 

 3. To compare individual simulation results, click on the cell in the 
table that represents an individual simulation. 

 4. To clear selected simulations, click Clear Selection, green check 
marks will no longer display on the table. 

 5. When you select the first simulation, the alternative associated with 
that simulation will become the primary or base alternative in the 
available comparison graphs and reports.  A "P" will appear in the 
cell of the selected simulation.  For example, in Figure 10.8, the 
simulation for the Without Project Conditions alternative and 1993 
Flood analysis period will be the primary alternative in comparison 
graphs and reports. 

 6. In the WAT you can save your selections of alternatives to view in 
an analysis group.  An analysis group is just a way to group 
alternative/analysis period sets together with a name.  There is a 
default analysis group which is your selection without specifically 
saving an analysis group. 

 7. To save your selection to an analysis group, select the 
alternatives/analysis periods you wish to compare, in the 
Create/Edit Analysis Groups box (Figure 10.8), click New, the 
Create New Analysis Group dialog box will open (see Figure 
10.9, page 10-9). 

 8. Enter an analysis group name in the Name box, and an optional 
description in the Description box, click OK.  The Create New  
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Figure 10.9  Create New Analysis Group Dialog Box 

  Analysis Group dialog box (Figure 10.9) will close.  From the list 
located in the Create/Edit Analysis Groups box, the new analysis 
group will appear. 

 11. Once you have set up the alternative/analysis periods you want to 
compare, close the Result Comparison Manager (see Figure 10.8, 
page 10-8). 

 
Now to complete your alternatives analysis, open a simulation map 
window, and from the schematic right-click on a model element, from that 
shortcut menu select a model graphic or report.  When either a graphic or 
report opens, you should be able to view all the alternatives that were 
selected for that analysis group and proceed with your alternative analysis.  
Also, from the Results menu, you can select reports from the various 
models that will display comparison results. 
 
 

10.2.2 Analysis Tab 
 
The Analysis Tab (see Figure 10.10, page 10-10) provides a view for 
comparing results for the selected analysis group.  You can select which 
alternatives to compare, which alternative will be the "base" alternative, 
and select analysis groups. 
 
In the Study Pane (see Chapter 3, Section 3.2.2, page 3-6) of the Analysis 
Tab, is a list of the simulations that are associated with the selected 
analysis group.  From the list at the top of the Study Pane you can select 
which analysis group you wish to view in the simulation map window. 
 
The simulation that is in bold is the base or primary alternative, and is 
usually listed first.  However, by using the up and down arrows at the 
bottom of the Study Pane, you can re-arrange the order of the simulations.  
You can also turn-off simulations for viewing by clearing the selection by 
the name, and then graphics and reports will no longer display that 
simulation.  Also from the Analysis Tab, you can create, delete and edit 
analysis groups. 
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Figure 10.11  New Analysis Group Dialog Box 

Figure 10.10  Analysis Tab 

 

 Creating an Analysis Group 

o create an analysis group from the Analysis Tab: 

1. From the Analysis Tab (Figure 10.10), on the Study Pane (see 

 2. n (10.11).  Enter an 

.  The 

 3. ar in the list at the top 

 

 

 
T
 
 

Chapter 3, Section 3.2.2, page 3-6), click      . 
The New Analysis Group dialog box will ope
analysis group name in the Name box, and an optional (but 
recommended) description in the Description box, click OK
New Analysis Group dialog box will close. 

The name of the new analysis group will appe
of the Study Pane.  The Study Pane will be blank; you will need to 
edit the analysis group to add simulations to the analysis group. 
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 Deleting an Analysis Group 

 
To delete an analysis group from the Analysis Tab: 
 
 1. From the Analysis Tab (see Figure 10.10, page 10-10), on the 

Study Pane, from the list at the top of the Study Pane (see Chapter 
3, Section 3.2.2, page 3-6), select the analysis group you wish to 
delete. 

 2. Click      , a warning message will appear asking you if you really 
want to delete the selected analysis group.  Click Yes, the warning 
message will close, and the analysis group will be removed from 
the list and the study. 

 
 

 Editing an Analysis Group 
 
To edit an analysis group from the Analysis Tab: 
 
 1. From the Analysis Tab (see Figure 10.10, page 10-10), on the 

Study Pane, from the list at the top of the Study Pane (see Chapter 
3, Section 3.2.2, page 3-6), select the analysis group you wish to 
edit. 

Figure 10.12  Selection Editor 

 2. Click      , the Selection Editor will open (Figure 10.12).  From the 
Available box, select the simulations you wish to add to the 
analysis group, click Add.  The selected simulations will now 

appear in the Selected box.  You can order the simulations in the 
Available box by selecting the simulation you wish to move up or 
down in the list, and clicking Up or Down to move the simulation 
in the list. 

 3. To remove simulations from an analysis group, from the Selected 
box, select the simulations you no longer want associated with the 
selected analysis group, click Remove.  The selected simulations 
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will no longer appear in the Selected box (see Figure 10.12, page 
10-12), and will appear now in the Available box. 

 4. Once you have decided on the simulation for the selected analysis 
group, click OK.  The Selection Editor will close, and the changes 
you have made to the analysis group will appear on the Study Pane 
of the Analysis Tab. 

 
 

Figure 10.13  Model Results from Schematic - FIA 

10.2.3 Viewing Results 
 
Now that you have setup the alternatives that you would like to compare, 
from the map window containing the primary alternative you can select 
any hydrologic object or element and a list of tabular or graphical output 
will be available.  The available output is from the programs executed in 
the selected simulations.  More detail on available results from the WAT 
is discussed in Chapter 11.  The following is an example of a report and 
graphical image that compares alternatives results. 
 
To view the FIA Comparison Report: 
 
 1. From the Analysis Tab (see Figure 10.10, page 10-10), on the 

Desktop Pane (see Chapter 3, Section 3.2.2, page 3-7), from the 
simulation map window, zoom in on a particular part of the 
schematic. 

 2. After zooming in, right-click on a cross section, a shortcut menu 
will appear (Figure 10.13).  The shortcut menu will list the model 
elements that it can find in the area where you right-clicked.  For 

example, in Figure 10.13, you right-clicked on a cross section, but 
there is also an impact area within that area, so the shortcut menu 
lists impact area (FIA result) and cross section (RAS result). 

 3. To view FIA results at an impact area, point to Impact Area, click 
on Comparison Report.  The Compare Alternatives Report – 
StudyName dialog box will open (see Figure 10.14, page 10-13).   
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Figure 10.14 FIA Compare Alternatives Report – StudyName 
Dialog Box 

Figure 10.15  Model Results from Schematic - RAS 

  This report is from FIA, and compares the damages for each 
alternative, and in the last column of the report is the difference in 
flood damage (benefit). 

 4. Click Close, the Compare Alternatives Report – StudyName 
dialog box (Figure 10.14) will close. 

 5. To view RAS results at a cross section, right-click on a cross 
section, a shortcut menu will appear (Figure 10.15).  The shortcut 
menu will list the model elements that it can find in the area where 

you right-clicked.  To view RAS results, point to Cross Section, 
click on Cross Section Plot.  The Cross Section dialog box will 
open (see Figure 10.16, page 10-13).   

 6. This plot is from RAS, and contains results for both alternatives that 
were selected for comparison.  For further details on the 
information contained in this plot, please see the RAS User's 
Manual. 
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Figure 10.16  RAS Cross Section Dialog Box 

 7. From the File menu, click Exit, the Cross Section dialog box 
(Figure 10.16) will close. 
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CHAPTER 11  
 
 

Model Results 
 
 

11.1 Overview 
 
To view model results in HEC-WAT, you must have at least one 
simulation map window open.  Results will display for the active 
simulation map window by model alternatives that are associated with the 
simulation.  Results are available either interactively from the schematic 
(Section 11.2) or from the WAT main window (Section 11.3, page 11-10).   
 
 

Figure 11.1  ToolTip Information from Schematic (Simulation Map Window) 

11.2 Schematic 
 
From the active simulation map window you can access model results 
from the model elements that are available on the map window. If you 
hover over a model element, the tooltip that appears (Figure 11.1) will list 
what model information is available for that particular model element.  For 
example, in Figure 11.1, at the junction there is possible information from 
ResSim, there must be a cross section in the area, and a reach element that 
is recognized by ResSim, HMS, and RAS. 

 
To access model results, right-click on a model element, you will get a 
shortcut menu (see Figure 11.2, page 11-2) that will provide access to the 
model results.  The WAT searches for all available model results in the 
area that you right-clicked on, so the shortcut menu will usually have 
results for all model elements that were found in the area.  Results can 
either be reports or graphical output that is available from the individual 
models.  For example, in Figure 11.2 (page 11-2), right-clicking at a reach, 
the WAT provides results from ResSim, HMS, and RAS. 
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Figure 11.2  Model Result Shortcut Menus 
 

11.2.1 HMS 
 
Whether you are right-clicking on a subbasin element, junction element, 
reach element, or sink element, from the schematic there are three HMS 
model results you can view.  The following section describes those results. 
 

 Graph 
 
To view graphical results from HMS: 
 
 1. From the simulation map window, right-click on an HMS model 

element on the schematic, a shortcut menu will appear.  For 
example, in Figure 11.3, 
you have right-clicked 
on a subbasin element, 
from the shortcut menu, 
point to Subbasin, click 
Graph. 

Figure 11.3 HMS Model Result Shortcut 
Menu 

 2. The Graph for 
Subbasin "subbasin 
name" dialog box will 
open (see Figure 11.4, 
page 11-3).  In the Beta version of the WAT, this dialog box might 
open behind the WAT for the first time.  Once you bring the dialog 
box to the front, then after that the dialog box will open in front of 
the WAT. 

 3. The graphical output displayed is from the HMS model and is 
discussed in detail in the HMS User's Manual. 

 4. To close the Graph for Subbasin "subbasin name" dialog box 
(see Figure 11.4, page 11-3) click      . 
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Figure 11.4  HMS – Graphical Results from Schematic 
 

 Time-Series Table 
 
 1. From the simulation map window, right-click on an HMS model 

element on the schematic, a shortcut menu will appear.  For 
example, in Figure 11.3 (page 11-2), you have right-clicked on a 
subbasin element, from the shortcut menu, point to Subbasin, click 
Time-Series Table. 

 2. The Time-Series 
Results for 
Subbasin "subbasin 
name" dialog box 
will open (Figure 
11.5).  In the Beta 
version of the WAT, 
this dialog box might 
open behind the 
WAT for the first 
time.  Once you bring 
the dialog box to the 
front, then after that 
the dialog box will 
open in front of the 
WAT. 

Figure 11.5 HMS Report – Time-Series 
Results from Schematic 

 3. The report displayed 
is from the HMS 
model and is 
discussed in detail in the HMS User's Manual. 
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 4. To close the Time-Series Results for Subbasin "subbasin name" 
dialog box (see Figure 11.5, page 11-3) click      . 

 
 Summary Table 

 
 1. From the simulation map window, right-click on an HMS model 

element on the schematic, a shortcut menu will appear.  For 
example, in Figure 11.3 (page 11-2), you have right-clicked on a 
subbasin element, from the shortcut menu, point to Subbasin, click 
Summary Table. 

 2. The Summary Results for Subbasin "subbasin name" dialog box 
will open (Figure 11.6).  In the Beta version of the WAT, this 
dialog box might open behind the WAT for the first time.  Once 
you bring the dialog box to the front, then after that the dialog box 
will open in front of the WAT. 

Figure 11.6  HMS Report – Graphical Results from Schematic 

 3. The report displayed is from the HMS model and is discussed in 
detail in the HMS User's Manual. 

 4. To close the Summary Results for Subbasin "subbasin name" 
dialog box (Figure 11.6) click      . 

 
 

11.2.2 ResSim 
 
When right-clicking on a reservoir element, junction element, or reach 
element, from the schematic there are several ResSim model results you 
can view.  The following sections describe those results. 
 

 Reservoir Element 
 
Release Decision Report 
 
The Release Decision Report provides the decision information that the 
ResSim model alternative reached.  The report shows the rules that 
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governed these decisions.  For further details on the Release Decision 
Report see the ResSim User's Manual. 
 
To view the Release Decision Report: 
 

Figure 11.7 ResSim Model Result for a Reservoir - 
Shortcut Menu 

 1. From the 
simulation map 
window, right-
click on a 
reservoir on the 
schematic, a 
shortcut menu 
will appear 
(Figure 11.7).  
From the 
shortcut menu, 
point to 
Reservoir, click 
Release Decision Report. 

 2. The Release Decision Report will open (Figure 11.8). 

Figure 11.8  ResSim Report – Release Decision Report 

 3. In the Beta version of the WAT, this dialog box might open behind 
the WAT for the first time.  Once you bring the dialog box to the 
front, then after that the dialog box will open in front of the WAT. 

 4. The report displays the ResSim model alternative name; in addition, 
the time window information for the simulation is displayed.  This 
report will display the decisions based on rules defined in ResSim. 

 5. From the File menu, click Close, the Release Decision Report 
(Figure 11.8) will close. 
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Plot 
 
 1. From the simulation map window, right-click on a reservoir on the 

schematic, a shortcut menu will appear (see Figure 11.7, page  
  11-5).  From the shortcut menu, point to Reservoir, click Plot. 
 2. A Plot dialog box will open (Figure 11.9). 

Figure 11.9  ResSim – Plot for a Reservoir 

 3. In the Beta version of the WAT, this dialog box might open behind 
the WAT for the first time.  Once you bring the dialog box to the 
front, then after that the dialog box will open in front of the WAT. 

 4. The plot displays graphically, the computed ResSim results for a 
reservoir. 

 5. From the File menu, click Close, the Plot dialog box (Figure 11.9) 
will close. 

 
Plot Power 
 
 1. From the simulation map window, right-click on a reservoir on the 

schematic, a shortcut menu will appear (see Figure 11.7, page  
  11-5).  From the shortcut menu, point to Reservoir, click Plot 

Power. 
 2. A Power dialog box will open (see Figure 11.10, page 11-7). 
 3. In the Beta version of the WAT, this dialog box might open behind 

the WAT for the first time.  Once you bring the dialog box to the 
front, then after that the dialog box will open in front of the WAT. 

 4. The plot displays graphically, the power and flow results for a 
reservoir from ResSim.  The power results are shown in the upper  
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  window (top viewport), while the flow results are shown in the 
lower plot window (bottom viewport). 

Figure 11.10  ResSim – Power Plot for a Reservoir 

 5. From the File menu, click Close, the Power dialog box (Figure 
11.10) will close. 

 
Plot Releases 
 
 1. From the simulation map window, right-click on a reservoir on the 

schematic, a shortcut menu will appear (see Figure 11.7, page  
  11-5).  From the shortcut menu, point to Reservoir, click Plot 

Releases. 
 2. A Plot dialog box will open (Figure 11.11). 

Figure 11.11  ResSim – Releases Plot for a Reservoir 
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 3. In the Beta version of the WAT, this dialog box might open behind 
the WAT for the first time.  Once you bring the dialog box to the 
front, then after that the dialog box will open in front of the WAT. 

 4. The plot displays graphically, the computed ResSim release results 
for a reservoir. 

 5. From the File menu, click Close, the Plot dialog box (see Figure 
11.11, page 11-7) will close. 

 
Plot Operations 
 
 1. From the simulation map window, right-click on a reservoir on the 

schematic, a shortcut menu will appear (see Figure 11.7, page  
  11-5).  From the shortcut menu, point to Reservoir, click Plot 

Operations. 
 2. A Plot dialog box will open (Figure 11.12). 

Figure 11.12  ResSim – Operations Plot for a Reservoir 

 3. In the Beta version of the WAT, this dialog box might open behind 
the WAT for the first time.  Once you bring the dialog box to the 
front, then after that the dialog box will open in front of the WAT. 

 4. The plot displays graphically, the computed ResSim operation 
results for a reservoir. 

 5. From the File menu, click Close, the Plot dialog box (see Figure 
11.12, page 11-9) will close. 

 
 Junction Element 

 
Plot 
 
To view a plot from a junction: 
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 1. From the simulation 
map window, right-
click on a junction on 
the schematic, a 
shortcut menu will 
appear (Figure 11.13).  
From the shortcut 
menu, point to 
Junction, click Plot. 

Figure 11.13 ResSim Model Result for a 
Junction - Shortcut Menu 

 2. A Plot dialog box will 
open (Figure 11.14). 

Figure 11.14  ResSim –Plot for a Junction 

 3. In the Beta version of 
the WAT, this dialog 

box might open behind the WAT for the first time.  Once you bring 
the dialog box to the front, then after that the dialog box will open 
in front of the WAT. 

 4. The plot displays graphically, the computed ResSim results for a 
junction. 

 5. From the File menu, click Close, the Plot dialog box (see Figure 
11.14, page 11-9) will close. 

 
Plot Operations 
 
 1. From the simulation map window, right-click on a junction on the 

schematic, a shortcut menu will appear (Figure 11.13).  From the 
shortcut menu, point to Junction, click Plot Operations. 

 2. A Plot dialog box will open (see Figure 11.15, page 11-10). 
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 3. In the Beta 
version of the 
WAT, this dialog 
box might open 
behind the WAT 
for the first time.  
Once you bring 
the dialog box to 
the front, then 
after that the 
dialog box will 
open in front of 
the WAT. 

Figure 11.15 ResSim – Operations Plot for a 
Junction 

 4. The plot displays 
graphically, the 
computed 
ResSim operation results for a junction. 

 5. From the File menu, click Close, the Plot dialog box (Figure 11.15) 
will close. 

 
Plot Inflow/Outflow 
 
 1. From the simulation map window, right-click on a junction on the 

schematic, a shortcut menu will appear (see Figure 11.13, page  
  11-9).  From the shortcut menu, point to Junction, click Plot 

Inflow/Outflow. 
 2. A Plot dialog box will open (Figure 11.16). 

Figure 11.16  ResSim – Inflow/Outflow Plot for a Junction 
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 3. In the Beta version of the WAT, this dialog box might open behind 
the WAT for the first time.  Once you bring the dialog box to the 
front, then after that the dialog box will open in front of the WAT. 

 4. The plot displays graphically, the computed ResSim inflow/outflow 
results for a junction. 

 5. From the File menu, click Close, the Plot dialog box (see Figure 
11.16, page 11-10) will close. 

 
 Routing Reach Element 

 
Plot 
 
To view a plot from a routing reach: 
 
 1. From the simulation map 

window, right-click on a routing 
reach on the schematic, a 
shortcut menu will appear 
(Figure 11.17).  From the 
shortcut menu, click Plot. 

 2. A Plot dialog box will open 
(Figure 11.18). 

 3. In the Beta version of the WAT, 
this dialog box might open 
behind the WAT for the first 
time.  Once you bring the dialog 
box to the front, then after that 
the dialog box will open in front 
of the WAT. 

Figure 11.17 ResSim Model Result 
for a Routing Reach - 
Shortcut Menu  4. The plot displays graphically, the 

computed ResSim results for a routing reach. 

Figure 11.18  ResSim –Plot for a Routing Reach 
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 5. From the File menu, click Close, the Plot dialog box (see Figure 
11.18, page 11-11) will close. 

 
 

11.2.3 RAS 
 
When right-clicking on a cross section element or a reach element, from 
the schematic there are several RAS model results you can view.  The 
following section describes those results. 
 

 Cross Section Element 
 
Cross SectionPlot 
 
To view a cross section graphically: 
 
 1. From the simulation 

map window, right-
click on a cross s
on the schematic, a 
shortcut menu will 
appear (Figure 11.
From the shortcut 
menu, point to Cros
Section, click Cross 
Section Plot. 
A Cro

Figure 11.19 RAS Model Result for a Cross 
Section - Shortcut Menu 

Figure 11.20  RAS – Cross Section Plot 

ection 

19).  

s 

 2. ss Section dialog box will open (Figure 11.20). 

 3. Th tion computed by RAS.  e plot displays graphically, a cross sec
The cross section plot displays the water surface elevation for a  
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  cross section on a reach in the river system.  To view cross-sections 
from another reach, use the Reach list on the Cross Section dialog 
box (see Figure 11.20, page 11-12). 

 4. From the File menu, click Exit, the Cross Section dialog box (see 
Figure 11.20, page 11-12) will close. 

 
 Cross Section Table 

 
To view the Cross Section Table: 
 
 1. From the simulation map window, right-click on a cross section on 

the schematic, a shortcut menu will appear (see Figure 11.19, page 
11-12).  From the shortcut menu, point to Cross Section, click 
Cross Section Table. 

 2. The Cross Section Output dialog box will open (Figure 11.21). 

Figure 11.21 RAS – Cross Section Output Dialog Box 

 3. The report displays detailed output for cross sections; any cross 
section can be displayed by selecting the appropriate river, reach 
and river station.  Also, any of the computed profiles can be 
displayed by selecting the desired profile.  Additionally, different 
plans can be also viewed. 

 4. From the File menu, click Exit, the Cross Section Output dialog 
box (Figure 11.21) will close. 
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 Routing Reach Element 
 
Profile Plot 
 
To view a Profile Plot: 
 
 1. From the simulation 

map window, right-
click on a routing 
reach on the 
schematic, a shortcut 
menu will appear 
(Figure 11.22).  From 
the shortcut menu, 
point to Reach, click 
Profile Plot. 

 2. The Profile Plot 
dialog box will open 
(Figure 11.23). Figure 11.22 RAS Model Result for a Routing 

Reach - Shortcut Menu 

Figure 11.23  RAS – Profile Plot Dialog Box 

 3. The profile plot 
displays the water 
surface profile for the first reach in the river system.  If there is 

more than one reach, additional reaches can be selected from the 
Options menu. 

 4. From the File menu, click Exit, the Profile Plot dialog box (Figure 
11.23) will close. 

 
Profile Table 
 
To view the Profile Output Table – Standard Table 1: 
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 1. From the simulation map window, right-click on a routing reach on 
the schematic, a shortcut menu will appear (see Figure 11.22, page 
11-14).  From the shortcut menu, point to Reach, click Profile 
Table. 

 2. The Profile Output Table – Standard Table 1 dialog box will 
open (Figure 11.24). 

Figure 11.24  RAS – Profile Output Table – Standard Table 1 Dialog Box 

 3. The report displays a number of hydraulic variables for stream 
stations.  You can change certain parameters for reporting, from the 
Options menu, you can choose which profiles and reaches to 
display, you can add a column to the report that includes the profile 
name, and you can choose which system units you wish to view the 
report in. 

 4. From the File menu, click Exit, the Profile Output Table – 
Standard Table 1 dialog box (Figure 11.24) will close. 

 
Plot XYZ 
 
To view an X-Y-Z Perspective Plot: 
 
 1. From the simulation map window, right-click on a routing reach on 

the schematic, a shortcut menu will appear (see Figure 11.22, page 
11-14).  From the shortcut menu, point to Reach, click Plot XYZ. 

 2. The X-Y-Z Perspective Plot dialog box will open (see Figure 
11.25, page 11-16). 

 3. The X-Y-Z plot is a pseudo three-dimensional plot of multiple cross 
sections within a reach.  The user has the ability to select which 
reaches to be plotted, the range of the river stations, and which 
plans and profiles to be displayed.  The plot can be rotated left and 
right, as well as up and down, in order to get different perspectives 
of the river system. 

 4. From the File menu, click Exit, the X-Y-Z Plot (see Figure 11.25, 
page 11-16) will close. 
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Figure 11.25  RAS – X-Y-Z Perspective Plot Dialog Box 
 

11.2.4 FIA 
 
When right-clicking on an impact area element, from the schematic there 
are several FIA model results you can view.  The following section 
describes those results. 
 

 Impact Area Element 
 
Alternative Report 
 
To view the Alternative Report: 
 

Figure 11.26 FIA Model Result for an Impact 
Area - Shortcut Menu 

 1. From the 
simulation map 
window, right-click 
on an impact area 
on the schematic, a 
shortcut menu will 
appear (Figure 
11.26).  From the 
shortcut menu, 
point to Impact Area, click Alternative Report. 

 2. The Alternative Report will open (see Figure 11.27, page 11-17). 
 3. The report displays the name of the study, the name of the FIA 

model alternative, and the time window of the simulation.  This 
report summarizes all the impacts by impact area for the study.  
There are separate reports for urban damages, structures impacted, 
agricultural damage, and report that summarizes all damage and 
impacts, including population impacted.  You can view this report 
by different boundary categories.  From the View By list, select the  
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  boundary category you wish to view results by; the default is impact 
area. 

Figure 11.27  FIA – Alternative Report 

 4. Click Close, the Alternative Report (Figure 11.27) will close. 
 
Impact Response Report 
 
Using the hydrographs (time-series data) defined for the impact area; FIA 
continuously simulates conditions and evaluates damage during a flood 
event.  As the program steps through a simulation, evaluating damage, it 
also searches through the rules in the Impact Table to identify the stage 
thresholds that may be exceeded.  When it finds a threshold that is 
exceeded, it records the time and date.  At the conclusion of the 
simulation, the results are displayed in the Impact Response Report. 
 
To view the Impact Response Report: 
 
 1. From the simulation map window, right-click on an impact area on 

the schematic, a shortcut menu will appear (see Figure 11.26, page 
11-16).  From the shortcut menu, point to Impact Area, click 
Impact Response Report. 

 2. The Impact Response Report will open (see Figure 11.28, page 
11-17). 

 3. This report summarizes, for each impact area, thresholds that were 
exceeded, along with the time and date of the exceedence.  Also, 
this report will inform you of the actions you should take when 
those thresholds are exceeded.  The columns of the report represent 
the various FIA model alternatives that have been evaluated.  Also, 
from this report you can determine how various FIA model 
alternatives would affect an impact area during a flood event. 

 4. As illustrated in Figure 11.28 (page 11-18), the FIA model 
alternative, Without Project Conditions has been evaluated.  For the 
impact area, Lock Haven, at 25Nov1993, 22:00, Flap gates of  
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  interior drains underwater was reached, and the following action is 
recommended – Check drains to ensure operation. 

Figure 11.28  FIA – Impact Response Report 

 5. Click Close, the Impact Response Report (Figure 11.28) will 
close. 

 
Comparison Report 
 
To view the Comparison Report: 
 
 1. From the simulation map window, right-click on an impact area on 

the schematic, a shortcut menu will appear (see Figure 11.26, page 
11-16).  From the shortcut menu, point to Impact Area, click 
Comparison Report. 

 2. The Compare Alternatives Report will open (Figure 11.29). 

Figure 11.29  FIA – Comparison Report 
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 3. The report (see Figure 11.29, page 11-18) displays the name of the 
study, the title of the report, the name of the base FIA model 
alternative, and the names of the comparison alternatives.  This 
report summarizes all the impacts by impact area for the selected 
simulation alternatives.  There are separate reports for urban 
damages, structures impacted, population impacted, and agricultural 
damage.  From the View By list, select the boundary category you 
wish to view results by; the default is impact area. 

 4. Click Close, the Compare Alternatives Report (see Figure 11.29, 
page 11-18) will close. 

 
 

11.3 Results Menu 
 
 

11.3.1 HMS Reports 
 

 Global Summary Table 
 
To view the Global Summary Table: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2.1, page 3-4), point to HMS, click Global Summary 
Table. 

 2. The Global Summary Results for Run "HMS Model Alternative 
Name" dialog box will open (Figure 11.30). 

Figure 11.30  HMS – Global Summary Table Dialog Box 

 3. This report provides information about the HMS model alternative 
for the selected WAT simulation.  This information includes the  
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  HMS project name, the HMS run name, the time window, the 
compute time, the HMS basin model name, the HMS meteorologic 
model name, the HMS control specifications name, volume units, 
and by hydrologic element various hydrologic parameters. 

 4. To close the Global Summary Results for Run "HMS Model 
Alternative Name" dialog box (see Figure 11.30, page 11-19)  

  click      . 
 
 

11.3.2 ResSim Reports 
 

 Reservoir Summary Report 
 
This report summarizes the reservoirs for the active simulation.  These 
results include the storage, elevation, controlled release, and uncontrolled 
spill parameters for each reservoir.  Reported are the average, maximum, 
and minimum values for each parameter. 
 
To view the Reservoir Summary Report: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to ResSim, click Reservoir 
Summary. 

 2. The Reservoir Summary Report will open (Figure 11.31). 

Figure 11.31  ResSim – Reservoir Summary Report 

 3. The report displays the ResSim model alternative name; in addition, 
the time window information for the simulation is displayed.  This 
report will give you information regarding the average, maximum 
and minimum values for the reservoirs and certain parameters for 
the time window of the simulation. 
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 4. From the File menu, click Close, the Reservoir Summary Report 
(see Figure 11.31, page 11-20) will close. 

 
 Flow Summary Report 

 
This report summarizes the flow at reservoirs and non-reservoir locations 
for the active simulation.  These results include the regulated flow, 
unregulated flow, and cumulative local flow for each location.  Reported 
are the average, maximum, and minimum values for each parameter. 
 
To view the Flow Summary Report: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to ResSim, click Flow Summary. 
 2. The Flow Summary Report will open (Figure 11.32). 

Figure 11.32  ResSim – Flow Summary Report 

 3. The report displays the ResSim model alternative name; in addition, 
the time window information for the simulation is displayed.  This 
report will give you information regarding the average, maximum, 
and minimum flow values for all locations and certain parameters. 

 4. From the File menu, click Close, the Flow Summary Report 
(Figure 11.32) will close. 

 
 Power Summary Report 

 
This report summarizes the hydropower information at a reservoir for the 
active simulation.  These results include generation efficiency, power  
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head, hydraulic losses, energy generated per time step, power generated, 
plant factor, and flow power for each power plant.  Reported are the 
average, maximum, and minimum values for each parameter.  If the 
appropriate data (hydropower plant) has not been entered this report will 
be blank: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to ResSim, click Power Summary. 
 2. The Power Summary Report will open (Figure 11.33). 

Figure 11.33  ResSim – Power Summary Report 

 3. The report displays the ResSim model alternative name; in addition, 
the time window information for the simulation is displayed.  This 
report will give you information regarding the average, maximum, 
and minimum hydropower values for all locations. 

 4. From the File menu, click Close, the Power Summary Report 
(Figure 11.33) will close. 

 
 Gate Summary Report 

 
This report summarizes the gates defined for the reservoirs in the active 
simulation.  Reported is the average, maximum, minimum value for the 
gate opening at each reservoir where a gate has been defined.  To view the 
Gate Summary Report (if the appropriate data has not been entered this 
report will be blank): 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to ResSim, click Gates Summary. 
 2. The Gate Summary Report will open (see Figure 11.34, page  
  11-23). 
 3. The report displays the ResSim model alternative name; in addition, 

the time window information for the simulation is displayed.  This 
report will give you information regarding the average, maximum,  
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  and minimum gate opening values for all locations and certain 
parameters. 

Figure 11.34  ResSim – Gate Summary Report 

 5. From the File menu, click Close, the Gate Summary Report 
(Figure 11.34) will close. 

 
 Stage Summary Report 

 
This report summarizes the stage at reservoirs and non-reservoir locations 
for the active simulation.  These results include the regulated stage, 
unregulated stage, and cumulative local stage for each location.  Reported 
are the average, maximum, and minimum values for each parameter.  If 
the appropriate data has not been entered (rating curves) this report will be 
blank. 
 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to ResSim, click Stage Summary. 
 2. The Stage Summary Report will open (Figure 11.35). 

Figure 11.35  ResSim – Stage Summary Report 
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 3. The report displays the ResSim model alternative name; in addition, 
the time window information for the simulation is displayed.  This 
report will give you information regarding the average, maximum, 
and minimum stage values for all locations and certain parameters. 

 4. From the File menu, click Close, the Stage Summary Report (see 
Figure 11.35, page 11-23) will close. 

 
 Release Decision Report 

 
The Release Decision Report provides the decision information that the 
ResSim model alternative reached.  The report shows the rules that 
governed these decisions. 
 
To view the Release Decision Report: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to ResSim, click Release Decision 
Report. 

 2. The Release Decision Report will open (see Figure 11.8, page  
  11-5). 
 3. The report displays the ResSim model alternative name; in addition, 

the time window information for the simulation is displayed.  This 
report will display the decisions based on rules defined in ResSim. 

 5. From the File menu, click Close, the Release Decision Report (see 
Figure 11.8, page 11-5) will close. 

 
11.3.3 RAS Reports 

 
 Standard Table 1 Report 

 
To view the Standard Table 1 Report: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to RAS, click Summary Output 
Table. 

 2. The Profile Output Table - Standard Table 1 dialog box will 
open (see Figure 11.24, page 11-15). 

 3. The report displays a number of hydraulic variables for stream 
stations.  You can change certain parameters for reporting, from the 
Options menu, you can choose which profiles and reaches to 
display, you can add a column to the report that includes the profile 
name, and you can choose which system units you wish to view the 
report in. 

 4. From the File menu, click Exit, the Profile Output Table – 
Standard Table 1 dialog box (see Figure 11.24, page 11-15) will 
close. 
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 Cross Section Output Report 
 
To view the Cross Section Output Report: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to RAS, click Detailed Output Table. 
 2. The Cross Section Output dialog box will open (see Figure 11.21, 

page 11-13). 
 3. The report displays detailed output for cross sections; any cross 

section can be displayed by selecting the appropriate river, reach 
and river station.  Also, any of the computed profiles can be 
displayed by selecting the desired profile.  Additionally, different 
plans can be also viewed. 

 4. From the File menu, click Exit, the Cross Section Output dialog 
box (see Figure 11.21, page 11-13) will close. 

 
 Profile Plot 

 
To view a Profile Plot: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to RAS, click Profile Plot. 
 2. The Profile Plot dialog box will open (see Figure 11.23, page  
   11-14). 
 3. The profile plot displays the water surface profile for the first reach 

in the river system.  If there is more than one reach, additional 
reaches can be selected from the Options menu. 

 4. From the File menu, click Exit, the Profile Plot dialog box (see 
Figure 11.23, page 11-14) will close. 

 
 Stage and Flow Hydrograph Plot 

 
To view a Stage and Flow Hydrograph Plot: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to RAS, click Stage & Flow 
Hydrograph. 

 2. The Stage and Flow Hydrographs dialog box will open (see 
Figure 11.36, page 11-26). 

 3. If the user has performed an unsteady flow analysis, then stage and 
flow hydrographs will be available for viewing, otherwise this 
dialog box will be blank.  You can view just stage hydrographs, just 
flow hydrographs, or both.  By default, the plot is at cross sections 
only, you can select from several other parameters. 

 4. From the File menu, click Exit, the Stage and Flow Hydrographs 
dialog box (Figure 11.36) will close. 
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Figure 11.36  RAS – Stage and Flow Hydrographs Dialog Box 

 
 Rating Curve Plot 

 
To view a Rating Curve Plot: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to RAS, click Rating Curve. 

Figure 11.37  RAS – Rating Curve Dialog Box 

 2. The Rating Curve dialog box will open (Figure 11.37). 
 3. The rating curve is a plot of the water surface elevation versus flow 

rate for the profiles that were computed.  A rating curve can be 
plotted at any cross-section by selecting the appropriate reach and 
river station. 

 4. From the File menu, click Exit, the Rating Curve dialog box 
(Figure 11.37) will close. 
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 Cross Section Plot 

 
To view a Cross Section Plot: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to RAS, click Cross Section Plot. 
 2. The Cross Section Plot dialog box will open (see Figure 11.20, 

page 11-12). 
 3. The cross section plot displays the water surface elevation for a 

reach in the river system.  If there is more than one reach, additional 
reaches can be selected. 

 4. From the File menu, click Exit, the Cross Section dialog box (see 
Figure 11.20, page 11-12) will close. 

 
 X-Y-Z Perspective Plot 

 
To view an X-Y-Z Perspective Plot: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to RAS, click X-Y-Z 3D Plot. 
 2. The X-Y-Z Perspective Plot dialog box will open (see Figure 

11.25, page 11-16). 
 3. The X-Y-Z plot is a pseudo three-dimensional plot of multiple cross 

sections within a reach.  The user has the ability to select which 
reaches to be plotted, the range of the river stations, and which 
plans and profiles to be displayed.  The plot can be rotated left and 
right, as well as up and down, in order to get different perspectives 
of the river system. 

 4. From the File menu, click Exit, the X-Y-Z Plot (see Figure 11.25, 
page 11-16) will close. 

 
 General Profile Plot 

 
To view a General Profile Plot: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to RAS, click General Profile Plot. 
 2. The General Profile Plot - Velocities dialog box will open (see 

Figure 11.38, page 11-28). 
 3. Any RAS parameters that are computed at a cross section can be 

displayed in a profile view.  For example, in Figure 11.38 (page 11-
28), velocity versus distance has been displayed.  The user can plot 
several different variable types at one time (e.g., velocity and area 
versus distance), but the scaling may not be appropriate when this is 
done. 
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 4. From the File menu, click Exit, the General Profile Plot - 
Velocities dialog box (Figure 11.38) will close. 

Figure 11.38  RAS – General Profile Plot Dialog Box 
 

 Hydraulic Property Tables Report 
 
To view the Hydraulic Properties Table: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to RAS, click Hydraulic Properties 
Table. 

 2. The View Hydraulic Property Tables dialog box will open 
(Figure 11.39). 

Figure 11.39  RAS – View Hydraulic Property Tables Dialog Box 

 3. If the user has performed an unsteady flow analysis, the hydraulic 
property table will be available for viewing; otherwise this dialog 
box will be blank. 

 4. From the File menu, click Exit, the View Hydraulic Property 
Tables dialog box (Figure 11.39) will close. 
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11.3.4 FIA Reports 
 
 

 Alternative Report 
 
To view the Alternative Report: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to FIA, click Alternative Report. 
 2. The Alternative Report will open (see Figure 11.27, page 11-17). 
 3. The report displays the name of the study, the name of the FIA 

model alternative, and the time window of the simulation.  This 
report summarizes all the impacts by impact area for the study.  
There are separate reports for urban damages, structures impacted, 
agricultural damage, and report that summarizes all damage and 
impacts, including population impacted.  You can view this report 
by different boundary categories.  From the View By list, select the 
boundary category you wish to view results by; the default is impact 
area. 

 4. Click Close, the Alternative Report (see Figure 11.27, page 11-17) 
will close. 

 
 Compare Alternatives Report 

 
To view the Comparison Report: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to FIA, click Comparison Report. 
 2. The Compare Alternatives Report will open (see Figure 11.29, 

page 11-18). 
 3. The report displays the name of the study, the title of the report, the 

name of the base FIA model alternative, and the names of the 
comparison alternatives.  This report summarizes all the impacts by 
impact area for the selected simulation alternatives.  There are 
separate reports for urban damages, structures impacted, population 
impacted, and agricultural damage.  From the View By list, select 
the boundary category you wish to view results by; the default is 
impact area. 

 4. Click Close, the Compare Alternatives Report (see Figure 11.29, 
page 11-18) will close. 

 
 Project Benefits Report 

 
To view the Project Benefits Report: 
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 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to FIA, click Project Benefits Report. 
 2. The Project Benefits Report will open (Figure 11.40). 

Figure 11.40  FIA – Project Benefits Report 

 3. The report displays the title of the report and the name of the 
forecast alternative.  This report displays the results from the 
computer project benefits option in FIA.  There are three specific 
areas to the report. 

   Damage Suffered - when FIA performs the computation for 
project benefits, it actually computes two sets of results.  The 
without project which means no projects (levees and reservoirs) 
are included in calculations, and the other, with project which 
includes projects in the calculations. 

   Damage Prevented - includes the differences between with and 
without project damages (Total column) and the distribution of 
the benefits among the projects.  In addition, the amount of the 
benefits awarded to Corps’ projects is displayed. 

   % Damage Prevented - reports the damage reductions for the 
differences between with and without project damages (Total 
column), each type of project (levee, reservoir), and damage 
reductions awarded to Corps project) by a percentage.  This 
percentage is simply calculated by dividing the Damage 
Prevented column by the Without Project column. 

 4. There are separate reports for urban damages, structures impacted, 
population impacted, and agricultural damage.  You can view this 
report by different boundary categories.  From the View By list, 
select the boundary category you wish to view results by; the 
default is impact area. 

 5. Click Close, the Project Benefits Report t (Figure 11.40) will 
close. 
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 Impact Response Report 
 
Using the hydrographs (time-series data) defined for the impact area; FIA 
continuously simulates conditions and evaluates damage during a flood 
event.  As the program steps through a simulation, evaluating damage, it 
also searches through the rules in the Impact Table to identify the stage 
thresholds that may be exceeded.  When it finds a threshold that is 
exceeded, it records the time and date.  At the conclusion of the 
simulation, the results are displayed in the Impact Response Report. 
 
To view the Impact Response Report: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to FIA, click Impact Response. 
 2. The Impact Response Report will open (see Figure 11.28, page 

11-18). 
 3. This report summarizes, for each impact area, thresholds that were 

exceeded, along with the time and date of the exceedence.  Also, 
this report will inform you of the actions you should take when 
those thresholds are exceeded.  The columns of the report represent 
the various FIA model alternatives that have been evaluated.  Also, 
from this report you can determine how various FIA model 
alternatives would affect an impact area during a flood event. 

 4. As illustrated in Figure 11.28 (page 11-18), the FIA model 
alternative, Without Project Conditions has been evaluated.  For the 
impact area, Lock Haven, at 25Nov1993, 22:00, Flap gates of 
interior drains underwater was reached, and the following action is 
recommended – Check drains to ensure operation. 

 5. Click Close, the Impact Response Report (see Figure 11.28, page 
11-18) will close. 

 
 Receding Response Report 

 
Using the hydrographs (time-series data) defined for the impact area; FIA 
continuously simulates conditions and evaluates potential environmental 
and operational problems due to low flow.  As the program steps through a 
simulation, evaluating damage, it also searches through the rules in the 
Receding Table to identify the stage thresholds that need to be maintained 
or exceeded.  When it finds a threshold that is not met, it records the time 
and date.  At the conclusion of the simulation, FIA will display the results 
in the Receding Response Report.  This report summarizes, for each 
impact area, thresholds that were not met, along with the time and date of 
the threshold not being met.  The columns of the report represent the 
various simulation alternatives that have been evaluated.  Also, from this 
report you can determine how various simulation alternatives would affect 
an impact area during a low flow event. 
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To view the Receding Response Report: 
 
 1. From the WAT main window, on the Results menu (see Chapter 3, 

Section 3.2, page 3-3), point to FIA, click Receding Response. 
 2. The Receding Response Report will open (Figure 11.41). 

Figure 11.41  FIA – Receding Response Report 

 3. This report summarizes, for each impact area, thresholds that were 
exceeded, along with the time and date of the exceedence.  Also, 
this report will inform you of the actions you should take when 
those thresholds are exceeded.  The columns of the report represent 
the FIA model alternative that is being evaluated for the active 
simulation.  Also, from this report you can determine how various 
alternatives would affect an impact area during a flood event. 

 4. As illustrated in Figure 11.41, the FIA model alternative, Without 
Project Conditions have been evaluated.  For the impact area, 
Beech Ck Agri, at 29Nov93 22:00, Flood Stage was reached, and 
the following action is recommended – Minor agricultural flooding 
begins. 

 5. Click Close, the Receding Response Report (Figure 11.41) will 
close. 
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Appendix B  
 
 

Plug-In Concepts 
 
 
The HEC-WAT (Watershed Analysis Tool) uses a number of standalone 
programs, initially HMS, ResSim, RAS and FIA.  These programs need to 
be incorporated into the WAT in a generic robust fashion.  The "plug-in" 
allows the WAT to provide an integrated modeling experience without 
requiring special code to support individual models 
 
 

B.1 Overview 
 
The WAT by itself contains no software application specific logic, 
through the use of a "plug-in" the WAT will be able to incorporate a 
program seamlessly into its interface.  Software applications incorporated 
into the WAT will be run as client/server architecture, with the WAT 
acting as the client and the software application as the server.  There are 
numerous ways to implement the client/server architecture and the WAT 
"plug-in" design is not meant to preclude the use of any of them. 
 
 ● The WAT provides the analysis framework. 
 ● Software applications provide everything else. 
 ● The WAT does not know about the software application code. 
 ● New software applications can be added without any change to the 

WAT code. 
 ● The "plug-in" provides integrated schematic elements, access to 

native software application editors and result displays, ability to 
launch software application computations. 

 
There are two initial designs that are going to be used to incorporate the 
HEC software applications.  The first design is used for the Java® based 
software applications, HMS, ResSim and FIA (Figure B.1). 
 

WAT

Java 
Plugin

Java Model Program
(HMS, ResSim, FIA)

Java 
ServerRMI

Figure B.1  Java Software Applications 
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Figure B.2  Non-Java Software Applications 

 
The second design is used for RAS which is a Visual Basic program 
(Figure B.2). 

 
It is not intended that any of the application software contain WAT 
specific code when the application software is run outside of the WAT 
environment. 
 
 

WAT RAS

COM

DLL  
Plugin

DLL

B.2 Loading 
 
Plug-ins will be loaded using the framework’s Plug-in Manager. The 
Plug-in Manager searches for jar files in the lib/ext directory.  When it 
finds a jar file it checks the jar file’s manifest file for the entry MainClass.  
If the MainClass entry is found, it loads that class through reflection and 
looks for a public static void main(String[] args) method.  If the main 
method is found it invokes the method.  When the plug-in’s main method 
is called, the plug-in can then install itself into the application by 
registering with the appropriate factories. 
 
The plug-in must register itself with the 
hec2.wat.plugin.WatPluginManager by calling register(WatPlugin) to be 
recognized by the WAT as a plug-in.  It should also add it’s 
hec2.model.PluginOrderItem to the hec2.model.PluginOrderItem class by 
calling addProgramOrderItem(ProgramOrderItem). 
 
 

B.3 Interfaces 
 

B.3.1 BasicWatPlugin 
 
A plug-in must implement the interface hec2.wat.client.BasicWatPlugin.  
This interface defines the basic functionality that a plug-in must support, 
such as creating a project, opening a project, getting a list of model 
alternatives etc. 
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The hec2.wat.client.BasicWatPlugin interface consists of: 
 
 /** 
  * create a new project for the program 
  */ 
 public boolean createProject(com.rma.model.Project project); 
 /** 
  * open a project for the program 
  */ 
 public boolean openProject(com.rma.model.Project project); 
 /**  
  * save the current project. 
  */ 
 public boolean saveProject(); 
 /** 
  * called when the WAT is shutting down or opening a new Study 
  */ 
 public boolean close(boolean watExiting); 
 /** 
  * unique name of the plugin 
  * @return 
  */ 
 public String getName(); 
 /** 
  * get the name of the project/watershed/etc opened by this plugin 
  * @return 
  */ 
 public String getProjectName(); 
 /**  
  * get the name of the log file if there is one. 
  * @return 
  */ 
 public String getLogfile(); 
 /** 
  * display the program to give the user full functionality to the program 
  */ 
 public boolean displayApplication(); 
 /** 
  * return the version of the application 
  */ 
 public String getVersion() 
 /** 
  * add the MessageTaker msgTaker to the plugin.  For adding messages to the 
  * framework 
  */ 
 public void addMessageTaker(MessageTaker msgTaker); 
 /** 
  * remove the MessageTaker msgTaker from the plugin 
  */ 
 public void removeMessageTaker(MessageTaker msgTaker); 
 /** 
  * get the directory that this plugin is storing its base data in 
  * @return the plugin’s working directory 
  */ 
 public String getDirectory(); 

 
Table B.1 

BasicWatPlugin Methods 
 

createProject() Create a new project.  The current WAT project is 
passed in so that the plug-in can get any 
information it needs, like the name, directory, unit 
system etc. 

openProject() Open an existing project.  The current WAT 
project is passed in so that the plug-in can use its 
information in determining which project to open 
if there is more than one. 

close() Close the plug-in application’s project.  If 
watExisting is true the application should shut 
down. 

getName() Get the name of the plug-in.  
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getProjectName() Return the name of the plug-in application’s 

project name. 
getLogFile() Return the log file for the plug-in application if it 

has one. 
displayApplication() Display the plug-in applications main window. 
getVerion()  Get the application’s version number. 

 
 

B.3.2 WatPlugin 
 
Plug-ins that is to be inserted into a WAT Simulation compute must 
implement the hec2.wat.plugin.WatPlugin which extends 
hec2.wat.plugin.BasicWatPlugin and defines methods used by the 
Simulation process. 
 
The hec2.wat.plugin.WatPlugin interface consists of: 
 
 /** 
  * get the ProgramOrderItem for the plugin. The ProgramOrderItem is used to 
  * determine where the plug goes in the Program execution order 
  */ 
 public ProgramOrderItem getProgramOrderItem(); 
  
 /** 
  * compute the specified ModelAlternative 
  */ 
 public boolean compute(hec2.wat.model.ModelAlternative modelAlt); 
  
 /** 
  * get the list of ModelAlternatives that this program has. The schematic 
  * isn’t used initially 
  */ 
 public List getModelAlternatives(Condition schematic); 
  
 /** 
  * add the ComputeProgressListener's to the Plugin 
  * @param progressListeners List of ComputeProgressListener 
  */ 
 public void addComputeListeners(List<ComputeProgressListener> progressListeners); 
 public void setComputeListeners(List<ComputeProgressListener> progressListeners); 
 /** 
  * called when the user cancels the compute 
  * @return true if the compute was canceled 
  */ 
 public boolean cancelCompute(); 
 /** 
  * display the program with the Alternative represented by malt loaded  
  */ 
 public boolean displayApplication(ModelAlternative malt) 
 /**  
  * check to see if the data represented by the Alternative malt is out of date. 
  */ 
 public boolean needToCompute(ModelAlternative malt, HecTime lastComputeTime) 
 /** 
  * import data from the plugin's application into the WAT 
  */ 
 public void importData(); 
 /** 
  * return whether the plugin is capable of importing it’s data into the WAT 
  */ 
 public boolean canImport() 
 /** 
  * get the DataLocations for the ModelAlternative modelAlt 
  */ 
 public List getDataLocations(ModelAlternative modelAlt, int direction) 
 /** 
  * set the DataLocations for the ModelAlternative modelAlt 
  */ 
 public boolean setDataLocations(ModelAlternative modelAlt, List dataLocations) 
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Table B.2 

WatPlugin Methods 
 

getProgramOrderItem() Return the plug-in's ProgramOrderItem. 
compute() Compute the specified ModelAlternative. 
getModelAlternatives() Return a list of ModelAlternatives that the plug-

in application’s project knows about.  For RAS 
this is a Plan, for ResSim it's an Alternative.  

addComputeListeners() Add the com.rma.model.ComputeListeners to 
the plug-in applications compute process.  There 
is usually an interface class that needs to take 
the application's compute information and 
translate the method calls to call the 
corresponding methods in the ComputeListener. 

cancelCompute() Cancel the current compute. 
displayApplication() Load the alternative specified by malt and 

display the plug-in application. 
importData() Display the plug-in applications import data 

window, if it has one. 
needToCompute() Check to see if the data represented by the 

alternative malt is out of date. 
importData() Import data from the plugin's application into 

the WAT. 
canImport() The DataLocations for the ModelAlternative 

modelAlt 
getDataLocations() Get the DataLocations for the ModelAlternative 

modelAlt 
setDataLocations() Set the DataLocations for the ModelAlternative 

modelAlt 
 
 

B.3.3 DisplayableWatPlugin 
 
Plug-ins that also need able to display information on the map schematic 
should implement the interface, hec2.wat.client.DisplayableWatPlugin.  
The DisplayableWatPlugin interface defines additional functionality that a 
plug-in must support to be displayed on a map schematic.  These are 
things like returning a list of elements to display, displaying an editor for 
an item, displaying output for one or more elements, etc. 
 
The hec2.wat.client.DisplayableWatPlugin interface extends 
hec2.wat.client.WatPlugin and adds the following methods: 
 
 /** 
  * get the list of GraphicElements to draw on the map for the 
  * ModelAlternative modelAlt 
  */ 
 public List getGraphicElements(hec2.wat.model.ModelAlternative modelAlt); 
 /** 
  * get the list of output reports for the ModelAlternative modelAlt 
  */ 
 public List getOutputReports(hec2.wat.model.ModelAlternative modelAlt); 
 /** 
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  * display the editor for the selected GraphicElement element 
  */ 
 public boolean displayEditor(hec2.wat.map.GraphicElement element); 
 /** 
  * display the output (plot/table) for the selected OutputElements 
  */ 
 public boolean displayOutput(hec2.wat.model.OutputElement element); 

/** 
  * get the EditActions to put in the Edit Menu for the ModelAlternative 
  * @param modelAlt the ModelAlternative, can be null  
  * @return a List of EditActions 
  */ 
 public List getEditActions(ModelAlternative modelAlt); 
 /**  
  * display the editor for the specified ModelAlternative 
  */ 
 public void editAlternative(ModelAlternative modelAlt); 
 /** 
  * get the List of EditActions that are always available in the WAT frame’s Edit 
menu 
  */ 
 public List getGlobalEditAction(); 
 /** 
  * perform the edit action. The Action is fromt the List of Actions returned by  
  * getEditActions() 
  */ 
 public void editAction(String action, ModelAlternative modelAlt) 
 /** 
  * called when a Map Layer is added to the WAT project to tell the plugin to add 
the  
  * Map Layer to its project 
  */ 
 public void addMap(String mapPath) 
 /** 
  * called when a Map Layer is removed from the WAT project to tell the plugin to 
remove 
  * the Map Layer from it’s project. 
  */ 
 public void removeMap(String mapPath) 

 
Table B.3 

DisplayableWatPlugin Methods 
 

getGraphicElements() Returns the list of GraphicElements for the 
specified ModelAlternative.  The 
GraphicElement should have any 
OutputElements that it wants displayed in its 
popup menu added to it with 
addOutputAction(OutputElement). 

getOutputReports() Returns the list of OutputElements that should be 
added to the WAT's main window, Results menu.  

displayEditor() Displays the editor associated with the 
GraphicElement. 

displayOutput() Displays the report/table/plot etc for the 
OutputElement specified. The OutputElement 
passed in is a copy of the OutputElement 
originally returned from the plug-in. 

getEditActions() Returns the list of EditActions that should be 
displayed on the WAT's main window, Edit 
menu. 

editAlternative() Display the editor for the ModelAlternative. 
getGlobalEditAction() Get the list of EditActions that are always 

available in the WAT's main window, Edit menu 
editAction() Perform the edit action.  The action is from the 

list of actions returned by getEditActions(). 
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addMap() Called when a Map Layer is added to the WAT 
project to tell the plug-in to add the Map Layer to 
its project. 

removeMap() Called when a Map Layer is removed from the 
WAT project to tell the plug-in to remove the 
Map Layer from it’s project. 

 
The four HEC application software packages will all be 
DisplayableWatPlugins, since they all have graphics elements. 
 
An additional interface hec2.wat.plugin.ClientServerPlugin is used by the 
plug-in panel for client/server plug-ins, it consists of the following 
methods: 
 
 /** 
  * return whether the server is alive 
  * @return the server alive state 
  */ 
 public boolean isServerAlive(); 
 /** 
  * start the plugin's server 
  * @return true if the server was started successfully 
  */ 
 public boolean startServer(); 

 
 

B.3.4 Java Program Plug-In 
 
The three application software that are Java based, HMS, ResSim, FIA, 
will all share a common client side plug-in and RMI interface for the 
server side.  Only on the server side is unique to each program, the client 
needs to only implement a couple of methods.  Since the server-side 
component of the plug-ins will all be implemented using the same RMI 
interface, the client side can be based on the same base class, with the only 
difference being the server that they launch. 
 
 

B.4 Map Drawing 
 
 

B.4.1 Graphic Elements 
 
Every plug-in that displays graphic elements on the screen will need to 
return a list of those elements to the WAT.  The WAT Glyph that draws 
these elements will attempt to combine like elements from the various 
models into a single image on the screen.  If two reaches exist on the same 
segment of a stream, the WAT will only draw a single reach. Elements can 
reference their location either by stream name and stream station or by X-
Y coordinates, with the stream name/stream station being the preferred 
method.  The WAT Glyph will have the ability to draw a limited number 
of elements directly.  For plug-ins that need additional elements that are  
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Figure B.3  Graphic Elements 

not built into the WAT Glyph, the WAT Glyph will have those graphic 
elements draw themselves on the map.  No drawing optimizations will be 
attempted on these unknown element types. 
 
Element types that have optimized drawing: 
 
 ReservoirElement 
 ReachElement 
 JunctionElement 
 DiversionElement 
 XSectionElement 
 PoolElement 
 ImpactAreaElement 
 SubBasinElement 
 LeveeElement 
 
Additional elements that are drawn: 
 
 PointElement 
 PolygonElement 
 LineElement 
 
All elements of a specific type, from the optimized set, are drawn using 
the same drawing properties.  Therefore, all ReservoirElements, no matter 
which application software they come from, are all drawn the same 
(Figure B.3). 

 
Graphic elements also have a drawing hierarchy number; the lowest 
number will be the element that actually gets draw on the map panel.  In 
the case of reservoirs, where ResSim, HMS and RAS can all have 
reservoirs, the ResSim reservoir is the most detailed so it should be one 
drawn (assuming there is a reservoir for each model at the location). So  

GraphicElement

PointElement LineElement PolygonElement

JunctionElement XSectionElement ReachElement PoolElementLeveeElement ImpactAreaElement
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the ResSim ReservoirElement should have a lower number than the HMS 
or RAS ReservoirElements. 
 
Reaches are treated a bit special.  The WAT MapGlyph figures out the 
longest reach on a stream and creates a new dummy reach.  This dummy 
reach then holds a list of all the plug-in reaches.  When a right-click or 
tooltip is called for, the WAT MapGlyph figures out which plug-in reaches 
are located at that stream station. 
 
GraphicElements will also contain information used by the plug-in to 
display the editor for that element as well as information for creating the 
plot and tabulate popup menus.  This will keep the WAT from having to 
constantly contacting the model program to determine what functionality 
that element has. 
 
 

B.5 Compute 
 
 

B.5.1 Passing Information to the Plug-In 
 
The call to compute() is passed with a single argument of the 
hec.wat.model.ModelAlternative.  The ModelAlternative will have the 
necessary information for the plug-in to perform the compute. 
 
This information consists of: 

• DSS Filename for both input and output of DSS data 
• F-Part for DSS pathnames 
• Run time window 
• Simulation name 
• The base compute directory.  The plug-in is expected to compute 

in a subdirectory under this directory. 
• Compute Progress Listeners, these listeners allow the plug-in to 

return compute status back to the WAT. 
 
 

B.5.2 DSS F-Part 
 
The DSS F-Part will consist of the <Simulation Name>:<Event 
Name>:<Model> where: 
 

<Simulation Name> is the first 10 character in the name of the 
simulation. 

<Event Name> is the first 10 characters in the name of the event. 
<Model> is the name of the plug-in. 
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B.5.3 F-Part Replacement 
 
To ensure that upstream models can feed downstream models data through 
the simulation’s DSS file F-Part replacement will have to occur during the 
compute.  The plug-in will be told what its output F-Part will be at 
compute time.  The program should then look through its input time series 
pathnames and if it finds a pathname matching a WAT F-Part pathname it 
should replace the simulation name:event name part of the pathname with 
the current simulation name:event name and replace the DSS file. 
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Appendix C  
 
 

Tools 
 
 
The HEC-WAT has several tools available for the user to make use of in 
manipulating DSS data, doing a statistical analysis, setting options for the 
WAT, customizing the WAT menus and toolbars, view the WAT 
execution, and check memory usage.  The following sections describe 
theses tools, with Appendix G covering the use of HEC-DSSVue. 
 
 

Figure C.1  HEC-SSP Main Window 

C.1 HEC-SSP 
 
The Statistical Software Package, HEC-SSP, is used to perform statistical 
analyses of hydrologic data (Figure C.1).  The current version is limited to 
frequency analysis based on Bulletin 17B, "Guidelines for Determining 

Flood flow Frequency" by the Interagency Advisory Committee on Water 
Data.  From the WAT a frequency analysis would be performed at stream 
gages to create frequency curves that could be used by other software in 
the WAT program sequence.  See the HEC-SSP User's Manual (CPD-86) 
for further details. 
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Figure C.2  Bulletin 17B Editor 

 
To perform a frequency analysis: 
 
 1. From the WAT main window, from the WAT Tools toolbar (see 

Chapter 3, Section 3.2.1, page 3-4), click HEC-SSP, the HEC-SSP 
main window will open (Figure C.1). 

 2. Another way to access HEC-SSP from the WAT main window, on 
the Tools menu, click HEC-SSP. 

 3. Either way in the Desktop pane, the Bulletin 17B Editor is open 
(Figure C.2). 

 4. You must enter a name for the frequency analysis, select a flow data 
set; select a name for the output DSS file, and enter a name for the 
report file. 

 5. The General tab (Figure C.2) is where you will set the general 
settings for a frequency analysis.  This includes:  generalized skew, 
expected probability curve (frequency curve), plotting positions, 
and confidence limits. 

 6. The Options tab (see Figure C.3, page C-3) provides a place for the 
user to enter optional data like low outlier threshold, historic period 
data, and user-specified frequency outliers. 

 7. The last tab is the Results tab (see Figure C.4, page C-3), which is 
populated after the user clicks Compute.  This tab contains the 
computed flow frequency curve, the expected probability adjusted 
curve, general statistics about the data, and information on the 
events.  Also, you can view data graphically and in a report form 
from this tab. 

 8. Data is stored to a DSS file, which is where the programs would 
retrieve the data. 
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Figure C.3  Bulletin 17B Editor – Options Tab 
 

 
 

Figure C.4  Bulletin 17B Editor – Results Tab 

C.2 HEC-GeoRAS 
 
HEC-GeoRAS is a set of ArcGIS® tools specifically designed to process 
geospatial data for use with HEC-RAS.  This set of procedures, tools, and 
utilities will give a user the ability to prepare GIS data for import to RAS 
and generate GIS data from RAS output with limited GIS experience.  
Users must have experience modeling with RAS and have a thorough 
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understanding of river hydraulics to properly create and interpret GIS data 
sets.  For further details see the GeoRAS User's Manual (CPD-83). 
 
 

C.3 HEC-GeoHMS 
 
HEC-GeoHMS is a geospatial hydrology tool kit for engineers and 
hydrologists with limited GIS experience.  The program allows users to 
visualize spatial information, document watershed characteristics, perform 
spatial analysis, delineate subbasin and streams, construct inputs to 
hydrologic models, and assist with report preparation.  The GeoHMS 
interface allows a user to expediently create hydrologic inputs that can be 
used directly with HEC-HMS.  For further details see the GeoHMS User's 
Manual (CPD-77). 
 
 

C.4 HEC-WAT Options Dialog Box 
 
The WAT allows you to configure several options for the interface.  You 
can specify loading the last study, show startup screen and other general 
options; view and add system properties, view the threads being used by 
the WAT, configure the colors of the messages that are displayed in the 
table on the Compute Manager, configure the colors for the state of 
simulations on the Compute Manager and the Results Comparison 
Manager, and find information and review log files for the plug-ins. 
 
 

C.4.1 General Tab 
 
From this worksheet, you can set whether the last study you had open will 
be loaded on startup of the WAT, display a dialog box that will allow you 
to open or create a study, automatically save the study on exiting the 
WAT, restore the layout, synchronize the Study Tree to the open Map 
Window, and set an interval to for saving the study. 
 
To set the automatic reload of the last study: 
 
 1. On the Tools menu, click Options. 
 2. The Options dialog box will open, click the General tab (see 

Figure C.5, page C-5). 
 3. If you wish to have the last study automatically loaded the next time 

you start the WAT, click Load Last Study at startup to set. 
 4. Once you have the automatic study loaded set, click OK.  The 

Options dialog box will close. 
 
To display the Startup dialog box: 
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Figure C.5  Options Dialog Box 

Figure C.6  Startup Dialog Box 

 1. On the Tools menu, click Options. 
 2. The Options dialog box will open (Figure C.5), click the General 

tab. 
 3. If you wish to have the Startup 

dialog box open the next time you 
start the WAT, click Show Startup 
Screen to set.  For this option to 
work properly you can not have the 
Load Last Study at startup option 
selected (Figure C.5). 

 4. Once you have the automatic study 
loaded set, click OK.  The Options 
dialog box will close (Figure C.5).  
The next time you bring up the 
WAT, the Startup dialog box will 
display (Figure C.6).  This allows 
you a convenient way to open or 
create a study. 

 
 

C.4.2 System Properties Tab 
 
System properties allow you to view system properties, and if you have 
the correct user access, you can edit some or all of the system properties.  
The recommendation is that you only use this information for debugging 
purposes and viewing.  Editing must be done with extreme caution as any 
changes you make can directly affect the WAT functionality. 
 
To view system properties: 
 
 1. On the Tools menu, click Options. 
 2. The Options dialog box will open, click the System Properties tab 

(see Figure C.7, page C-6). 
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Figure C.7  Options Dialog Box – System Properties Tab 

 3. The Server Properties Worksheet will give you information 
regarding the WAT system properties that have been set. 

 4. Click OK, the Options dialog box will close. 
 
To add a system property: 
 
 1. If you have the correct user access levels then the New command 

will be available and you can add system properties. 
 2. Click New, the New System Property dialog box (Figure C.8) will 

open. 

 3. In the Property box (Figure C.8), enter the name of the new system 
property.  For the parameters of the new system property, will enter 
the parameters in the Property Value box. 

 4. Click OK, the New System Property dialog box closes, and the 
new system property will appear on the System Properties 
worksheet (Figure C.7). 

 
To edit a system property: 
 
 1. If you have the correct user access levels then the Edit command 

will be available and you can edit system properties. 
 2. From the System Properties worksheet (Figure C.75), select a 

system property from the available list, click Edit, the Edit System 
Property dialog box (see Figure C.9, page C-7) will open. 

 3. In the Property and Property Value boxes, from the selection you 
made, edit the items, as you need to. 

Figure C.8  New System Property Dialog Box 
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Figure C.9  Edit System Property Dialog Box 

 4. Click OK, the Edit System Property dialog box closes, and the 
changed system property will appear on the System Properties 
worksheet (see Figure C.7, page C-6). 

 
To delete a system property: 
 
 1. If you have the correct user access levels then the Delete command 

will be available and you can delete system properties. 
 2. From the System Properties worksheet (see Figure C.7, page C-6), 

select the system property you wish to delete.  To select, click on 
the system property, it will 
now be highlighted in blue. 

 3. Click Delete, a Confirm 
message (Figure C.10) will 
open.  If you want to delete 
the selected system property,  

  click Yes.  The Confirm 
message will close and the selected system property will be 
removed from the System Properties worksheet (see Figure C.7, 
page C-6). 

 
 

Figure C.10  Confirm Message 

C.4.3 Threads Tab 
 
A thread is a single sequential flow of control within software.  Within 
Java you have the ability to have multiple threads in a piece of software all 
running at the same time and performing different tasks.  The WAT is a 
multi-threaded program, and the Options dialog box provides you a view 
of the threads being used by the WAT. 
 
To view threads: 
 
 1. On the Tools menu, click Options. 
 2. The Options dialog box will open, click the Threads tab (see 

Figure C.11, page C-8). 
 3. The Threads Worksheet will give you information regarding the 

threads that are actively being used by the WAT.  To provide an up-
to-date list of the active threads, click Refresh. 

 4. Click OK, the Options dialog box will close. 
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Figure C.11  Options Dialog Box – Threads Tab 
 

Figure C.12  Options Dialog Box – Compute Colors Tab 

C.4.4 Compute Colors Tab 
 
During a compute, from the Compute Manager and the Compute 
Progress dialog box, messages are written.  There are three different types 
of messages, each with its own default color.  From the Options dialog 
box you can change the default color for each message type. 
 
To set the colors for messages displayed during a compute: 
 
 1. On the Tools menu, click Options. 
 2. The Options dialog box will open, click the Compute Colors tab 

(Figure C.12). 

 3. The Compute Colors Worksheet displays the default colors for 
Normal Messages, Warning Messages, and Error Messages.  To 
change the color, from the color list associated with each message 
type, click on a new color. 

 4. Click OK, the Options dialog box will close.  The new color will 
appear in the Compute Manager and the Compute Progress 
dialog box, the next time a compute is executed. 

 
 



HEC-WAT User's Manual Appendix C - Tools 

 C-9 

Figure C.13  Options Dialog Box – Simulation Compute Colors Tab 

C.4.5 Simulation Compute Colors Tab 
 
Simulations are color coded in the WAT, so the user can at a glance see 
what simulations need to be computed, which ones had errors, which ones 
successfully computed, which ones are out-of-date, and what simulations 
are not computable.  Each category has its own default color, which 
appears in the Study pane, the Compute Manager, and the Result 
Comparison Manager.  From the Options dialog box you can change the 
default color for each simulation compute category. 
 
To set the colors for simulations: 
 
 1. On the Tools menu, click Options. 
 2. The Options dialog box will open, click the Simulation Compute 

Colors tab (Figure C.13). 

 3. The Simulation Compute Colors Worksheet displays the default 
colors for Compute Error, Computed, Never Computed, Out-of-
Date, and Not Computable.  To change the color, from the color 
list associated with each simulation compute category, click on a 
new color. 

 4. Click OK, the Options dialog box will close (Figure C.13).  The 
new color will appear in the Study Pane, Compute Manager and 
the Result Comparison Manager, the next time a simulation is 
computed. 

 
C.4.6 WAT Plug-Ins Tab 

 
This worksheet provides information on the plug-ins that are currently 
being used in the WAT for the four basic programs in the default program 
order, plus the plug-in for the HEC-SSP tool (see Section C.1).  The 
information includes the plug-in name, the version of the software the 
plug-in represents, the name of the project, whether the plug-in is written 
in a client/server mode or not, status of the server side, and a log file 
associated with the plug-in.  The log file is very important when 
debugging issues related to the individual programs in the WAT.  The  
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Figure C.14  Options Dialog Box – Plug-ins Tab 

Figure C.15  hmsserver.log 

only program that does not have a log file for the Beta version is HEC-
RAS.  The following steps can be followed for any of the software plug-
ins. 
 
To access the HMS server log file: 
 
 1. On the Tools menu, click Options. 
 2. The Options dialog box will open, click the Plug-ins tab (Figure 

C.14). 

 3. To view the log file for the HMS server, on the table, in the HMS 
row, click View.  The hmsserver.log will open (Figure C.15). 

 4. Review the hmsserver.log for any information that can help you 
debug any issues with the HMS program.  From the File menu, 
click Close, the hmsserver.log will close. 

 5. Click OK, the Options dialog box will close (Figure C.14). 
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Figure C.16  Customize Dialog Box  

.16). 
 3. e Categories box, 

 

 on the 

box. 
 4. 

 
r i

 
C.6 HEC-WAT Output 

o review the progress of the WAT, on the Tools menu, click Console 
g 

 

C.5 Customize HEC-WAT Menus and Toolbars 
 
This item allows the user to customize the menu items in the WAT, and 
turn on and off the WAT toolbars. 
 
To customize menu items: 
 
 1. On the Tools menu, click 

Customize. 
 2. The Customize dialog box 

will open; click the 
Commands tab (Figure C
From th
select the menu you wish to
customize.  From the 
Commands box, click
command you wish to remove 
and click Remove.  The 
command will no longer 
appear in the Commands 
Click OK, the Customize 
dialog box will close.  The 
command you removed from
the menu will no longer appea n the WAT. 

 
T
Output, the Console Window will open (Figure C.17).  From this dialo
box you can view the progress of the WAT, help in debugging issues with 

Figure C.17  Console Window 
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the WAT, search for certain items, format the dialog box, and print the 
contents of the dialog box.  From the File menu, click Close, the Console 
Window will close. 
 

C.7 HEC-WAT Memory Usage 
 
To review the memory being 
used by the WAT, on the Tools 
menu, click Memory Monitor, 
the Memory Monitor dialog 
box will open (Figure C.18).  
From this dialog box you can 
view the memory usage of the 
WAT.  Click the X to close the 
Memory Monitor dialog box. 
 
 
 

Figure C.18  Memory Monitor Dialog Box 
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Appendix D  
 
 

Setting Up the Coordinate System 
 
 
To maintain a geographic reference (also called a geo-reference), HEC-
WAT uses a user-selected coordinate system, called the World 
Coordinate System (WCS).  This superimposes a grid on layer features to 
establish x- and y-coordinates in WCS for each point on the layer.  The x-
coordinate is referred to as "easting" and the y-coordinate is referred to as 
"northing" following customary use in surveying and mapping.  The user 
can select the extent of this grid, the dimensions of the cells of the grid, 
the units of measurement of the grid, and even the location of the origin of 
the grid.  This appendix focuses on how to setup and edit different 
coordinate systems. 
 
 

D.1 Geographic Referencing 
 
To maintain a geographic reference, you must specify a coordinate system 
for each watershed.  To establish the grid size and coordinate system: 
 
 1. On the Maps menu, click Default Map Properties, the Map 

Default Properties for StudyName dialog box will open (Figure 
D.1).  By default, the Map Extents tab is selected. 

 2. The information in the Map Extents tab includes: 
 ● Coordinate System.  This box identifies the established 

coordinate system for a study.  To edit the coordinate system,  

Figure D.1  Map Default Properties for StudyName Dialog Box 
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Figure D.2  Map Coordinate Information Dialog Box 

  click Edit, and the Map Coordinate Information dialog box 
(Figure D.2) will open.  Remember that all layers must exist 
in one unified coordinate system. 

 ● Extents – Easting Minimum, Maximum, Northing 
Minimum, and Maximum.  These values indicate the 
location of the left, right, bottom and top borders 
(respectively) of the grid in the map window. 

 ● Grow to Map Extents.  When selected, the WAT 
automatically sets the geographic extents to define the 
smallest rectangle that encompasses all the objects in the 
study. 

 ● Set Map Extents to Display.  This will set the limits of the 
map window.  If you zoom in on an area, and click Set Map 
Display to Display, the extents on the Default Map 
Properties, the Map Default Properties for StudyName 
dialog box (see Figure D.1, page D-1) will change to the 
zoomed area. 

 
Note that the geographic extents of your layers must be selected carefully 
to ensure that the entire study is included.  Further, the extents you specify 
and the coordinate system you use must be consistent for all the layers. 
Therefore, you may need to use GIS tools to transform the layers from one 
coordinate system to another before using them with the WAT.  The WAT 
has no coordinate system transformation tools. 
 
 

D.2 Coordinate System Types 
 
A coordinate system is a method of representing points in a space of 
given dimensions by coordinates.  There are several different types of 
coordinate systems; two of interest to the WAT is the geographic 
coordinate system, which is based on latitude and longitude coordinates, 
and the project coordinate system that represents the projection of a 
geographic coordinate system on a plane. 
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The coordinate systems available in The WAT are shown in Table D.1.  
This table also shows the units and spheroid type for each coordinate 
system.  A spheroid (ellipsoid) is the shape of the earth that used in the 
calculations that transform positions on the curved surface of the earth to 
positions on a flat map.  It is part of the horizontal datum, which 
approximates the curved surface of the earth over part of the globe. 
 

Table D.1 
Coordinate System Available in the WAT 

 
Coordinate Systems Units Spheroid 

X-Y U.S. feet N/A 
Geographic radians WGS 72 
Universal Transverse Mercator meters GRS 1980(NAD83) 
State Plane Coordinates meters GRS 1980(NAD83) 
 
Albers Equal-Area Conic 

 
Degrees of Arc 

Sphere of Radius 
6370997 meters 

Lambert Conformal Conic International Feet  
Transverse Mercator U.S. feet Clarke 1866(NAD27) 
Albers Equal-Area Conic (SHG) meters GRS 1980(NAD83) 
 
Polar Sterographic (HRAP) 

 
meters 

Sphere of Radius 
6371200 meters 

 
 

D.2.1 X-Y Coordinate System 
 
 
The X-Y coordinate system is also known as the World Coordinate 
System (WCS).  This superimposes a grid on layer features to establish x- 
and y-coordinates for each point on the layer.  The origin point (0,0) can 
be located anywhere, but every object is located in relation to the origin 
point.  For the X-Y, coordinate system there is not a specification for 
spheroid. 
 
To set parameters for the X-Y Coordinate System: 
 
 1. On the Maps menu, click Default Map Properties, the Map 

Default Properties for StudyName dialog box will open (see 
Figure D.1, page D-1).  By default, the Map Extents tab is selected. 

 2. The Coordinate System box contains the default coordinate system 
for the maps, click Edit, the Map Coordinate Information dialog 
box (see Figure D.2, page D-2) will open. 

 3. From the System list, select X-Y. 
 4. From the Units list, select the units for the X-Y coordinate system. 
 5. Click OK, the Map Coordinate Information dialog box (see 

Figure D.2, page D-2) will close, and you will be returned to the 
Map Default Properties for StudyName dialog box (see Figure 
D.1, page D-1).  In the Coordinate System box, X-Y should be 
displayed. 
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D.2.2 Geographic Coordinate System 
 
For the geographic coordinate system, there you will specify units and a 
spheroid type.  To set parameters for the Geographic Coordinate System: 
 
 1. On the Maps menu, click Default Map Properties, the Map 

Default Properties for StudyName dialog box will open (see 
Figure D.1, page D-1).  By default, the Map Extents tab is selected. 

 2. The Coordinate System box contains the default coordinate system 
for the maps, click Edit, the Map Coordinate Information dialog 
box (Figure D.3) 
will open. 

 3. From the System 
list, select 
Geographic. 

 4. From the Units list, 
select the units for 
the Geographic 
coordinate system.  
The only units 
available should be 
Radians, Seconds 
of Arc, and Degrees of Arc. 

 5. From the Spheroid list, select a spheroid type for the Geographic 
coordinate system. 

 6. Click OK, the Map Coordinate Information dialog box will close, 
and you will be returned to the Map Default Properties for 
StudyName dialog box.  In the Coordinate System box, 
Geographic should be displayed. 

 
 

Figure D.3  Geographic Coordinate System 

D.2.3 Universal Transverse Mercator Coordinate System 
 
The Universal Transverse Mercator (UTM) coordinate system is a 
projection coordinate system.  UTM is used to define horizontal positions 
throughout the world by dividing the surface of the Earth into six-degree 
zones, with a central meridian in the center of each zone. 
 
To set parameters for the Universal Transverse Mercator Coordinate 
System: 
 
 1. On the Maps menu, click Default Map Properties, the Map 

Default Properties for StudyName dialog box will open (see 
Figure D.1, page D-1).  By default, the Map Extents tab is selected. 

 2. The Coordinate System box contains the default coordinate system 
for the maps, click Edit, the Map Coordinate Information dialog 
box (see Figure D.4, page D-5) will open. 
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Figure D.4  Universal Transverse Mercator Coordinate System 

  3. From the System list, select Universal Transverse Mercator. 
 4. From the Units list, select the units for the Universal Transverse 

Mercator coordinate system. 
 5. From the Spheroid list, select a spheroid type for the Universal 

Transverse Mercator coordinate system. 
 6. In the UTM Zone box, enter the UTM zone number. 
 7. Click OK, the Map Coordinate Information dialog box will close, 

and you will be returned to the Map Default Properties for 
StudyName dialog box.  In the Coordinate System box, Universal 
Transverse Mercator should be displayed. 

 
 

D.2.4 State Plane Coordinate System 
 
The State Plane Coordinate System (SPCS) was established in the 1930's 
and now covers all fifty states.  Zones were established for each state 
using either the Lambert Conformal or Traverse Mercator projections.  
Units are generally in feet (NAD27) or meters (NAD83). 
 
To set parameters for the State Plane Coordinate System: 
 
 1. On the Maps menu, click Default Map Properties, the Map 

Default Properties for StudyName dialog box will open (see 
Figure D.1, page D-1).  By default, the Map Extents tab is selected. 

 2. The Coordinate System box contains the default coordinate system 
for the maps, click Edit, the Map Coordinate Information dialog 
box (see Figure D.5, page D-6) will open. 

 3. From the System list, select State Plane Coordinates. 
 4. From the Units list, select the units for the State Plane coordinate 

system. 
 5. From the Spheroid list, select a spheroid type for the State Plane 

coordinate system.  There should only be two choices:  Clarke 
1866(NAD27) and GRS 1980(NAD83). 
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 6. In the Zone box, enter 
the zone for the state.  
These codes are FIPS 
codes. 

 7. Click OK, the Map 
Coordinate 
Information dialog 
box will close, and 
you will be returned to 
the Map Default 
Properties for 
StudyName dialog 
box.  In the Coordinate System box, State Plane Coordinates 
should be displayed. 

 
 

Figure D.5  State Plane Coordinate System 

D.2.5 Albers Equal-Area Conic Coordinate System 
 
The Albers Equal-Area Conic projection was established for mapping 
large countries like the United States.  The projection is an equivalent 
projection, where areas are proportional and directions are true in limited 
areas. 
 
To set parameters for the Albers Equal-Area Conic Coordinate System: 
 
 1. On the Maps menu, click Default Map Properties, the Map 

Default Properties for StudyName dialog box will open (see 
Figure D.1, page D-1).  By default, the Map Extents tab is selected. 

 2. The Coordinate System box contains the default coordinate system 
for the maps, click Edit, the Map Coordinate Information dialog 
box (Figure D.6) will open. 

 
Figure D.6  Albers Equal-Area Conic Coordinate System 
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 3. From the System list, select Albers Equal-Area Conic. 
 4. From the Units list, select the units for the Albers Equal-Area 

Conic coordinate system. 
 5. From the Spheroid list, select a spheroid type for the Albers Equal-

Area Conic coordinate system. 
 6. The remaining items to be entered are the angular parameters that 

are required to fine-tune the projection.  When specifying latitudes 
you will enter N or S, and for longitudes, you will enter E or W.  
Use the SPACEBAR to toggle between the entries. 

 7. Click OK, the Map Coordinate Information dialog box will close, 
and you will be returned to the Map Default Properties for 
StudyName dialog box.  In the Coordinate System box, Albers 
Equal-Area Conic should be displayed. 

 
 

D.2.6 Lambert Conformal Conic Coordinate System 
 
The Lambert Conformal Conic projection is used extensively for mapping 
areas of the world with predominantly east-west orientation.  Similar to 
the Albers Equal-Conic projection, however the projection is not done in 
an equal-area. 
 
To set parameters for the Lambert Conformal Conic Coordinate System: 
 
 1. On the Maps menu, click Default Map Properties, the Map 

Default Properties for StudyName dialog box will open (see 
Figure D.1, page D-1).  By default, the Map Extents tab is selected. 

 2. The Coordinate System box contains the default coordinate system 
for the maps, click Edit, the Map Coordinate Information dialog 
box (Figure D.7) will open. 

 
Figure D.7  Lambert Conformal Conic Coordinate System 
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 3. From the System list, select Lambert Conformal Conic. 
 4. From the Units list, select the units for the Lambert Conformal 

Conic coordinate system. 
 5. From the Spheroid list, select a spheroid type for the Lambert 

Conformal Conic coordinate system. 
 6. When specifying latitudes you will enter N or S, and for longitudes, 

you will enter E or W.  Use the SPACEBAR to toggle between the 
entries. 

 7. Click OK, the Map Coordinate Information dialog box will close, 
and you will be returned to the Map Default Properties for 
StudyName dialog box.  In the Coordinate System box, Lambert 
Conformal Conic should be displayed. 

 
 

D.2.7 Transverse Mercator Coordinate System 
 
The Transverse Mercator projection is where a sphere is projected onto a 
cylinder tangent to a central meridian.  Similar to the Lambert Conformal 
Conic project, but used to portray large areas in a north-south orientation.  
Many national grid systems are based on the Transverse Mercator 
projection. 
 
To set parameters for the Transverse Mercator Coordinate System: 
 
 1. On the Maps menu, click Default Map Properties, the Map 

Default Properties for StudyName dialog box will open (see 
Figure D.1, page D-1).  By default, the Map Extents tab is selected. 

 2. The Coordinate System box contains the default coordinate system 
for the maps, click Edit, the Map Coordinate Information dialog 
box (Figure D.8) will open. 

 
Figure D.8  Transverse Mercator Coordinate System 
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 3. From the System list, select Transverse Mercator. 
 4. From the Units list, select the units for the Transverse Mercator 

coordinate system. 
 5. From the Spheroid list, select a spheroid type for the Transverse 

Mercator coordinate system. 
 6. Enter a scaling factor for central meridian, in the Scale factor at 

central meridian box. 
 7. When specifying latitudes you will enter N or S, and for longitudes, 

you will enter E or W.  Use the SPACEBAR to toggle between the 
entries. 

 8. Click OK, the Map Coordinate Information dialog box will close, 
and you will be returned to the Map Default Properties for 
StudyName dialog box.  In the Coordinate System box, 
Transverse Mercator should be displayed. 

 
 

D.2.8 Albers Equal-Area Conic (SHG) Coordinate System 
 
This is the SHG version of the Albers Equal-Area Conic coordinate 
system.  The parameters are set to match USACE map coordinates for 
SHG, so do not change any parameter settings. 
 
To view the parameters for the Albers Equal-Area Conic (SHG) 
Coordinate System: 
 
 1. On the Maps menu, click Default Map Properties, the Map 

Default Properties for StudyName dialog box will open (see 
Figure D.1, page D-1).  By default, the Map Extents tab is selected. 

 2. The Coordinate System box contains the default coordinate system 
for the maps, click Edit, the Map Coordinate Information dialog 
box (Figure D.9) will open. 

 
Figure D.9  Albers Equal-Area Conic (SHG) Coordinate System 
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 3. From the System list, select Albers Equal-Area Conic (SHG). 
 4. From the Units list, select the units for the Albers Equal-Area 

Conic (SHG) coordinate system. 
 5. From the Spheroid list, select a spheroid type for the Albers Equal-

Area Conic (SHG) coordinate system. 
 6. The remaining parameters are informational and are not editable. 
 7. Click OK, the Map Coordinate Information dialog box will close, 

and you will be returned to the Map Default Properties for 
StudyName dialog box.  In the Coordinate System box, Albers 
Equal-Area Conic (SHG) should be displayed. 

 
 

D.2.9 Polar Sterographic (HRAP) Coordinate System 
 
The Polar Sterographic (HRAP) is used for navigation in polar regions.  
The parameters are set to match NWS map coordinates used for radar 
grids, so do not change any parameter settings. 
 
To view the parameters for the Polar Sterographic (HRAP) Coordinate 
System: 
 
 1. On the Maps menu, click Default Map Properties, the Map 

Default Properties for StudyName dialog box will open (see 
Figure D.1, page D-1).  By default, the Map Extents tab is selected. 

 2. The Coordinate System box contains the default coordinate system 
for the maps, click Edit, the Map Coordinate Information dialog 
box (Figure D.10) will open. 

 
Figure D.10  Polar Sterographic (HRAP) Coordinate System 
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 3. From the System list, select Polar Sterographic (HRAP). 
 4. From the Units list, select the units for the Polar Sterographic 

(HRAP) coordinate system. 
 5. From the Spheroid list, select a spheroid type for the Polar 

Sterographic (HRAP) coordinate system. 
 6. From the Axis box you can edit the axes information for either the 

Semi-major or the Semi-minor axes. 
 7. The remaining parameters are informational and are not editable. 
 8. Click OK, the Map Coordinate Information dialog box will close, 

and you will be returned to the Map Default Properties for 
StudyName dialog box.  In the Coordinate System box, Polar 
Sterographic (HRAP) should be displayed. 
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Appendix E  
 
 

Using Map Editors 
 
 
The are seven map layers supported by HEC-WAT, the different map 
layers are described in Chapter 5, Section 5.2.1 (page 5-1) of this manual.  
In the WAT you can configure several options for each type of map layer, 
except for AutoCAD® DXF files; additional customization is in 
development for future versions of the software. 
 
You will access the map layer editors, from the Maps Tab, which 
provides a view of the active map window in the Desktop Pane.  From the 
Content Pane, either double-click on a map layer name, or right-click, 
and from the shortcut menu click Properties.  An editor specific to the 
type of map layer you selected will open. 
 
 

E.1 Arc Shapefiles (.shp) 
 
This layer type is the native data structure for the ArcView® GIS 
program.  Shapefiles store nontopolgical geometry and attribute 
information for the spatial features of a data set.  There are three kinds of 
shapefiles: line, polygon, and point. 
 
To edit a line or polygon Arc Shapefile: 
 
 1. From the Maps Tab, from the Content Pane, right-click on an Arc 

Shapefile that you know is either a line or a polygon shapefile, from 
the shortcut menu click Properties or double-click on the Arc 
Shapefile filename. 

 2. The Shapefile Display Options dialog box (see Figure E.1, page  
  E-2) will open. 
 3. Across the top of the dialog box, is displayed the location and name 

of the shapefile. 
 4. From the list, you can select the field from the shapefile to be used 

for associating colors and what labels can be displayed.  In Figure 
E.1 (page E-2), you have chosen Stream_ID, which displays the 
name of the individual streams in the shapefile. 

 5. By default, the shapefile will display lines and areas (polygons).  To 
turn off either one of these options clear Draw Line or Draw 
Areas.  Click OK, the Shapefile Display Options dialog box will 
close.  From the Layer Selector dialog box, click Apply.  If you  
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  have cleared Draw Areas, 
then the areas (polygons) 
will now no longer appear i
the display area. 

n 

 6. If you wish to display labels 
associated with the 
shapefile, click Draw 
Labels.  Click OK, the 
Shapefile Display Options 
dialog box will close.  From 
the Layer Selector dialog 
box, click Apply, the labels 
for the selected field will 
appear in the display area. 

 7. To change the colors of line 
or polygons, from the table, 
in the Color column, click 
on the color square.  A 
Color Chooser (Figure E.2) 
will open. 

 8. The properties of the Color 
Chooser are discussed in detail in Appendix F.  From the color 
palette, select a color, click OK.  The Color Chooser will close and 
the selected color will now appear in the color square for the 
selected field. 

 9. Click OK, the Shapefile Display Options dialog box will close.  
From the Layer Selector dialog box, click Apply, the color for the 
selected field will appear in the display area. 

 10. If you wish to save any changes, from the File menu, choose Save 
Watershed.  Changes are saved to a file with the extension .gdr.  
For example, in Figure E.1, the shapefile name is stream.shp, if you 
have made changes and saved, a file stream.gdr will be created. 

Figure E.1 Shapefile Display Options 
Dialog Box 

Figure E.2  Color Chooser 
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To edit a point Arc Shapefile: 
 
 1. From the Layer Tree, right-click on an Arc Shapefile that you 

know is a point shapefile.  From the shortcut menu, click 
Properties, or double-click on the Arc Shapefile name. 

 2. The Color Chooser (see Figure E.2, page E-2) will open. 
 3. The properties of the Color Chooser are discussed in detail in 

Appendix F.  From the color palette, select a color, click OK.  The 
Color Chooser will close. 

 4. From the Layer Selector dialog box, click Apply, the color for the 
points will appear in the display area. 

 5. In the Beta Version of the WAT, any of the above changes are not 
saved and the procedures described may not always behave 
correctly in the Beta Version. 

 
 

E.2 USGS Digital Line Graph (.dlg) 
 
This layer type is a vector representation of the data.  When the WAT 
interacts with a dlg file it automatically creates a dlgbin file for use. 
 
To edit a USGS Digital Line Graph file: 
 
 1. From the Maps Tab, from the Content Pane, right-click on a 

USGS Digital Line Graph file.  From the shortcut menu, click 
Properties, or double-click on the USGS Digital Line Graph 
filename. 

 2. The USGS Digital Line Graph Editor (Figure E.3) will open. 

 3. Across the top of the dialog box, is displayed the location and name 
of the USGS Digital Line Graph file. 

 4. To change the color of the lines of the dlg file, click the color box.  
The Color Chooser (see Figure E.2, page E-2) will open. 

 5. The properties of the Color Chooser are discussed in detail in 
Appendix F.  From the color palette, select a color, click OK.  The  

Figure E.3  USGS Digital Line Graph Editor 
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  Color Chooser will close and the selected color will now appear in 
the color box. 

 6. From the Layer Selector dialog box, click Apply, the color for the 
lines will appear in the display area. 

 7. You can control the appearance of nodes, line, and areas by 
selecting and clearing Draw Nodes, Draw Lines, and Draw Areas, 
respectively. 

 8. You can also control the saturation and brightness level of the color 
you have selected by entering values in the Saturation or 
Brightness boxes.  Values entered for saturation or brightness must 
be between zero (0) and one (1). 

 9. If you wish to save any changes, from the File menu, choose Save 
Study.  The color for a USGS digital line graph file is stored in the 
watershed file (*.wksp). 

 
 

E.3 Elevation Options Dialog Box 
 
For the other map layer formats – USGS DEM, ASCII NetTin, and 
ArcInfo® DEM; they all have the same editor, the Elevation Options 
dialog box. 
 
To edit an ASCII NetTin file: 
 
 1. From the Maps Tab, from the Content Pane, right-click on an 

ASCII NetTin file.  From the shortcut menu, click Properties, or 
double-click on the ASCII NetTin name. 

 2. The Elevation Options dialog box (Figure E.4) will open. 
 3. Across the top of the dialog box, is displayed the name of the 

ASCII NetTin file. 
 4. From the list box, there 

are available color 
contour schemes – 
Aspect Shading, 
Grayscale, Linear, 
Precipitation, Red-
Green-Blue, and 
Terrain (default). 

 5. The Draw Edges check 
box is specifically for 
ASCII NetTin files.  If 
selected, the edges of the 
triangles the make up an 
ASCII NetTin file will 
be drawn. 

 6. You can set the contour 
tic interval, by entering a  Figure E.4  Elevation Options Dialog Box 
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  value in the Tic Interval box.  The program sets the maximum and 
minimum limits of the contours automatically.  You can set your 
own maximum and minimum limits.  Clear System Specified 
Min/Max Values, the Maximum and Minimum boxes are now 
available for you to enter values. 

 7. You can control the brightness (amount of white), saturation 
(amount of black), and transparency (level of opacity or alpha) for 
the colors.  You can adjust the values by using the Brightness, 
Saturation, and Transparency slider bars or boxes. 

 8. By default the Aspect Shading option is on, aspect shading is 
where you make the map layer appear in relief by placing an 
imaginary light source above the map and shading the contours.  
You can adjust the angle of the light source by using the Angle 
slider bar or the box.  If you do not want aspect shading, clear 
Aspect Shading. 

 9. Clipping provides you a way to highlight an area based on your 
color choices and values.  For maximum clipping, you would fill 
the contour with the clip color from the maximum value of the map 
to the value entered for Maximum Clipping.  An example of where 
you might use maximum clipping would be smog levels, cloud 
cover, or snow level at a particular elevation.  By default, maximum 
clipping is turned off, to select click the Maximum Clipping check 
box.  Then choose a color by clicking the Color box and either 
enter a maximum clipping value by using the slider bar or enter a 
value in the box. 

 10. Minimum clipping will fill the contour with the clip color from the 
minimum value of the map to the value entered for Minimum 
Clipping.  An example of where you might use minimum clipping 
would be to see where a water level would be if it flooded to a 
particular elevation.  By default, minimum clipping is turned off, to 
select click the Minimum Clipping check box.  Then choose a 
color by clicking the Color box and either enter a minimum 
clipping value by using the slider bar or enter a value in the box. 

 11. In the Beta Version, any of the above changes are not saved and the 
procedures described may not always behave correctly in the Beta 
Version of the WAT. 
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Appendix F  
 
 
 
 

Using the Color Chooser 
 
 
 
The Color Chooser (Figure F.1) affords great flexibility when you need to 
select default colors for map layers, labels, and background colors in your 
watershed display.  The Color Chooser has three tabs: Swatches, HSB, 
and RGB, offering three methods for choosing a color.  For each method, 
the preview area allows you to see your choice before applying changes. 

Figure F.1  Color Chooser – Swatches Worksheet 
 

F.1 Swatches Worksheet 
 
The Swatches worksheet provides a palette of pre-defined colors.  From 
the palette, select a color.  Once you have selected a color, the Recent box 
displays that color, as also does the Preview box.  Click OK, the Color 
Chooser will close.  Depending on where you accessed the Color 
Chooser, you will have to click either Apply or OK for the color change 
to appear in the map window. 
 
For example, for a USGS Digital Line Graph, you would have accessed 
the Color Chooser from the USGS Digital Line Graph Editor (see 
Appendix E, Section E.2, page E-3).  Once you have selected the color  
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from the Color Chooser and closed, then you need to click OK or Apply 
from the USGS Digital Line Graph Editor for the color change to appear 
in the map window. 
 
 

F.2 HSB Worksheet 
 
HSB is the Hue, Saturation, and Brightness color model, which allows you 
to set the hue, saturation, and brightness of the colors you wish to produce.  
From the Color Chooser, select the HSB tab; the HSB Worksheet 
(Figure F.2) becomes available. 

 
There are several ways to adjust the hue, saturation, and brightness of the 
colors.  The slider bar in conjunction with the H, S, and B options will 
change the color, if you select red with the H option selected, then when 
you switch to the S and B options, you will be changing the saturation and 
brightness of red.  Another way to affect the colors is in the H, S, and B 
boxes you can directly enter a value for hue, saturation, and brightness.  
The following rules apply to the values you can enter for each box: 
 
  H Box:  Hue is measured in a circle from zero (0) to 359 degrees. 
   0 = red, 60 = yellow, 120 = green, 180 = cyan 
   240 = blue, 300 = magenta 
  S Box:  Saturation is the amount of black, measured from zero (0) 

to one hundred (100) percent. 

Figure F.2  Color Chooser – HSB Worksheet 
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  B Box:  Brightness is the amount of white, measured from zero (0) 
to one hundred (100) percent. 

 
A finally way to set a color on the HSB worksheet, is from the color 
palette, click and drag the little white circle.  This will automatically 
change the hue, saturation, and brightness values, along with the red, 
green and blue color values.  The red, green, and blue values in the R, G, 
and B boxes are not editable, and informational only. 
 
Click OK, the Color Chooser will close.  Depending on where you 
accessed the Color Chooser, you will have to click either Apply or OK 
for the color change to appear in the display area. 
 
 

F.3 RGB Worksheet 
 
RGB is the Red, Green, and Blue color model, which allows you to set the 
red, green, and blue values of the colors you wish to produce.  From the 
Color Chooser, select the RGB tab; the RBB Worksheet (Figure F.3) 
becomes available. 
 
There are two ways to 
adjust the red, green, 
and blue value of colors.  
There is a slider bar for 
Red, Green, and Blue.  
As you change the slider 
bar for each one, in the 
Preview box, the color 
you are producing is 
shown.  Another way to 
affect colors is in the 
Red, Green, and Blue 
boxes you can directly 
enter a value.  Click 
OK, the Color Chooser 
will close.  Depending 
on where you accessed the Color Chooser, you will have to click either 
Apply or OK for the color change to appear in the map window. 
 

Figure F.3  Color Chooser – RGB Worksheet 
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Appendix G  
 
 

Using HEC-DSSVue 
 
 
HEC-DSSVue (Hydrologic Engineering Center Data Storage System 
Visual Utility Engine) is a graphical user interface program for viewing, 
editing, and manipulating data in HEC-DSS database files.  With 
DSSVue, data may be plotted, tabulated, edited, and manipulated with 
over fifty mathematical functions.  Along with these functions, DSSVue 
provides several utility functions, such as entering data sets into a 
database, renaming data set names, copying data sets to other DSS 
database files, and deleting data sets. 
 
For HEC-WAT, you will use DSSVue mainly as a viewing tool for DSS 
data.  This appendix will review some of the general functions in DSSVue.  
For further detail, see the HEC-DSSVue User's Manual. 
 
 

G.1 HEC Data Storage System Concepts 
 
HEC-DSS is a database system that was designed to efficiently store and 
retrieve scientific data that is typically sequential.  Such data types 
include, but are not limited to, time series data, curve data, spatial-oriented 
gridded data, textual data (such as this manual), and others.  The system 
was designed to make it easy for users and application programs to 
retrieve and store data. 
 
The data are arranged into blocks.  For example, one year of daily-interval 
data is stored in a single record in the DSS.  Each record is given a unique 
name called a pathname.  The pathname is formulated in a way that makes 
it easy to group related data together.  Software from HEC has the ability 
to read from and write to DSS.  This capability facilitates data exchange 
among applications.  For example, you could use ResSim to generate the 
time series input for FIA. 
 
 

G.2 Overview of HEC-DSSVue in the WAT 
 
On the Tools menu, click HecDssVue, the DSSVue main window opens.  
The main window and the different components are illustrated in Figure 
G.1 (page G-2). 
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Figure G.1  DSSVue Main Window 

The Menu Bar contains the menus for the main window of DSSVue.  The 
following list is a description of the available menus. 
 
 File This menu is used for DSS file management and 

contains the following command:  New, Open, Release 
DSS File, Print Catalog Preview, Print Catalog, and 
Close. 

 
 Edit This menu provides editing functions and contains the 

following commands:  Tabular Edit, Graphical Edit, 
Edit In MS Excel and Select All. 

 
 View This menu provides options for viewing DSS 

pathnames.  Available commands are: Pathname List, 
Pathname Parts, Condensed Catalog, No Pathnames, 
Search pathnames by string, Search pathnames by 
parts, Refresh Catalog, and Time Window. 

 
 Display After you have selected a pathname, this menu gives you 

the ability to display the data for that pathname.  
Available commands are:  Plot, Plot Data Options, 
Tabulate, Tabulate with MS Excel, and Supplemental 
Information. 

 
 Utilities This menu provides options for manipulating data stored 

in the pathnames, entering data, renaming, copying, and 
duplicating records, merging of DSS files, performing 
maintenance on a DSS file, and viewing the status of a 
DSS file.  Available commands are:  Math Functions,  
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  Compare, Manual Data Entry, Import, Export, Copy 
Records, Rename Records, Duplicate Records, Delete 
Record, Undelete, Merge Files, Squeeze, Script 
Editor, and Script Selector. 

 
 Options This menu provides options for manipulating the DSS 

catalog, merging of DSS files, viewing the status of a 
DSS file, and viewing the output log.  Available 
commands are:  Condensed Disk Catalog, 
Abbreviated Disk Catalog, Full Disk Catalog, Status, 
View Output Log, and Program Options. 

 
 Help Displays current version information about DSSVue. 
 
 
The Toolbar (see Figure G.1, page G-2) contains buttons that provide you 
with the capability to open a DSS file, plot the data, and tabulate the data.  
These buttons provide a shortcut to the respective commands in the 
Display menu. 
 
 Open File Button – opens an Open File Browser, which allows 

you to select a DSS file. 
 
 Plot Button – plots the data of the selected pathname(s). 
 
 Tabulate Button – displays the data of the selected pathname(s) in 

a tabular form. 
 
The DSS File Information (see Figure G.1, page G-2) box displays the 
filename of the DSS file, and statistics about the pathnames in the DSS file 
and the size of the DSS file. 
 
The Filter Lists (see Figure G.1, page G-2) are used to sort DSS 
pathnames by parts.  There is a filter list for each individual part, A 
through F.  The Pathname Table displays the filtered pathnames 
contained in the DSS file.  The pathnames are displayed by the individual 
parts.  The Selected Pathname List displays the pathnames that you have 
selected from the Pathname Table. 
 
The Select Commands (see Figure G.1, page G-2) are available after you 
have selected the pathnames you wish to view or manipulate.  Available 
commands are Select, De-Select, Clear Selections, Restore Selections, 
and Set Time Window.  These commands will be detailed later in this 
appendix. 
 
When you have entered time window information, the Status Bar (see 
Figure G.1, page G-2) will display the time window information.  A time 
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window is where you give a specific time frame for viewing or 
manipulating data. 
 
 

G.3 Opening a DSS File 
 
There are several ways to open a DSS file from DSSVue.  One way is to 
type in the location and filename of the DSS file in the File Name box of 
the DSSVue main window (see Figure G.1, page G-2).  After you have 
entered the correct information, press ENTER, the Pathname Table will 
display the pathnames of the selected DSS file, and the DSS File 
Information (see Figure G.1, page G-2) box will display statistics about 
the DSS file. 
 
Another way to open a DSS file is from the File menu, choose Open; or, 
click the Open File button from the Toolbar.  Either method opens an 
Open HEC-DSS File 
(Figure G.2) browser.  The 
browser defaults to the 
WAT working directory, 
which is viewable in the 
Folder box of the b
If you are in the 
Simulation Module and 
you have opened a 
simulation, the browser 
will default to the 
simulation directory. 

rowser.  

 
Locate the DSS file you 
wish to open, click OK.  
The Open HEC-DSS File 
browser will close, and the DSSVue main window will display the name 
of the DSS file and all of the pathnames associated with that DSS file will 
appear in the Pathname Table (see Figure G.1, page G-2). 
 
 

Figure G.2  Open HEC-DSS File Browser 

G.4 Set Time Window 
 
To view the data for a certain block of time, you can set a time window: 
 
 1. On the View menu, click Time Window, the Set Time Window 

dialog box (see Figure G.3, page G-5) will open. 
 2. To enter a start date and time, click Specific Time Window.  In the 

Start Date box type a date in the format ddmmmyyyy (i.e., 
26Nov1993), and in the Start Time box type a time in the format 
hhmm (i.e., 0630). 
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Figure G.3  Set Time Window Dialog Box 

 3. To enter an ending date and time, in the End Date box type a date 
in the format ddmmmyyyy (i.e., 26Dec1993), and in the End Time 
box type a time in the format hhmm (i.e., 0630). 

 4. To clear the time window boxes, click Clear. 
 5. If you want to use the current date and time, click Set Current 

Time.  All time window boxes will be filled, you will probably 
need to edit the ending data and time. 

 6. Click OK, the Set Time Window dialog box will close, the time 
window will be set, and the time window will be displayed in the 
Status Bar of the DSSVue main window (see Figure G.1, page  

  G-2). 
 
 

G.5 DSS Pathnames 
 
Data is stored in blocks, or records, within a file, and each record is 
identified by a unique name called a pathname.  Each time that data is 
stored or retrieved from the file, its pathname must be given.  The 
pathname is the key to the data’s location in the database. A pathname is 
analyzed by DSS to determine an index number. This index determines 
where the data set is stored within the database. The design ensures that 
very few disk accesses are made to retrieve or store data sets. One data set 
is not directly related to another, so there is no need to update other areas 
of the database when a new data set is stored. 
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DSS references records (data sets) by a pathname.  The pathname of a 
DSS record can be three hundred and ninety-one (391) characters or less, 
and is, by convention, separated into six parts.  The parts can be sixty-
four (64) characters or less and are delimited by slashes in the pathname.  
The pathname parts are designated A through F.  Table G.1 provides an 
example naming convention for regular-interval time series: 
 

Table G.1 
DSS Pathname Parts 

 
A project, river, or basin name 
B location identifier 
C data parameter (e.g., FLOW, PRECIP) 
D starting block data; format ddmmyyyy 
E time interval 
F additional user-defined descriptive information 

 
 

G.5.1 Viewing of DSS Pathnames 
 
The display of pathnames in the Pathname Table shows all of the 
pathnames by the different parts (see Figure G.1, page G-2).  You can 
change this display from the View menu; available commands are 
Pathname List, Pathname Parts, Condensed Catalog, and No 
Pathnames. 
 
The Pathname List command (Figure G.4) displays the pathnames in the 
Pathname Table, while No Pathnames displays nothing.  The Pathname 
Parts command is the same as the Condensed Catalog command, except 
for the D part.  On the Condensed Catalog, the D part displays the date 
span for each pathname. 

 
 

Figure G.4  Pathname List Display 

G.5.2 Sorting DSS Pathnames by Parts 
 
Another way to affect the display of the pathnames is through sorting by 
pathname parts.  Sorting the DSS pathnames by parts is the command 
Search pathnames by part (default).  However, another way to sort the  



HEC-WAT User's Manual Appendix G – Using HEC-DSSVue 

 G-7 

pathnames is available from the View menu, choose Search pathnames 
by string.  The details for this method are described in the HEC-DSSVue 
User's Manual. 
 
To sort by pathname parts, from the Filter Lists (Figure G.5) decide 
which pathname parts will be used to sort the pathname list.  There is a 
Filter List for each individual pathname part.  An example is shown in 

Figure G.5 where filters are used to see all of the FLOW records that are 
observed data.  From the Filter C list, select FLOW, and from the Filter F 
list, select OBS.  The Pathname Table will now display only the 
pathnames that fit the criteria you stated in the Filter Lists. 
 
 

Figure G.5  Sorting Pathnames 

G.5.3 Selecting Pathnames 
 
Once you have the appropriate list of pathnames in the Pathname Table, 
you can select which pathnames you want to view or manipulate.  To 
select a pathname, double-click on a pathname in the Pathname Table 
and the selected pathname will appear in the Selected Pathname List (see 
Figure G.1, page G-2).  You can also click on a pathname in the 
Pathname Table, and then click Select. 
 
To select multiple pathnames, in the Pathname Table, click on a 
pathname the pathname will be highlighted.  Find the next pathname you 
would want to include in a group, hold down the SHIFT key and click.  
The block of pathnames will be highlighted, click Select, and all the 
pathnames within that block will be added to the Selected Pathname List. 
 
Another way to select multiple pathnames is from the Pathname Table, 
click and drag across the pathnames you want, release the mouse button 
and the block of pathnames will be highlighted.  Click Select, and all of 
the pathnames within that block will be added to the Selected Pathname 
List. 
 
You can select individual pathnames to be in a group for selection.  From 
the Pathname Table, select a pathname which will be highlighted, to 
select another not in a contiguous group, hold down the CTRL key and  
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select the next pathname which will be highlighted.  Continue to do this 
until you have selected all of the pathnames you want, release the CTRL 
key and click Select.  All the pathnames you have selected will be added 
to the Selected Pathname List. 
 
You can select all of the pathnames displayed in the Pathname Table.  
From the Edit menu, choose Select All.  All of the pathnames will now 
appear in the Selected Pathname List. 
 
 

G.5.4 Clearing Selected Pathnames 
 
To clear a pathname from the Selected Pathname List (see Figure G.1, 
page G-2), select a pathname and click De-Select.  The pathname will be 
cleared from the Selected Pathname List.  To clear all pathnames from 
the Selected Pathname List, click Clear Selections, and the Selected 
Pathname Box will be empty. 
 
You can also clear groups of pathnames by using the same concepts 
described in selecting pathnames (see Section G.5.3, page G-7) by using 
the SHIFT and CTRL keys.  Once pathnames have been cleared from the 
Selected Pathname Box, the pathnames can be restored to the Selected 
Pathname Box by clicking Restore Selections. 
 
 

G.6 Visualizing Data 
 
After you have selected a pathname or multiple pathnames, you can 
visualize the data associated with the pathname.  You can do this through 
a graphical means – plots, or through a tabular form – tabulate.  Further 
details on plots and tables are discussed in the HEC-DSSVue User's 
Manual. 
 
 

G.6.1 Plots 
 
To view a plot of the pathnames in the Selected Pathname List (see 
Figure G.1, page G-2), you can either click the Plot button from the 
Toolbar, or from the View menu, choose Plot.  Either way will open the 
Plot Window (see Figure G.6, page G-9). 
 
The parameters for the plots are labeled and color-coded, date ranges are 
specified along one axis, and the units of measure are specified along the 
other axis.  You can resize the Plot Window by grabbing the corner of the 
window and dragging it to the desired size. 
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Figure G.6  Plot Window 

You can also zoom in on areas of the plot.  Click the Zoom Tool,       find 
the area on the plot you wish to zoom in on, click and drag over the area.  
The plot will refresh, the area within the zoom rectangle will fill the plot 
window.  To zoom out, with the Zoom Tool selected, right-click 
anywhere on the plot area. 
 
 

G.6.2 Tables 
 
To view a table of the pathnames in the Selected Pathname List (see 
Figure G.1, page G-2), you will either click the Tabulate button from the 
Toolbar, or from the View menu, choose Tabulate.  Either way will open 
the Tabulate Window (see Figure G.7, page G-10). 
 
The Tabulate Window displays the ordinate (starting from the start 
date/time), the date and time stamp, and the values for the selected data 
sets.  From the Tabulate Window, you have several options for 
displaying the tabular data (e.g., displaying commas in the number 
formatting, setting the precision of decimal places for your data). 
 
 

G.7 DSS Records 
 
HEC-DSS uses a block of sequential data as the basic unit of storage.  
Each block contains a series of values of a single variable over a time span 
appropriate for most applications.  The basic concept underlying DSS is  
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Figure G.7  Tabulate Window 

the organization of data into records of continuous, applications-related 
elements, as opposed to individually addressable data items.  This 
approach is more efficient for scientific applications than that of a 
conventional database system because it avoids the processing and storage 
overhead required for assembling an equivalent record from a 
conventional system.  Data is stored in blocks, or records, within a file, 
and each record is identified by a pathname. 
 
 

G.7.1 Renaming Records 
 
To change the pathname parts of a pathname: 
 
 1. You must have selected one or more pathnames (see Section G.5.3, 

page G-7) for this command to be available. 
 2. On the Utilities menu, click Rename Records.  The Rename 

Records to: dialog box (Figure G.8) will open. 

 
Figure G.8  Rename Records to: Dialog Box 
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 3. Each of the boxes (A - F) represents the different pathname parts.  
You cannot rename the D and E parts.  For parts A, B, C, and F you 
can change the parts by typing the new information in the 
appropriate box. 

 4. Click OK, the Rename Records to: dialog box will close, a 
message will appear informing you of the number of records 
renamed.  The selected pathname will no longer be displayed in the 
Selected Pathname Box (see Figure G.1, page G-2) and the 
pathname will display in the Pathname Table (see Figure G.1, 
page G-2) with the new pathname parts. 

 
 

G.7.2 Duplicating Records 
 
Duplicating a record allows you to make a copy of a record, but with a 
pathname part that has been changed.  To duplicate records: 
 
 1. You must have selected one or more pathnames (see Section G.5.3, 

page G-7) for this command to be available. 
 2. On the Utilities menu, click Duplicate Records.  The New 

pathname parts for duplicate records: dialog box (similar to 
Figure G.8, page G-10) will open. 

 3. Each of the boxes (A - F) represents the different pathname parts.  
You cannot rename the D and E parts.  For parts A, B, C, and F you 
can change the parts by typing the new information in the 
appropriate box. 

 4. Click OK, the New pathname parts for duplicate records: dialog 
box will close, a message will appear informing you of the number 
of records that were duplicated.  A new pathname will be displayed 
in the Pathname Table (see Figure G.1, page G-2). 

 
 

G.7.3 Deleting Records 
 
To delete records: 
 
 1. You must have selected one or more pathnames (see Section G.5.3, 

page G-7) for this command to be available. 
 2. On the Utilities menu, click Delete Records, a warning message 

dialog box appears asking you if you really want to delete the listed 
pathnames.  These should be the same pathnames displayed in the 
Selected Pathname List (see Figure G.1, page G-2). 

 3. Click Yes, the warning message dialog box will close.  A message 
will appear informing you of the number of records deleted. 

 4. The deleted records no longer appear in the Pathname Table (see 
Figure G.1, page G-2). 
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G.7.4 Editing Data Associated with Records 

 
You can edit the data associated with a pathname, if you have the 
appropriate permissions, on the Edit menu, click Tabular Edit, 
Graphical Edit, or, Edit in MS Excel.  You can edit data directly, enter 
new time-series data or paired data, or use math functions to manipulate 
the data.  All of these features are detailed in the HEC-DSSVue User's 
Manual. 
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Appendix H  
 
 

Glossary 
 
 
This glossary is a collection of definitions from throughout this user’s 
manual, plus definitions of other pertinent terms. 
 
Acre: A unit of area in English units used in calculation of agricultural 

crop damage. 
 
Activity: Linked with features and may involve changes to operations or 

institutional actions. 
 
Alternative: A system of structural and/or nonstructural measures, 

strategies, or programs formulated to alleviate problems or 
take advantage of specific opportunities associated with 
water and related land resources in the planning area.  An 
alternative in the WAT is a way to group a schematic with 
different operations and model parameters.  The WAT 
creates a base alternative (Without Project Conditions) by 
default. 

 
Analysis Period: Defines the time window and events that could be 

associated with an alternative.  Analysis periods are 
for determining damage and project performance 
information for specific time periods, such as the base 
year or the most likely future year.  The analysis year 
results for a plan are also used to perform equivalent 
annual damage computations.  The analysis years are 
used for all study evaluations.  An analysis year 
represents a static time period or year that the H&H 
and economic data represent.  Base year is the first 
year of the plan operation.  The "most likely future 
year" condition is a development projection for a 
specific future year; say twenty years out from the 
base year.  It usually is based on the projections of 
local future development plans. 

 
Arc Shapefile: This layer type is the native data structure for the 

ArcView® GIS program.  Shapefiles store non-
topolgical geometry and attribute information for the 
spatial features of a data set.  Usually there are three 
files:  *.dbf, *.shp, and *.shx.  The shp file contains the  
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 shapes (point, polylines, or polygons) that are displayed 
in the layer.  Each shape has a record in the dbf file 
containing descriptive data called “attributes.”  The .shx 
file contains an index that links each shape to its record 
in the .dbf file. 

 
ArcInfo® DEM: This is an ASCII file format representation of a grid 

generated by ArcInfo®.  The file consists of keywords 
followed by values defining the number of columns, 
number of rows, lower left corner, cell size, no data 
value, and each cell value. 

 
ASCII NetTin: This is an ASCII file format used to represent a 

triangulated irregular network (TIN).  The TIN data are 
stored in a simple format that defines the nodes, edges, 
and triangles contain in the TIN.  This format is common 
for transferring TIN data between software. 

 
AutoCAD® DXF: A Drawing Interchange File (dxf) is created by a 

Computer-Aided Design (CAD) package, 
AutoCAD®.  This format is a tagged data 
representation of an AutoCad® drawing file.  
Tagged data is where each data element is preceded 
by a group code.  A group code is an integer 
indicating the type of data element.  The file created 
is a vector-based graphic.  The DXF format is 
commonly used for data export from other CAD and 
GIS programs. 

 
CAP: Continuing Authorities Program; is a group of legislative 

authorities that give the Corps of Engineers the authority to plan, 
design, and construct certain types of water resource and 
ecosystem restoration projects without additional and specific 
congressional authorization.  The following are the most 
commonly used CAP authorities:  Small Flood control Projects 
(authorized by Section 205 of the 1948 Flood control Act); 
Emergency Streambank Protection Projects (authorized by Section 
14 of the 1946 Flood control Act), Aquatic Ecosystem Restoration 
(authorized by Section 206 of the 1996 Water Resources 
Development Act); and, Project Modifications of the Improvement 
of the Environment (authorized by Section 1135 of the 1986 Water 
Resources Development Act). 

 
Channel Modification: Physical alternation of the channel through re-

sizing, re-configuration, or re-vegetation, etc. 
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Channel Modification  Tool to create, delete, rename, and edit channel 
Tool: modifications.  A channel modification has to be 

created on the stream alignment. 
 
Common Computation Locations where one model transfers data to  
Point: another model, a location where results are 

needed for model development or alternative 
analysis, or locations where input boundary 
conditions are to be defined. 

 
Common Computation Tool to create, delete, rename, and edit common 
Point Tool: computation points.  See Chapter 7 (Section 

7.14.2, page 7-40) for more detail on creating, 
deleting, renaming, and editing computation 
points. 

 
Compute: Capability within the WAT that allows the user to perform the 

calculations made available through the WAT.  These 
calculations could be for one or more of the models in an 
order chosen by the Project Delivery Team (PDT). 

 
 Also, a menu where you can compute individual simulations; 

compute multiple simulations; compute by individual 
program; and, view the compute log for the active simulation. 

 
Content Pane: Area of the WAT framework that provides details on the 

selected WAT component in the Study Pane. 
 
Desktop Pane: Area of the WAT framework where the different Map 

Windows available from the WAT will display. 
 
Diversion: Removal and redirection of water from its normal course for 

various reasons, water supply, flood control, or 
environmental, etc. 

 
Diversion Tool: Tool to create, delete, rename, and edit diversions.  A 

diversion has to be started on the stream alignment. 
 
DXF: See AutoCAD® DXF. 
 
Easting: The X-coordinate of a location in the user-selected World 

Coordinate System (WCS). 
 
Ecosystem Restoration  Physical modifications or other actions that 
Measure: improve the value and function of an ecosystem 

(e.g., channel improvements, removal of 
drainage structures or levees). 
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Edit: A menu where the program order can be set; manipulate 
alternatives and simulations; link individual model alternatives; 
and, access the individual program editors. 

 
Event: A rainfall and/or flow episode.  Normally the event is the time 

period over which the model will retrieve data and produce 
results.  An occurrence of precipitation/snowmelt that leads to 
some sort of hydrologic response normally associated with a 
specific time period.  The event can be historical or represent the 
upper limit of a precipitation runoff response. 

 
File: A menu used for study management, printing the active map, and, 

importing and exporting model alternatives. 
 
FIA: Flood Impact Analysis, see HEC-FIA. 
 
Feature: A physical element that generally requires site construction. 
 
Flood Damage Can be a physical modification (structural  
Reduction Measure : measures) designed to reduce the frequency of 

damaging levels of flood inundation (i.e., 
reservoirs, levees, channelization measures, walls, 
etc.); or, it can be an activity (non-structural 
measure) that reduces flood damage without 
significantly altering the nature or extent of 
flooding (e.g., flood proofing, relocation of 
structures, raising structures). 

 
Floodwall: A levee/floodwall is man made barrier built along a stream to 

provide protection from flooding.  A levee/floodwall can 
reduce flood damage by preventing flood stages from 
reaching a potential damage area. 

 
GIS: Geographic Information System 
 
Group Code: In a DXF file an integer indicating the type of data 

element, see AutoCAD® DXF. 
 
GUI: Graphical User Interface, designed to make the program easy and 

efficient to enter data, review output, and make comparisons. 
 
Hectare: A unit of area in SI units used in calculation of agricultural crop 

damage. 
 
HEC-DSS: The HEC database management system, HEC Data Storage 

System, stores data in a convenient manner for inventory, 
retrieval, and archiving for water resource applications. 
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HEC-DSSVue: The HEC software package, HEC Data Storage System 
Visual Utility Engine, which provides a graphical user 
interface for viewing, editing, and manipulating data in 
HEC-DSS files. 

 
HEC-FIA: The HEC software package, HEC Flood Impact Analysis.  

This software package provides the capability to estimate 
the impacts and damage associated with flood events and the 
benefits attributed to flood control projects. 

 
HEC-HMS: The HEC software package, HEC Hydrologic Modeling 

System.  This software package is designed to simulate the 
precipitation-runoff processes of dendritic watershed 
systems and provides the capability to simulate the 
hydrologic response in a watershed. 

 
HEC-RAS: The HEC software package, HEC River Analysis System.  

This software package is designed to perform one-
dimensional hydraulic calculations for a full network of 
natural and constructed channels, that allow the user the 
capability to perform one-dimensional steady and unsteady 
flow river hydraulics calculations, sediment transport-
mobile be modeling, and water temperature analysis. 

 
HEC-ResSim: The HEC software package, HEC Reservoir System 

Simulation.  This software package provides the 
capability to simulate the operation of a reservoir or 
reservoir system for an observed, synthetic or predicted 
flow event using a defined operation scheme. 

 
HEC-SSP: The HEC software package, HEC Statistical Software 

Package.  This software package allows the user to perform 
statistical analyses of hydrologic data. 

 
HEC-WAT: The HEC software package, HEC Watershed Analysis 

Tools.  This software package will provide an interface that 
will streamline the analytical process using the tools 
commonly applied by multi-disciplinary teams at Corps 
offices. 

 
Help: A menu that provides access to WAT help and displays current 

information about the WAT. 
 
Impact Area: Is any distinct portion of a study area that is affected by 

rising or falling stage in a stream, river, lake, or reservoir.  
The boundaries of an impact area are defined by a closed 
polygon, and you characterize the effects of rising or 
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falling stage by describing the property and population at 
risk in the area bounded by the polygon. 

 
Impact Area Tool: Tool is used to create, edit, delete, and rename, 

impact areas.  See Chapter 7 (Section 7.15, page  
 7-42) for more detail on creating, deleting, 

renaming, and editing impact areas. 
 
JRE: Java Runtime Environment (JRE) 
 
Layer: Layers are maps that can be placed as background images behind 

the workspace.  They are optional but do provide significant 
information.  Layers can be many types (*.dlg, *.shp 
(ARC/INFO® or Arc Shapefile), *.dxf (AutoCAD®), *.dem). 

 
Levee : A levee/floodwall is a man made barrier built along a stream to 

provide protection from flooding.  A levee/floodwall can reduce 
flood damage by preventing flood stages from reaching a 
potential damage area. 

 
Levee Tool: Tool to create, delete, rename, and edit levees.  See Chapter 

7 (Section 7.13.2, page 7-32) for more details on creating, 
deleting, renaming, and editing levees. 

 
Map Windows: A way to graphically display the major components of a 

WAT study (stream alignments, schematics, alternatives, 
simulations).  From these map windows you can created, 
edit, delete, open model editors, or view results. 

 
Maps: A menu where you can setup map layers and map windows.  You 

can set spatial properties; zoom the active map window out to its 
full extents, add map layers, remove map layers, open a new map 
window, adjust the active map windows properties, save the 
contents of the active map window as a graphic file, import a 
stream alignment from an ArcView® shapefile, import impact 
areas from an ArcView® shapefile, export a stream alignment to 
an ArcView® shapefile, and, export impact areas to an 
ArcView® shapefile. 

 
Measure: Measures for the WAT include structural/non-structural 

measures (flood damage reduction), and/or ecosystem 
measures.  Structural measures are physical modifications 
designed to reduce the frequency of damaging levels of flood 
inundation, and include dams with reservoirs, levees, 
channelization measures, walls, diversion channels, pumps, 
bridge modifications, and ice-control structures.  Non-
structural measures are activities that reduce flood damage 
without significantly altering the nature or extent of flooding 
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(e.g., flood proofing, relocation of structures, raising 
structures).  Ecosystem restoration measures are physical 
modifications or other actions that improve the value and 
function of an ecosystem (e.g., channel improvements, 
removal of drainage structures or levees). 

 
Message Pane: Area of the WAT framework that contains messages that 

the WAT program is providing for informational 
purposes.  The information in the Message Pane is a 
record for the WAT program activity, recording the 
opening of the study, opening map windows, accessing 
DSS, and many other WAT activities. 

 
NED: National Economic Development; usually referring to the NED 

plan which is the plan the Corps is required to compute and report.  
It is the plan that provides the greatest economic benefits.  If a plan 
is recommended, most likely it is the NED plan. 

 
NexGen: Next Generation Software Development Project 
 
Northing: The Y-coordinate of a location in the user-selected World 

Coordinate System (WCS). 
 
Panes: Viewing areas of the WAT main window that allow you to view 

WAT study data. 
 
Pan Tool: Tool to move the display area while you are zoomed in. 
 
PDT: Project Delivery Team 
 
Plan: A set of one or more flood damage reduction or ecosystem 

restoration measures or actions designed to operate over a period 
of time (project life).  The plan is inclusive of the entire study area 
although it may have a flood damage reduction measure for a 
single damage reach. 

 
Plug-In: Provides the ability to access model parameters and view 

results of a model from the WAT 
 
PM: Project Manager 
 
Pointer/Selector Tool: Allows the user to select components for editing 

and viewing (plots) data or results. 
 
Project: A man-made structure for the purpose of reducing flood 

damage or for ecosystem restoration. 
 
R&U: Risk and Uncertainty 
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Raster Image: Generally defined as a rectangular array of sampled 

values (pixels).  Each pixel has one or more number 
associated with it, generally specifying a color the pixel 
should be display in.  The raster image formats 
supported by the WAT are JPEG format (*.jpg) and 
Graphics Interchange Format (*.gif).  For The WAT to 
access these file types an *.img (ASCII text) file must be 
created by the user outside of the WAT.  The file needs 
to contain the following lines, which need to match the 
easting and northing parameters stated in the Map 
Default Properties for StudyName dialog box (see 
Chapter 5, Section 5.2.5, page 5-6). 

 
Rating Curve: A graphical relationship that yields the stage for a 

given discharge at a specific location on a stream or 
river. 

 
Reservoir: The impoundment created behind dams, or behind 

navigation locks and dams. For the WAT a reservoir also 
includes the dam built on a stream to store water for uses 
such as navigation, tribal resources, flood damage reduction, 
fish and wildlife habitat considerations, hydroelectric power 
generation, recreation use, water quality, water supply, 
erosion and sedimentation control, and sustaining 
hydrologic function on lakes and rivers.  The releases from a 
reservoir can reduce flood damage by reducing flood stages. 

 
Reservoir Tool: Tool to create, delete, rename, and edit reservoirs.  See 

Chapter 7 (Section 7.13.1, page 7-27) for more detail on 
creating, deleting, renaming, and editing reservoirs. 

 
Results: A menu from which you can select simulations for comparison; 

and, view results from the individual WAT programs. 
 
Risk: The probability an area will be flooded, resulting in undesirable 

consequences. 
 
Risk Analysis: An approach to evaluation and decision making that 

explicitly, and to the extent practical, analytically, 
incorporates considerations of risk and uncertainty in a 
flood damage reduction study. 

 
Run: Capability within the WAT that allows the PDT to select the models 

they want to execute for a given event or events. 
 
Schematic: In the WAT, a physical representation of the study and it 

includes: common computation points, impact areas, stream 
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alignment, and flood damage reduction and environmental 
measures that will be modeled. 

 
Simulation: A combination of an analysis period and event(s) 

associated with an alternative. 
 
Stage: The vertical distance in feet (meters) above or below a local or 

national datum (N.G.V.D. for elevations). 
 
Stage Hydrograph: A graphical relationship of stage as a function of 

time for a certain location. 
 
Status Bar: Displays the coordinates of the pointer on a map window.  

Outside of a map window it reflects the status of the 
program. 

 
Stream Alignment: Represents the stream system in the watershed.  The 

alignment indicates where confluences and 
bifurcations occur and provides a sense of distance 
and scale.  In the WAT, stream alignments are 
composed of a series of stream elements. 

 
Stream Alignment Properties of a stream alignment that include: 
Properties: line width, color of line, font style, etc. 
 
Stream Alignment Tool is used to create, delete, and edit the stream  
Tool: elements that make up the stream alignments.  See 

Chapter 7 (Section 7.12, page 7-11) for more detail 
on creating, deleting, renaming, and editing a 
stream alignment. 

 
Stream Element: Segment of the stream alignment that is composed 

of vertex points, with the beginning and ending 
vertex points being stream nodes.  Typically begins 
or ends at a confluence, bifurcation, or at the 
boundary of the river system. 

 
Streamgage Records: Records of the stream elevation or stage taken at 

a streamgage location. 
 
Stream Node: The beginning and ending point for each stream element.  

Stream nodes are also created where stream elements 
meet.  Also, a stream node can be used to establish 
stationing for a stream element. 

 
Stream Node Tool: Tool is used to create, delete, and edit stream nodes 

on the stream alignment.  See Chapter 7 (Section 



Appendix H - Glossary HEC-WAT User's Manual 

H-10 

7.12.7, page 7-19) for more detail on creating, 
deleting, renaming, and editing a stream alignment. 

 
Stream Stationing: Watershed adopted stations along a stream normally 

denoted as miles (kilometers) above the mouth of a 
stream. 

 
Study: The basic component of the WAT.  The WAT study defines the 

watershed or geographic are to be evaluated.  The study includes 
alternative analyses which is the investigation of with and 
without-project conditions involving hydrology, hydraulics, 
economics, plan formulation and evaluation.  In the WAT it also 
includes all of the necessary information to complete an analysis 
of a specific geographical area. 

 
Study Pane: Area of the WAT framework that provides an overview of 

WAT alternatives, simulations, and analysis periods that 
have been defined for a study. 

 
System Units: This value is used as a label for data entry forms and 

output reports.  Choices are English or Metric, with the 
default being English. 

 
Tabs: Provides different views of the available data in a WAT study.  

The user can perform certain operations for a study from the tabs. 
 
Toolbar: Provides quick access to the most frequently used options from 

the WAT menu bar. 
 
Tools: A menu that provides access to DSS data (HEC-DSSVue); 

provides access to the Statistical Software Package (HEC-SSP); 
allows creating and editing of scripts; allows you to view general 
information about the study; provides options for the WAT 
startup and system properties; customize menus and toolbars; 
view WAT program activity; and, monitor memory usage.. 

 
Top of Levee: Stage at the top of the levee, floodwall or tidal barrier. 
 
Uncertainty: A measure of imprecision of knowledge of parameters and 

functions used to describe the hydraulic, hydrologic, 
geotechnical, and economic aspects of a project plan. 

 
USGS DEM: The USGS Geological Survey publishes the file format 

USGS DEM (Digital Elevation Map).  A raster file format, 
DEM files usually contain terrain elevations, but the file 
format can be used for representing any surface.  The 
format, published by the USGS, allows internal 
documentation of coordinate system, date of publication, 
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etc.  These values are referenced horizontally either to a 
Universal Transverse Mecator (UTM) projection or to a 
geographic coordinate system. 

 
USGS Digital USGS Digital Line Graphs (DLG) are created from two 
Line Graph: sources using manual and automated digitizing methods.  

The two sources are aerial photographs or cartographic 
sources.  DLG files are vector representations of the data.  
When the WAT interacts with a dlg file it automatically 
creates a dlgbin file for use. 

 
Vertex Point: A point with known coordinates on a stream element in 

the stream alignment. 
 
View: A menu that allows you to setup the WAT main window; you can 

select toolbars and panes; set display unit for plotting and 
tabulating; and manage layouts for the WAT main window. 

 
WAT: Watershed Analysis Tool, see HEC-WAT. 
 
Watershed: The total area of land that drains to a common stream 

system. 
 
Window: A menu where you can control the appearance of the map 

windows in the Desktop Pane of the WAT main window. 
 
With Project The economic, performance, and other conditions  
Conditions: associated with implementing a flood damage reduction 

plan.  It is compared to the without-project condition.  It 
includes the base-year and static future analysis year 
periods to determine the equivalent values. 

 
Without Project Base alternative in the WAT for evaluating the benefits  
Conditions: and performance of potential flood damage reduction 

plans and represents the conditions of the study if no 
actions are taken.  The without project conditions 
includes the base year conditions and the most likely 
future year conditions. 

 
World Coordinate To maintain a geographic reference (also called a 
System: geo-reference), the WAT uses a user-selected and 

customizable coordinate system, called the World 
Coordinate System (WCS).  This superimposes a 
grid on layer features to establish x- and y-
coordinates in WCS for each point on the layer.  The 
x-coordinate is referred to as "easting" and the y-
coordinate is referred to as "northing".  Possible 
choices for the WCS include but are not limited to 
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State Plane Coordinates and Universal Transverse 
Mercator (UTM) coordinates. 

 
Zoom Tool: Tool that allows zooming in and out of map windows.  See 

Chapter 7 (Section 7.3, page 7-3) for more detail on how 
this tool works in the WAT. 
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APPENDIX I  
 
 
 

Editing Model Data 
 
 
 

I.1 Overview 
 
The HEC-WAT provides an interface that streamlines and integrates a 
study using software commonly used within the corps.  This software is 
directly accessible from within the WAT, which allows the user to edit 
individual model data directly from the individual software pieces.  This 
flexibility is accomplished through the use of a "plug-in" (see Appendix 
B) that is built for each piece of software.  The plug-in allows the WAT 
and the individual software to communicate without any specific ode 
being need by the WAT or the individual software. 
 
From the WAT you have several options on editing model data.  You can 
execute the software that edits the model data by clicking the appropriate 
software button from the Programs Toolbar (see Chapter 3, Section 
3.2.1, page 3-4) of the WAT main window.  Also from the WAT main 
window, from the Study Tab, on the Study Pane (see Chapter 3, Section 
3.2.2, page 3-5), right-click on a simulation, from the shortcut menu, point 
to Edit Model, and then click on the model alternative you want to edit, 
the software associated with that model alternative will open. 
 
This appendix will focus on accessing specific editors from the available 
software, from within the WAT.  These editors can be accessed 
interactively from the schematic (Section I.2) or from the WAT main 
window (see Section I.3, page I-10) 
 
 

I.2 Schematic 
 
From the active simulation map window you can access model specific 
editors from the model elements that are available on the map window. If 
you hover over a model element, the tooltip that appears (see Figure I.1, 
page I-2) will list what model information is available for that particular 
model element.  For example, in Figure 11.1 (page I-2, at the junction 
there is possible information from ResSim, there must be a cross section in 
the area, and a reach element that is recognized by ResSim, HMS, and 
RAS. 
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Figure I.1  ToolTip Information from Schematic (Simulation Map Window) 

Figure I.2  Model Element Shortcut Menus 

To access model specific editors, right-click on a model element, you will 
get a shortcut menu (Figure I.2) that will provide access to the model 
editors.  The WAT searches for all available model elements in the area 

that you have right-clicked on, so the shortcut menu will usually display 
all the model elements that were found in the area.  For example, in Figure 
I.2, right-clicking at a cross section, the WAT has found three model 
elements in the area of that cross section.  To access the editor specific for 
the cross section, from the shortcut menu, point to Cross Section, click 
Edit Properties, the Cross Section Data Editor from RAS will open. 
 
The following sections will cover the available model editors in the Beta 
version of the WAT. 
 
 

I.2.1 HMS 
 
Whether you are right-clicking on a subbasin element, junction element, 
reach element, or sink element, from the schematic there are various HMS 
model editors you can access.  The following section describes those 
editors. 
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Figure I.4  HMS Editor - Subbasin 

Figure I.3 Subbasin Element Shortcut 
Menu 

 Subbasin Element 
 
To edit HMS model data at a subbasin: 
 
 1. From the simulation map window, right-click on an HMS subbasin 

model element on the schematic, a shortcut menu will appear 
(Figure I.3).  From the 
shortcut menu, point to 
Subbasin, click Edit 
Properties. 

 2. The HMS editor for 
subbasins will open (Figure 
I.4).  In the Beta version of 
the WAT, this dialog box 
might open behind the 
WAT for the first time.  
Once you bring the dialog box to the front, then after that the dialog 
box will open in front of the WAT. 

 3. This editor allows you to change parameters that are specific to a 
subbasin.  For further detail on this editor, reference the HMS 
User's Manual. 

 4. To close the HMS editor for subbasins (Figure I.4) click      . 
 

 Routing Reach Element 
 
 1. From the simulation map window, right-click on an HMS routing 

reach model element on the schematic, a shortcut menu will appear 
(see Figure I.5, page I-4).  From the shortcut menu, point to Reach, 
click HMS. 

 2. The HMS editor for a routing reach will open (see Figure I.6, page 
I-4).  In the Beta version of the WAT, this dialog box might open 
behind the WAT for the first time.  Once you bring the dialog box  
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Figure I.5 Routing Reach Element 
Shortcut Menu 

Figure I.7 Junction Element 
Shortcut Menu 

Figure I.6  HMS Editor – Routing Reaches 

  to the front, then after that the 
dialog box will open in front 
of the WAT. 

 3. This editor allows you to 
change parameters that are 
specific to a subbasin.  For 
further detail on this editor, 
reference the HMS User's 
Manual. 

 4. To close the HMS editor for 
routing reaches (Figure I.6) 
click      . 

 
 Junction Element 

 
 1. From the simulation map window, 

right-click on an HMS junction 
model element on the schematic, a 
shortcut menu will appear (Figure 
I.7).  From the shortcut menu click 
Edit Properties. 

 2. The HMS editor for a junction will 
open (see Figure I.8, page I-5).  In t
Beta version of the WAT, this dialo
box might open behind the WAT fo
the first time.  Once you bring the dialog box to the front, then after 
that the dialog box will open in front of the WAT. 

he 
g 
r 

 3. This editor allows you to change parameters that are specific to a 
junction.  For further detail on this editor, reference the HMS User's 
Manual. 
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Figure I.8  HMS Editor - Junction 

 4. To close the HMS editor for junctions (Figure I.8) click      . 

 
I.2.2 ResSim 

 
Whether you are right-clicking on a reservoir element, junction element, 
or reach element, from the schematic there are various ResSim model 
editors you can access.  The following section describes those editors. 
 

Figure I.9  Reservoir Element Shortcut Menu 

 Reservoir Element 
 
To edit ResSim model data at a reservoir: 
 
 1. From the simulation map window, right-click on a reservoir model 

element on the schematic, a shortcut menu will appear (Figure I.9).  
From the shortcut menu, point to Reservoir, click Edit Properties. 

 2. The ResSim Reservoir Editor will open (see Figure I.10, page I-6).  
In the Beta version of the WAT, this dialog box might open behind 
the WAT for the first time.  Once you bring the dialog box to the 
front, then after that the dialog box will open in front of the WAT. 
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Figure I.10  ResSim – Reservoir Editor 

Figure I.11  Junction Element Shortcut Menu 

 3. This editor allows you to change physical data requirements for the 
reservoir, change the operation sets for a reservoir, and specify 
observed data if needed.  For further detail on this editor, reference 
the ResSim User's Manual. 

 4. Click OK, the Reservoir Editor (Figure I.10) will close. 
 

 Junction Element 
 
To edit ResSim model data at a junction: 
 
 1. From the simulation map window, right-click on a junction model 

element on the schematic, a shortcut menu will appear (Figure I.11).  
From the shortcut menu, point to Junction, point to Edit 
Properties, click ResSim. 
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Figure I.12  ResSim – Junction Editor 

Figure I.13  Reach Element Shortcut Menu 

 2. The ResSim Junction Editor will open (Figure I.12).  In the Beta 
version of the WAT, this dialog box might open behind the WAT 
for the first time.  Once you bring the dialog box to the front, then 
after that the dialog box will open in front of the WAT. 

 3. This editor allows you to change information about a ResSim 
junction, add local flow and a rating curve, and if needed add 
information about observed data.  For further detail on this editor, 
reference the ResSim User's Manual. 

 4. Click OK, the Junction Editor (Figure I.12) will close. 
 

 Routing Reach Element 
 
To edit ResSim model data at a routing reach: 
 
 1. From the simulation 

map window, right-
click on a routing 
reach model element 
on the schematic, a 
shortcut menu will 
appear (Figure I.13).  
From the shortcut 
menu, point to 
Reach, point to Edit 
Properties, click 
ResSim. 
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Figure I.14  ResSim – Reach Editor 

 2. The ResSim Reach Editor will open (Figure I.14).  In the Beta 
version of the WAT, this dialog box might open behind the WAT 
for the first time.  Once you bring the dialog box to the front, then 
after that the dialog box will open in front of the WAT. 

 3. This editor allows you to change information about a ResSim reach, 
add/change routing information, edit information about losses for 
the reach, and if needed add information about observed data.  For 
further detail on this editor, reference the ResSim User's Manual. 

 4. Click OK, the Reach Editor (Figure I.14) will close. 
 
 

Figure I.15 Cross Section Element 
Shortcut Menu 

I.2.3 RAS – Cross Section Data Editor 
 
To edit RAS model data at a cross section: 
 
 1. From the simulation map 

window, right-click on a 
cross section model 
element on the schematic, 
a shortcut menu will 
appear (Figure I.15).  
From the shortcut menu, 
point to Cross Section, 
click Edit Properties. 

 2. The RAS Cross Section Data Editor will open (see Figure I.16, 
page I-9).  In the Beta version of the WAT, this dialog box might  
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Figure I.16  RAS – Cross Section Data Editor 

  open behind the WAT for the first time.  Once you bring the dialog 
box to the front, then after that the dialog box will open in front of 
the WAT. 

 3. This editor allows you to change information about a RAS cross 
section, add/change Manning's n values, edit cross section 
coordinates, and edit other information regarding a cross section.  
For further detail on this editor, reference the RAS User's Manual. 

 4. From the Exit menu, click Exit Cross Section Editor, the Cross 
Section Data Editor (Figure I.16) will close. 

 
 

Figure I.17 Impact Area Element 
Shortcut Menu 

I.2.4 FIA – Impact Area Editor 
 
To edit FIA model data at an impact area: 
 
 1. From the simulation map 

window, right-click on an 
impact area model element 
on the schematic, a shortcut 
menu will appear (Figure 
I.17).  From the shortcut 
menu click Edit Properties.  
The FIA Impact Area 
Editor will open  (see Figure 
I.18, page I-10).   

 2. In the Beta version of the WAT, this dialog box might open behind 
the WAT for the first time.  Once you bring the dialog box to the 
front, then after that the dialog box will open in front of the WAT. 

 3. This editor allows you to change information about an FIA impact 
area, add/change general information about an impact area, edit 
information about damage functions and crop information, and edit  
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Figure I.18  FIA – Impact Area Editor 

  impact response information regarding the impact area.  For further 
detail on this editor, reference the FIA User's Manual. 

 4. Click OK, the Impact Area Editor (Figure I.18) will close. 
 
 

Figure I.19  Edit Menu – Access to HMS Model Editors 

I.3 WAT Main Window 
 
From the menu bar of the main WAT window, click Edit (Figure I.19), 
from this menu you can access various editors that are specific to the 
software included in the program order for the study.  For example, in 

Figure I.19, point to HMS, the available commands allow you to execute 
the HMS program, or access several specific editors from the HMS 
program like the Basin Model Editor.  The following sections provide an 
overview of the available editors.  For more detail you will need to visit 
the user's manuals associated with each piece of software. 
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I.3.1 HMS 

 

Figure I.20  HMS – Basin Model Editor 

 Basin Model 
 
To edit HMS model data for a basin: 
 
 1. From the WAT main window, from the Edit menu (see Figure I.19, 

page I-10), point to HMS, click Basin Model. 
 2. The HMS Basin Model Editor will open (Figure I.20).  In the Beta 

version of the WAT, this dialog box might open behind the WAT 
for the first time.  Once you bring the dialog box to the front, then 
after that the dialog box will open in front of the WAT. 

 3. This editor allows you to change parameters that are specific to 
HMS basin.  For further detail on this editor, reference the HMS 
User's Manual. 

 4. From the File menu, click Exit, the HMS Basin Model Editor 
(Figure 11.20) will close. 

 
 Meteorologic Model 

 
To edit the HMS meteorologic model for a study: 
 
 1. From the WAT main window, from the Edit menu (see Figure I.19, 

page I-10), point to HMS, click Meteorologic Model. 
 2. The HMS Meteorologic Model Editor will open (see Figure I.21, 

page I-12).  In the Beta version of the WAT, this dialog box might 
open behind the WAT for the first time.  Once you bring the dialog  
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Figure I.21  HMS – Meteorologic Model Editor 

  box to the front, then after that the dialog box will open in front of 
the WAT. 

 3. This editor allows you to edit parameters that have been defined for 
the meteorologic model.  For further detail on this editor, reference 
the HMS User's Manual. 

 4. From the File menu, click Exit, the HMS Meteorologic Model 
Editor (Figure 11.21) will close. 

 
 Simulation Run 

 
To edit the defined parameters for an HMS simulation: 
 
 1. From the WAT main window, from the Edit menu (see Figure I.19, 

page I-10), point to HMS, click Simulation Run. 
 2. The HMS Simulation Run Editor will open (see Figure I.22, page 

I-13).  In the Beta version of the WAT, this dialog box might open 
behind the WAT for the first time.  Once you bring the dialog box 
to the front, then after that the dialog box will open in front of the 
WAT. 

 3. This editor allows you to edit parameters that have been defined for 
an HMS simulation run.  For further detail on this editor, reference 
the HMS User's Manual. 

 4. From the File menu, click Exit, the HMS Simulation Run Editor 
(see Figure 11.22, page I-13) will close. 

 
 Reach to Stream Mapping 

 
To edit the geographic location of HMS reaches: 
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Figure I.22  HMS – Simulation Run Editor 

Figure I.23  HMS Reach to Stream Editor 

 
 1. From the WAT main window, from the Edit menu (see Figure I.19, 

page I-10), point to HMS, click Reach To Stream Mapping. 
 2. The HMS Reach to Editor will open (Figure I.23).  This editor is 

not from HMS, but from the WAT.  Since the current version of 

HMS does not know about the coordinate system that the WAT has 
for a study, this editor allows you to enter information that will give 
the HMS model elements the correct geographic location on the 
schematic. 

 3. Click OK, the HMS Reach to Stream Editor (Figure 11.23) will 
close. 

 
 

I.3.2 ResSim 
 

 Time Step Information 
 
To edit time step and lookback duration for ResSim model alternatives: 
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Figure I.24  Edit Menu – Access to ResSim Model Editors 

Figure I.25  TimeStep Information Dialog Box 

 1. From the WAT main window, from the Edit menu (Figure I.24), 
point to ResSim, click TimeStep Information. 

 2. The TimeStep Information dialog box will open (Figure I.25).  
This editor is not from ResSim, but from the WAT.  The TimeStep 
Information dialog box allows you to adjust the time step and 
lookback duration for ResSim model alternatives if necessary. 

 3. Click OK, the TimeStep Information dialog box (Figure 11.25) 
will close. 

 
 Reservoir Editor 

 
To edit ResSim model data at a reservoir: 
 
 1. From the WAT main window, from the Edit menu (Figure I.24), 

point to ResSim, click Edit Reservoirs. 
 2. The ResSim Reservoir Editor will open (see Figure I.10, page I-6).  

This editor allows you to change physical data requirements for the 
reservoir, change the operation sets for a reservoir, and specify 
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Figure I.26  ResSim Editor 

observed data if needed.  For further detail on this editor, reference 
the ResSim User's Manual. 

 3. Click OK, the Reservoir Editor (Figure I.10) will close. 
 

 Reach Editor 
 
To edit ResSim model data at a reach: 
 
 1. From the WAT main window, from the Edit menu (see Figure I.24, 

page I-14), point to ResSim, click Edit Reaches. 
 2. The ResSim Reach Editor will open (see Figure I.14, page I-8).  

This editor allows you to change information about a ResSim reach, 
add/change routing information, edit information about losses for 
the reach, and if needed add information about observed data.  For 
further detail on this editor, reference the ResSim User's Manual. 

 3. Click OK, the Reach Editor (see Figure I.14, page I-8) will close. 
 

 ResSim Editor 
 
To edit ResSim simulation information: 
 
 1. From the WAT main window, from the Edit menu (see Figure I.24, 

page I-14), point to ResSim, click Edit Run Info. 
 2. The ResSim Editor will open (Figure I.26).  This editor allows you 

to edit options that will affect the way ResSim will compute.  Also, 
from this editor you can also access all of the individual ResSim 
editors.  For further detail on this editor, reference the ResSim 
User's Manual. 

 3. Click OK, the ResSim Editor (Figure I.26) will close. 
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I.3.3 RAS 
 

Figure I.27  Edit Menu – Access to RAS Model Editors 

 Geometric Data 
 
To edit geometric data associated with a RAS model alternative: 
 
 1. From the WAT main window, from the Edit menu (Figure I.27), 

point to RAS, click Geometric Data. 

 2. The RAS Geometric Data Editor will open (Figure I.28).  In the 
Beta version of the WAT, this dialog box might open behind the 
WAT for the first time.  Once you bring the dialog box to the front, 
then after that the dialog box will open in front of the WAT. 

Figure I.28  RAS – Geometric Data Editor 



HEC-WAT User's Manual Chapter I – Editing Model Data 

 I-17 

Figure I.29  RAS – Steady Flow Data Editor 

 
 3. This editor allows you to edit parameters that have been defined for 

the geometric data for a RAS model alternative.  For further detail 
on this editor, reference the RAS User's Manual. 

 4. From the File menu, click Exit Geometry Data Editor, the RAS 
Geometric Data Editor (see Figure I.28, page I-17) will close. 

 
 Steady Flow Data 

 
To edit steady flow data associated with a RAS steady flow model 
alternative: 
 
 1. From the WAT main window, from the Edit menu (see Figure I.27, 

page I-16), point to RAS, click Steady Flow Data. 
 2. The RAS Steady Flow Data Editor will open (Figure I.29).  In the 

Beta version of the WAT, this dialog box might open behind the 
WAT for the first time.  Once you bring the dialog box to the front, 
then after that the dialog box will open in front of the WAT. 

 3. This editor allows you to edit parameters that have been defined for 
the steady flow data for a RAS model alternative.  For further detail 
on this editor, reference the RAS User's Manual. 

 4. From the File menu, click Exit Flow Data Editor, the RAS Steady 
Flow Data Editor (Figure I.29) will close. 

 
 Quasi-Unsteady Flow Data 

 
To edit quasi-unsteady flow data associated with a RAS unsteady flow 
model alternative: 
 
 1. From the WAT main window, from the Edit menu (see Figure I.27, 

page I-16), point to RAS, click Quasi-Unsteady Flow Data. 
 2. The RAS Quasi Unsteady Flow Editor will open (see Figure I.30, 

page I-18).  In the Beta version of the WAT, this dialog box might 
open behind the WAT for the first time.  Once you bring the dialog 
box to the front, then after that the dialog box will open in front of 
the WAT. 
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Figure I.30  RAS – Quasi Unsteady Flow Editor 

 3. This editor allows you to edit parameters that have been defined for 
the quasi-unsteady flow data for a RAS unsteady flow model 
alternative.  For further detail on this editor, reference the RAS 
User's Manual. 

 4. Click OK, the RAS Quasi- Unsteady Flow Editor (Figure I.30) 
will close. 

 
 Unsteady Flow Data 

 
To edit unsteady flow data associated with a RAS unsteady flow model 
alternative: 
 
 1. From the WAT main window, from the Edit menu (see Figure I.27, 

page I-16), point to RAS, click Unsteady Flow Data. 
 2. The RAS Unsteady Flow Editor will open (see Figure I.31, page  
  I-19).  In the Beta version of the WAT, this dialog box might open 

behind the WAT for the first time.  Once you bring the dialog box 
to the front, then after that the dialog box will open in front of the 
WAT. 

 3. This editor allows you to edit parameters that have been defined for 
the unsteady flow data for a RAS unsteady flow model alternative.  
For further detail on this editor, reference the RAS User's Manual. 

 4. From the File menu, click Exit, the RAS Unsteady Flow Editor 
(see Figure I.31, page I-19) will close. 
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Figure I.31  RAS – Unsteady Flow Data Editor 
 

 Sediment Data 
 
To edit sediment data associated with a RAS model alternative: 
 
 1. From the WAT main window, from the Edit menu (see Figure I.27, 

page I-16), point to RAS, click Sediment Data. 
 2. The RAS Sediment Data Editor will open (see Figure I.32, page  
  I-20).  In the Beta version of the WAT, this dialog box might open 

behind the WAT for the first time.  Once you bring the dialog box 
to the front, then after that the dialog box will open in front of the 
WAT. 

 3. This editor allows you to edit parameters that have been defined for 
the sediment data for a RAS model alternative.  For further detail on 
this editor, reference the RAS User's Manual. 

 4. From the File menu, click Exit, the RAS Sediment Data Editor 
(see Figure I.32, page I-20) will close. 

 
 Water Quality Data 

 
To edit water Quality data associated with a RAS model alternative: 
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Figure I.32  RAS – Sediment Data Editor 

Figure I.33  RAS – Water Quality Data Editor 

 
 1. From the WAT main window, from the Edit menu (see Figure I.27, 

page I-16), point to RAS, click Water Quality Data. 
 2. The RAS Water Quality Data Editor will open (Figure I.33).  In 

the Beta version of the WAT, this dialog box might open behind the 
WAT for the first time.  Once you bring the dialog box to the front, 
then after that the dialog box will open in front of the WAT. 

 3. This editor allows you to edit parameters that have been defined for 
the water quality data for a RAS model alternative.  For further 
detail on this editor, reference the RAS User's Manual. 

 4. From the File menu, click Exit, the RAS Water Quality Data 
Editor (Figure I.33) will close. 

 
 Plan Data 

 
To edit plan data associated with a RAS model alternative: 
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Figure I.34  RAS – Steady Flow Editor 

 
 
 1. From the WAT main window, from the Edit menu (see Figure I.27, 

page I-16), point to RAS, click Plan Data. 
 2. The RAS Steady Flow Analysis Editor will open (Figure I.34).  In 

the Beta version of the WAT, this dialog box might open behind the 
WAT for the first time.  Once you bring the dialog box to the front, 
then after that the dialog box will open in front of the WAT. 

 3. This editor allows you to edit parameters that have been defined for 
the plan data for a RAS model alternative.  For further detail on this 
editor, reference the RAS User's Manual. 

 4. From the File menu, click Exit, the RAS Steady Flow Editor 
(Figure I.34) will close. 

 
 

I.3.4 FIA 
 

 Global Data Edtior 
 
To edit the global data associated with an FIA model alternative: 
 
 1. From the WAT main window, from the Edit menu (see Figure I.35, 

page I-22), point to FIA, click Global Data. 
 2. The FIA Global Data Editor will open (see Figure I.36, page  
  I-22).  In the Beta version of the WAT, this dialog box might open 

behind the WAT for the first time.  Once you bring the dialog box 
to the front, then after that the dialog box will open in front of the 
WAT. 

 3. This editor allows you to edit the global data that has been defined 
for an FIA model alternative.  For further detail on this editor, 
reference the FIA User's Manual. 
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Figure I.35  Edit Menu – Access to FIA Model Editors 

Figure I.36  FIA – Global Data Editor 

 4. Click OK, the FIA Global Data Editor (Figure I.36) will close. 

 
 Impact Area Editor 

 
To edit impact area data associated with an FIA model alternative: 
 
 1. From the WAT main window, from the Edit menu (Figure I.35), 

point to FIA, click Global Data. 
 2. The FIA Impact Area Editor will open (see Figure I.18, page  
  I-10).  In the Beta version of the WAT, this dialog box might open 

behind the WAT for the first time.  Once you bring the dialog box 
to the front, then after that the dialog box will open in front of the 
WAT. 
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Figure I.37  FIA – Alternative Editor 

 3. This editor allows you to change information about an FIA impact 
area, add/change general information about an impact area, edit 
information about damage functions and crop information, and edit 
impact response information regarding the impact area.  For further 
detail on this editor, reference the FIA User's Manual. 

 4. Click OK, the Impact Area Editor (see Figure I.18, page I-10) 
will close. 

 
 Alternative Editor 

 
To edit data associated with an FIA model alternative: 
 
 1. From the WAT main window, from the Edit menu (see Figure I.35, 

page I-22), point to FIA, click Alternative. 
 2. The FIA Alternative Editor will open (Figure I.37).  In the Beta 

version of the WAT, this dialog box might open behind the WAT 
for the first time.  Once you bring the dialog box to the front, then 
after that the dialog box will open in front of the WAT. 

 3. This editor allows you to change information about an FIA model 
alternative.  For further detail on this editor, reference the FIA 
User's Manual. 

 4. Click OK, the Alternative Editor (Figure I.37) will close. 
 

 Compute Project Benefits 
 
To set the compute project benefits for an FIA model alternative: 
 
 1. From the WAT main window, from the Edit menu (see Figure I.35, 

page I-22), point to FIA, click Edit Run Info. 
 2. The FIA Compute Project Benefits dialog box will open (see 

Figure I.38, page I-24).  In the Beta version of the WAT, this dialog 
box might open behind the WAT for the first time.  Once you bring 
the dialog box to the front, then after that the dialog box will open 
in front of the WAT. 
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 3. This dialog allows you to 
compute project benefits for 
an FIA model alternative.  For 
further detail on this editor, 
reference the FIA User's 
Manual. 

 4. Click OK, the Compute 
Project Benefits dialog box 
(Figure I.38) will close. 

 
 

Figure I.38 FIA – Compute Project 
Benefits Dialog Box 
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APPENDIX J  
 
 
 

Plots 
 
 
Plots are highly customizable and offer an array of information that will 
assist you with reviewing your data in HEC-WAT.  This appendix covers 
some of the capabilities of plots within the WAT.  For more detail, see the 
HEC-DSSVue User's Manual (Chapter 5). 
 
 

J.1 Plot Window 
 
The Plot window provides tools that facilitate the viewing of WAT data.  
The main window and the different components for the Plot window are 
illustrated in Figure J.1.  The Title Bar contains the name of the location 
that the data represents.  For example, in Figure J.1, the plot is illustrating 
the raw and revised data for stage and flow at a location called Beech 
Creek Sta. 

 

Menu Bar 

Pointer /Selector Tool 

Zoom Tool 

Title Bar 

Figure J.1  Plot Window 
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J.1.1 Menu Bar 

 
Following is an overview of the Menu Bar (see Figure J.1, page J-1) for 
the Plot window.  The commands available from the menus will facilitate 
the viewing and customizing of plots. 
 
 File From this menu you can view the plotted data in a tabular 

format, save the plot as a graphics file, save a template, use a 
template, copy the plot to the clipboard, and print the plot.  
Available commands are:  Tabulate, Save As, Save 
Template, Apply Template, Copy to Clipboard, Print, 
Page Setup, Print Preview, Print Multiple, and Close. 

 
 Plot From this menu you can customize the layout of an individual 

plot, and save a plot type.  Available commands are:  Select 
Variables, Open Plot Type and Save Plot Type. 

 
 Edit From this menu you can customize the plot.  Available 

commands are:  Plot Properties, Configure Plot Layout, 
Default Line Styles, and Default Plot Properties. 

 
 View From this menu you can have the plot window always on top 

of your desktop, and you can choose to use line styles.  
Available commands are:  Always On Top, Use Line Styles, 
and Zoom to all. 

 
 

J.1.2 Tools 
 
The Tools appear in a toolbar on the left side of the Plot window (see 
Figure J.1, page J-1).  The tools change the appearance of the mouse, as 
well as the functionality of the mouse: 
 
 Pointer/Selector Tool 
 
With the Pointer/Selector Tool, you can access shortcut menus that allow 
you to customize features of your plots using the plot editing tools. 
 
 Zoom Tool 
 
The Zoom Tool allows you to view data closely at a specific time.  To 
zoom in, hold the mouse button down and outline the area you want to 
enlarge.  To zoom out, click the right mouse button (right-click).  The 
zoom out is done by a factor of two and positions the clicked location at 
the center of the display area. 
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J.2 Customizing Plots 

 
 

J.2.1 Overview 
 
From the Plot window several editors allow you to configure default 
properties for all plots as well as customize individual plots.  Figure J.2 
shows the features plot area that can be configured. 

 
 Title You can add a title to all plots or to individual plots. 
 Marker You can add markers on the X- and Y-axes and customize 

the appearance of these markers. 
 Panel Background Color 
  You can specify the background color of the plot window 

(light grey is the default) for all plots only. 
 Curve/Line Properties 
  You can choose the line and point styles, add labels, and 

specify symbols to indicate quality. 
 Label You can add borders and backgrounds to axis and legend 

labels. 

Figure J.2  Elements of the Plot Window 

Panel 
Background 
Color 

Title of Plot

Curve/Line 

Marker 

Spacer 

Callout 

Viewport 

Label 

Legend 

Axis 
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 Spacer You can specify the distance between viewports, between 
a viewport and the legend, and the width of side margins. 

 Viewport You can customize the border around the viewport, the 
background color and pattern, and the appearance of 
gridlines.  You can also specify the number, size, and 
content of viewports. 

 Callout You can add descriptive callouts at specific points along a 
line. 

 Axis You can specify either a linear or log axis type, specify the 
axis scale, and customize tic marks. 

 Legend You can add titles to the plot legend and specify whether 
the legend appears below or to the right of the plot. 

 
 

J.2.2 All Plots 
 
You can customize all the plots for an entire watershed.  From the Plot 
window (see Figure J.1, page J-1), from the Edit menu, there are two 
commands - Default Line Styles and Default Plot Properties.  These 
commands will allow you to customize all new plot windows that will be 
accessed for a watershed. 
 

 Default Line Style Options 
 
The Default Line Style Options dialog box (Figure J.3) is specifically for 
adjusting the curves (lines) in all of your plots.  It allows you to add curve 
(line) types, change the color and fill of the curves (lines), and add labels 
for the curves (lines) for all plots.  For more detailed information on 
Default Line Style Options dialog box, refer to the HEC-DSSVue User's 
Manual (Chapter 5). 

 
Figure J.3  Default Line Style Options Dialog Box 
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From the Line tab (see Figure J.3, page J-4) you can set the color, style, 
and weight for your curves (lines) in all plots.  If the curves have points, 
you can also set the style, color, and fill color for the points on your curves 
in all plots. 
 
From the Default Line Style Options dialog box (see Figure J.3, page  
J-4) you can also add labels to the curves and adjust the position of the 
label (Label tab) for all plots.  You can manually adjust the maximum and 
minimum values for your X-axis, set viewport weight, and reverse the X-
axis (Defaults tab) for certain curve types such as Precip. 
 

 Default Plot Properties 
 
The Default Plot Properties dialog box (Figure J.4) allows you to 
configure allows you to set all of the other properties of your plots.  The 
worksheets for this dialog box allow you to make adjustment to the 
viewport, add a title for all plots, adjust grids, labels, axes, marker lines, 
and legend, change the color of the panel background, change the layout 
of the legend, and adjust the size of the spacer. 

 
To add a title for all plots: 
 
 1. Open a Plot window (see Figure J.1, page J-1). 
 2. From the Edit menu, click Default Plot Properties. 
 3. The Default Plot Properties dialog box will open (Figure J.4). 
 4. Click the Title tab; the Default Plot Properties dialog box will 

now display the Title worksheet (see Figure J.5, page J-6). 

Figure J.4  Default Plot Properties Dialog Box 



Chapter J - Plots HEC-WAT User's Manual 

J-6 

 5. To add a title, click Custom.  In the Title box enter a title that will 
appear on all of the plots in the watershed.  You can align the title, 
adjust the font size, add a border with color, and add a color 
background to the title. 

 6. Click Apply, the title will now appear on all plots. 
 7. Click OK, the Default Plot Properties dialog box will close, and 

all plots will display the title you entered. 
 
To change the panel background color for all plots: 
 
 1. Open a Plot window (see Figure J.1, page J-1). 
 2. From the Edit menu, click Default Plot Properties. 
 3. The Default Plot Properties dialog box will open (see Figure J.4, 

page J-5). 
 4. Click the Misc tab; the Default Plot Properties dialog box will 

now display the Misc worksheet (see Figure J.6, Page J-7). 
 5. To change the panel background color of the plot, from the Panel 

Background Color list, select a color. 
 6. Click Apply, to view the change, you must close the Default Plot 

Properties dialog box, close the Plot window, and then reopen the 
Plot window. 

 7. Click OK, the Default Plot Properties dialog box will close, and 
all plots will display the title you entered. 

 
 

Figure J.5  Default Plot Properties Dialog Box – Title 
W k h t

J.2.3 Individual Plots 
 
To customize individual plots that you are displaying (see Figure J.1, J-1) 
you can either use two dialog boxes, or using shortcut menus to make 
changes through individual editors.  The two dialog boxes are available 
from the Edit menu; there are two commands – Plot Properties and 
Configure Plot Layout. 
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Figure J.6  Default Plot Properties Dialog Box – Misc 
 

 Individual Plot Properties 
 
The Plot Properties dialog box (Figure J.7) allows you to configure 
multiple display properties of an individual plot.  This includes the border 
and background patterns of the viewport; add a title to the plot;  
adjust the gridlines of the plot; edit the titles, tic marks, and scale of an  

Figure J.7  Individual Plot Properties Dialog Box 
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axis; adjust the style, add points, and add quality symbols for curves; 
adjust the color, add labels, and position of marker lines; add a title, icon, 
and move the legend; change the color of the panel background; adjust the 
layout of the legend; and, the size of the spacer. 
 
To change the gridlines of an individual plot: 
 
 1. Open a Plot window (see Figure J.1, page J-1). 
 2. From the Edit menu, click Plot Properties. 
 3. The Plot Properties dialog box will open (see Figure J.7, page J-7). 
 4. The Title Bar displays the name of the location that data is being 

plotted. 
 5. If your plot has multiple viewports, the Select Viewport list 

displays the viewport where you're editing is taking place. 
 6. Click the Gridlines tab; the Plot Properties dialog box will now 

display the Gridlines worksheet (Figure J.8). 

 7. To change the color and style of the X-axis gridlines, from the 
Major X Grid box, click Custom.  From the Color list select the 
color you want.  You call also change the style of the grid from the 
Style list.  You can also change the Y-axis from the Major Y Grid 
box.  By default the minor gridlines for each axis is set to off, but 
by clicking Custom in each box you can turn the minor gridlines on 
for your plot. 

Figure J.8  Individual Plot Properties Dialog Box – Gridlines 
Worksheet
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 8. Click Apply, the color changes and style changes you made will 
now be reflect on the gridlines of your plot. 

 9. Click OK, the Plot Properties dialog box (see Figure J.8, page J-8) 
will close. 

 
 Configure Plot Layout 

 
The Configure Plot dialog box (Figure J.9) allows you to customize the 
layout of an individual plot.  You can add and remove axes, arrange the 
order of viewports, add and remove viewports, and set the weight of 
viewports.  The plot components are displayed in a tree structure. 
 
To add a viewport to an individual plot: 
 
 1. Open a Plot window (see Figure J.1, page J-1). 
 2. From the Edit menu, click Configure Plot Layout. 
 3. The Configure Plot dialog box will open (Figure J.9). 
 4. From Edit menu, click Add 

Viewport.  A new viewport 
will be added to the bottom 
of the tree. 

 5. You now need to add data 
from one of the other 
viewports to your new 
viewport.  If you do not add 
data, the viewport will not 
be saved.  Select a curve 
from one of the existing 
viewports, using the down move arrow, move the curve to the new 
viewport. 

 6. For example (Figure J.10), 
from Viewport (2,1), select 
BEECH JCT OBS FLOW.  
The down move arrow on 
the right-side of the 
Configure Plot dialog box 
becomes active.  Click the 
down move arrow, the 
selected curve moves to the 
new viewport (Viewport 
(3,1). 

 7. Click Apply, the plot will now have an additional viewport that 
displays the curve that was moved. 

 8. Click OK, the Configure Plot Editor (Figure J.10) will close, and 
your plot will display the changes that were made. 

 

Figure J.9  Configure Plot Dialog Box 

Figure J.10  Added Viewport with Data
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 Shortcut Menus 
 
When you want to edit a specific property of a plot without using the 
Individual Plot Properties dialog box (see Figure J.7, page J-8), you can 
use individual plot property dialog boxes instead.  To access these dialog 
boxes, select the Pointer/Selector tool, right-click on the element of the 
plot that (see in Figure J.2, page J-3) you want to edit, from the shortcut 
menu that appears, click Edit Properties. 
 
Edit Title Properties 
 
To add a title to an individual plot: 
 
 1. Right-click on the Plot window where the title is displayed or 

would be displayed (Figure J.11). 

 2. From the shortcut menu, click Edit Properties. 
 3. The Edit Title Properties dialog box will open (Figure J.12). 

 4. Click Custom, in the Title box, enter the title for the individual 
plot.  From this dialog box you can also set the alignment, the size 
of the font, and add a border and background colors to the title. 

 5. Click Apply, the title will now be displayed on the plot. 
 6. Click OK, the Edit Title Properties dialog box (Figure J.12) will 

close. 
 

Figure J.11  Plot Title Shortcut Menu 

Figure J.12  Edit Title Properties Dialog Box 
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Edit Marker Lines Properties 
 
To edit the maker lines of an individual plot: 
 
 1. Right-click on the Plot window where the marker line is displayed 

(Figure J.13). 

 2. From the shortcut menu, click Edit Properties. 
 3. The Edit Marker Line 

Properties dialog box 
will open (Figure J.14). 

 4. To change the style of 
the marker line, you 
need to work from the 
Style worksheet.  This 
worksheet should be the 
default.  You can c
the color, style, and 
weight of the mark
line.  You can also add
fill if you wish. 

Figure J.13  Marker Line Shortcut Menu 

hange 

er 
 

 5. If you want to add a 
label to the marker line, 
click the Label/Value 
tab.  From the 
Label/Value worksheet, 
you can add a label, the 
alignment of the label, 
and the placement of the 
label along the marker 
line. 

 6. If your plot has more than one viewport, you will have to set marker 
line properties for each viewport. 

 7. Click Apply, the changes to the marker line will now be displayed 
on the plot. 

 8. Click OK, the Edit Marker Line Properties dialog box (see 
Figure J.14, page J-11) will close. 

 

Figure J.14 Edit Marker Line 
Properties Dialog Box 



Chapter J - Plots HEC-WAT User's Manual 

J-12 

Edit Curve Properties 
 
To edit the curves of an individual plot: 
 
 1. Right-click on the Plot window where a curve is displayed (Figure 

J.15). 

 
 2. From the shortcut menu, click Edit Properties. 
 3. The Edit Curve Properties dialog box will open (Figure J.16). 

 4. To change the style of the curve, you need to work from the Style 
worksheet.  This worksheet should be the default.  You can change 
the color, style, and weight of the curve.  You can also add fill if 
you wish. 

Figure J.15  Curve Shortcut Menu 

Figure J.16  Edit Curve Properties Dialog Box 
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 5. The data that creates the curves in your plots could have quality 
attached to it.  This means the data has been checked to see if what 
CWMS received is correct.  If you want you can have the curves 
display their quality.  Click Quality Symbols tab, from the 
worksheet you can set the symbol and color for each type of quality 
that is provided by CWMS. 

 6. If your plot has more than one curve, you will need to edit 
properties for each curve individually. 

 7. If your plot has more than one viewport, you will have to set curve 
properties for each viewport. 

 8. Click Apply, the changes to the marker line will now be displayed 
on the plot. 

 9. Click OK, the Edit Curve Properties dialog box (see Figure J.16, 
page J-12) will close. 

 
To add a callout to a curve of an individual plot: 
 
 1. Right-click on the Plot window where a curve is displayed (see 

Figure J.15, page J-12). 
 2. From the shortcut menu, click Add Callout. 
 3. The Add Callout dialog box will open (Figure J.17). 
 4. Enter the callout you want i

the Callout Text box. 
n 

 4. Click Apply, the changes to 
the marker line will now be 
displayed on the plot. 

 5. Click OK, the new callout 
will now be displayed on the 
plot and the Add Callout dialog box (Figure J.17) will close. 

 
Edit Axis Title Properties 
 
To edit the appearance of axis titles for an individual plot: 
 
 1. Right-click on the Plot window where the axis titles are displayed 

(Figure J.18). 

 

Figure J.17  Add Callout Dialog Box 

Figure J.18  Axis Title Shortcut Menu 
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 2. From the shortcut menu, click Edit Properties. 
 3. The Edit Label Properties dialog box will open (Figure J.19). 

 4. To give an axis title a border, in the Border box, click Custom.  
You can set the color, style, and weight of the border around the 
axis title. 

 5. To give an axis title a background color, in the Background box, 
click Custom.  You can set the color and the pattern of the 
background for the axis title. 

 6. Click Apply, the axis title will now be displayed with whatever 
changes you made. 

 7. Click OK, the Edit Label Properties dialog box (Figure J.19) will 
close. 

 
Edit Spacer Properties 
 
To edit the spacer properties for an individual plot: 
 
 1. Right-click on the Plot window where the spacer is (Figure J.20) 

located on the plot.  Spacers are between viewports, on either side 
of each viewport, and the top of the plot. 

 2. From the shortcut menu, click Edit Properties. 
 3. The Edit Spacer 

Properties dialog box 
will open (Figure 
J.21). 

 4. Enter the size of the 
spacer in pixels in the 
Size in Pixels box. 

Figure J.19  Edit Label Properties Dialog Box 

Figure J.20  Spacer Shortcut Menu 

Figure J.21  Edit Spacer Properties Dialog Box
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 5. Click Apply, the changes you made to the spacer will appear on the 
plot. 

 6. Click OK, the Edit Spacer Properties dialog box (see Figure J.21, 
page J-14) will close. 

 
Edit Viewport Properties 
 
To edit the viewports of an individual plot: 
 
 1. Right-click on the Plot window where a viewport is displayed 

(Figure J.22). 

 2. From the shortcut menu, click Edit Properties. 
 3. The Edit Viewport Properties dialog box will open (Figure J.23). 

 4. To change the border or give a background color to a viewport, you 
need to work from the Patterns worksheet.  This worksheet should 
be the default.  Click Custom, from the Border box you can 
change the color, style, and weight of the viewport border. 

 5. Still on the Patterns worksheet, click Custom, from the 
Background box you can select a color and pattern for the 
background of the viewport. 

 6. If you want to change the gridlines of the viewport, click the 
Gridlines tab.  The Gridlines worksheet is available (similar to 
Figure J.8, page J-8).  To change the color and style of the X-axis 
gridlines, from the Major X Grid box, click Custom.  From the 
Color list select the color you want.  You call also change the style 

Figure J.22  Viewport Shortcut Menu 

Figure J.23  Edit Viewport Properties Dialog Box 
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of the grid from the Style list.  You can also change the Y-axis from 
the Major Y Grid box.  By default the minor gridlines for each 
axis is set to off, but by clicking Custom in each box you can turn 
the minor gridlines on for your plot. 

 7. If your plot has more than one viewport, you will have to set curve 
properties for each viewport. 

 8. Click Apply, the changes to the viewport will now be displayed on 
the plot. 

 9. Click OK, the Edit Viewport Properties dialog box (see Figure 
J.23, page J-15) will close. 

 
Edit Axis Tics Properties 
 
To edit the X-axis scale of an individual plot: 
 
 1. Right-click on the Plot window where the X-axis is displayed 

(Figure J.24). 

 2. From the shortcut menu, click Edit Properties. 
 3. The Edit Axis Properties dialog box will open (Figure J.25). 
 4. To change the scale of the 

X-axis, you need to work 
from the Scale worksheet.  
This worksheet should be t
default.  The worksheet 
displays the default settings 
for the X-axis scale. 

Figure J.24  Axis Tics Shortcut Menu 

he 

 5. Still on the Scale worksheet, 
click the Maximum 
checkbox.  You can enter a 
new maximum value for the 
X-axis. 

 6. If you want to change the tic 
marks of the X-axis, click 
the Tics tab.  By default 
major tic marks are selected 
with tic mark labels with a 
default color of black.  You 
can add minor tics marks, do 
minor tic marks only, and change the color of the tic mark and tic 
mark label. 

Figure J.25 Edit Axis Tics 
Properties Dialog Box 
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 7. If your plot has more than one viewport, you will have to set axis 
tics properties for each viewport. 

 8. Click Apply, the changes to the X-axis will now be displayed on 
the plot. 

 9. Click OK, the Edit Axis Properties dialog box (see Figure J.25, 
page J-16) will close. 

 
Edit Legend Panel Properties 
 
To edit the legend panel of an individual plot: 
 
 1. Right-click on the Plot window where the legend panel is displayed 

(Figure J.26). 

 2. From the shortcut menu, click Edit Properties. 
 3. The Edit Legend Properties dialog box will open (Figure J.27). 

 4. You can give the legend panel a title by entering information in the 
Legend Title box. 

 5. You can also an icon and information to the left and right areas of 
the legend bock.  For example, if you want a description to display 
on the left side of the legend panel, in the Left Block Area group, 
in the Text box, enter the description information. 

 6. To add an icon, you need to enter the path and filename of icon to 
be display in the Icon box for either the left or right sides of the 
legend panel. 

 8. Click Apply, the changes to the legend panel will now be displayed 
on the plot. 

 9. Click OK, the Edit Legend Properties dialog box (see Figure J.27, 
page J-17) will close. 

 

Figure J.26  Legend Panel Shortcut Menu 

Figure J.27  Edit Legend Properties Dialog Box 
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J.2.4 Exporting and Importing Templates 
 
After you have customized a plot, you can save its settings as a template 
for use in other plots.  Generally, you would use templates when scripting 
plots.  For example, every day you generate a plot of flow, stage, and 
precipitation via a script, and then apply a template that has all of the 
correct formatting, such as viewport placement, size, line colors, and fills. 
 
To create a template from a plot: 
 
 1. Open a Plot window (see Figure J.1, page J-1). 
 2. From the File menu, click Save Template. 
 3. The Export Plot Template… dialog box will open (Figure J.28). 
 4. Specify whether you 

want the template to be 
available for All 
Applications or This 
Watershed only.  Then 
enter a name for the 
template in the Name 
box. 

 5. Click OK, the Save 
Template dialog box 
will c1ose, and the 
template will be saved. 

 
To apply (import) a template 
you have created to another 
plot currently open: 
 
 1. Open a Plot window (see 

Figure J.1, page J-1). 
 2. From the File menu, click Apply Template. 
 2. The Import Plot Template dialog box opens, which is very similar 

to the dialog box in Figure J.28. 
 3. Specify whether you want the template to be available for All 

Applications or This Watershed only. 
 4. A list of available templates will display.  Choose the template you 

want by clicking on its name. 
 5. When you select a template, its name will display in the Name box. 
 6. Click OK to apply the template to the current plot and close the 

dialog box. 
 

Figure J.28 Export Plot Template… 
Dialog Box 
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APPENDIX K  
 
 
 

Printing and Copying Data 
 
 
Plots and tables in HEC-WAT offer detailed views of data and model 
results that you can print or copy and paste into other applications.  In 
addition, you can print reports generated by the individual models. 
 
 

K.1 Plots 
 
Plots provide a graphical representation of your data.  From the Plot 
Window (Figure K.1) you can view the plot, as well as print, save as a 
graphics file, copy the contents of the Plot Window to the clipboard, and 
save the properties of the plot to a template to be used by other plots.  
Following is an overview of the menu bar of the Plot Window.  The 
commands available from the menus are: 

 
Figure K.1  Plot Window 
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 File From this menu you can view the plotted data in a tabular 
format, save the plot as a graphics file, save a template, use a 
template, copy the plot to the clipboard, and print the plot.  
Available commands are:  Tabulate, Save As, Save 
Template, Apply Template, Copy to Clipboard, Print, 
Page Setup, Print Preview, Print Multiple, and Close. 

 
 Plot From this menu you can customize the layout of an individual 

plot, and save a plot type.  Available commands are:  Select 
Variables, Open Plot Type and Save Plot Type. 

 
 Edit From this menu you can customize the plot.  Available 

commands are:  Plot Properties, Configure Plot Layout, 
Default Line Styles, and Default Plot Properties. 

 
 View From this menu you can have the plot window always on top 

of your desktop, and you can choose to use line styles.  
Available commands are:  Always On Top, Use Line Styles, 
and Zoom to all. 

 
The Tools appear in a toolbar on the left side of the Plot window (see 
Figure K.1, page K-1).  The tools change the appearance of the mouse, as 
well as the functionality of the mouse: 
 
 Pointer/Selector Tool 
 
With the Pointer/Selector Tool, you can access shortcut menus that allow 
you to customize features of your plots using the plot editing tools. 
 
 Zoom Tool 
 
The Zoom Tool allows you to view data closely at a specific time.  To 
zoom in, hold the mouse button down and outline the area you want to 
enlarge.  To zoom out, click the right mouse button (right-click).  The 
zoom out is done by a factor of two and positions the clicked location at 
the center of the display area. 
 
 

K.1.1 Save As 
 
The Save As command will allow you to save your plot to a graphics file.  
CWMS has four possible formats:  Windows Metafile (*.wmf), Postscript 
(*.ps), JPEG (*.jpg, *.jpeg), and Portable Network Grap0hics (*.png). 
 
To create a graphics file: 
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 1. On the File menu, click Save As, the Save browser will open 
(Figure K.2). 

 2. Find the location where you want to save the graphics file. 
 3. Enter a name for the file in the File name box. 
 4. From the Files of type list, select the type of graphics file you wish 

to create. 
 5. Click Save, a file with the appropriate extension will be created in 

the selected location.  The file will contain the contents of the Plot 
Window (see Figure K.1, page K-1). 

 
 

Figure K.2  Save Browser 

K.1.2 Copy to Clipboard 
 
The Copy to Clipboard command will copy the contents of the Plot 
Window to the clipboard.  Once the copy is complete, you can paste the 
plot as an image into other applications. 
 
 

K.1.3 Print Commands 
 
The Plot Window (see Figure K.1, page K-1) provides the user with 
several different commands to setup the printing process and to print. 
 

 Print 
 
The Print command opens a standard system Print dialog box (see Figure 
K.3, page K-4).  From the dialog box you can select the printer, choose to  
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print to a file, and the number of copies to print.  Click OK, the Print 
dialog box will close and the plot will print to the selected printer. 

 
 Page Setup 

 
The Page Setup command opens the Page Setup dialog box (Figure K.4).  
When using this dialog box, you can setup the format of the printed page.  
Following is a list of the 
available options: 
 
 Orientation 
  By default, the page 

will be printed in 
Portrait.  In 
addition, you can 
choose to print in 
Landscape or 
Reversed (does not 
work in the Beta 
version of the 
WAT). 

 
 Margins 
  The default margin 

settings are 
displayed in the 
Margins area of the 
Page Setup dialog 
box.  If you want to  

Figure K.3  Print Dialog Box 

Figure K.4  Page Setup Dialog Box 
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  set the margins, click Set 
Margins, the Printer 
Margins dialog box (Figure 
K.5) will open.  From this 
dialog box, you can adjust 
the top, left, bottom, and 
right margins. 

 Additional Options 
  If you would like page 

numbers included on your 
printed page, select the 
Page Numbers check box 
(see Figure K.4, page K-4).  
The Frame around plot option is not available in the Beta version 
of the WAT. 

 Printer Scale 
  The default option is Maximum Plotting Area, and in the Beta 

version of the WAT, is the only available option. 
 

 Print Preview 
 
The Print Preview command opens the Preview dialog box (Figure K.6).  
From this dialog box, you can view the plot, adjust the scaling of the plot, 
and print the plot.  The Print command automatically prints the plot to the 
default system printer. 

 

Figure K.5  Printer Margins Dialog Box

Figure K.6  Preview Dialog Box 
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 Print Multiple 
 
The Print Multiple command opens the Print Multiple dialog box 
(Figure K.7).  To be able to print multiples plots you must have opened 
multiple individual plot windows.  The open plots are listed in the 

Available Plots list of the Print Multiple dialog box.  To select plots to 
be printed on one page, double-click on a plot name in the Available Plots 
list.  The plot name will move to the Selected Plots list.  You can adjust 
the way the plots are arranged on a page, horizontally or vertically.  Use 
the Number Across or Number Down sliders.  The grid to the right of 
the sliders reflects your choices.  From the File menu, the Page Setup and 
Print Preview commands are available. 
 
 

Figure K.7  Print Multiple Dialog Box 

K.2 Tables 
 
Tables provide a tabular format of your data.  From the Tabulate 
Window (see Figure K.8, page K-7) you can view the data, as well as 
print the table, copy the selected contents of the Tabulate Window to the 
clipboard, adjust the display of the data, and save the data to an ASCII 
file.  Following is an overview of the menu bar of the Tabulate Window.  
The commands available from the menus are: 
 
 File From this menu, you can print the data in a tabular format and 

view a plot of the data.  Available commands are:  Print, 
Print Preview, Export, Plot, and Close. 

 
 Edit From this menu, select data to be copied to the clipboard.  

Available commands are:  Copy, Select All, Find, and 
Compare data sets. 
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 View From this menu, 
you can control 
the appearance of 
the data d
in the Tabulate 
Window.  
Available 
commands
Commas, Date 
and Time 
Separately
with 4 Digit 
Years, Show 
Decimal Place
(auto, 1 - 6), and 
Show Missing As (blank, -901.00, M, -M-). 

isplayed 

 are:  

, Date 

s 

 
 

Figure K.8  Tabulate Window 

K.2.1 Copying to the Clipboard 
 
To copy data from the Tabulate Window (Figure K.8) to the clipboard, 
there are several ways.  To use the Copy command from the Edit menu, 
you must first select the cells in the table you wish to copy to the 
clipboard.  If you want the whole table, from the Edit menu choose Select 
All.  If there is, only a certain area you wish to copy to the clipboard, from 
the table click and drag over the cells you wish to copy, your selection will 
be highlighted.  With either method, then from the Edit menu choose 
Copy.  The contents will then be copied to the clipboard you can paste the 
data into other applications.  In addition, if you right-click on the table, a 
shortcut menu will appear which will also allow you to copy data to the 
clipboard. 
 
 

K.2.2 Displaying Data 
 
By default, data is displayed with commas and two decimal places.  If you 
want to change the way the data is displayed, from the View menu there 
are several options.  If you do not want commas displayed, from the View 
menu, click Commas. 
 
For time series data the date and time are displayed in the following 
default format:  ddmmmyy hhmm.  You can change the way the date and 
time are displayed.  From the View menu, click Date and Time 
Separately; the date and time are now displayed in two separate columns 
in the table.  Another way is from the View menu, click Date with 4 Digit 
Years; the date and time now displays a four-digit year instead of a two-
digit year. 
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Numbers by default are displayed with two decimal places.  If you want to 
see more or less number of decimal places, from the View menu, point to 
Decimal Places, and click on the number (0 thru 6) of decimal places you 
would like displayed. 
 
 

K.2.3 ASCII File 
 
You can save the table of data to an ASCII file, right-click on the table.  
From the shortcut menu, click Export, the Table Export Options dialog 
box will open (Figure K.9).  From this dialog box, you can set certain 
options for the ASCII file. 
 
You can set the delimiter for 
the file from the Field 
Delimiter list.  The 
hardwired choices are TAB 
(default), SPACE, 
COMMA, and COLON.  
You also make choices on 
whether the file contains 
fixed width columns, strings 
are set in quotes, whether to 
include column headers in 
the file, include gridlines in 
the file, and whether to 
include the a title in the file. 
 
When you have all of your options set, click OK.  A Save browser will 
open.  Find the location where you want the file saved, and provide a 
filename.  Click Save, the file will be created without an extension, since 
this is an ASCII file, you might want to give the file an extension of .txt. 
 
 

Figure K.9  Table Export Options Dialog Box 

K.2.4 Printing 
 
The Print command opens the Properties dialog box will open (see 
Figure K.10, page K-9).  From this dialog box, you can set up the format 
of the table for output. 
 
From the Page Worksheet (see Figure K.10, page K-9), you can set the 
orientation; fit the table to a page, and whether to include the entire table 
or only a selection.  In addition, you also choose to print the table in 
ASCII, add headers, add background color to headers (non-ASCII option), 
and add gridlines. 
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If you want to add header or f
information to the table repor
click the Header/Footer tab 
(Figure K.10).  From the 
Header/Footer Worksheet 
enter header or footer 
information. 

oot 
t, 

 
The title of the table report 
defaults to the pathname tag 
associated with the data.  If you 
want to change this title, click 
the Table Title tab.  From the 
Table Title Worksheet enter or 
change the title, and decide if 
you want the title to print on 
each page of the report.  When 
you have everything set, click 
Print, a standard system Print 
(see Figure K.3, page K-3) 
dialog box will open. 
 
To preview you table report, right-click on the table, from the shortcut 
menu click Print Preview.  A dialog box similar to the Properties dialog 
box (Figure K.10) will open.  Setup your options for the table report; click 
Preview, and the Print Preview dialog box (Figure K.11) will open.  
From this dialog box, you can view the table report, adjust the scaling of 
the report, and print the report.  The Print command automatically prints 
the report to the default system printer. 

 

Figure K.10  Properties Dialog Box 

Figure K.11  Print Preview Dialog Box 
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K.3 Printing Reports from HEC-WAT 

 
The printing of reports from the BETA version of the WAT are handled 
by the individual programs.  In future version of the WAT, there could be 
WAT specific reports that will be printed. 
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Appendix L  
 
 

Terms and Conditions of Use 
 
 
Use of the program is governed by the terms and conditions of use.  They 
limit what can be done with the program software, waive warranty, limit 
liability, and indemnify the developers and the United States government.  
The program cannot be used unless the terms and conditions of use are 
accepted; the full text is given below. 
 
 

 Terms and Conditions of Use 
 
The United States Government, US Army Corps of Engineers, Hydrologic 
Engineering Center ("HEC") grants to the user the rights to install 
Watershed Analysis Tool (HEC-WAT) "the Software" (either from a disk 
copy obtained from HEC, a distributor or another user or by downloading 
it from a network) and to use, copy and/or distribute copies of the 
Software to other users, subject to the following Terms and Conditions of 
Use: 
 
All copies of the Software received or reproduced by or for user pursuant 
to the authority of this Terms and Conditions of Use will be and remain 
the property of HEC. 
 
User may reproduce and distribute the Software provided that the recipient 
agrees to the Terms and Conditions for Use noted herein. 
 
HEC is solely responsible for the content of the Software.  The Software 
may not be modified, abridged, decompiled, disassembled, unobfuscated 
or reverse engineered.  The user is solely responsible for the content, 
interactions, and effects of any and all amendments, if present, whether 
they be extension modules, language resource bundles, scripts or any other 
amendment. 
 
The name "HEC-WAT" must not be used to endorse or promote products 
derived from the Software.  Products derived from the Software may not 
be called "HEC-WAT" nor may any part of the "HEC-WAT" name appear 
within the name of derived products. 
 
No part of this Terms and Conditions for Use may be modified, deleted or 
obliterated from the Software. 
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No part of the Software may be exported or re-exported in contravention 
of U.S. export laws or regulations. 
 
Waiver of Warranty 
 
THE UNITED STATES GOVERNMENT AND ITS AGENCIES, 
OFFICIALS, REPRESENTATIVES, AND EMPLOYEES, INCLUDING 
ITS CONTRACTORS AND SUPPLIERS PROVIDE HEC-WAT \"AS 
IS,\" WITHOUT ANY WARRANTY OR CONDITION, EXPRESS, 
IMPLIED OR STATUTORY, AND SPECIFICALLY DISCLAIM ANY 
IMPLIED WARRANTIES OF TITLE, MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT.  
Depending on state law, the foregoing disclaimer may not apply to you, 
and you may also have other legal rights that vary from state to state. 
 
Limitation of Liability 
 
IN NO EVENT SHALL THE UNITED STATES GOVERNMENT AND 
ITS AGENCIES, OFFICIALS, REPRESENTATIVES, AND 
EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS, 
BE LIABLE FOR LOST PROFITS OR ANY SPECIAL, INCIDENTAL 
OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR IN 
CONNECTION WITH USE OF HEC-WAT REGARDLESS OF CAUSE, 
INCLUDING NEGLIGENCE. 
 
THE UNITED STATES GOVERNMENT’S LIABILITY, AND THE 
LIABILITY OF ITS AGENCIES, OFFICIALS, REPRESENTATIVES, 
AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND 
SUPPLIERS, TO YOU OR ANY THIRD PARTIES IN ANY 
CIRCUMSTANCE IS LIMITED TO THE REPLACEMENT OF 
CERTIFIED COPIES OF HEC-WAT WITH IDENTIFIED ERRORS 
CORRECTED.  Depending on state law, the above limitation or exclusion 
may not apply to you. 
 
Indemnity 
 
As a voluntary user of HEC-WAT you agree to indemnify and hold the 
United States Government, and its agencies, officials, representatives, and 
employees, including its contractors and suppliers, harmless from any 
claim or demand, including reasonable attorneys' fees, made by any third 
party due to or arising out of your use of HEC-WAT or breach of this 
Agreement or your violation of any law or the rights of a third party. 
 
Assent 
 
By using this program you voluntarily accept these terms and conditions.  
If you do not agree to these terms and conditions, uninstall the program 
and return any program materials to HEC (If you downloaded the program 
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and do not have disk media, please delete all copies, and cease using the 
program.) 
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 HEC-WAT, xvii, xix, 1-1, 1-2, 2-1, 2-5, 3-1, 3-2, 
   4-1, 4-6, 5-1, 5-2, 6-1 
  icon, 2-5 
 HEC-WAT Framework, 3-1 
 HEC-WAT Splash Dialog Box, 2-5 
 Help, 3-4 
 historical, 2-4 
 HMS, 2-2, 3-1 thru 3-3, 3-5, 3-10, 4-7 
 horizontal tile, 3-3 
 hydraulic, 1-1, 2-2 
 hydraulic engineer, 2-2 
 hydrologic, 1-1, 2-2, 2-4 
  response, 2-4 
 Hydrologic Engineering Center, xvii, xix 
 Hydrologic Modeling Systems, 2-2 
 hydrologic response, 2-4 
 hydrologist, 2-2 
 hydrometeorological data, 3-1 
 hypothetical, 2-4 
 
I 
 
 icon, 2-5 
 identification 
  model, 1-2, 2-2, 6-1 
 identify, 2-2 
 Identify a WAT Study, 2-2 
 impact, 1-1, 3-1, 3-7, 4-8, 5-14, 6-5, 6-7, 6-11,  
   6-12 
  areas, 3-1, 3-9, 4-8, 5-14, 6-5, 6-7, 6-11, 6-12 
  social, 1-1 
 impact areas, 3-1, 3-3, 3-9, 4-8, 5-14, 6-5, 6-7,  
   6-11, 6-12 
  edit, 6-5, 6-11 
 impacts, 1-1 

 images, 5-15 
 implementation, 1-1 
 import, 3-3 
  impact areas, 3-3 
  stream alignment, 3-3 
 Import, 3-2, 3-3 
 imported, 2-2, 3-1, 5-9 
 importing, 2-3, 2-4, 3-2 
 input data, 2-2 
 integrate, xix, 1-1, 3-10 
 integrates, 2-1, 3-1 
 interface, xvii, xix, 1-1, 2-1, 2-2, 3-1, 3-10 
  common, 1-1 
  WAT, 2-1, 3-1 
 interfaces, 2-2, 3-1, 3-16 
 Introduction, 1-1 
 
J 
 
 JPEG, 5-2 
 junctions, 5-12, 5-13 
 Junction Color, 5-13 
 Junction Width, 5-13 
 
L 
 
 labels, 5-9, 5-11, 5-12 
 label, 5-5 
  stream, 5-11 
  tic mark, 5-12 
 layer, 2-3, 4-5, 5-1, 5-3 thru 5-9 
  map, 2-3, 4-5, 5-3 thru 5-5, 5-7, 5-8 
 Layer Visualization Scaling, 5-15 
 layers, 1-2, 2-2, 2-3, 3-1, 3-3, 3-8, 4-4, 4-7, 4-8,  
   5-1, 5-3 thru 5-5, 5-7, 5-9, 5-15 
  primary, 5-1 
 Layout Manager, 3-3 
 layouts, 3-2, 4-8 
 legend, 5-5 
 length, 5-11 
 levees, 2-3, 3-1 
 lines, 5-3, 5-9, 5-10 
 link, 3-4 
 linking, 2-2 
 locations, 1-2, 2-2, 2-3, 3-1 
  gage, 2-3, 3-1 
  reservoir, 2-3 
 logs 
  compute, 3-3 
 logistics, 1-1 
 
M 
 
 main window, 2-5, 3-1, 3-2, 3-4, 3-5, 4-2, 6-2,  
   6-4 thru 6-7 
  study name, 4-2 
 



Index HEC-WAT User's Manual 

Index-8 

  title bar, 4-2 
  toolbar, 6-2, 6-4 thru 6-7 
 major, 4-7, 5-11 
 Major Tic Length, 5-11 
 Make a Copy of a Study, 4-4 
 Making a Copy of an Existing Alternative, 6-6,  
   6-12 
 manage, 1-2, 3-2 
  analysis periods, 1-2 
  alternatives, 1-2 
  events, 1-2 
  layouts, 3-2 
  schematics, 1-2 
  simulations, 1-2 
  studies, 1-2 
 management, 3-2 
 management team, 1-1 
 Management Tools Toolbar, 3-4 
 manager, 1-2 
 Managing Studies, 4-1 
 manual, xix, 1-2 
 map, 2-3, 3-2 thru 3-4, 3-7 thru 3-10, 4-1, 4-3 thru  
   4-5, 4-7, 4-8, 5-1, 5-3 thru 5-9, 5-11 thru 5-15,  
   6-1, 6-3 thru 6-5, 6-8, 6-9, 6-11 
  coordinate information, 4-7 
  layers, 3-3, 4-1, 4-4, 4-7, 4-8, 5-1, 5-3 thru 5-5,  
   5-7, 5-15 
  properties, 5-5, 5-8 
  save, 3-3 
  windows, 3-3, 3-4, 3-7, 4-3 
 Map Coordinate Information, 5-6 
 Map Default Properties for StudyName, 5-2, 5-6,  
   5-7 
  Coordinate System, 5-6 
  Edit, 5-6 
  Extents, 5-7 
   Easting, 5-7 
   Northing, 5-7 
  Grow to Map Extents, 5-7 
  Map Extents, 5-6 
  Ste Map Extents to Display, 5-7 
 Map Extents, 5-6 
 map layer, 2-3, 4-5, 4-1, 5-1, 5-3 thru 5-8 
 Map Layer Formats, 5-1, 5-3 
  Arc Shapefiles (.shp), 5-1 
  AutoCAD® DXF (.dxf), 5-2 
  Raster Image, 5-2 
 Map Layer Formats Supported by HEC-WAT, 5-2 
 Map Layer Properties Dialog Box – Scale Tab, 5-8 
 Managing Studies, 4-1 
 map layers, 3-8, 4-2, 4-4, 4-7, 4-8, 5-1, 5-3 thru  
   5-5, 5-7 
  add, 3-3, 4-2, 5-3, 5-4 
  remove, 3-3, 5-4 
  setting up, 3-3, 3-4, 3-7 
 Map Layers, 5-1, 5-5, 5-6 
 
 

 map window, 3-7 thru 3-10, 4-3, 5-4, 5-5, 5-7, 5-8,  
   5-11 thru 5-15, 6-1, 6-3 thru 6-5, 6-8, 6-9, 6-11 
  alternative, 6-3, 6-5, 6-8, 6-11 
  cascading, 3-3 
  next, 3-3 
  open, 3-3 
  print, 3-4 
  schematic, 4-3, 6-1, 6-4, 6-9 
 Map Window Properties, 3-3 
 map windows, 3-3, 3-4, 3-17, 5-4, 5-5, 5-7 thru  
   5-9, 5-11 thru 5-15 
  adjust, 3-3 
  appearance, 3-3 
  properties, 3-3 
  setting up, 3-3 
 Map Windows, 3-9 
 maps, 2-3, 3-1, 3-6, 4-2, 5-1, 5-4, 6-5, 6-6, 6-11 
 maps folder, 4-2 
 Maps, 3-3, 3-8, 4-3, 5-4 
 Maps Menu 
  Add Map Layers, 3-3, 5-4 
  Default Map Properties, 3-3, 5-6 
  Export, 3-3 
  Import, 3-3 
  Map Window Properties, 3-3 
  New Map Window, 3-3 
  Remove Map Layers, 3-3, 5-4 
  Save Map Image, 3-3 
  Zoom To All, 3-3 
 Maps Tab, 3-8, 5-5, 5-7 thru 5-9, 5-14 
 measures, 2-3, 2-5, 3-9, 4-8, 6-3, 6-5, 6-7, 6-8,  
   6-11, 6-12 
  delete, 3-9 
  edit, 3-9, 6-5, 6-11 
  flood control, 2-3 
  flood damage reduction, 2-3 
  levees, 2-3 
  modify, 3-9 
  reservoirs, 2-3 
  restoration, 2-3 
 memory, 3-3 
 Memory Monitor, 3-3 
 menu, 3-2, 3-3, 3-4, 4-1, 4-2, 4-5, 4-6, 4-7, 5-4  
   thru 5-6, 5-14, 6-2, 6-4 thru 6-11 
  Compute, 3-3 
  Edit, 3-2, 6-2, 6-4 thru 6-7 
  File, 3-2, 3-4 
  Help, 3-4 
  Maps, 3-3, 5-4, 5-5, 5-6 
  Results, 3-3 
  Tools, 3-3 
  View, 3-2 
  Window, 3-3 
 menu bar, 3-4 
 Menu Bar, 3-2 
 menus, 3-2, 3-3 
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 message 
  warning, 5-5, 6-4, 6-5, 6-9 thru 6-11 
 Message Pane, 3-7 
 messages, 3-7 
 Messages, 3-3 
 minor, 5-11 
 minus sign, 5-9 
 model, 1-1, 1-2, 2-2, 2-4, 3-1, 3-2, 3-4, 3-5, 3-7,  
   3-10, 4-7, 4-8, 6-1 
  alternatives, 3-2, 3-4, 3-7 
  files, 4-7, 4-8 
  identification, 1-2, 2-2, 6-1 
  parameters, 2-4, 3-1, 3-5, 3-10, 6-1 
  results, 2-2, 3-10 
  runs, 1-1 
  sequencing, 1-2, 2-2 
  setup, 1-1 
 Model, 1-2 
 Model Linking, 3-4 
 Model Linking Editor, 3-2, 3-4 
 Model Results, 1-2 
 model runs, 1-1 
 model parameters, 2-4, 3-1, 3-10 
 model setup, 1-1 
 modeling, 1-1, 1-2, 2-1 thru 2-4 
  programs, 1-2 
  results, 1-1, 1-2 
  teams, 2-3 
 modeling results, 1-1, 1-2 
 modeling teams, 1-1, 2-3 
 models, 1-1, 1-2, 2-2 thru 2-4, 3-1, 3-2, 3-10 
 Move Down, 5-5, 5-14 
 Move to Bottom, 5-5, 5-14 
 Move to Top, 5-5, 5-14 
 Move Up, 5-5, 5-14 
 multi-disciplinary, xix, 2-1, 3-1, 3-10 
 
N 
 
 name, 3-2, 4-1, 4-2, 4-3, 5-5, 6-1, 6-3, 6-4, 6-6  
   thru 6-10, 6-12 
  alternative, 6-1, 6-3, 6-4, 6-6 thru 6-10 
  default alternative, 4-2, 6-1 
  schematic, 6-9 
  stream alignment, 4-7 
  study, 4-1, 4-3, 4-7 
 Name, 5-5, 6-2 thru 6-4, 6-6, 6-8, 6-9, 6-12 
 networks, 2-2, 3-1 
 new 
  alternative, 6-6, 6-12 
  schematic, 6-3, 6-4, 6-6, 6-8, 6-9, 6-12 
  study, 4-1, 4-2 
 New, 5-13, 6-2, 6-8 
 New Alternatives, 6-2, 6-3, 6-8 
 New Alternatives Dialog Box, 6-2 
  Description, 6-2, 6-8 
  Name, 6-2, 6-8 

  Schematic, 6-3, 6-8 
  Stream Alignment, 6-3, 6-8 
 New Map Window, 3-3 
 New Study, 3-2, 4-1 
  dialog box, 4-1 
 New Study Dialog Box, 4-2, 4-4 
  Add Maps, 4-2 
  Create Default Alternative, 4-2 
  Other, 4-2 
 NexGen, xvii, 1-1 
 Next Generation Software Development  
   Project, xvii, 1-1 
 Next Window, 3-4 
 Node Color, 5-12 
 Node Outline Color, 5-12 
 Node Width, 5-12 
 nodes, 4-7, 5-3, 5-12 
 nomenclature, 2-2 
 non-topological geometry, 5-1 
 northing, 5-2, 5-6 
 Northing 
  Maximum, 5-7 
  Minimum, 5-7 
 
O 
 
 objectives, 2-2 
 Only show layer in the following scale range, 5-8 
 Only visible above 1:, 5-8 
 Only visible below 1:, 5-8 
 open, 6-2 thru 6-9 
  Browser, 4-2 
  existing study, 4-1 
  map window, 4-3, 6-3, 6-5, 6-9 
 Open, 3-2, 4-2, 4-3, 5-4, 6-11 
 Open Browser, 4-2, 4-3 
 Open Study, 3-2, 4-3 
 Opening an Existing Study, 4-3 
 operations, 2-4 
 Options, 3-3 
 order, 2-2, 3-2, 3-4 
  program, 3-2, 3-4 
 organize, 2-2, 3-6 
 organization, 1-2 
 Organization of Manual, 1-2 
 origin, 5-3, 5-6 
 Other, 4-2 
 output, 1-2, 2-1, 2-2 
 overview, 1-2, 3-5 
 Overview, 1-2, 2-1, 3-1, 6-1 
 Overview of HEC-WAT, 1-2, 2-1 
 
P 
 
 pane, 3-7, 6-8 
 panes 
  Content Pane, 3-5, 3-6, 5-7 
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  Desktop Pane, 3-7, 4-3, 4-8, 6-1, 6-3 thru 6-5,  
   6-8, 6-9, 6-11 
  Message Pane, 3-7 
  Study Pane, 3-5, 3-6, 4-3, 6-8 thru 6-12 
 Panes, 3-5 
 parameters, 2-4, 3-1, 3-5, 5-2, 6-1 
 partners, 2-1 
 PDT, 1-2, 2-1 
 physical representation, 2-3 
 planner, 2-2 
 planning, 1-1, 2-1, 2-2 
 plotting, 3-2 
 plug-in, xix, 3-3, 3-10 
 plug-ins, xvii 
 Plug-Ins, 3-10 
 plus sign, 5-9 
 PM, 2-2, 2-3 
 point, 3-8, 4-5, 5-1, 5-6, 5-7 
 points, 2-3, 4-7, 5-3, 6-7, 6-12 
  common computation, 4-8, 6-7, 6-12 
  vertex, 4-7 
 polygons, 5-1, 5-3 
 polylines, 5-1 
 precipitation, 2-4 
 precipitation runoff response, 2-4 
 Previous Window, 3-4 
 Preview Changes, 5-11 
 primary layer, 5-14 
 primary layers, 5-1, 5-9 
 Primary Layers, 5-9, 5-14 
 print 
  active map, 3-2 
  map window, 3-4 
 Print Map, 3-2 
 process 
  anlaysis, 2-2 
  analytical, xix, 1-2 
 program, 2-1, 2-5, 3-2 thru 3-5, 3-7, 4-7, 5-1, 5-9,  
   5-13 
 program order, 3-2, 3-4, 4-7 
  XML, 4-7 
 programOrder.xml, 4-7 
 Program Order, 3-2, 3-4 
 programs, 2-2, 3-1, 3-3, 5-2 
  compute, 3-3 
  individual, 3-3 
  sequence order, 2-2, 3-1 
 Programs Toolbar, 3-5 
 Programs, 2-5, 3-5 
 project, xvii, 1-1, 1-2, 2-1, 2-2 
  delivery team, 1-2, 2-1 
  management, 1-1 
  NexGen, xvii 
  status, 1-1 
  study, 1-1, 2-2 
 project delivery team, 1-2 
 Project Delivery Team, 2-1 
 

 Project Manager, 2-2 
 project management, 1-1 
 project status, 1-1 
 project study, 1-1, 2-2 
  feasibility, 2-2 
  reconnaissance, 2-2 
 projection, 5-3, 5-4 
 properties, 5-5, 5-8, 5-14, 6-7, 6-8, 6-12 
  alternative, 6-7, 6-8, 6-12 
  map layer, 5-5 
  map windows, 3-3 
  system, 3-3 
  viewing, 6-12 
 Properties, 5-5, 5-8, 5-9, 5-14, 6-7, 6-12 
 Properties for Alternative Name, 6-7, 6-12 
 Properties for AlternativeName Dialog Box, 6-7 
 Purpose, 1-1 
 
R 
 
 rainfall-runoff analysis, xvii, 1-1 
 RAS, xvii, 2-2, 2-4, 3-1 thru 3-3, 3-5, 3-10, 4-7 
  folder, 2-4, 4-8 
 raster, 5-2, 5-3, 5-15 
 Raster image, 5-2 
 Raster Image, 5-2 
 Raster ImageFile, 5-2 
 Recent Studies, 3-2, 4-3 
 reconnaissance, 2-2 
 Relationship of Alternatives and Analysis  
   Periods to Simulations, 2-5 
 Relationship of Alternatives and  
   Schematics, 2-4 
 remove 
  map layers, 5-4 
 Remove, 5-5 
 Remove Map Layers, 3-3, 5-6 
 Remove Map, 5-4, 5-5 
 Remove Map Dialog Box, 5-5 
  Existing, 5-5 
  Name, 5-5 
  Remove, 5-5 
 Remove Scale Factore, 5-6, 5-8 
 Removing Map Layers, 5-4, 5-6 
 rename 
  alternative, 6-4, 6-9 
  alternatives, 6-8 
 Rename, 6-4, 6-9 
 Rename Alternatives, 6-4, 6-9 
 Rename Alternatives Dialog Box, 6-4, 6-10 
  Description, 6-4, 6-9 
  Existing, 6-9 
  Name, 6-4, 6-9 
  Rename, 6-9 
 Renaming an Alternative, 6-4, 6-9 
 reporting, xvii, 1-1 
  modeling results, 1-1 
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  status, 1-1 
 reports, 1-2 
 representation, 1-1, 2-2, 2-3, 3-7, 5-2, 5-3, 6-1 
 representations, 1-2, 2-2, 5-3, 5-13, 6-1 
  schematic, 1-2, 2-2, 6-1 
  vector, 5-3 
 reservoir, 1-2, 2-2, 2-3 
 reservoir system analysis, xvii, 1-1 
 Reservoir System Simulation, 2-2 
 reservoirs, 2-3, 3-1 
 response 
  hydrologic, 2-4 
  precipitation runoff, 2-4 
 Resources Management Associates, xvii 
 ResSim, xvii, 2-2, 3-1 thru 3-3, 3-5, 3-10, 4-7 
 restoration, 2-2, 2-3 
 Restore Layout, 3-3 
 Result Comparison Manager, 3-3, 3-5 
 results, xvii, 1-1, 1-2, 2-2 thru 2-5, 2-8, 3-1 thru  
   3-3, 3-5, 3-7 thru 3-10, 3-12, 3-14, 3-16, 4-5 
  model, 2-2 
 Results, 1-2, 3-3, 3-7 
 Results Menu 
  FIA, 3-3 
  HMS, 3-3 
  RAS, 3-3 
  ResSim, 3-3 
  Result Comparison Manager, 3-3 
 River Analysis Systems, 2-2 
 river hydraulics, xvii, 1-1 
 RMA, xvii 
 run, 2-2, 3-1, 3-7, 5-13 
  program, 5-13 
  sequence, 2-2 
  simulation, 3-1 
 runs, 1-1 
  model, 1-1 
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 save, 4-4, 6-12 
  alternative, 6-12 
  map window, 3-3 
  study, 4-1 
 Save, 3-3, 3-4, 4-4, 4-5, 6-12 
 Save a Study, 4-4 
 Save Alternative As, 6-6, 6-12 
 Save Alternative As Dialog Box, 6-7 
  Descripiton, 6-12 
  Name, 6-6, 6-12 
 Save a Study, 4-4 
 Save As 
  alternative, 6-6 
 Save File Dialog Box, 4-4 
  Save, 4-4 
 Save Layout, 3-3 
 Save Map Image, 3-3 

 Save Study, 3-2, 4-4 
 Save Study As, 3-2, 4-4 
 Saving an Alternative, 6-12 
 scale, 5-6 thru 5-8, 5-13 
 Scale, 5-8, 5-13 
 Scale menu, 5-13 
  New, 5-13 
  Set to Defaults, 5-13 
 schematic, 1-1, 1-2, 2-2 thru 2-4, 3-2, 3-5 thru 3-7, 
   3-9, 3-10, 4-3, 4-7, 5-1, 6-1, 6-3, 6-4, 6-6, 6-8,  
   6-9, 6-11, 6-12 
  common, 1-1, 2-2, 3-2 
  create, 6-3, 6-8 
  data, 4-7 
  default, 6-1 
  elements, 2-2, 2-3 
  map window, 4-3, 6-1, 6-3, 6-4 
  new, 6-3, 6-4, 6-8, 6-9, 6-12 
  representations, 2-2, 6-1 
 Schematic, 3-9, 6-3, 6-8 
 schematic map window, 3-9, 4-3 
 Schematic Tab, 3-9, 4-8 
 schematics, 1-2, 2-2, 2-3, 3-1, 3-9, 5-9 
  created, 3-9 
  deleted, 3-9 
  edited, 3-9 
 Schematics, 2-4 
 scripts, 3-3 
  creating, 3-3 
  editing, 3-3 
 Scripts, 3-3 
 Select Map, 6-3, 6-5, 6-8, 6-9 
 Select Map Dialog Box, 6-3 
 Select Map to Add, 4-2, 4-3, 5-4 
  Create Copy, 4-2, 5-4 
  Files of type, 5-4 
  Open, 4-2, 5-4 
 Select Map to Add Browser, 5-4 
 sequence, 2-2, 3-1 
  order, 2-2, 3-1 
 sequence order, 2-2, 3-1 
 sequencing, 1-2, 2-2 
 Set Display Units, 3-3 
 Set Map Extents to Display, 5-7 
 Set Scale for Zoom-in, 5-6, 5-7 
 Set Scale for Zoom-out, 5-6, 5-8 
 Set to Current, 5-8 
 Set to Defaults, 5-13 
 Setting Visualization Scales – Map Layer, 5-7 
 shape, 5-1 
 shapefile, 2-3, 3-3, 5-1 
 shapefiles, 2-2, 3-1, 5-2 
 Shapefiles, 5-1 
 shapes, 5-1 
  point, 5-1 
  polylines, 5-1 
  polygons, 5-1 
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 share, 2-2, 3-1 
 shortcut menu, 5-5, 5-7 thru 5-9, 5-14, 6-2, 6-4  
   thru 6-12 
 shortcut menus 
  Alternative and Simulation Manager 
   Alternatives 
    Delete From Study, 6-5 
    Display in Map Window, 6-5 
    Edit, 6-6 
    New, 6-2 
    Properties, 6-7 
    Rename, 6-4 
    Save As, 6-6 
  Map Layers 
   Change Label, 5-5 
   Collapse, 5-5 
   Expand, 5-5 
   Move Down, 5-5 
   Move to Bottom, 5-5 
   Move to Top, 5-5 
   Move Up, 5-5 
   Properties, 5-5, 5-8 
   Remove Scale Factors, 5-6, 5-8 
   Set Scale for Zoom-in, 5-6, 5-7 
   Set Scale for Zoom-out, 5-6, 5-8 
   Show Legend, 5-5 
  Primary Layers 
   Collapse, 5-14 
   Expand, 5-14 
   Move Down, 5-14 
   Move Down, 5-14 
   Move to Bottom, 5-14 
   Move to Top, 5-14 
   Move Up, 5-14 
  Study Pane 
   Alternatives 
    Delete, 6-10 
    Delete From Study, 6-10 
    Edit, 6-11 
    New, 6-8 
    Properties, 6-12 
    Rename, 6-9 
    Open, 6-11 
    Save, 6-12 
    Save As, 6-12 
 Shortcut Menu for Map Layers, 5-5 
 Shortcut Menu for Primary Layers, 5-14 
 Show Legend, 5-5 
 Show Stream Name, 5-11 
 simulation, 2-1, 2-4, 3-3 thru 3-7, 3-10, 4-1, 4-5,  
  5-1, 5-13, 5-14 
 simulation map window, 5-13, 5-14 
 Simulation, 4-1, 5-13 
 simulation layer, 5-14 
 Simulation Layer, 5-13 
 simulations, 1-2, 2-1, 2-4, 2-5, 3-1 thru 3-6,  
   3-8, 3-9, 4-4, 5-9, 6-1, 6-5, 6-10 
 

  comparison, 3-3 
  create, 3-8 
  delete, 3-8, 6-5, 6-10 
  edit, 3-8 
  individual, 3-3 
  multiple, 3-3 
 Simulations, 3-8 
 size, 5-11, 5-12 
 Size, 5-11, 5-12 
 snowmelt, 2-4 
 social, 1-1 
 software, xvii, xix, 1-1, 2-1, 2-4, 3-1, 3-5, 3-10,  
   5-1, 5-3 
 spatial 
  configuration, 3-1 
  features, 5-1 
  properties, 3-3 
 spatial configuration, 3-1 
 spatial features, 5-1 
 spatial properties, 3-3 
 splash dialog box, 2-5 
 SSP, xvii, 2-2, 3-1, 3-3, 3-5 
 Standard Toolbar, 3-4 
 stakeholders, 2-1 
 Start, 2-5 
 starting, 2-8, 2-9 
 Starting the WAT, 2-5 
 state plane coordinates, 5-4 
 starting, 2-8, 2-9 
 Station, 5-19 
 Statistical Software Package, 2-2, 3-3, 3-5, 3-7 
 status, 1-1, 1-2, 3-7, 3-10 
  project, 1-1 
  simulation, 3-7 
  study, 1-2 
 Status, 3-3 
 storage, 2-2 
 stream, 2-2, 2-3, 3-1, 3-3, 3-8, 3-9, 4-4, 4-7, 5-1,  
   5-4, 5-9 thru 5-13, 6-3, 6-5, 6-7, 6-8, 6-11,  
   6-12 
  alignment, 2-3, 3-9, 4-4, 4-7, 5-1, 5-4, 5-9 thru  
   5-13, 6-3, 6-5, 6-7, 6-8, 6-11, 6-12 
  networks, 2-2, 3-1 
  system, 3-1 
 stream alignment, 2-3, 3-3, 3-9, 4-4, 4-7, 5-1, 5-4,  
   5-9 thru 5-13, 6-3, 6-5, 6-7, 6-8, 6-11, 6-12 
  default, 6-3, 6-8 
  descripiton, 4-7 
  edit, 6-5, 6-11 
  stream element, 4-7 
  stream nodes, 4-7 
  vertex points, 4-7 
 Stream Alignment, 5-1, 5-9, 5-13, 6-3, 6-8 
 Stream Alignment Layer, 5-1, 5-9, 5-13 
  Streams, 5-9 
  Stream Junctions, 5-9 
  Stream Nodes, 5-9 
 



HEC-WAT User's Manual Index 

 Index-13 

 Stream Alignment Properties, 5-9, 5-11 thru 5-13 
 Stream Alignment Properties Dialog Box, 5-10 
  Apply, 5-11, 5-12 
  Choose Font, 5-11, 5-12 
  Draw Junctions, 5-12 
  Draw Station Tics, 5-11 
  Draw Stream Nodes, 5-12 
  Draw Tic Labels, 5-11, 5-12 
  Edit Properties, 5-11 
  Junction Color, 5-13 
  Junction Width, 5-13 
  Major Tic Length, 5-11 
  Node Color, 5-12 
  Node Outline Color, 5-12 
  Node Width, 5-12 
  Scale Menu, 5-13 
  Show Stream Name, 5-11 
  Stream Color, 5-10 
  Tic Length, 5-11 
 Stream Alignment Properties – Stream  
   Junctions, 5-13 
 Stream Alignment Properties – Stream Nodes, 5-12 
 Stream Alignment Properties – Streams, 5-10 
 Stream Alignment Properties – Tic Marks, 5-11 
 Stream Color, 5-10 
 stream element, 4-7 
 stream junctions, 5-9, 5-12, 5-13 
 Stream Junctions, 5-9, 5-12 
 stream networks, 2-2, 3-1 
 stream nodes, 4-7, 5-9, 5-12 
 Stream Nodes, 5-9, 5-12 
 stream stationing, 5-11 
 stream system, 3-1 
 Stream Width, 5-9 
 stream.align, 4-7 
 streamline, xix, 1-1, 3-10 
 streamlines, xvii, 1-1, 2-1, 3-1 
 streams, 5-4, 5-9 thru 5-11 
 Streams, 5-9 
 studies, xvii, xix, 1-1, 1-2, 2-1, 2-2, 3-2, 4-3, 5-6,  
   6-1 
  area, 2-3 
  boundaries, 2-3 
  CAP, xix, 2-1 
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